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Intro
The Cumulus® Digital Asset Management System provides powerful

tools for archiving, managing and marketing your digital files.

Cumulus can store any type of digital media assets, including all types

of documents, images, audio, video, layouts from publishing pro-

grams, presentations, and PDF files. Once assets are stored, Cumulus

becomes a central media repository from which you and your co-

workers can view, locate, search, organize, copy, move, categorize, and

otherwise manipulate the cataloged assets. Once you've settled on a

process for storing and retrieving your digital assets that works for you,

the process can be automated, further enhancing the efficiency of

your workflows. 
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Cumulus
Canto offers different editions of Cumulus and various add-on products. To see 
Cumulus in action, watch the Cumulus Product Tour.

This User Guide
This guide covers the Cumulus Client functionality of Cumulus Workgroup as 
well as Enterprise. Functions and feature that are available with certain editions 
or add-product only are denoted. The Administrator functionality is covered in 
the Cumulus Administrator Guide. How to install Cumulus editions is described in 
the corresponding Installation Guides. The Installation Guides also contains 
descriptions on how to register and activate add-on products.

Organization
This guide offers the following basic ways to learn about Cumulus:
• Table of Contents – Find information based on section and heading.
• Index – Find information based on alphabetical listing by topic. 
• Concept – Learn Cumulus basics. (See “Explore Cumulus” chapter, starting on 

page 15.)
• Tasks – Learn Cumulus based on the need to do a certain task. (See “Use 

Assets” chapter, starting on page 65, and the “Specialized Usage” chapter, 
starting on page 133.)

• Special functions – Learn the basics of working with Cumulus Vault and with 
the Cumulus URL AssetStore Module and find out how Cumulus supports MS 
Office documents or RAW Images. You can also learn how to assign individ-
ual record and category permissions. (See “Specialized Usage chapter, start-
ing on page 133.)

• Preferences – Learn about the various settings that can be made for Cumulus. 
(See “Customize Cumulus” chapter, starting on page 181.)

• Reference – Learn what the program can do based on what each menu 
option does. (See “Menu Reference” chapter, starting on page 245.)

Information is not necessarily presented in the order in which you should read it. 
The way you’ll use Cumulus determines what information is of most use and 
importance to you. 
Here are some guidelines based on user experience:
• “I know nothing about Cumulus or my computer.”
• If this is you, then you need to read the manual that came with your operat-

ing system before you try to learn to use Cumulus. Cumulus is very easy to 
use, but it relies on many user interface conventions found on the supported 
platforms (drag and drop, opening and closing files, etc.). If you’re not familiar 
with using your computer, you’ll get lost pretty quickly.

• “I’ve got my computer down, but I’ve never used Cumulus or anything like it. 
All I need to do is access some Cumulus catalogs that are already made.”
You’ll find chapter “Menu Reference,” p. 245, very useful. It offers a menu-by-
menu rundown of the entire program. At some point you should glance over 
chapter “Use Assets,” p. 65, for a better understanding of Cumulus and what’s 
possible. 

• “I’ve got my computer down, but I’ve never used Cumulus or anything like it. 
And I need to build my own file collections.”
To get you up to speed on Cumulus basics, read chapter “Explore Cumulus,” 
p. 15. But before you start doing any real work, make sure that you’ve read the 

http://www.canto.com/en/docs/flash/intro-demo/demo.php
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chapter “Use Assets,” p. 65. This section explains some very important stuff 
that you should know before building your own catalogs. While using the 
program, you’ll find the chapter “Menu Reference,” p. 245, a great resource.

• "I’m already familiar with programs like Cumulus. This is nothing new to me."
You may want to start out in the chapter “Menu Reference,” p. 245, to get an 
idea of the options available in Cumulus. But it’s also a good idea to skim 
through the chapter “Use Assets,” p. 65, to make sure there’s nothing that 
you’ve missed.

• “I’m a complete Pro. There’s nothing that this manual could tell me that I 
don’t already know. I’ve seen it all, done it all, know it all!”
Canto accepts job applications online and is always looking for a few more 
geniuses like you. (www.canto.com)

Cross-Platform Issues
Cumulus is a cross-platform application, meaning that it runs on Windows® and 
Mac® OS X (Macintosh®) systems. Though the program’s features are identical in 
each version, portions of the user interface differ due to operating system or key-
board conventions. These differences are denoted or explained when necessary 
and assumed otherwise (e.g., the difference between “maximizing” a window in 
Windows, and “zooming” a window in the Mac OS X is not explained).

This icon denotes what pertains to Mac OS X only.
This icon denotes what pertains to Windows only.

User Interface Item Conventions
To differentiate user interface items – buttons, menus, text fields, etc. – from sur-
rounding text, those items are displayed in bold. For example:

“Click the Open button.”
To differentiate menu hierarchies, the > character is used. For example:

“Select File > Open to open a file.”
This example means to select the Open item from the File menu.

Cumulus Step by Step
Instructional steps are identified by the following structure:

1. This would be the first instruction. The mouse icon makes it easy to identify.

2. The final instruction has a border beneath it, indicating that there are no fur-
ther steps.

Your Experience
You’re a busy professional. You probably don’t have time to read this entire man-
ual before you get started with the program. To ensure that the amount of mate-
rial found within this document is kept to a minimum, assumptions about your 
experience have been made.
This manual assumes that you have a basic understanding of the use of your 
computer’s operating system and the terminology used therein. For example, if 
you were asked to open a file, would you know how? How about saving a file in 
a new location? Or changing window sizes? If these actions are child’s play for 
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you, then you’re set. If not, review the user instructions that came with your com-
puter.
Cumulus is a well-designed, easy-to-use program that takes advantage of oper-
ating system standards. As such, many of its features will be obvious to you. Any 
parts of the program that are unique to using Cumulus are explained in detail.

Understanding Cumulus
To get started with Cumulus, you need to understand only a few basic concepts. 
Cumulus creates special files called catalogs, which Cumulus uses to keep track 
of your valuable assets. As you catalog your assets, Cumulus creates special cata-
log entries called records that represent the assets to be managed. Each record 
contains vital searchable information about the asset it represents. To make 
searching and retrieving records easier, Cumulus lets you organize and classify 
records into logical groups called categories. Any individual set of records com-
prises a collection. A collection is a way of looking at catalog(s).

Assets
An asset in Cumulus is simply any one cataloged file or data stream. A video clip, 
an audio clip, an image, or a page layout document are examples of files that are 
commonly cataloged in Cumulus. But the word file suggests an asset that is 
stored on a digital medium like a hard-disk or CD-ROM. What if the asset is a 
record in a database? This is not a file per se, but as far as Cumulus is concerned, 
it is a data stream that can be cataloged, kept track of and accessed. 

Catalogs
Like a filing cabinet, Cumulus catalogs serve as storage locations for asset collec-
tions. You can have as many catalogs as you like. Catalogs are cross-platform 
compatible, so it doesn’t matter what type of computer is used to create a cata-
log. For more information, see “Catalogs”.

Collections
Collections are like snapshots from your open catalog(s). When you work with 
your assets in Cumulus, you’re viewing a constantly changing group of records. 
Without collections, each view of this group would be lost as soon as it is was 
changed. Collections, however, enable you to capture any particular set of 
records and save it as you see it - all without disrupting your workflow. Once you 
see something you like or could use again, save it as a collection and recall it 
whenever you need it. You can even send your collection as an attachment to an 
e-mail message in one easy step.
A collection also acts as your temporary workspace in Cumulus, meaning that 
changes made to your collections do not affect the content of your catalogs. 
Even deleting a record from a collection does not remove it from the catalog 
(unless you really want it to, which you can do, too). For more information, see 
“Collections”. 

Categories
Like folders in a filing cabinet, Cumulus categories serve to organize assets (files). 
But here the similarities end. Assets can appear in any number of Cumulus cate-
gories at the sametime. For more information, see “Categories”. 
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Records
Records represent assets. Each record represents one asset. Records hold infor-
mation on the asset, such as file size, type, location, creation date, and much 
more. Cumulus allows the creation of customizable record fields, which can con-
tain almost any sort of information you desire. Since these user-defined record 
fields are also fully searchable, you can tailor Cumulus to fit your requirements.
It’s very important to draw the distinction between records and assets. Records 
are part of Cumulus catalogs; assets are not. Records represent assets. For more 
information, see “Assets/Records”.

How These Work Together
Cumulus creates special files called catalogs, which Cumulus uses to keep track 
of your valuable assets. As you catalog your assets, Cumulus creates special cat-
alog entries called records, which are indicators to the media assets. To make 
searching and retrieving records easier, Cumulus lets you organize and classify 
records into logical groups called categories. 
Once cataloged, you can view assets as thumbnails or as plain text, conduct 
searches using generic or user-defined conditions, and track the location of the 
original digital media file and preview it. Each record contains vital searchable 
information about the asset, such as its file name, file location, file type, file size, cre-
ation/modification date, height, width, and more.
Cumulus uses catalogs to manage your assets. A Cumulus catalog contains 
records that represent the assets to be managed. A record contains information 
on the asset it represents. This information is stored in Record fields. Cumulus 
makes it possible for you to determine precisely what sort of information should 
be kept on your assets. This can be defined differently for each catalog as each 
catalog can have different Record fields. 
Any individual set of records comprises a collection. A collection is a way of look-
ing at your catalog(s) – the way that you are looking at it at any given time. A col-
lection can be saved. Then the collection file remembers the records it contains 
and even more as the Record View Set used and special stuff as the column 
width of the Details View.
A Record View Set defines how records are displayed in the different view modes 
Cumulus provides: Thumbnail View, Details View, Report View, Info View and 
Information window. View Sets define which field’s information should be dis-
played and how (font and color). These definitions are not specific to any one cat-
alog. They do not care about a catalog’s record fields and whether any 
information is there to be displayed. That’s why you have to take care to select a 
View Set that fits the catalog(s) or collection(s) you work with.
An Asset Handling Set is also not specific to any one catalog. It affects how 
Cumulus deals with your assets – during the cataloging process and when 
accessing assets. And again it is up to you to select an Asset Handling Set that fits 
the assets you use it for.

Sets and Templates 
To ease your work Cumulus provides several sets and templates. Access to them 
is controlled via user permissions. Users who are allowed to create them can 
share them so that they are accessible to all users with the permissions to use 
them.
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View Sets
View Sets define which field’s information should be displayed and how (font 
and color). These definitions are not specific to any one catalog. They do not care 
about a catalog’s record fields and whether any information is there to be dis-
played. That’s why you have to take care to select a View Set that fits the cata-
log(s) or collection(s) you work with. A Record View Set defines how records are 
displayed in the different view modes Cumulus provides: Thumbnail View, 
Details View, Info View and Information window.
Once you have added the fields you need, you define the screen layouts that 
enable users to interact with your metadata. Cumulus calls these layouts “View 
Sets.” Each View Set contains several different types of views, including thumb-
nail views, list views, asset previews and more. A single View Set represents the 
way each of these individual views appear to users. 
Each view in a View Set can contain a different array of metadata fields from your 
catalog. This is helpful because you don't likely want to see all of your data fields 
when looking at thumbnails, but you would want to see them when looking at 
an Information View. Some metadata fields, such as thumbnail or record name, 
might be useful in both views.
The ability to create different View Sets enables you to configure screen layouts 
that are task or user specific. For example, when browsing catalogs for images, a 
layout artist might want to see a Thumbnail View that includes no other fields. To 
address this, you'd create a “Browsing” View Set. The omission of others fields in 
the Thumbnail View enables Cumulus to display as many thumbnails on a single 
screen as possible, which is great for browsing. The Info View of your “Browsing” 
View Set might include the remaining fields that a layout artist should see before 
making a selection, such as “License Restrictions,” “Copyright Notice” and 
“Approval Status” fields.

Asset Handling Sets
An Asset Handling Set is also not specific to any one catalog. It affects how 
Cumulus deals with your assets – during the cataloging process and when 
accessing assets. And again it is up to you to select an Asset Handling Set that fits 
the assets you use it for.

Metadata Templates 
In order to fill asset records with predefined metadata values, Cumulus provides 
Metadata Templates. You can think of Metadata Templates as a “rubber stamp” 
that’s applied to a selection of asset records. Metadata Templates can be used to 
update existing asset records or “prefill” new asset records during cataloging. 

Print Templates
Different combinations of print options can be combined and saved as Print 
Templates. A Print Template defines how records will be printed. Print Templates 
include definitions for the document layout (page size and orientation, as well as 
margins) and the layout of the records to be printed. Either a Record View Set or 
defined advanced print settings can serve as print layout for the records.

Permissions Templates
Permissions templates enable you to assign, remove or explicitly set individual 
asset or category permissions for users or entire groups at once. Note that per-
missions templates are available only when connected to a Cumulus Enterprise 
Server. 
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A Permissions template includes permissions for records and categories. 
Depending on the context in which a template is used, either the record or cat-
egory permissions will be used. With selected records, the defined record per-
missions will be used; with categories, the defined category permissions will be 
used.

Finding Help
If you have a question that is not answered in this guide, there are a number of addi-
tional resources to check:

Online Help 
Cumulus includes an online help system. Access it via the Help menu, the F1 key 
or the Help buttons provided in dialog windows. Similar to other help systems, 
subjects are organized by contents and index, and are searchable. The Cumulus 
help system is based on HTML pages that can be viewed with any standard Web 
browser. However, if you employ any pop up blockers, the display of the help sys-
tem may not be possible.

Canto Online
The Canto website (www.canto.com) contains many resources of value to you as 
a Cumulus user. Among them Canto's User 2 User Support Forums. These forums 
are non-moderated bulletin boards hosted on the Canto website. Canto support 
does not answer questions here, the forums are user to user only. Feel free to use 
the forums to discuss any problems you may be having using Cumulus and 
receive help from other Cumulus users. 
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Explore Cumulus
In order to exploit the potential of Cumulus fully, it’s necessary to pro-

ceed from a strong foundation. It’s a good idea to know the meaning

and capabilities of the features you’re using in Cumulus and how

they’re related. This section contains an overview of the Cumulus

interface and describes the basic components of Cumulus in more

detail – catalogs, collections, records, and categories.
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verview: The Cumulus User Interface
e Cumulus main window, your workspace, is the Collection window. It provides two main panes, the Category

ane and the Record pane. Additional panes, e.g. the Info pane, can be activated.

Main Toolbar – provides icons for some of the most popular functions and for modifying the workspace. For details refe
to the tooltips that appear when hovering with the mouse over an icon.

Category Pane – displays categories. Each Cumulus catalog is represented by a main category which has by default 
three subcategories. These correlate with the Category Tabs.
The top bar of the Category pane indicates the total number of categories in all open catalogs, the number of currently 
visible categories and the number of selected ones (if any).
Additionally, the Category pane top bar contains three icons:

indicates the active category search options; opens the Search & Sort preferences 
opens a menu to change the Category View Set
closes the Category pane

Record Pane – displays the records of cataloged assets..
The top bar of the Record pane indicates the total number of records in all open catalogs, the number of currently visible
records and the number of selected ones (if any).
Additionally, the Record pane top bar contains icons and selection lists:

displays and/or activates filters
toggles the display of records (records of master assets only/records of all assets). (For more information, see 
page 129.)
toggles the sort order (ascending/descending)

displays the current sorting criteria; 
clicking on the arrow opens a selection list of available sorting criteria (record fields)
displays the current Record View Set; 
clicking on the arrow opens a selection list of available Record View Sets

opens/closes a subpane of the Record pane (for more information, see page 126.)

Status Bar – contains icons for toggling the display of additional panes and one icon to change the order of the left 
side panes:

opens a menu to mange the workspace
hides/shows the Category pane
shows/hides the Information pane (providing further information on the selected record)
shows/hides the Category Information pane (providing information to the selected category)
shows/hides the Thumbnail pane
shows/hides the Preview pane
shows/hides the Calendar pane
All panes listed above are displayed on the left side of the Record pane.
shows/hides the Collection Basket pane on the right side of the Record pane
opens a dialog to rearrange the order in which the panes on the left side are displayed.

1

2 3

4
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Catalogs
A Cumulus catalog is a group of records that, together, represent the assets you 
want to manage. Each asset is represented by one record. There is no limit to the 
number of different media file formats that can be represented in one catalog. 
One of the greatest features of Cumulus is its ability to catalog any digital asset, 
in addition to the file formats directly supported. 
A catalog has a database file at its core. The way you work with the information 
in this file can be extensively customized. 
When you catalog assets, the catalog settings determine how and what sort of 
information Cumulus extracts, creates and stores on the assets as metadata in 
the record fields and category fields.
Each catalog can have its own distinct properties. Any changes made to the catalog 
settings affect the way information is stored on all of that catalog’s assets.  To set 
up a catalog to store information in addition to or differently from the default set-
tings, fields can be added to the catalog either by activating them from the list 
of fields that Cumulus supports or by defining your own custom fields. 
With Workgroup or Enterprise, catalogs can only be created by the Cumulus 
Administrator. And the Cumulus Administrator can give each user different 
rights for each catalog. The range of functions a specific user is allowed to per-
form depends on the rights the Cumulus Administrator assigned to her/him.

Catalog Size and Performance
As catalogs increase in size, so do the requirements they place on computer 
hardware. It takes more processing power to work with 200,000 records than it 
does with 200. It also takes more RAM to hold the larger catalog in memory. 

NOTE: The unique way Cumulus searches for records prevents large catalogs 
from slowing down the search speed.

There is virtually no limit to the size of a catalog file (up to 1 TB). Most users will 
find it best to split catalogs for organizational and performance reasons. The 
actual number of records that can be stored in a catalog and the catalog’s actual 
file size is determined by the size of each record. (See “Record Size,” p. 27.)

Catalog Scope
Catalogs can include records for as many different asset types as you like. But you 
may find it best to have different asset formats cataloged independently. For 
example, it might not make sense to have your image assets in the same catalog 
as your audio clips, though it is possible. 
On the other hand, don’t limit the scope of each catalog too much. For example, 
when you’re looking for an image to use on a Web page, do you care if it’s in GIF 
or JPEG format? Separating similar asset types by specific file format can be 
inconvenient when searching. Cumulus cannot search through catalogs that 
aren’t open. If each of your image file formats has its own catalog, they’ll all have 
to be open if you want to search through all of them. Remember, you can use 
Cumulus’ categories or built-in information fields to find files based on format, 
projects in which they were used, or status, for example.

Live Filtering (optional) 
Maybe you have a “filtered view” on a certain catalog or some or all accessible 
catalogs. The Cumulus Administrator can limit the view of a user or a user group 
to preselected categories and/or records. For example the asset access for the 
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sales staff can be limited to final, approved material, while the work in progress 
in the Marketing department should not be visible. 

Things You Can Do with Catalogs
You can:
• Open the catalogs assigned to you. (See “Connect to Server,” p. 246, and 

“Open Recent Catalog,” p. 246.)
• Search through one or multiple catalogs. (See “Searching,” p. 44.)
If you are the Cumulus Administrator or have the appropriate permissions, you 
can:
• Backup. 
• Change catalog setting. 
• Compress. 
• Copy a catalog.
• Create a new catalog.
• Delete a catalog. 
• Divide a catalog into smaller catalogs. 
• Merge one catalog with another. 
• Publish catalogs on the Internet using Cumulus Sites, Cumulus Web Client, 

Cumulus Web Publisher Pro or Cumulus Internet Client Pro. (For more infor-
mation, see the corresponding Administrator Guide.)

• Rename a catalog. 
• Repair a damaged catalog. 
• Update catalogs from earlier Cumulus versions. 

Adding Assets to Catalogs
The term cataloging describes the process of importing and storing information 
about your digital assets. This information, called metadata, is the data associated 
with a digital asset beyond the actual file data itself. So, while the words you type 
in a Microsoft Word file constitute the file’s data, the file’s name, size, location, 
author, creation date etc. are examples of the file’s metadata.
Some metadata is added to assets automatically by the software used to create 
or edit the asset. This is the case with the most common file metadata, such as 
size and modification date. But, depending on the creating software (or hard-
ware), additional metadata can be embedded, too. This is the case with digital 
cameras that embed photo shoot dates, camera type, lens aperture and shutter 
speed, and even the GPS coordinates of the shot location into the files. 
Additional metadata can be added after the asset has been cataloged. An asset's 
metadata serves as the basis for how you find the asset, so it’s important that 
your DAM system enables you to create as much metadata as you need. For 
example, if you need to find photographs based on the photographer’s name, 
you want to make sure photographer names are included in the metadata stored 
for your photograph assets. If you need to find a Microsoft Word file that includes 
a certain text phrase, is associated with a given fiscal year's revenue, and edited 
within the last month, the proper metadata enables that too. A complete DAM 
solution like Cumulus can also enable you to automatically find all images used 
in that document, and even find the PDFs that were later generated from it.
With regard to file formats, Cumulus can catalog any type of digital asset and 
offers enhanced support for the most popular formats. The term “enhanced sup-
port” means different things, depending on the file format in question. For exam-
ple, Cumulus offers enhanced support for Adobe® InDesign® and QuarkXPress® 
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files by enabling you to preview individual layout pages right from within 
Cumulus. Enhanced support for Microsoft® PowerPoint files enables you to actu-
ally generate new PowerPoint presentations—right from within Cumulus—
using assets and PowerPoint slides cataloged in Cumulus. Enhanced support for 
Microsoft® Word, Excel, Illustrator and PDF files includes extracting text that's 
included inside the files and making it searchable catalog metadata. So, not only 
can you find the files in Cumulus based on metadata—file name, modification 
date, production status, etc.—you can also find some files based on their actual 
contents. 
When you catalog digital assets, Cumulus performs a number of behind-the-
scenes tasks in order to generate an asset record that best represents the asset. 
It’s easiest to think of these tasks as a series of steps through which the asset 
flows during the cataloging process. They are:
• Filters
• Metadata Extraction
• Field Linking
• Metadata Templates
• Central Asset Storage Options
• Asset Handling Sets

Filters   
Filters provide “knowledge” of a given asset type to Cumulus. They are, in fact, 
what enables the program to offer enhanced metadata support for so many file 
formats. For example, the JPEG filter knows to parse incoming JPEG assets for 
information common to that file type, such as horizontal and vertical dimensions 
(and much more). The MP3 filter extracts audio-related metadata, such as length 
and sample rate. Filters are like plug-ins—they can be added, activated and 
deactivated at any time. The Cumulus SDK (software development kit) enables 
others to create custom filters.

Metadata Extraction 
As mentioned, all file formats include at least a basic set of metadata that 
Cumulus captures during the cataloging process. For many file formats, this core 
information is the only metadata captured during cataloging. Some formats, 
however, store extensive metadata right “inside” the file itself through the use of 
metadata standards called XMP, IPTC and EXIF. Popular formats that support one 
or more of these standards include JPEG, PDF and TIFF.
Many applications enable users to “stuff” metadata directly into files using these 
standards. During the cataloging process, Cumulus copies this data into the asset 
record, making it easily searchable. (Cumulus can also write data back into some 
“metadata fat” file formats.)
Metadata can also come from sources other than assets, such as databases or 
financial systems. Cumulus enables you to import metadata originating from 
sources like these into your catalogs through a menu command. This offers a 
great way to synchronize your Cumulus catalogs with other systems, such as 
product databases or financial systems. 
For example, say you have a database that contains details about each of your 
products—UPC codes, color options, sizes, etc.—and you use Cumulus to keep 
track of product photographs used for packaging, online sales and advertising. 
By importing the product data into Cumulus, you can perform the same searches 
for product images as you can for product information.
This is a workflow example already in use successfully at Cumulus installations 
now. One customer produces weekly fliers that showcase sale items. UPC codes 
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for products to be featured are sent to the graphics department who then use 
Cumulus to find acceptable product images. This ensures the correct image is 
used for each product in the advertisements. (If you’ve ever seen a weekly mailer 
that describes one product, but shows another, you can understand the value of 
this workflow.)
Category trees can also be constructed based on imported data. This makes it 
easy to create an organizational structure that’s familiar to your employees: just 
provide Cumulus with a text file that represents your current organization struc-
ture, and the category tree is created for you automatically. The import function 
can also make upgrading to Cumulus from other DAM systems much easier.
No matter what the origin, Cumulus stores all metadata in catalog fields. A 
default set of fields is provided with each newly created catalog, and you can also 
define any number or type of custom fields you need. Later, you’ll read about the 
various field types available in Cumulus.

Field Linking 
Cumulus can map and copy the metadata found inside your assets to appropri-
ate fields inside your Cumulus catalogs. So, for example, the contents of the 
“Notes” field in the asset can be copied to the “Notes” field in the catalog. 
You can also define field links of your own, in case you want to override default 
mappings, or create new ones. This is especially helpful when you want certain 
fields in your catalog to serve the same purpose for different asset types. 
For example, say you work with video in both QuickTime and Windows Media 
formats. QuickTime includes a standard metadata field for video that's called 
“Writer.” Windows Media, on the other hand, includes a field called “Author.” You 
could have fields in your catalogs for both, but then you'd have to include both 
when searching for that information. A more convenient way to go about this 
would be to choose one of those field names for your Cumulus catalog and use 
field linking to map the contents of the other field to that field. That way Quick-
Time “Writer” and Windows Media “Author” metadata are stored in the same cat-
alog field, making searching a breeze.
Asset metadata fields can also be field-linked to generate Cumulus categories. 
This is handy if your assets contain metadata keywords that you want translated 
into Cumulus categories. Cumulus can even generate category trees that emu-
late the folder structure the asset was found in. If your current folder structures 
are based on hierarchies that enhance your workflow, this option offers a great 
way to get instant category trees that will be familiar to users.

Collections
A collection is Cumulus-speak for a set of records from any one catalog or even 
multiple catalogs. It is a way of looking at your catalog(s) – the way that you look 
at it at any given time. Whenever you work with assets in the record and category 
panes – which make up the Collection window – you’re creating or modifying 
collections. When you view the records in any category, you’re looking at a col-
lection. When you view the results of a search, you’re also looking at a collection. 
The same is true for individual records you’ve dragged and dropped into the win-
dow – any ‘snapshot’ of your catalog can comprise a collection. A collection acts 
as your temporary workspace in Cumulus, and you can also save it as a file.
While a collection can contain all records in a single catalog or all in a single cat-
egory, it is neither one nor the other. A collection can also contain – and here is 
where its advantages become obvious – the results of a search (either as a new 
collection or replacement of the current collection), or any records you drag and 
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drop into the Collection window. Any individual set comprises a collection. The 
records in one collection may even belong to different catalogs.
Once saved, a collection file remembers the records it contains and the Record 
View Set used. A collection file also keeps track of column width of the Details 
View.
Assume, for example, that you have a catalog containing thousands of records 
organized neatly into categories. Your latest project, however, only requires 
assets from four of those categories, and from those it only requires the image 
files. You could first run a search to pull all image files from those four categories. 
Then you could select a Record View Set and emphasize the exact information 
you need for this project. Save the collection, and from now on you can simply 
open the collection containing the records you really need – while the entire cat-
alog remains available to you in the background. You could then e-mail the col-
lection to in-house members of the project team.
A collection, whether saved or unsaved, is always connected to its catalog(s). 
When a collection is open, the catalog(s) storing the records of the collection are 
also open. In order to open a particular collection, you must have access to its 
catalog(s). If a record is removed from a catalog, it is removed from any of the col-
lections it was in. Similarly, if you delete a category, it is deleted not only from one 
collection, but also from the catalog.
You can, however, delete a record from the collection without deleting it from 
the catalog – as long as you press only the DEL key. But if you press both 

Command / Control and DEL, the record will be removed from both col-
lection and catalog (see “Delete,” p. 260, for more information).

Working with Collections
Collections can be customized and then saved, so that your particular prefer-
ences for a special set of records can be recalled. A collection file remembers the 
records it contains, the Record View Set used and the column width of the Details 
View.
As collections are such flexible and malleable creatures, it might be a good idea 
to save your special collection once you have configured it. This is because an 
unsaved collection with its specific configuration is not automatically saved when 
you close it. And as soon as your collection changes – which can happen quite 
often – any unsaved changes are lost. Saving a collection is easily done via File > 
Save Collection As. A dialog appears for you to choose the name and location for 
the collection file. Once a collection is saved, it is easy to open via File > Open Col-
lection
When you create a new collection via File > New Collection, it can either be 
empty or contain the currently selected records. However, concerning the view, 
the new collection will be a copy of the active collection. In other words, the col-
ors, fonts, and fields of the new collection will be the same as the previous one. 
From here, you can proceed to make any changes you like while retaining the old 
collection in the background. You might want to save your new collection after 
you have assembled the desired records and carefully arranged them.
All collections are stored at the Cumulus Server and can be shared between 
users. When connecting to the Cumulus Server with the Cumulus Client applica-
tion, you can open catalogs or collections. 
Collections stored with previous Cumulus versions on the computer running the 
Client application can be imported (File > Import  > Collections.) To store collec-
tions at any location other than the Cumulus Server, you can use the export func-
tion (File > Export  > Collections.) 
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For sending a collection via email to another user, a special export function is 
provided (File > Export  > Mail Collection To.) However, don’t forget: Since a col-
lection is always connected to catalog(s), it is necessary for the recipient to have 
access to the catalog(s) ‘serving’ the collection.
To make use of a collection you received, you use the import function. 

IMPORTANT! If the Remember Password option is activated in your Connect to 
Server window, any collection you export or mail contains your login information. 
Opening such an exported or mailed collection will connect to the Cumulus Server 
with your login and password. And this means that the user who opens the collection 
works as you and has your permissions. If this option is not activated, the Connect to 
Server dialog will appear when an exported or mailed collection is opened. 

Instead of sending entire collections, you may email just a link to a collection. 
Recipients, who don’t even need to be Cumulus users, can open the link and 
view the collection in any web browser. Via the Send Collection Link dialog, you 
can specify a password and an expiration date. You can also specify which 
actions recipients may perform on the assets. Note that this function will only 
work if your Cumulus installation includes a Cumulus Internet solution (e.g. 
Cumulus Sites), and a Base Web URL was defined by your Cumulus Administrator.
Collections can be edited only by users who are allowed to do so (User Manager 
> User/Role Properties > Server Permissions > Collections Permissions.)

Things You Can Do with Collections
• Create a new collection. (See “New Collection,” p. 248)
• Open an existing collection. (See “Open Collection,” p. 248.)
• Save a collection. (See “Save Collection As,” p. 248 and “Save Collection,” 

p. 248.)
• Search through a collection. (See “Searching,” p. 44.)
• Send a collection by e-mail. (See “Export,” p. 255.)
• Send a link to a collection (See “Send Collection Link,” p. 248
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Assets/Records
In Cumulus, each asset is represented by one record. Cumulus is able to catalog 
every sort of digital asset such as Photoshop® image files, video clips, sound clips, 
or QuarkXPress® page layouts. However, a digital asset can also be a spreadsheet 
file or even a data stream such as an entry in a data bank that Cumulus is keeping 
track of for you. Records can contain a thumbnail image of the asset. Records can 
(and should) be categorized for easy maintenance and searching. (See “Catego-
ries,” p. 29, for more information.)
Records are not actual copies of the asset. They merely "point" to the original file. 
This saves disk space and avoids confusion caused by maintaining multiple cop-
ies of an asset. Records contain information on the assets, which is called meta-
data. Using metadata makes it possible for Cumulus to track your assets and find 
their records at lightning-speed. A record is the sum of metadata stored on an 
asset. The metadata is kept in Record Fields.
Canto is setting the pace in the asset management field with its TAG files, which 
hold all of the information that can be viewed in the Asset Information applica-
tion – and more. TAG files have been developed by Canto to be the standard file 
format for the storage of metadata in the field of asset management. Cumulus 
can create TAG files when cataloging assets from a location where the user is 
allowed to save files. For how to activate this option, see “Browse for Assets,” 
p. 251.
All records contain at least some searchable information in their record fields on 
the asset file they represent. Generally, the range of information each record 
includes depends on the kind of asset represented.
However, Cumulus makes it possible to determine precisely what sort of infor-
mation should be kept on assets. Remember, this can be defined differently for 
each catalog as each catalog has its own properties. It is the catalog settings that 
determine what information is stored on the assets in the record fields. 
As it comes ‘out of the box,’ Cumulus has many record fields ready to be filled 
while cataloging, depending on the nature of the asset. Not all of the record 
fields that Cumulus supports are activated with Cumulus’ default settings. 

Asset Information
The information stored on an asset can be viewed and edited in the Information 
view or in the Information window. 

Example of an Asset Information 
Window

Example of an Asset Information 
View
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What you see depends on:
• the fields selected to be displayed in the current Record View Set.
• the fields of the catalog the asset is cataloged in and whether these fields 

contain any information or not.

TIP: 
The View Set you select should match with the catalog(s) you use it 
with. For example, if you have a special catalog for images that 
includes all fields that are important for images and you use a View Set 
that was designed for audio files, you may not see much information. 
If the catalog does not contain the fields that are selected for display 
in the View Set, no information can be displayed.

TIP: 
If you have the appropriate permissions, you can easily access the 
preferences of Record View Sets by selecting the Customize entry in 
the drop-down list for selecting Record View Sets. This entry opens the 
preferences for the current Record View Set.

To change to the Information View, click  on the toolbar.
To open the Asset Information window for an asset:

1. Select the record of the asset of which you want to see the information.

2. Select Metadata > Information or click  on the toolbar. The Asset infor-
mation window opens.

Once the Asset Information window is open you can use the arrow buttons to 
load other records into the window. For more details on the Information win-
dow, see “Information Window,” p. 36.

Field Types
Information on assets can be viewed and accessed via record fields and informa-
tion on categories can be viewed and accessed via category fields. Cumulus can 
store different kinds of information. Consequently, Cumulus features many dif-
ferent field types for storing information. The different field types are (the exam-
ples are drawn from the default record fields):
• String – Can be used to store textual information (e.g. Notes). String fields can 

be set to support multiple languages. In this case, the content of the field can 
be hold in different languages.

• Boolean – Great for on/off, yes/no options. Displays as a check box (e.g. Don’t 
Delete Record).

• Integer – Any non-fractional number up to 32 bits (e.g., non-decimal num-
bers as a price of $2).

• Real – Any number up to 64 bits (e.g., a decimal number such as a price of 
$2.99).

• Long – Can store 64-bit integer numbers. 
• Data Size – size in bytes (can store 32-bit values up to 4 GB) 
• Data Size (Long) – size in bytes (can store more than 4 GB values up to 64-bit 

values)
• Date – Any valid date (day and time) later than 1970 entered in the format of 

your computer’s system settings (e.g., Record Modification Date).
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• Date only – any valid date for any day entered in the format of your com-
puter’s system settings.

• Time only – Any valid time of day entered in the format hh:mm:ss. Optionally 
you can also enter milliseconds by employing a dot as separator: 
hh:mm:ss.123

• Length – in inches – displayed in the measurement you have chosen in your 
User Settings for the Cumulus application.

• Resolution – in dots per inch.
• Binary – Not user-editable; administered by custom asset information appli-

cations, which can manipulate and store binary data for further automation.
• Asset Reference – Special binary field used for asset references only. Not 

user-editable.
• Picture – Pictures can be pasted into these fields (e.g., Thumbnail).
• String List – This field type supports lists, such as menus, which can make 

data entry easier. The items in the list can be defined by the user (e.g., Status). 
The items can only be defined by users with the appropriate rights.

• Audio – Can store voice annotations that can be recorded directly into the 
computer or come from the assets themselves.

• Label – Enables users to label records by assigning colors. 
• Rating – Enables users to rate assets or records. 
• Table – Special field type that can include other metadata fields. This field 

type was designed for special usage purposes, e.g. the user comments added 
to a preview are managed by such a field. The fields included in a Table field 
can be configured to be searchable and sortable.

Asset Types Supported
Cumulus can catalog any kind of digital asset you throw at it. Moreover, it directly 
supports file formats with specially developed filters. (See “Asset Format Sup-
port,” p. 217, for details on supported formats.) Visit Canto’s website 
(www.canto.com) for news, updates and downloads, including new file filters as 
they are developed (for registered users only).

Editing Asset Information
In general, you can edit the information stored on an asset. But you can only edit 
information which is stored in record fields you are allowed to edit.
To edit the information stored on an asset:

1. Select a Record View Set that displays the information you want to edit in 
the Information View or the Asset Information window. 

2. Select the record you want to edit and change to Information View or open 
the Asset Information window.

3. Click the field you want to edit.

Fields with white backgrounds can be edited. If a field has a gray back-
ground, then it cannot be edited. (Either you are not allowed to edit or the 
field is not editable in general.)

4. Make your changes.

5. Click  to save your changes.

If you want to edit further records in the collection, you can use the arrow icons 
to load a new record.
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Editing a String Field in Multiple Records 
If you are about to edit the content of a string field for multiple records at once 
and one or more records already contain text in the field you want to edit, 
Cumulus will ask you how to handle the new text.

Editing Fields with Validators
If a catalog contains fields with validators and one or more of these fields contain 
invalid values, or if mandatory fields have no value at all, a validator pane is dis-
played at the bottom of the Information Window or Information View, and the 
respective fields are marked with a special icon.

The message(s) displayed in the validator pane can be different for each field, 
depending on the settings defined by the administrator. Clicking on a message 
immediately activates the field with the erroneous value, even if it is not visible 
in the first place. As soon as you enter a correct value, both the special icon and 
the message disappear.
As long as a record contains invalid field values, it can not be saved. Either you fill 
in appropriate values in all of these fields, or any changes made to the record will 
be discarded.

Using a Metadata Template
To add information to the metadata information that is stored on an asset, you 
can employ a Metadata Template. Metadata Templates can be set up by any 
user. For a description on how to set up Metadata Templates, see “Metadata 
Templates,” p. 226.
To make use of such a template, you can either use it while cataloging (along 
with the Prefiller Utility, see page 253) or apply the metadata information to the 
records of already cataloged assets.
There are different methods through which you can apply information from 
Metadata Templates to records of cataloged assets:
• Select one or more records and then select Metadata > Assign Metadata 

From Template. A list containing all your Metadata Templates is displayed. 
Select the desired one. 
NOTE: When using this method all fields that are included in the catalog 
of the record and that are set in the Metadata Template will be filled with 
the values of the selected Metadata Template. The changes are immedi-
ately saved with the record. 
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• Open the Asset Information window and then click . 
NOTE: When using this method all fields that are included in the Asset 
Information window (and that you are allowed to edit), and that are set 
in the Metadata Template will be filled with the values of the selected 
Metadata Template. Note that these changes will not be saved until you 
do so. 

• Open the IPTC Information window and then click . 
NOTE: When using this method all fields that are included in the IPTC 
Information window (and that you are allowed to edit), and that are set 
in the Metadata Template will be filled with the values of the selected 
Metadata Template. Note that these changes will not be saved until you 
do so. 

TIP: 
If you have the appropriate permissions, you can easily access the 
preferences of Metadata Templates by selecting the Customize entry 
in the drop down list for selecting Metadata Template. This entry 
opens the preferences for the current Metadata Template. 

Record Size
In general, a record’s size can depend on several factors:
• The size and quality setting of the thumbnail (if you choose to include one).
• The amount of text and notes stored in various record fields.
• The asset format the record represents. (Different assets generally require dif-

ferent amounts of data to describe them.)
• The amount of additional information you include in the record (such as 

voice annotation).
The customizability of Cumulus means that you can determine what information 
is stored on the assets in a particular catalog. If catalog size is a concern, there are 
a few catalog settings to keep in mind. These settings can affect the size of the 
records cataloged. 

Renaming Records
Records are named as the assets they represent by default. Sometimes asset 
names are not what you would like them to be. For renaming assets (and their 
records) Cumulus provides a special function. (See “Rename,” p. 283, for details.) 
However, you can also rename the record only. Though there is no menu item 
specifically for this use, renaming records is easy:

1. Select the record to be renamed.

2. Select Metadata > Information. The Asset Information window opens, 
which shows information on the asset.

3. Find and change the record’s name in the Record Name field.

4. Click  to save your changes.

If you want to edit more records in the collection, you can use the arrow icons in 
the Information window toolbar to load a new record. 
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Editing a Record’s Category Assignments
Also found within the default Asset Information window is a list of the categories 
currently assigned to the record. From this list you can remove category assign-
ments or add new ones. 
To remove a record’s category assignment:

1. Select the record whose category assignments you want to change.

2. Select Metadata > Information. The Asset Information window opens, 
which shows information on the asset.

3. Select the category you wish to remove and press the DEL key.

4. Click  to save your changes.

If you want to edit more records in the collection, you can use the arrow icons in 
the Information window’s toolbar to load a new record. After deleting a category 
in the category pane, all assignments to this category are automatically deleted 
as well.
There are different ways to add a category assignment to a record, or to assign a 
record to a category, depending on your perspective. The perhaps most intuitive 
way is by dragging and dropping the category to the record, or the record to the 
category. (See “Editing a Record’s Category Assignments,” p. 28.) It is also possible 
to add a category assignment to a record via the Asset Information window, 
which displays a list of the categories the record is associated with.
To add a category assignment to this list:

1. Select the record whose category assignments you want to change.

2. Select Metadata > Information. The Asset Information window opens, 
which shows information on the asset. If necessary, drag this window aside 
so that you can also see the Category pane of the Collection window.

3. Click the category in question in the Category pane.

4. Drag the category to the categories list in the Asset Information window. 
The category is assigned to the record.

5. Click  to save your changes.

If you want to edit more records in the collection, you can use the arrow icons to 
load a new record. 

Things You Can Do with Records
• Assign a record to a category. (See “Editing a Record’s Category Assign-

ments,” p. 28.)
• Change a record’s category assignments. (See “Editing a Record’s Category 

Assignments,” p. 28.)
• Copy/Cut and Paste records between catalogs and/or collections. (Record 

categories are copied along with records.)
• Create a new record (same as cataloging assets). (See “Browse for Assets,” 

p. 251.)
• Delete a record and (optionally) its asset. (See “Delete,” p. 260.)
• Drag and drop a record into another drag and drop-supporting application. 

Dragging a record copies the asset into the target document. You may prefer, 
instead, to place the asset manually and access it by reference.
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• Export records. (See “Export,” p. 255) 
• Import records. (See “Import,” p. 254.)
• Optimize a records’ preview icon. (See “Optimize Thumbnail,” p. 277.)
• Print records. (See “Print,” p. 255.)
• Rename a record. (See “Renaming Records,” p. 27.)
• Rotate a record’s preview icon. (See “Rotate Thumbnail,” p. 277.)
• Search for specific records. (See “Searching,” p. 44.)
• Update a record to reflect an edited asset. (See “Update Record,” p. 274.)
• Update a record to reflect a relocated asset. (See “Update Record,” p. 274.)

NOTE: It’s very important to keep records in sync with their associated 
asset files. If you move an asset after cataloging it, be sure to update its 
record by using the menu item. (See “Update Asset Reference(s),” p. 284.)  

• View and optionally edit a record’s asset information. (See “Asset Informa-
tion,” p. 23, for details.)

Things You Can Do with Assets
Cumulus is also able to help you manage your original assets. Cataloged assets 
can be copied, deleted, moved, printed – all from the Cumulus interface using 
the Asset menu commands. And when you copy, delete or move an asset, 
Cumulus takes care of its TAG file at the same time, treating it accordingly. For fur-
ther information on TAG files, see “Options While Cataloging,” p. 252.
• Convert the asset to another file format. (See “Convert To,” p. 281)
• Copy the asset into another application by dragging the record into the 

application.
• Create copies of the assets in another location. (See “Copy To,” p. 281.)
• Customize the display of the information on an asset. (See “Record View 

Sets,” p. 188.)
• Delete an asset. (See “Delete,” p. 260.)
• Move assets. (See “Move To,” p. 283.)
• Open assets using the application they were created with or another appli-

cation. (See “Edit With,” p. 280.)
• Preview a record’s asset. (See “Preview,” p. 279.)
• Print assets using the application they were created with or another applica-

tion. (See “Print With,” p. 280.)
• Send your assets by e-mail. (See “Mail To,” p. 281.)
• Rename assets. (See “Rename,” p. 283.)
• Show information on an asset. (See “Asset Information,” p. 23.)
• Show the location of the asset. (See “Show Location,” p. 282.)
• Show a preview image of the asset. (See “Preview,” p. 279.)

Categories
Cumulus categories are used to organize records, much like folders are used to 
organize files in a traditional filing cabinet. But the asset can appear in any num-
ber of Cumulus categories at the same time. They are similar in purpose to key-
words used in other programs. 
Simply double-clicking on a category is the most direct method of searching in 
Cumulus. All records assigned to that category are displayed. You can also use 
the category list to find contents of two or more categories at a time. Other 
options for category list searching include the ability to see the contents of cat-
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egories in the tree either above or below the one you double click. (See “Search 
& Sort Tab,” p. 185, for more detailed information.)
To make organizing easier, Cumulus provides multiple tabs: Instead of having all 
categories appear in one category pane, categories can be created and dis-
played in separate tabs. 
• The Keyword tab contains those categories that are created with the inten-

tion of organizing the assets via keywords. These categories may be created 
manually by the user or automatically by Cumulus Filters and AssetStores. 

• The Sources tab will display the automatically created categories that resem-
ble the folder or directory hierarchy in which the assets reside. 

• Use the Categories tab to create your own individual category hierarchy – a 
hierarchy that suits your specific needs. 

• The All tab gives you an overview on all categories contained in the current 
collection. In the All tab the other tabs are denoted as categories with names 
that begin with a $ sign. 
NOTE: Do not rename or move these special categories. 

If you don’t get all default category tabs displayed, your administrator has 
restricted your access to category tabs.
Categories can be nested within one another. The highest hierarchical category 
level is the category representing a catalog. It has no categories above it. A cate-
gory that nests other categories is also denoted by a blue arrow. A square 
denotes a category that does not nest any other category. To expand a category 
in order to see its subcategories, click on its arrow. Use drag and drop to move 
categories to where you want them inside the hierarchie of the category repre-
senting a catalog. The categories that you create can be easily moved to other 
locations at any time. 
The Category pane displays all available categories. To check the categories a 
record is assigned to, open the Asset Information window and check the entries 
in the Categories field. (For information on how to edit, see “Editing a Record’s 
Category Assignments,” p. 28.) 

Category Types
Cumulus offers different types of categories: Normal Categories, Related Catego-
ries and Folder Categories. These category types have the following characteris-
tics:
• Normal Categories can be created by the user at any position in the category 

hierarchy. We recommend creating individual categories either in the Cate-
gories or the Keyword tab.

• Related Categories are aliases of existing categories which can be created by 
the user. They can be placed in any position in the category hierarchy. Com-
plete alternate catalog hierarchies can be built using related categories. 
In the image shown, related categories were made and placed under the 
Images category. Selecting and double-clicking a related category works the 
same as with the original category. (See “New Related Category,” p. 279.) To 
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identify them, their names are displayed in italics.

• Folder Categories are automatically created by Cumulus during the catalog-
ing process. These automatically created categories resemble the folder or 
directory hierarchy in which the assets reside. The Source tab displays them 
all. They are created by default but this option can be disabled (with Work-
group or Enterprise, by users with the specified rights only). 

NOTE: Live Filtering (optional)
If you can see categories but can’t select them, your administrator has acti-
vated pre-selections for you and those categories do not belong to the range 
of pre-selections. 

Creating Categories
If you’ve been snooping around the Cumulus menu bar, you can probably guess 
how to create a new category.
To create a category:

1. Click the category in which the new category should be nested.

2. Select Metadata > New Category or New Related Category. This creates a 
category nested in the selected category.

3. Rename the new category. (Category names can be up to 255 characters in 
length.)

You can easily change the category hierarchies by clicking a category and drag-
ging it on top of another category. This places the category inside the other cat-
egory. To move a category to the top level of a catalog, drop it on the category 
representing the catalog. 

NOTE: In the All tab, never change the hierarchy for the categories with 
names that begin with a $ sign as they denote the category tabs. 

Renaming categories is easy:

1. Double-click the category’s name (not its icon). Its name will be selected for 
editing. 

2. Edit the name. (Category names can be up to 255 characters long.)

A category structure 
featuring different cat-
egory types including 
related categories.
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Custom Ordering of Categories
By default, the categories displayed in the category pane are sorted alphabeti-
cally. As this may not always be the most convenient solution, the order of the 
categories can be changed manually by dragging a category to a different place 
in the category tree, e.g. to have frequently used categories shown on top of the 
category tree.
Custom ordering of categories only works if 
• the respective catalog contains the category field Custom Order,
• the Enable/Show Language Specific Category Sorting and Custom Order-

ing option is activated in the used Category View Set,
• the user who wants to reorder the categories has the permission to modify 

categories.
A custom-ordered category tree is displayed in that order only for users that 
employ a Category View Set with the Enable/Show Language Specific Cate-
gory Sorting and Custom Ordering option activated. Elsewise the category tree 
is displayed in the default order. 

NOTE: It is advised to be extremely cautious with custom ordering of catego-
ries, as this may effect the view of potentially all other users.

To manually change the order of categories:

1. Drag any category with the mouse to the position where you want to have 
it.  

A thin black line indicates where it will be placed when you release the 
mouse button.

To override custom ordering and re-establish the alphabetic sorting of catego-
ries:

1. Right-click into a category level that you want to sort alphabetically and 
select Sort by Name from the shortcut menu.  

The respective level of categories is sorted alphabetically.
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Example o
window
NOTE: Sorting categories by name only affects the current level. If subcatego-
ries have a custom order, they will retain it. Thus you can sort any level in your 
category tree either by name or manually as you need it, independent of any 
other level.

Category Fields
Category fields are used for information that relates to all records assigned to that 
category, or they can be used to store additional information on the category 
itself. With a standard Workgroup installation, a significant difference between 
record fields and category fields is that category fields are not searchable.
Category fields can be activated and set up in the Catalog Settings. This can only 
be done by the Cumulus Administrator. 

Category Information Window
Information on categories can be viewed in the Category Information window. 
What you see depends on:
• the fields selected to be displayed in the Category View Set defined for the 

Category tab the selected category resides in.
• the fields of the catalog the selected category resides in and whether these 

fields contain any information or not.

TIP: Access Preferences
If you have the appropriate permissions, you can easily access the 
preferences of Category View Sets by selecting the Customize entry in 
the drop-down list for selecting Category View Sets. This entry opens 
the preferences for the current Category View Set.

To open the Category Information window:

1. Click once on a category to select it.

2. Select Metadata > Information. The information window for the selected 
category appears.

The information on categories can be viewed and accessed via category fields. 
What category fields are displayed and also how the category fields are displayed 
depends on the selected View Set. 
Once the Category Information window is opened, you can use the arrow but-
tons to load other categories into the window. For more details on the Informa-
tion window, see “Information Window,” p. 36.

Editing Category Information
In general you can edit the information stored on a category. But you can only 
edit information which is stored in category fields you are allowed to edit. 
To edit the information stored on a category:

1. Load the category you want to edit into the Category Information window.

2. Click the field you want to edit.

Fields with white backgrounds can be edited. If a field has a gray back-
ground, then it cannot be edited. (Either you are not allowed to edit or the 
field is not editable in general.) 

f a Category Information 
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3. Make your changes.

4. Click  to save your changes.

If you want to edit more categories, you can use the arrow icons of the Informa-
tion window’s toolbar to load another category.

Categories and Auto-cataloging
Cumulus can auto-catalog the contents of folders that are represented by folder 
categories in Cumulus. Any new assets saved to this folder will be cataloged peri-
odically, depending on how often you would like this done. This feature can be 
customized to be performed anything from hourly to daily to weekly. It is per-
formed on the machine you are working at. 
To make use of this feature:

1. Click the Sources category tab. The categories representing folders that can 
be used for auto-cataloging are displayed.

2. Select the category representing the folder you want to have auto-cata-
loged.

3. Select File > Add Assets to Catalog >Setup Auto Cataloging.
OR
Open the context menu by clicking the right mouse button /  Control 
key + mouse button and select Setup Auto Cataloging. 

The Auto Cataloging dialog is opened.

4. Activate the Use AutoSync on Category option.

5. Define the performance options:

• Select the Asset Handling Set for the auto-cataloging.
NOTE: You should select an Asset Handling Set with the Skip Dupli-
cates option activated for cataloging. Otherwise all assets in the folder 
will be cataloged again and again with each run. 

• Under Next Start, enter date and time when the function should be per-
formed.

• Under Period, enter the regularity time interval you want the function to 
be performed. For example: to start it once a day enter 24:00 

• Under User, enter your Cumulus Login name.
6. Click OK.

NOTE: With this version of Cumulus the Auto Cataloging feature works only 
for folders that were created when cataloging was performed on the same 
operating system you are working with. You can check this with the informa-
tion in the Category Type field. A category of the type Directory Category can 
only be auto-cataloged when you are working under Windows. And a cate-
gory of the type Directory Category Mac can only be auto-cataloged when 
you are working under Mac OS X. 

If you want to use this feature with catalogs created with former versions of 
Cumulus you have to add the following category fields to the catalog:
• AutoSync Asset Handling Set
• AutoSync Next Start
• AutoSync On
• AutoSync Period
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• AutoSync User
• Folder Reference

TIP: More Autocataloging Features
Optional features provide additional auto-cataloging options; e.g. a 
Cumulus Scheduler Action that enables Cumulus to check a standard 
POP3 email account and retrieve and automatically catalog any email 
it finds. For more information, see the Administrator Guide.

Individual Category Tabs (optional)

Optional feature! May not be available with your Cumulus configuration.

To make organizing easier, Cumulus provides multiple Category tabs: Instead of 
having all categories appear in one category pane, categories can be created and 
displayed in separate tabs. Cumulus lets you create your own Category tabs. As 
category tabs are related to master ctaegories, creating a new tab  is as simple as 
creating a  new master category.
To create an individual Category tab:

1. Click on the entry for the catalog in which you want to have the new Cate-
gory tab. 

2. Select Metadata > New Master Category. This creates a new master cate-
gory called Category. The new category’s name is highlighted, ready to be 
renamed.

3. Enter the name for the new Category tab and press the Enter key to rename 
the category. 

A new master category and a new Category tab are created. 

You can rename or delete such a category just as any other category.

Things You Can Do with Categories
• Assign a category to a record. (See “Editing a Record’s Category Assign-

ments,” p. 28.)
• Create a new category. (“New Category,” p. 279, and “New Related Category,” 

p. 279.)
• Create a related category. (See “New Related Category,” p. 279.)
• Delete a category. (See “Editing a Record’s Category Assignments,” p. 28.)
• Export categories. (See “Export,” p. 255.)
• Import categories. (See “Import,” p. 254.)
• Move a category inside or outside another category. (See “Creating Catego-

ries,” p. 31.)
• Remove a category assignment from a record. (See “Editing a Record’s Cate-

gory Assignments,” p. 28.)
• Rename a category. (See “Creating Categories,” p. 31.)
• Show or hide categories. (See “Collection Basket Pane,” p. 263.)
• Use AutoSync on categories. (See “Categories and Auto-cataloging,” p. 34.)
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To open the
Information Window 
The information stored on an asset or category can be viewed and edited in the 
Information window. What you see depends on:
• the fields selected to be displayed in the current View Set.
• the fields of the corresponding catalog and whether these fields contain any 

information or not. 

BACKGROUND INFORMATION:  Information Window vs. 
Properties Window
Whereas the Information window provides access to the metadata 
stored on an asset or a category, the Properties window provides 
access to the triggers and permissions set for an asset’s record or a cat-
egory. 

The Properties windows of a record or category. 
Opened via the right-mouse click context menu.

ormation Window
tion window provides access to the information (metadata) stored on a category or on an asset. The Asset Info window p
e information on the asset stored in the record. The Category Info window provides access to the information on a categ
played in which order depends on the selected View Set. The field contents are editable depending on the field type and

r it. However, to edit the metadata stored you need the appropriate permissions to modify records.

 Information window: Select a record/category first and then select Metadata > Information
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 edits you made in this window.
dd information from a Metadata Template. (For details on how to set 

data Templates, see “Metadata Templates,” p. 226.)
ANT!  The template will only fill in the fields that are included in the 
tion window. And only those that you are allowed to edit. Note that 
anges will not be saved until you do so. 
u have the appropriate permissions, you can easily access the prefer-
 Metadata Templates by selecting the Customize entry in the list for 
 Metadata Template. This entry opens the preferences for the current 

ta Template.
e first record/category from the collection window’s current selection.
e previous record/category from the collection window’s current selec-

e next record/category from the collection window’s current selection.
e last record/category from the collection window’s current selection.
 the selected Record View Set. 
select a Record View Set.

 Information window on the right shows:
f the field (as defined in the Catalog Settings).
 of the field for the selected record/category (editable or not depending 
eld type and whether Allow User to Edit is checked in the record field 
es). If the field background is dark gray it cannot be edited.
 the categories the asset is assigned to. (For more on categories and 
 tabs, see “Categories,” p. 29.)

ark a few examples of the various field types.
an be user-editable; click in field and type new value (or in Windows use 
p/down keys).
: User-editable; numbers only (without decimal places), up to 32 bits.

: Check box for selected or deselected. (If the field has no value, under 
s the check box and mark are gray and under Mac OS the check box is 
with a hyphen.)
 Not user-editable; maintained by Cumulus or an Asset Storage Mod-
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ultiple values by activating them in the check boxes
ference: Not user-editable; maintained by Cumulus or Asset Storage 

ser-editable; only available when QuickTime is installed on your com-
uickTime 7.0 is recommended). You can record voice annotations for 
rd. 

NOTE: None of the default fields is an Audio fi
Audio field always has to be set up as a custom

 Click to record a voice annotation. A dialog
from which you can stop or cancel the recordi

 Click to play the voice annotation. (Button 
 for stopping while playing.)
 Click to delete the voice annotation. (Field 

value then.)

elected multiple records before opening the Asset Information window and the option Display values identical for all se
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Sets and Templates 
To ease your work Cumulus provides several sets and templates. Access to them 
is controlled via user permissions. Users who are allowed to create them can 
share them so that they are accessible to all users with the permissions to use 
them.

View Sets
What Cumulus calls view sets are the screen layouts that enable users to interact 
with the metadata stored for the managed assets. Each View Set contains several 
different types of views, including thumbnail views, list views, asset previews and 
more. A single View Set represents the way each of these individual views appear 
to users. 
View sets make it easy for you to switch between different views that are set up 
for certain formats or tasks. Once view sets have been appropriately defined to 
meet differing demands, you can switch between them with just a mouse click.
Each view in a View Set can contain a different array of metadata fields from a cat-
alog. This is helpful because you don't likely want to see all data fields when look-
ing at thumbnails, but you might want to see them when looking at an 
Information View. Some metadata fields, such as thumbnail or record name, 
might be useful in both views.
The ability to create different view sets enables you to configure screen layouts 
that are task or user specific. For example, when browsing catalogs for images, a 
layout artist might want to see a Thumbnail View that includes no other fields. To 
address this, you'd create a “Browsing” View Set. The omission of others fields in 
the Thumbnail View enables Cumulus to display as many thumbnails on a single 
screen as possible, which is great for browsing. The Info View of your “Browsing” 
View Set might include the remaining fields that a layout artist should see before 
making a selection, such as “License Restrictions,” “Copyright Notice” and 
“Approval Status” fields.
If that same layout artist was cataloging new assets, he/she would want to see 
more than just those few fields useful for browsing. She might need access to a 
“Notes” field, a “Production Status” field or even the “Categories” field, which 
enables her to easily see and edit the category assignments made for the asset.
These are examples of task-specific view sets. But user- or group-specific view 
sets are just as important. Your catalog might include financial or licenser contact 
fields that are of no interest to designers, but paramount to accountants. On the 
other hand, your accounts probably don't care about “Color space,” “File Resolu-
tion” or “Workflow Status” fields. You'd create view sets for them that include only 
the fields they need to see. 
Access to view sets is permissions based, so you can easily determine which 
users can access which view sets. This is particularly important if any of your 
metadata fields contain sensitive or private information. For example, you might 
use “Notes” fields to enable managers to communicate thoughts to one another 
that designers shouldn’t see. Using view sets in this manner offers an additional 
layer of security to your metadata, but it also helps “clean up” everyone's work-
space by displaying to them only what they need to see.
Cumulus categories have view sets of their own. We call these Category View Sets 
to differentiate them from the Record View Sets just covered.
Category View Sets are required because Cumulus categories also have meta-
data fields. This enables you to use categories as a type of “asset container” for 
project management—each category can have a manager, budget, due date, 
etc. Asset records added to the category are assumed to be a part of the project. 
Double-click on the category and you see all the assets used in it. In practice, Cat-
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egory View Sets are created, edited and chosen by users, just like Record View 
Sets.
Newly created Cumulus catalogs include default view sets for records and cate-
gories. These view sets include many of the default metadata fields created for 
each new catalog, which enables you to start managing assets immediately. 
If you add any metadata fields of your own, however, you’ll also need to add 
those fields to view sets before users will be able to see the fields and edit their 
contents. You can add your custom fields to existing view sets, or you can create 
new view sets from scratch. There is no limit on the number of view sets that you 
can create.
View sets are not “connected” to any one catalog—they are Server specific. This 
means that each view set you create will potentially be available from all catalogs 
hosted on that Server. This enables you to create view sets that include fields 
from multiple catalogs. (Cumulus enables users to open several catalogs at 
once.)
You can limit view set access on a catalog-by-catalog basis, so if a given view set 
includes fields not found in other catalogs, you can create custom view sets for 
that catalog and configure user permissions to ensure that those view sets are 
not accessible in other catalogs.
The same view sets available to users connecting via the Cumulus Native Client 
software, are also available to those connecting via the Cumulus Web Clients.

Asset Handling Sets
An Asset Handling Set is also not specific to any one catalog. It affects how 
Cumulus deals with your assets – during the cataloging process and when 
accessing assets. 
Asset Handling Sets define:
• Which filters should be active during cataloging,
• What metadata should be extracted from the assets (via filter settings),
• How field linking should be configured, 
• Which Metadata Template (if any) should be used, and
• Whether central asset storage should be used, and where that location 

should be. (file server, ftp site, Vault, etc.) 
Additional configuration options include:
• The size of the “thumbnail” that represents the asset record,
• Whether Cumulus should catalog duplicate assets, or ignore duplicates while 

cataloging,
• Whether Cumulus should resolve operating systems aliases and shortcuts 

and catalog the assets they point to, and
• Whether Cumulus should automatically catalog assets referenced in “con-

tainer” documents, such as InDesign and QuarkXPress, which is a powerful 
option available with some Cumulus solutions.

You can define as many Asset Handling Sets as you need, which is great because 
they serve so many useful purposes. 
One set, for example, might extract all text from a Word document and add that 
as metadata to the asset record. Another set might extract a maximum number 
of characters or none at all. (Similar options exist for the PDF, PowerPoint, Excel 
and even the Adobe Illustrator filters.)
Or, you might have a set for laptop-based remote users that copies all assets they 
catalog into a secure, remote location, turning Cumulus into a convenient on-
the-road back-up solution. A “hotspot” Internet cafe is never far away; now users 
can back up new orders and expense reports while they’re there.
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Asset Handling Sets can also determine special ways in which assets are accessed 
after cataloging, such as whether QuarkXPress files should be previewed inside 
Cumulus, or opened from within QuarkXPress itself.

Asset Storage Modules
At the heart of Asset Handling Sets are a series of “engines” called Asset Storage 
Modules. Asset Storage Modules enable Cumulus to communicate with different 
types of storage systems and provide additional functionality for certain file 
types. Examples of different systems Cumulus supports “out of the box” include 
the filing systems of the Mac OS, Windows and Unix. Without Asset Storage Mod-
ules for these operating systems, Cumulus would not be able to read and write 
data to storage devices hosted on those systems as it does. Keep in mind that 
Cumulus Servers are available on many different operating systems, and the Cli-
ent software is available for Mac OS X and Windows. Because it’s transparent to 
the user, you might not wonder what enables Cumulus to “speak” all those dif-
ferent filing system languages so fluently, but the credit goes to the Asset Stor-
age Modules.
Asset Storage Modules that offer additional file-handling capabilities include 
those for Zip, QuarkXPress and PDF files. Using the Zip module, for example, you 
can drag a Zip archive onto your catalog and Cumulus will extract and catalog its 
contents on the fly—each file within the archive becomes its own searchable 
asset record. On the flip side, this same module enables Cumulus to deliver one 
or more assets to a user already Zipped up and ready to go. This is especially 
handy when assets are downloaded over the Web.
Similarly, Asset Storage Modules for PDF, InDesign, PowerPoint and QuarkXPress 
give users the option of splitting the various pages (slides) found in those files 
into individual asset records, each with its own set of metadata. These modules 
have output benefits too: For example, users can assemble brand new Power-
Point presentations using cataloged slides or even stand-alone assets in the cat-
alog. 
In a nutshell, Asset Storage Modules enable Cumulus to read from and write to 
storage locations. Those locations include the physical storage locations we natu-
rally think of, such as hard discs and servers, but they can also be less conven-
tional “locations,” such as Zip archives and PowerPoint presentations.

Default Asset Handling Sets 
The Asset Handling Sets that come standard with Cumulus are not configured 
with any custom purposes in mind. While this makes them useful for all catalog-
ing processes, it also makes them less efficient. To ensure optimum performance 
from Cumulus, set up custom Asset Handling Sets to specifically deal with the 
asset types your company uses. (Cumulus “offers” each file being cataloged 
through each of the activated file filters. So if you know what type of asset you’re 
cataloging, it makes sense to disable unnecessary filters.)

Asset Handling Sets and Workflow
Access to Asset Handling Sets is based on user permissions, so administrators can 
define, in advance, exactly how assets should be cataloged for each user or 
group. If a user is permitted access to only one Asset Handling Set, that set will 
be used automatically during all cataloging performed by that user. If more than 
one set is available to the user, a dialog appears that prompts the users to select 
an Asset Handling Set for the cataloging operation.
Cumulus can also “watch” certain folders and automatically catalog assets 
dropped into them. Asset Handling Sets and Metadata Templates can be deter-
mined in advanced for these operations, making the process entirely automatic. 



EXPLORE CUMULUS –  SETS AND TEMPLATES 41
If your workflow were to use a system like this, and you needed an easy way to 
see which assets were newly cataloged, you could have a Metadata Template 
automatically load a field called “New” with the value “yes.” Users could then eas-
ily find new asset records based on that value, make any metadata edits needed, 
and then change the “New” field value to “no,” indicating the asset record was 
ready for use.

Metadata Templates 
In order to fill asset records with predefined metadata values, Cumulus provides 
Metadata Templates. You can think of Metadata Templates as a “rubber stamp” 
that’s applied to a selection of asset records. Metadata Templates can be used to 
update existing asset records or “prefill” new asset records during cataloging. 
For example, say you’re about to catalog a group of photographs taken by the 
same photographer on the same date, using the same camera. Each photograph 
has unique attributes, which you’ll enter into its asset record later, but you can 
save yourself some time by using a Metadata Template to “stuff” the asset 
records at cataloging time with the information common to all. In this case you'd 
be using the photographer's name. But you could also “pre-choose” category 
assignments, set a status field to “new,” or any other combination of field edits. 
You can define as many Metadata Templates as you need. At cataloging time, 
you can choose an existing template, or manually enter data to be “prefilled” into 
the new asset records.
Access to Metadata Templates is controlled via user permissions. They can be 
shared so that they are accessible to all users with the permissions to use them.

Print Templates
Different combination of print options can be combined and saved as Print Tem-
plates. A Print Template defines how records will be printed. Print Templates 
include definitions for the document layout (page size and orientation, as well as 
margins) and the layout of the records to be printed. Either a Record View Set or 
defined advanced print settings can serve as print layout for the records.

Permissions Templates
Permissions templates enable you to assign, remove or explicitly set individual 
asset or category permissions for users or entire groups at once. Note that per-
missions templates are an optional feature which may not be available with your 
Cumulus configuration. 
A Permissions template includes permissions for records and categories. 
Depending on the context in which a template is used, either the record or the 
category permissions will be used. With selected records, the defined record per-
missions will be used; with categories, the defined category permissions will be 
used.
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Find Assets
If you can’t find it, you can’t use it. With Cumulus it is easy to find the

assets you are looking for as Cumulus provides easy and powerful

search capabilities. These are described in this chapter.
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Searching
Cumulus provides several ways to search for records: searching by category, 
quick searching and searching with the Find window. Depending on the size of 
your catalogs and the complexity of your search requirements, you may find one 
way better suited to your needs.

Searching for Records By Category
The simplest form of searching for records is simply double-clicking on a cate-
gory in the Category pane. This quickly finds all of the records that are associated 
with that category. You can also select more than one category to see all the 
records associated with the set.
To quickly view the records assigned to categories,  hold down  Alt /  both  
Alt+Cmd  and press an arrow key (up, down, left or right). 
There are several Preference options that affect the way category list searching 
works. (See “Search & Sort Tab,” p. 185, for more detailed information.)

Searching with Quicksearch
To perform a Quicksearch in all catalogs open in the current collection, simply 
enter a search term (e.g. a name or a number) into the toolbar’s search field and 
click the icon or press Enter. 
With Quicksearch, Cumulus by default looks for the search term in the following 
record fields only:  Record Name, Document Text, Notes, Keywords, and Catego-
ries. The result of the Quicksearch shows all records for which the search term is 
contained in any one of these fields.
The selection of fields used by Quicksearch can be changed in the User Settings 
section of the Preferences dialog (see “Search & Sort Tab,” p. 185, for details). 
Quicksearch performs a “contains” search for all included String fields and String 
List fields and an “is” search for all included Integer fields. 

Search Options
If you enter two or more terms into the Quicksearch field, Cumulus combines 
these terms with “and”. Entering Canto Cumulus will result in all records that con-
tain Canto AND Cumulus in any of the searched record fields.
To use a term that consists of more than one string,  you have to enclose the 
strings with  double quotation marks.  Quicksearch handles the strings in quota-
tion marks as one search term. Entering “Canto Cumulus” will result in all records 
that contain the string Canto Cumulus (i.e. the words Canto and Cumulus sepa-
rated by a space) in any of the searched record fields.
To combine search terms with “or” rather than with “and”, you have to separate 
them with two pipes (||). Entering Canto || Cumulus  will result in all records  con-
taining either Canto or Cumulus or both.
To search for records that do not contain certain terms in any of the searched 
record fields,  you have to prepend the terms with a  minus symbol (-). Entering 
Cumulus -Cloud  will result in all records that contain Cumulus, but do not contain 
Cloud .
To search for one of the special characters you have to put a backslash in front; 
e.g. \- to find the minus symbol,  \&& to find && or \/ to find /. 

NOTE: If the Categories field is included in Quicksearch, the search results also 
depend on the settings specified under Category Search Also Finds Records 
of (Preferences > User Settings > Application > Search & Sort). (See “Search & 
Sort Tab,” p. 185, for details.) 
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The Quicksearch Menu
The Quicksearch menu is displayed by clicking the arrow button next to the 
magnifying glass icon.  

Besides a section displaying previously used search terms, and a section display-
ing saved search queries (see “Saving and Loading Search Queries,” p. 52), the 
Quicksearch menu provides the following entries:
• Find – Searches in all catalogs open int the current collection; replaces the 

current collection with the search result. (Equivalent to the magnifying glass 
icon.) 

• Find in Collection – Searches in the currently displayed collection only, e.g. 
in the result of a previous search. Handy for narrowing down search results.

• Find and Add to Collection – Searches in all open catalogs; adds the search 
result to the currently displayed collection. Handy for broadening a search 
result.

• Find All Records – All records of all open catalogs are displayed. (Equivalent 
to clicking the icon or pressing  Enter on an empty search field).

• Clear Quicksearch List – Deletes the previously used search terms.
• Find Window – Opens the Find window (See “Searching with the Find Win-

dow,” below, for details.)

Searching with the Find Window
The Find Window reveals the true search power of Cumulus. Complex search set-
ups (queries) can be constructed to find virtually any type of data stored for an 
asset. Boolean operators (and, or) increase the query possibilities even further. 
Different search methods let you define the search area (either all records of all 
catalogs opened in the current collection or only the records contained in the 
current collection.) The matches can either be added to the current collection, 
replace the records in the current collection or comprise a new collection of their 
own. 

A description of the Find window and a comprehensive listing of searchable 
fields are listed in the overviews “Overview: The Find Window,” p. 46 and “Over-
view: Sample Search Options,” p. 47. 

The Quicksearch menu 

Section with previously 
used search terms

Section with saved 
search queries
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BACKGROUND INFORMATION:  Window Connected to Collection
When a Find window is opened, it is connected to the active collec-
tion or catalog window. That’s why the name of the source window is 
displayed in the title of the Find window. It is important to be aware of 
this fact, when you use an open Find window for multiple searches – 
especially, if you decide to have the search results displayed in a new 
collection. Be aware of this fact when using the following search 
methods: 
– Find in Current Collection: the contents of the source window 
defines the ’search area’ 
– Find and Add to Current Collection: the matches of the search are 
added to the contents of the source window

erview: The Find Window 
open the Find window: Select Find > Find Records or Find > Find Categories 

Displays the name of the collection/catalog(s) that will be 
searched by the query in this Find window and that is 
referred to as ’current collection’. 
Search criteria.
Search operator.
Search value.
NOTE: You can search for whole words, not just for match-
ing strings – if the Record field set as search criteria is acti-
vated for word-searching. Enclose the word you are 
searching for in single  quotation marks and Cumulus will 
only find the records that contain the exact word. For exam-
ple searching for  copy will find records containing the 
words copy as well as copyright, copyhold, copyfree and 
so on. Searching for ‘copy’ will find records containing the 
word copy only.
Inserts a new search condition before the current one.
Inserts a new search condition after the current one.

NOTE: The order of search conditions is important when you
connect search conditions with the Boolean operator “or”. (F
more details, see “Sequence of Search Conditions,” p. 49.)
7 Will search all open catalogs of the current collection.
8 Will search the current collection only.
9 Found records/categories are added to the current collec

tion.
10 Found records/categories replace the current collection.
11 Found records/categories will comprise a new collection
12 Displays help text.
13 Opens the Advanced Find windows for entering nested qu

ries.
14 All records/categories of those catalogs opened in the cu

rent collection will be shown.
15 Starts the search.
16 Opens a menu for saving or loading queries. (For more 

details, see “Saving and Loading Search Queries,” p. 52.)

NOTE: Cumulus search options are NOT case sensitive. 
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Using the Find Window 
All example searches on the following pages are based on the Sample catalog.

Simple Searches
To set up a simple search (as opposed to a compound search, described on 
page 48):

1. Click Find > Find Records or Find Categories to open the Find window.

2. Select a search criterion from the Criteria list. This menu lists all record or 
category fields activated for searching.

3. Select an operator from the Operator menu. This menu lists all operators 
that are possible for the field type of the field selected as criteria. 

erview: Sample Search Options 
ria Field 

Type
Oper-
ator

Searches for Sample Data/Instructions

ories Special Records associated with specified category. Type category name or drag category  onto Value field. Use drag me
if catalog has multiple categories of the same name. Current Sear
Preferences settings affect results. (See “Search & Sort Tab,” p. 185)

bnail Special Similar thumbnails. Compares brightness and 
contrast.

Type record name or drag record thumbnail onto Value field.

ntal Res-
n

Real Dot-per-inch resolution of an image asset file. 200, 300

ata Size Integer The asset file size. (Not the record size.) 1024 KB (use KB for kilobytes)
24 MB (use MB for megabytes)

Creation Date  The date the asset was created. 11/22/97

Mode String List  The color mode of an image. Select from Value list.

ging String The name of the user who cataloged the asset. Clint, Carolyn

String Records with a group of characters in the Notes 
field that matches criteria. 

Any line of text. For example, “ball” finds ball, balloon and basebal
rights res” finds “All rights reserved.”

d /Cate-
ame

String The name of the record /category. Balloon, Clouds, Gun Shot / Illustration, Aircraft, Sounds

a
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ield Type Categories Thumbnail Date, Real, 
Integer

String 
List*

String*

* The menu options for this 
field type may differ depend-
ing on the field properties the 
Cumulus Administrator has 
set up for the selected field.

d

OTE: If the searched field is empty (has no value), the operators “is not” and “doesn’t contain” will not return a result. 
o find records with no value in a specific field, use the operator “has no value”.

Criteria

Operator
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4. Either select a value from the Value list, type a value in, or drag an appropri-
ate object onto the field. (Appropriate objects can be either thumbnails or 
categories.)

5. Leave the default search method Search in All Open Catalogs. This method 
searches all catalogs included in the current collection.

6. Click New Collection so that the records found will be displayed in a new 
collection of their own.

7. Click Find.

Compound Searches
In larger catalogs, finding records with a single search criterion may not be effi-
cient. To avoid sifting through tens of thousands of records, you may need to use 
more than one search criterion. For example, you may be looking for a photo-
graphic image in EPS format. 
Cumulus lets you do this in two different ways:
• You can enter a compound search (more than one search criterion), OR
• You can narrow the results of a simple or compound search. (See “Narrowing 

the Search,” p. 50.)
Building a compound search isn’t much more difficult than building a simple 
search. You just have to think in terms of what you are asking Cumulus to do, and 
then translate that request into the search fields. For example, your request, in 
English, might read:

“I need all records in the Photographs category that have ‘tree’ somewhere in 
their names.”

Translated into Cumulus-speak, this becomes:
• Category is Photographs and Record Name contains tree.
Now let’s break it down into separate search statements, called “conditions.”
• Category is Photographs
In our first condition, Category is our search criterion, is  our operator, and Pho-
tographs is the value we’re searching for. This tells Cumulus that the records we 
want are all in the Photographs category. This alone would find the records 
we’re looking for, but if our catalog contained thousands of images in the Pho-
tographs category, we’d spend quite a bit of time browsing through them all.
• and
This next little bit is very important. This is a Boolean operator that tells Cumulus 
how to consider the previous and next search conditions. By selecting and, we 
tell Cumulus that the records we want must match both conditions of our com-
pound search. Another option here is or, which would tell Cumulus that the 
records we want only need to match one of the conditions.
• Record Name contains tree
In the second condition of the search, we help Cumulus narrow the search 
results by giving it part of the record name that we want. We use the operator 
contains instead of is because we’re looking for records that have ‘tree’ any-
where in their names. Is would require that the record be called exactly ‘tree,’ 
with no variation.

Value
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In the Find window, the field values will construct a sentence similar to the one 
we just broke down. When you can see each condition on a line by itself, it’s eas-
ier to visualize the results of the request.
Setting up each condition in a compound search is the same as setting up a sim-
ple search. The only additional steps are adding a new line of search fields, and 
specifying the Boolean connector between each condition. 
Here’s how:

1. Click Find > Find Records to open the Find window.

2. Set up the first condition of the search as:

3. Click  to reveal a second set of fields.

4. Select and from the Boolean list, if it’s not already selected.

5. Set up the second condition of the search so that the window looks like this:

6. Leave the default search method Find in All Open Catalogs. This method 
searches all catalogs included in the current collection.

7. Click Create New Collection so that the records found will be displayed in a 
new collection of their own.

8. Click Find. The search finds two images: “Sunset with Tree” and “Tree in Win-
ter.”

Additional conditions may be added to further refine the search. Add and delete 
conditions using the following buttons:
•  Inserts a new search condition before the current condition. (The current 

condition is the line in which a field is highlighted or the flashing cursor I-
beam is found. Click in any field to make that line the current condition.)

•  Inserts a new search condition after the current condition.
•  Deletes the current condition. This is not undoable!

Sequence of Search Conditions
When performing a Find window search Cumulus performs one search condi-
tion after the other. The Boolean and and or operators define how Cumulus has 
to connect the previous and next search conditions. The operator and defines 
that the records must match both conditions. The operator or defines that the 
records need to match one of the conditions only. If you have more than two 
search conditions in a search query, a condition connected with and will search 
the matches of the previous condition and reduce this result – whereas a condi-
tion combined with or will search the entire ’search area’ (as defined under 
Search Method) and add the new matches to the previous matches. 
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SPECIAL TECH INFORMATION:  Nested Queries
If you want to enclose search conditions in brackets and set up nested 
queries, you must use the Find window in advanced mode. See “Using 
the Find Window in Advanced Mode,” p. 53, for details.

Examples
Search Query A: 

Category is Photographs 
and 
Record Name contains penguin
and 
Record Name contains balloon

First, Cumulus will search for all records that are assigned to the category Photo-
graphs and then, second, the result will be refined by searching for records that 
contain penguin in their names. Third, this result will be refined by searching for 
records that contain balloon in their names. 
In the Sample Catalog the final result of this search query is:
• Penguin Balloon.psd
Search Query B: 

Condition 1: Category is Photographs 
and 
Condition 2: Record Name contains penguin
or 
Condition 3: Record Name contains balloon

First Cumulus will search for all records that are assigned to the category Photo-
graphs and then, second, the result will be refined by searching for records that 
contain penguin in their names. Third, the ’search area’ (as defined under Search 
Method) will be searched for records that contain balloon in their names and the 
matches will be added to the results of the previous conditions. 
In the Sample Catalog the final result of this search query is: 
• Penguins.jpg
• Penguin Balloon.PSD
• Balloon Race.BMP

Narrowing the Search
If the results you get from either a simple or compound search are too broad, 
Cumulus can help. The search method Find In Current Collection allows you to 
search through the set of records contained in the current collection, instead of 
the entire catalogs of the current collection, thereby reducing the number of 
records found.
Using our example from the compound search section, we’ll perform the same 
search using the search method Find In Current Collection.

1. Make sure that the active window contains the collection of records you 
want to be searched.

2. Click Find > Find Records to open the Find window.
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3. Set up the first part of the search as:

4. Leave the default search method Find in All Open Catalogs. 

5. Click Update Current Collection so that the records found will replace those 
in the current collection. 

6. Click Find. Cumulus finds all records in the Photographs category.

7. Now change those same fields to:

8. Click Find In Current Collection as the search method. 

9. Click Current Collection so that the records found will replace those in the 
current collection. 

10. Click Find. Cumulus searches through the ten records found in the first 
search and narrows the set of records down to just two images: “Sunset with 
Tree” and “Tree in Winter.”

If it helps, you might want to think of Narrow Current Collection as an and Bool-
ean operator. That is, after your first search, you conduct another search with dif-
ferent search criteria, and the final results are the same as from the 
corresponding compound search using and. In the example above, the same 
final results were achieved with the compound search previously conducted.

Broadening the Search
If the results you get from either a simple or compound search are too narrow, 
Cumulus can be of assistance again. The search method Find and Add to Cur-
rent Collection adds the results of a subsequent search to the records contained 
in the current collection.
Let’s conduct an example search using the Find and Add to Current Collection 
search method:

1. If the Find window is not open, click Find > Find Records to open it.

2. Set up the first part of the search as:

3. Leave the default search method Find in All Open Catalogs for this first step.
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4. Click Create New Collection so that the records found will be displayed in a 
new collection of their own.

5. Click Find. Cumulus finds four records: “Camels in India,” “Indian Camel,” 
“Indian Music,” and “Sunset with Tree.”

6. Now use the same search criteria, but change the search method to:

7. Click Find and Add to Current Collection as the search method.

8. Click Update Current Collection so that the records found will supersede 
the current collection.

9. Click Find. The record “Map” is added to the four records found with the pre-
vious search, and your current collection is comprised of five records.

This search method can be seen as an or Boolean operator. That is, after your first 
search, you conduct another search using a different criteria, and the final results 
are the same as from the corresponding compound search using or.

Saving and Loading Search Queries
Although Cumulus remembers your search set-ups if you leave them open when 
you quit Cumulus, you can also save search set-ups, called queries. This prevents 
you from having to rebuild them each time you need them. It also ensures that 
your searches are consistent from session to session, which is important for some 
purposes. Cumulus query files can be used on any supported platform. You can 
store and load queries for quick retrieval if you have the appropriate permissions.
To save the current query: 

1. Click the  button and select Save.

A dialog appears in which you can name the query.

2. Type a name for the query in the Query Name field.

If you want the query to be available for other users, activate the Share 
Query option.

3. Click Save.

The query is stored in one of the two special query files Cumulus provides – one 
for the individual queries of a user and the other one for shared queries. With 
Workgroup or Enterprise these files are centrally stored at the Cumulus Server. 
To load a query:

1. Click the  button. A menu containing entries for all queries that are avail-
able to you is displayed. These include those that you set up as well as those 
set up by other users for sharing.

2. Select the entry for the desired query file.
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If you want to store a query as a separate file anywhere in the file system, you 
have to export it:

1. Click the  button. 

2. Select Export. A dialog appears from which you can save the current query 
anywhere in the file system.

3. Select a location.

4. Click the button Save.

To load such an exported query file you have to import it:

1. Click the  button. 

2. Select Import. A dialog appears from which you can select a query.

3. Select a query file.

4. Click the button Open.

Things You Can Do with Searches/Queries
• Create a new search condition. (See “Compound Searches,” p. 48.)
• Load search queries. (See “Saving and Loading Search Queries,” p. 52.)
• Save search queries. (See “Saving and Loading Search Queries,” p. 52.)

Using the Find Window in Advanced Mode
This mode is designed for advanced users only who know how to set up search 
queries that are of greater technical depth. In standard mode, the Find window 
combines search conditions in a sequence for a complex query, whereas in 
advanced mode, the Find window allows you to set up nested queries. If you are 
working in a multilingual environment, the advanced mode provides another 
advantage as the queries that are set up in this mode are language independent.
To switch the Find window to advanced mode, click the Advanced Mode button 
in the Find window. In advanced mode the Find window looks like this:

In the edit field you can enter any combination of search criteria, operators, val-
ues, and Boolean operators. For a detailed description, click the Help button. This 
envokes the help function which gives a link to a document called “Query For-
mat”. This description explains the possibilities. It is provided in English only.

NOTE: If the edit field was empty before you switched to the advanced mode, 
the field will contain the search query set up in standard mode.

Record fields that can be used as search criteria are displayed when you click the 
Fields button. This list displays all fields contained in the current collection that 
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are indexed for search. If you select an item in this list, it is inserted in the edit field 
of the Advanced Find window at the current cursor position.

The symbols you can use for search combinations are displayed when you click 
the Symbols button. 
If you select an item in this list, it is inserted in the edit field at the current cursor 
position – exception: If you have marked a selection and then choose the “com-
bine” symbol, the “combine” symbol will wrap the selection (opening bracket at 
the start and closing bracket at the end of the selection).
You can also set up a query in standard mode first and then switch to advanced 
mode. When switching back to standard mode by clicking the Simple Mode 
button, the query will be the same as before switching to the advanced mode. 
Note that it does not reflect the changes made in advanced mode. When chang-
ing back to advanced mode, the query set up in this mode is displayed again.

Searching for Categories
Certain Cumulus configurations enable you to search for categories as well. They 
provide two Find Windows: one to search for categories and one to search for 
records. But both look and work the same.

The difference is the result of your search. The categories found as a result of your 
search are displayed in the Category pane. The found categories are displayed 

In the Advanced Find Window the search criteria fields and symbols for 
search combinations are provided in drop-down lists. 

The Category Find Window

The Record Find Window
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and can be used. The categories above the found categories are also displayed – 
they are displayed for orientation only.

The categories found as a result of your search can either replace the categories of 
the current collection or comprise a new collection of their own. 

NOTE: The result also depends on the Live Filtering options the Cumulus 
Administrator may have set for you. 

Result of a search “Category Name contains p” on the right. 
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User Live Filtering
User live filtering enables you to set parameters that serve as a filter for all the 
records you find. Easily hide the file formats you don’t need, make sure what you 
see has been approved for use, or any other combination you need. Save your 
filters and even share them with others.

With User Live Filtering activated, the records on your Record pane get ’filtered’ 
by conditions you set up. 
You activate and deactivate User Live Filtering via the Filter icon in the Record 
pane top bar. 

As long as filtering is active, any further search operation – Quicksearch, Category 
Search, whatever – will only take into account the collection as defined by the 
filter criteria, not the whole catalog. Accordingly, the Find All Records command 
will only find records that match the filter criteria.

Adding Filters 
Create filters to quickly find files. For example, you can create a filter to find all files 
in a specific workflow state, a filter to limit the results you see in the Cumulus win-
dow to certain file types or to just those assets that belong to a certain client. 
Conditions define the criteria that files must meet to be included in filter results. 
You can combine multiple conditions to perform more complex filtering. 
To add a filter condition:

1. If filtering is not activated, click the Filter icon. 

2. Click the plus sign icon. A list of record fields opens. 



FIND ASSETS –  USER LIVE FILTERING 57
The list contains all record fields that are contained in the catalogs opened in 
the current collection and that have Include Field in Find and Filter Options 
activated in their properties. 
NOTE: Record Fields Offered as Criteria
Per filter a record field can only be used once as a criteria for a condition. 
This means that a record field already used for a condition is not offered in 
the list when adding a new condition. 

3. Select the record field you want to function as criteria. 

The Define Filter Condition dialog opens.

Depending on the field type of the field you selected as search criteria, the 
options differ. 

4. Set the criteria records must meet to pass the filter. For information on the 
different options, see “Using Filters,” p. 58.

5. Click OK to save your settings and activate the filter condition.

Managing Filters
To add additional filter conditions, repeat steps 2-5. 
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To edit an existing filter condition, maximize the pane (  ) and click the pencil 
icon.

To remove a filter condition, click the minus sign icon in the maximized pane.
To remove all filter conditions at once, from the Manage Filters menu select 
Remove all Conditions. Note that conditions not saved as filter will be lost. 

Saving Filters
Use Manage Filters menu to save the active filter conditions as a filter under a 
name. Saved filters are added to the menu and can be used any time you need 
them. You can share them with others.

1. Click the Manage Filters icon to open the menu.

2. Select the Save Filter option. The Save Filter dialog opens. 

3. Enter a Filter name. Make sure you use a descriptive name. If you want this 
filter to be available for other users, activate the Share Filter option. Note 
that you may only be able to save shared filters depending on your permis-
sions for shared queries.

4. Click OK to save the filter. 

An entry for this filter is added to the Manage Filters menu.

Using Filters 
You can filter the records of a collection window to display specific records only. 
Use the Manage Filters menu to select the desired filter. 

1. Click the Manage Filters icon ( ) to open the menu.

2. The available filters are listed at the bottom of the menu. The menu displays 
all shared filters in addition to private filters that you created.

3. Select the desired filter. 

Only the records of assets that meet the filter criteria are displayed. 
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Deleting Filters
Use the Manage Filters menu to delete filters you need longer.

1. Click the Manage Filters icon to open the menu.

2. Select the Delete Filter option. The Delete Filter dialog opens. It lists the 
available filters.

3.  Select the filter you want to delete.

4. Click OK to delete the filter. The entry for this filter is deleted from the Man-
age Filters menu.

Configuring Filters 
Filters comprise one or multiple conditions. 

Defining Conditions in General
Conditions are criteria that records must meet to be included in filter results. 
Depending on the field type of the field you selected as criteria, the options differ. 
For most of them you first have to decide on one of the three main options – 
either on one of the simple ones:
• Has value – Record will be included in the filter result if the field contains 

something.
• Has no value – Record will be included in the filter result if the field is empty.
Or the third one which offers further options that allow a precise description:
• Matches / Does not match (for most types) OR 

Contain / Does not contain (String lists only) OR
Is assigned to (Categories field only)

The further ’sub-options’ depend on the field type and range from general 
search criteria to exact matches with existing values. For most types the option 
From existing values is offered. It enables you to search for exact matches with 
existing values. 

Field Type Specific Condition Options
The options offered as conditions depend on the type of the field you have 
selected as search criteria.
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String 
Limits filter results to records with: Text that matches or does not match specific 
text string or a regular expression.

Select a matching option:
• Select Matches to search for records that contain the text.
• Select Does not match to search for records that do not contain the text.
Select the type of value to search for and enter or select the value: 
• Select Custom value to search for a text string you define. Enter the string 

and select the search operator.
• Select From existing values to search for exact matches with existing values. 

Once you have activated this option, existing values are displayed which you 
can select to be searched for.

String List
Limits filter results to records with values, such as workflow states, that contain or 
do not contain any or all of the values selected. 

Select an option to indicate if the results contain the selected values:
• Select Contains the following items to search for records that contain the val-

ues.
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• Select Does not contain the following items to search for records that do not 
contain the values.

Select the value(s) to search for: 
• Select Restrict to existing values to search for exact matches with existing 

values. Once you have activated this option, existing values are displayed 
which you can select to be searched for.

Long & Integer, Real & Data Size
Limits filter results to records with: numbers that match or do not match a num-
ber or numbers in a range. Integer restrictions, which are based on non-decimal 
numbers, limit results to records that contain or do not contain numbers in a 
range or list.

Select a matching option:
• Select Matches to search for records that contain the numbers.
• Select Does not match to search for records that do not contain the num-

bers.
Select the type of value to be searched for, and enter or select the value: 
• Select Range to search a range of values. Enter the From and to values.
• Select Any of the following numbers to search for multiple numbers. Enter 

the numbers to be searched for, separated by semicolons.

TIP: Greater Range
You can search for ranges greater than or less than a specific value. 
Leave the From field empty to search for matches less than the value 
in the to field. Leave the to field empty to search for matches greater 
than the value in the From field.

• Select From existing values to search for exact matches with existing values. 
Once you have activated this option, existing values are displayed which you 
can select to be searched for.
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Time Only & Date Only 
Limits filter results to records with: Time data or dates that match or do not match 
a specific date, date range, or time period. 

Select a matching option:
• Select Matches to search for records that contain the selected dates. 
• Select Does not match to search for records that do not contain the selected 

dates.
Select the type of value to be searched for and enter or select the value: 
• Select Range to search a specific date/time range. Enter the range in the 

From and through fields.
• Select Any of the following dates/times to search for multiple statements. 

Enter the time data to be searched for, separated by semicolons.

TIP: Greater Range
You can search for ranges greater than or less than a specific value. 
Leave the From field empty to search for matches less than the value 
in the to field. Leave the to field empty to search for matches greater 
than the value in the From field.

• Select From existing values to search for exact matches with existing values. 
Once you have activated this option existing, values are displayed which you 
can select to be searched for.

Date/Time
Limits filter results to records with: Dates that match or do not match a specific 
date, date range, or time period. 
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Date range restrictions limit results to records that contain or do not contain a 
date range, date/time range, or time period.

Select an option to indicate if the results meet the specified dates and times:
• Select Matches to search for records that contain the selected dates and 

times. 
• Select Does not match to search for records that do not contain the selected 

dates and times.
Select the time period to search.
• Select From date to search a specific date range. Enter the range.

TIP: Greater Range
You can search for ranges greater or less than a specific value. Leave 
the From field empty to search for matches less than the value in the 
to field. Leave the to field empty to search for matches greater than 
the value in the From field.

• Select From date/time to search a specific date/time range. Enter the range. 
This option is only available for date/time fields.

• Select a time period option to search a specific period, such as last week or 
last year. This option is only available for date fields that include the time, 
such as event date/time fields.

• Select In the to search a specified number of days, weeks, months, or years 
before or after the current date. Select Last or Next, enter a number, and 
select the time period.

• Select From existing values to search for exact matches with existing values. 
Once you have activated this option, existing values are displayed which you 
can select to be searched for.

Boolean
Limits filter results to records with: True or false set values 

Select an option.
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Categories
Limits filter results to records that are assigned to any or all categories selected. 

Check the categories to be searched for. Note that the categories available under 
Is Assigned To depend on the tab currently selected in the Category pane.



Use Assets
If you intend to do anything more than simply browsing through cat-

alogs, you should read this section. It describes how to use, present

and share your cataloged assets. This is followed by a few simple

guidelines that will ensure your workflow is as efficient as possible.
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Drag and Drop
Cumulus does not only support drag and drop in the Cumulus application and 
for cataloging. From within Cumulus you can drag and drop assets into other 
applications that support drag and drop. Under Mac OS you have to press the 
ALT key when starting dragging. 

Copying Assets
You can drag and drop a record into another drag and drop-supporting applica-
tion. Dragging a record copies the asset into the target document. Dragging a 
record into the Windows Explorer or the Mac OS X Finder copies the asset into 
the selected folder.

NOTE: It is not recommended to use drag and drop for copying a large num-
ber of files, because this may seriously impact the performance of your system 
and the available disk space. To copy a large number of files, use the Copy to 
menu command instead.
The reason for this is that both methods are handled in different ways inter-
nally. With the Copy to menu command, Cumulus creates a temporary file for 
each asset which is deleted as soon as the asset is copied. On the other hand, 
with drag and drop, temporary files of all selected assets are created before the 
first asset is copied, and these temporary files are not deleted until a new copy 
process via drag & drop is started, or Cumulus is closed.

Copying Categories and Associated Assets
Categories can be dragged and dropped – along with the assets associated with 
each category – into the Windows Explorer or the Mac OS X Finder. When you 
drop the categories, Cumulus creates a folder with the same name as the cate-
gory and copies the assets to that folder. If the category contains subcategories, 
subfolders will be created and the assets assigned to these subcategories are 
copied to the corresponding subfolders.
This option may be handy for collecting production files for output (assuming 
the files all have at least one common category, such as project name).
To copy categories and associated assets:

1. Select one or more categories that you want to copy along with the associ-
ated asset files.

2. Drag and drop the selected categories into the target application. 

NOTE: If you use this way of copying assets, any associated metadata files 
(e.g. TAG files) will not be copied even if the corresponding metadata 
modules are activated. 

A folder named as the category is created containing the asset assigned.

You also have the option of copying only the asset files associated with selected 
categories (see “Copy Assets Assigned to Category To,” p. 281).

Using Asset Actions
Cumulus Asset Actions simplify your daily workflow needs. An Asset Action refers 
to a combination of certain functions and can be saved under a chosen name. 
Whenever you wish to perform this combination of functions, all you have to do 
is select the corresponding Action and it will be done. You can perform an Asset 
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Action either on selected records or when mailing assets. To perform an Asset 
Action on records selected in the Record pane, you employ the menu item Asset 
> Perform Asset Action. (For details, see below.) To perform an Asset Action on 
records in the Collection Basket pane, you employ the Collection Basket’s tool-
bar. (For details, see “Outputting the Collection Basket’s Contents,” p. 264. 
These Asset Actions can be defined in your User Settings in the Preferences dia-
log – for a description, see “Cumulus Asset Actions,” p. 221. With Workgroup or 
Enterprise, you need the appropriate permissions for Asset Actions. 
To perform an Asset Action on records in the Record pane:

1. Select one or more records.

2. Select Asset > Perform Asset Action. A submenu opens that lists the avail-
able Actions.

3. Select the desired Asset Action.

Depending on how the action is defined dialogs for the included modules 
may show up. Make your selection and click the appropriate buttons. The 
Actions will be performed on the selected records.

Progress information is displayed on those actions that take a certain 
amount of time.

If the selected Asset Action failed to be performed on certain assets, theses assets 
are listed as soon as the Asset Action is completed, together with the respective 
error messages. 
Clicking Reveal in collection displays these assets in a collection of its own for 
further processing.
Clicking Ignore closes the window without any further action.

Mailing Your Assets
Cumulus also lets you e-mail the assets themselves, so that you can easily share 
them with people who don’t have access to your Cumulus catalogs. You can use 

Submenu with pre-configured Actions. Customize 
opens the Asset Actions Preferences window (only 
if you have the appropriate permissions).
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Cumulus’ powerful search and display features to find just the right assets, and 
then send them off with a single command.
To e-mail assets from within Cumulus:

1. Select one or more records whose assets you want to mail.

2. Select Asset > Mail To. A dialog opens prompting whether you want to 
send the original asset or to have a Cumulus Action performed on the 
asset(s) before it is sent.

3. Select the desired option (and if you decided on an Action, the desired 
Action) and click OK.

Cumulus launches your e-mail application (in case you have more than 
one, offers you a menu to select) / launches your default e-mail applica-
tion and attaches the selected asset(s) to an outgoing message. (If you 
decided on an Action, the result of the Action will also be saved as defined 
for the delivering module of the Action.)

Previewing Assets 
Cumulus provides several ways of previewing assets:
• Preview pane
• Preview view
• Preview window
• Fullscreen Preview
• Fullscreen Slide Show
Viewing an asset in Preview view or window lets you add user comments to it. In 
Fullscreen Preview you can compare up to six different assets and add labels and 
ratings. The Fullscreen Slide Show displays assets as fullscreen previews in a slide 
show. The Preview pane can be opened additionally at the left side of a collec-
tion window. 

Preview View and Window
The records’ assets must be available to display.
Previews can be zoomed in or out and displayed in different sizes using the win-
dow’s toolbar or menu options. (See “Overview: Toolbars for Previews”, below, 
and see “Zoom In,” p. 269, and “Zoom Out,” p. 269.) 
The default size of the preview display can be set in the User Settings. (See “Over-
view: User Settings (2) – Display Tab,” p. 186). 
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You can copy all or part of a preview to the Clipboard. To select a portion of the 
preview image:

1. Click the Select Tool ( ) on the toolbar and then click and hold the mouse 
down in the upper left hand corner of the region you want to copy.

2. Drag the mouse to the lower right of the region. A box is drawn around the 
selected area.

3. Press Command / Control and c to have the selected portion on the 
Clipboard.

The selected portion of the preview is on the Clipboard and may be pasted into 
other applications. Remember, this is a copy of the preview image, not the actual 
asset. 
A selected portion of a preview can also be zoomed in:

1. Click the Select Tool ( ) on the toolbar and then click and hold the mouse 
down in the upper left hand corner of the region you want to zoom in.

2. Drag the mouse to the lower right of the region. A box is drawn around the 
selected area.

verview: Toolbars for Previews
oolbar for 

Select tool: Use to select an area of the preview.
Handtool: Use to move around the preview so you view all 
areas of it. (Works only if the preview is larger than the win-
dow.)
NOTE: Toggling between Hand Tool and Select Tool! 
Activating the Hand Tool deactivates the Select Tool and 
vice versa.
User Comment tool: Click to activate commenting mode. 
Use arrow to open or close all comments.
Rectangle user comment 
Polygon user comment 
Sticky note user comment
Rotates the preview 90° counter-clockwise
Rotates the preview 180° 
Rotates the preview 90° clockwise

0 Zooms in the preview.
1 Zooms out the preview.
IP: Independent from the selected tool, using the ALT key in 
onjunction with the mouse lets you move the image inside the 
review window . 
2 Shows preview in original size.

13 Fits preview to window.
14 Shows preview in fullscreen.

TIP:  If you have a fullscreen preview, you can use the 
mouse scroll wheel to get the next or previous asset 
displayed. 

15 If activated, the displayed preview follows the selec-
tion in the collection window (same behavior as the 
Information Window). If not activated, the displayed 
preview remains independent from the selection in 
the collection window and must be changed manu-
ally.

16 Closes the window.
17 Shows the preview of the first record from the current 

collection.
18 Shows the preview of the previous record from the 

current collection.
19 Shows the preview of the next record from the current 

collection.
20 Shows the preview of the last record from the current 

collection.
21 Displays the current Record View Set; clicking on the 

arrow opens a selection list of available Record View 
Sets.

1 2 3 5 6 7 8 20104 9 1312 14 15 16 1711

Preview Window

Preview View

19 2118 19
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3. Click the Zoom in icon ( ) on the toolbar to have the selected portion fill in 
the entire size of the Preview window.

Multi-page Previews 
Multi-page previews are available for the following file formats: GIF, InDesign, 
JPEG, PCX, PDF, PowerPoint Presentations, Photoshop, Quark XPress, and TIFF. 
For InDesign a multi-page preview can be provided only if one of the following 
requirements is fulfilled:
• A Cumulus Metadata file (TAG file) is available which was created by the 

Cumulus Plug-in for Adobe InDesign
OR

• The corresponding XPV file is available (and a licensed HELIOS Image Server 
accessible in the network).

For Quark XPress a multi-page preview can be provided only if one of the follow-
ing requirements is fulfilled:
• The corresponding XPV file is available (and a licensed HELIOS Image Server 

accessible in the network) 
OR

• The Cumulus DDS Companion is installed and configured in the Cumulus 
Quark DDS Filter 
OR

• Under Mac OS: Quark XPress is installed.

NOTE: The preview always shows the current status of an asset. So the num-
ber of pages/slides might differ from those cataloged as contained sub assets 
if the asset has changed and the records were not updated. 

User Comments 
For work-in-progress management Cumulus provides user comments. From the 
Preview view or window, add comments, draw rectangles or polygons and com-
municate your ideas, approvals or anything else to other users. All comments are 
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searchable, meaning you can find assets based on comments they contain. Plus, 
you have an archive of change requests stored right alongside the assets.

Requirements
To have the user comment feature available for assets, the catalog which man-
ages them requires the record field User Comment Thread to store the com-
ment information. (For a description on how to add fields to a catalog, see the 
Administrator Guide.) 
To use the user comment feature, a user requires the appropriate permissions for 
the User Comment Thread field. (For more information, see the Administrator 
Guide.)

Working with User Comments
Cumulus provides two types of user comments. The rectangle comment and the 
sticky note comment. Both types are attached to an asset’s preview and appear 
in pop-up windows. 
To add comments or to view existing comments, the User Comment tool must 
be active.

Adding User Comments
When you add a user comment, a pop-up window opens. If you enter more text 
than fits into the pop-up window, the text scrolls. You can also resize the win-
dow, if desired.

User comments are easily entered in the Cumulus preview window or view. Each user can add comments, and 
you can even find records based on the comments they contain.
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To add a sticky note user comment:

1. Click the User Comment tool  in the Preview toolbar to activate it.

2. Click the sticky note icon  in the Preview toolbar.

3. Click the location where you want to place the note.

4. Type the text for the comment into the pop-up window. When you are fin-
ished, click the Close button in the upper right corner of the pop-up win-
dow.

Note that closing the pop-up window automatically saves the comment.
The User Comment tool switches to the Hand tool after you added a note. To add 
another comment, click the corresponding toolbar icon (rectangle or sticky note) 
and then click where to add the next comment.
To add a rectangle user comment:

1. Click the User Comment tool  in the Preview toolbar to activate it.

2. Click the rectangle icon  in the Preview toolbar.

3. Position the mouse pointer in the upper left hand corner of the area you 
want to comment on, click and drag across the area where you want the 
rectangle comment to appear.

4. Type the text for the comment in the pop-up window. When you are fin-
ished, click the Close button in the upper right corner of the pop-up win-
dow.

To add a polygon user comment:

1. Click the User Comment tool  in the Preview toolbar to activate it.

2. Click the polygon icon  in the Preview toolbar.

3. Click in the preview to set the starting point. Position the mouse pointer 
where you want the first straight segment to end, and click. Continue click-
ing to set endpoints for subsequent segments. To close the border, double-
click. 

4. Type the text for the comment in the pop-up window. When you are fin-
ished, click the Close button in the upper right hand corner of the pop-up 
window.

TIP: Close/Open Comment Pop-up Windows
To close or open all user comment pop-up windows at once, use the 
pull down menu provided by the User Comment tool. 

Editing User Comments
To edit a user comment:

1. If the comments are not displayed, click the User Comment tool icon 
in the Preview toolbar to activate them.
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2. Double-click the comment icon (note or rectangle) to open the pop-up 
window.

3. Edit the text as needed. When you are finished, click the Close button in the 
upper right corner of the pop-up window.

To resize a pop-up window, drag the lower right hand corner of the window to 
the appropriate size.
To resize a rectangle or polygon comment, grab a handle (little yellow square) of 
the border by holding the mouse button down while the cursor is over the han-
dle. Drag the handle for resizing. 

Deleting User Comments
To delete a user comment:

1. If the comments are not displayed, click the User Comment tool  in the 
Preview toolbar to activate them.

2. Do one of the following:

• Select the comment icon (note or rectangle), and then press the Delete 
key.

• Right-click / CRTL-click the comment icon, and then choose Delete. 
• In the open popup window, select the arrow icon in the title bar of the 

popup window, and then choose Delete. 

Displaying User Comments in a Sub-Pane
Use the sub-pane filter User Comments to have all comment text of an asset dis-
played.

Searching for User Comments
Use the Find window to search for text entered as user comments. As search cri-
teria select the field User Comment Thread – User Comment – Comments. 

Fullscreen Preview
The Fullscreen Preview window offers an interactive display of up to six different 
assets at once, making it easy to pick the perfect one each time – compare qual-
ity, sharpness, composition, etc. 
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Opening the Window
Select the records of the assets you want to have displayed in the window and 
select Asset > Fullscreen Preview.

Using the Window
You can have record fields displayed. What is displayed along with the previews 
depends on the selected Record View Set and its setting for the Preview window. 
(For a description on how to configure the view of the Preview window see 
“Record View Sets,” p. 188.) Always displayed on the statusbar and not depend-
ing on the selected Record View Set are the fields Record Name, Label and Rating 
(if contained in the catalog.)

Linking Panels
In Fullscreen Previews of multiple assets, two or more panels can be linked 
together for synchronous zooming, rotating and panning.
To link panels:

1. Click the icon on the statusbar of every panel you want to link, OR

CTRL-click /  CMD-click any of the  icons to link all panels in the 
fullscreen preview.

In linked panels, the  icon is highlighted.
To unlink panels, i.e. to exclude them from synchronous zooming, rotating and 
panning:

1. Click the highlighted  icon of every panel you want to unlink, OR

CTRL-click /  CMD-click any of the  icons to unlink all panels in the 
fullscreen preview.

NOTE: In fullscreen previews of single assets, the  icon is not displayed. 

Displaying the Info Window
Ready “slide on” access to the Info Window makes metadata edits easy. Move 
your mouse pointer to the left edge of the screen and the Info window will show 
up. Click the pin icon to dock it so it will stay when you change the mouse pointer 
position.

Using the Toolbar
Move your mouse pointer to the bottom of the window and its toolbar pops up. 

Fullscreen Preview Toolbar Items

1 Shows the preview of the first record from the current collection.
2 Shows the preview of the previous record from the current collection.
3 Shows the preview of the next record from the current collection.
4 Shows the preview of the last record from the current collection.
5 Shows/hides statusbar (comprising label, rating, rotating & zooming icons.)
6 Mouse over: Display list of available commands / Click: Open help system
7 Closes the window.

1 2 4 653 7
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Displaying a Command Overview
Position your mouse pointer on the question mark icon to have a list of available 
commands and keyboard shortcuts is displayed. Click on the question mark to 
access the Cumulus help system. 

Marking Assets
In the Fullscreen Preview window you can mark assets by using labels and rat-
ings. 
Color labels are set using the square symbol. Clicking on this icon opens a list of 
available labels. Select the label you want to mark the asset with. 
You can also mark assets using star ratings. Use the shortcuts CTRL+ALT+1-5 / 

ALT + CMD+ 1-5 to set the rating. See “Labeling,” p. 113, for more about 
labels; see “Rating Assets,” p. 115 for ratings.

Adjusting Preview Size
The magnify glass icons of the statusbar let you scale how an asset is displayed 
within each preview area (panel). To zoom in on a preview image, you also use 
the + (plus) and - (minus) key shortcuts. 

Rotating Previews
The rotation icons of the statusbar let you rotate a preview 90° clockwise or coun-
ter-clockwise.
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Next and Previous Assets
You can use the arrow icons of the toolbar or the PAGE DOWN and PAGE UP key 
to load assets in the window. When there is more than one asset on-screen, the 
asset that is changed is the one that is marked as selected by a  light green border 
and a big check mark symbol. If none is selected, the entire group of previewed 
assets is replaced by the next group. If one is selected, the PAGE DOWN key 
changes the asset to the next one in the collection and the PAGE UP key changes 
it to the previous one. You can also use the mouse wheel to scroll through.

TIP: 
If multiple assets are displayed in the Preview window, a single asset 
can be loaded into more than one preview area, enabling you to pan, 
zoom and examine it in detail. To load another preview in a preview 
area, select the preview area and use ALT+Mouse Wheel.

NOTE: Linked preview images are navigation locked, i.e. they never change 
position and can’t be replaced with other assets via the PAGE UP / PAGE 
DOWN keys or scroll wheel navigation.

Comparing Previews
Any two selected preview images can be automatically compared by Cumulus, 
with a visual representation of the comparison result displayed in the Fullscreen 
Preview. For details, see “Preview Comparison,” p. 77

Fullscreen Slide Show
Shows assets as fullscreen previews in a slide show. You can load the assets man-
ually or run them in a loop.

Opening the Window
Select the records of the assets you want to have displayed in the slide show and 
select Asset > Fullscreen Slide Show.

Using the Window
You can have record fields displayed. What is displayed along with the previews 
depends on the selected Record View Set and its setting for the Preview window. 
(For a description on how to configure the view of the Preview window see 
“Record View Sets,” p. 188.)

Using the Toolbar
Move your mouse pointer to the bottom of the window and its toolbar pops up

Fullscreen Slide Show Toolbar Items

1 Shows the preview of the first record from the current collection.
2 Shows the preview of the previous record from the current collec-

tion.
3 Shows the preview of the next record from the current collection.
4 Shows the preview of the last record from the current collection.
5 Displays how many seconds each slide (asset’s preview) will be 

displayed in a looping slide show. You can enter the number of 
seconds you want.

6 Stops/starts the loop.

7 Shows/hides statusbar (Statusbar comprises 
of label, rating, rotating & zooming icons.)

8 Mouse over: Display list of available com-
mands / Click : Open help system

9 Closes the fullscreen slide show.

1 3 42 5 6 7 8 9
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Displaying a Command Overview
Position your mouse pointer on the question mark icon and a list of available 
commands and keyborad shortcuts is displayed. Clicking on the question mark 
accesses the entire Cumulus help system. 

Preview Comparison
Cumulus provides a smart option that allows you to compare two image assets. 
A visual representation of the comparison result as well as the previews of the 
compared assets are presented in fullscreen preview. 
The comparison is done on a pixel-by-pixel base, i.e. any pixel in the preview of 
an asset is compared to the according pixel in the preview of the other asset. The 
comparison result is computed – and displayed – as the difference of the RGB 
values of the corresponding pixels. Pixels that are identical in both images 
appear as black in the comparison result.
If the two images to be compared have the same aspect ratio but different sizes, 
the larger one is scaled down to the size of the smaller one. If the images differ 
both in size and aspect ratio, they are overlaid centered.
Compare Previews is especially useful for detecting subtle differences in appar-
ently identical image assets.
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Starting the Comparison
The preview comparison can be startet either from the collection window, or 
from the fullscreen preview.

1. In the collection window, select the records of the two assets you want to 
compare, then select Asset > Compare Previews.

OR

In a Fullscreen Preview of multiple assets, select the previews of the two 
assets you want to compare, then open the context menu (with the right 

mouse button /  Control key + mouse) and select Compare.

Using the Window
A fullscreen preview comprising a comparison result behaves the same way and 
offers the same options as any fullscreen preview (see “Fullscreen Preview,” 
p. 73.) 
The statusbar of the panel with the resulting image displays the title Comparison 
Result and the current zoom factor. 

By default, the comparison result and the two previews of the compared assets 
are linked for all zooming, rotating and panning commands, i.e each zooming or 
panning operation in either panel is performed on the other two panels at the 
same time and in the same way (see “Linking Panels,” p. 74).
Comparison results can only be viewed, but not saved, rated, or labeled. And of 
course, there is no metadata for the comparison result to be displayed.
To get rid of the comparison result and possibly restore the preview image that 
was displayed previously in that panel, select the compare image, then open the 

Fullscreen Preview with Comparison result. The subtle difference between the two com-
pared assets (top) is clear in the comparison image below, where a stark outline indicates 
major differences. Less subtle differences are indicated in less contrasting colors.



USE ASSETS – REPURPOSING ASSETS 79
context menu (with the right mouse button /  Control key + mouse) and 
select Reset Compare Panel.

Repurposing Assets
Cumulus provides several ways for you to repurpose your cataloged assets. The 
following sections describe how you can do this making use of Cumulus Con-
verter module.

Converting Image Assets
The Pixel Image Converter enables you to convert any cataloged pixel image into 
the different formats on the fly, e.g. JPEG, TIFF, BMP, GIF, ScitexCT, PNG, PCX, and 
PDF. It also lets you resize the image and convert it into another color space.
With Cumulus, the images can also be cropped, rotated or flipped, Sharpen and 
Blur filters can be applied for the image processing. The sequence of the conver-
sion processes is cropping first, then resizing and after that applying a filter. 
Finally the image is saved in the specified color space and output format.
To convert image assets into another format:

1. Select the record(s) representing the image asset(s) to be converted.

2. Select Asset > Convert To menu command.

The Browse for Folder dialog opens for choosing a destination for the con-
verted asset.

3. Select the folder and click Open / OK.

A dialog opens for choosing the converter. The dialog lists the Asset Proces-
sors available to you. Available to you for converting are the Asset Processors 
that are activated in the Asset Handling Set which is chosen for Asset Access 
in your User Settings. 

4. Select Pixel Image Converter as Asset Converter. 

The Pixel Image Converter Parameter dialog opens. 

5. Choose your settings. For details, see “Pixel Image Converter Parameters,” 
p. 79.

6. Click OK.

The selected image asset(s) will be converted and the resulting images will be 
stored in the selected destination.

Pixel Image Converter Parameters
For the conversion you can define parameters referring to:
• Image Size
• Image Processing
• Output Format 
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Image Size
You can not only determine the image size (in pixel as well as inches, cm or per-
cent). You can also have the image cropped before it is scaled to the dimension 
defined by width and height. 
• Alternate Source Resolution

If you want to use the image with a resolution different from the stored orig-
inal, activate the User Alternate Source Resolution option.

• Crop Area 
Cropping refers to cutting down an image by cutting away unwanted parts 
at the edges. You specify left, top, right, bottom margins to be cropped off 
the source image. 
The cropping function can be used to trim the edges of an image. Enter the 
size of the edges to be removed. Define the measurement under Units.
NOTE: If you use an alternate source resolution, be aware that this resolu-
tion is the basis for any cropping in inches or cm measurements. 

• Scale Dimension 
The values for width, height and resolution determine the size of the con-
verted image. The image size can be specified in pixel dimensions or print 
dimensions. And you can decide to have the image converted either to an 
individual size or to a fixed size, the maximum of which is defined by a 
bounding box. The result depends on the selections set for the conversion:
• Work at

If you want to specify the size in inches or cm and have the software calcu-
lating the pixel dimension automatically depending on the set resolution, 
select Document Size. If this option is activated, the entered values deter-
mine the print dimensions.
If you want to specify the pixel dimension (not caring about print size), 
select Image Size. 
Note that the final output size depends on the output device’s settings 
(e.g. dpi of printer).
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TIP: 
Working at Image Size is useful when preparing images for online dis-
tribution. Keep in mind that changing pixel dimensions affects not 
only the size of an image on-screen but also its image quality and its 
printed characteristics – either its printed dimensions or its image res-
olution. 

• Constrain Proportions
To maintain the current proportions of width to height, activate this 
option. (This option is not available if you have selected multiple records 
for converting or if you are defining a Cumulus Action.)

TIP: 
To keep the proportions if you have selected multiple records or if you 
are defining a Cumulus Action we recommend you to specify height 
and width in percent. 

• Use Size as Bounding Box
If this option is activated, the size defines the bounding box into which the 
images has to fit. The image will be resized proportionally to fit the size of 
the bounding box. No dimension of the converted image will exceed the 
size of the box. When using this option, the proportions of the images are 
always constrained and that’s why the Constrain Proportions option is not 
available.
If you want images that are smaller than the size of the bounding box to 
be enlarged to this size, activate the Enlarge Smaller Images option. 

TIP: 
To define the size for a box you want to fit for portrait and landscape 
images, make it a square. Then the longest edge of an image (height 
or width) will be resized to the entered value and the shorter edge will 
be resized according to the proportions of the image. 

You can choose different units of measurement. To enter values as percent-
ages of the current dimensions, choose Percent as the unit of measurement.

Image Processing
With the conversion the image can be processed. You can have a filter run, rotate 
and flip the image. Select the desired processing options.
• Filter 

To have a filter run with the conversion, select a filter type and the radius 
range for the filter (small, medium, large.) The radius determines how far the 
filter considers surrounding pixels that affect the filter action. The following 
filters are available:
• Average Blur filter

Softens an image. It smooths transitions by averaging the color values of 
surrounding pixels. Eliminates noise where significant color transitions 
occur in an image. 

• Median Filter
Reduces noise in an image by blending the brightness of pixels. The filter 
adapts the brightness of pixels to the median brightness value of the sur-
rounding pixels. 

• Gaussian filter
Works similarly to the Blur filter but uses a weighted average of the color 
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values of the surrounding pixels. The weighting is generated using the 
Gaussian bell-shaped curve that is generated. 

TIP: 
The Blur as well as the Gaussian filter decreases high-frequency details 
and can produce a hazy effect. 

• Sharpen filter
Increases the visual sharpness of images by increasing the contrast at 
edges. 

TIP: 
Applying the Sharpen filter is recommended when scaling up images 
to keep their visual sharpness as high as possible. 

• Unsharp Mask Filter
Makes images appear sharper by increasing the contrast of small bright-
ness changes.

• Add Noise Filter
Applies random pixels to an image, simulating distortion or noise. You can 
also use the Add Noise filter to give a more realistic look to heavily 
retouched areas. 

• Rotation 
You may rotate the image by selecting image rotation degrees.
0 no rotation
90 to rotate the image clockwise by a quarter-turn
180 to rotate the image by a half-turn
270 to rotate the image counterclockwise by a quarter-turn.

• Flip 
– activate horizontal to flip the image along the vertical axis.
– activate vertical to flip the image along the horizontal axis.

Output Format
For the output you can define the following parameters:
• Color Space

Select the desired color space for the converted image. The available color 
spaces depend on the selected file format (e.g. GIF, PNG, PCX, and BMP do 
not support CMYK.)
NOTE: ICC Profile Embedded
The ICC profile of an original image will be embedded in the converted 
asset if the color space is not changed and the output file format supports 
ICC profiles. 

• File Format
Select the file format for the converted image. Depending on the selected file 
format, the available further parameters for the output format may differ. 

• Compression
Select a compression scheme that is supported for the selected file format. 
(This version of the Pixel Image Converter provides a compression scheme 
for TIFF only.)

• Quality (JPEG)
For JPEG and PDF files only, select the desired quality.

• Store IPTC Information
To store IPTC metadata within TIFF and JPEG images, activate this option.
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• Store XMP Information
To store XMP metadata within TIFF, JPEG, PNG, and PDF files, activate this 
option.

The selected asset(s) will be converted and stored under the name of the original 
asset in the selected destination. The Pixel Image Converter will automatically 
add the correct File Type and Creator / file extension to the file name. The 
name will be extended by a number if a file with that name already exits at the 
selected destination.

Watermarking Assets
With the ever increasing number of digital assets, digital watermarking has 
become an important topic. Watermarking helps you to protect your intellectual 
properties. Protect your images by adding watermarks.
Digital watermarking is a technology for embedding information into digital 
assets. In general, information for protecting copyrights is embedded as a water-
mark. A watermarked image can prove its origin, thereby protecting copyright. A 
watermark also discourages the making of illegal copies. 

BACKGROUND INFORMATION:  
Watermarking can serve many different purposes from tamper proof-
ing to authentication. Three major aspects in the protection of digital 
assets have been pointed out, each of them with different require-
ments: first copyright protection, protecting ownership and usage 
rights; secondly tamper-proofing, aiming at checking document 
integrity; and thirdly authentication, the purpose of which is to check 
the authenticity of a document. While robust watermarks are typically 
used for copyright protection, fragile or semi-fragile watermarks are 
proposed to ensure tamper proofing and authentication.

For embedding watermarks, Cumulus provides the Watermark AssetProcessor. It 
enables you to embed visible watermarks into following pixel image formats: 
JPEG, TIFF, BMP, GIF, PNG, and PCX. It creates a copy of a cataloged asset with the 
digital watermark embedded. 

Example for text and image watermarks
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Watermarking Parameters
You can provide both an image and text for your watermark. The position of the 
text can be set in the properties. You can provide just the image or just the text. 
Or a combination of the two. 

Visible Image 
As a watermark image you can use most common pixel image formats, e.g. JPEG, 
PNG, and TIF. If an animated image file is supplied, the first frame will be used as 
the watermark image. You can either type in or browse to find the watermark 
image file.
You define the opacity of the watermark from 0 to 100. If you set the opacity to 
0, the watermark image will be totally transparent and you will not be able to see 
it. If you set it to 50, the watermark will be semi-transparent. The watermark will 
be completely opaque (solid) if the opacity level is set to 100. 
Under Image Position, you define the area where the watermark image should 
be placed. The position of the watermark image within the resulting image is 
defined by anchor points.
You can control the size of the watermark image by scaling it. When scaling, pro-
portions are constrained, and the images will be scaled to provide the maximum 
overlay. Small watermark images will be enlarged and large ones will be made 
smaller. You can also define to have only small images enlarged. Following scal-
ing options are available: 
• At long edge – The watermark image is scaled at its long edge. The long 

edge will be scaled to fit the source image and with proportions constrained 
the short edge will be scaled accordingly.

• At short edge – The watermark image is scaled at its short edge. The short 
edge will be scaled to fit the source image and with proportions constrained 
the long edge will be scaled accordingly.

• Fit to image size – The watermark image is scaled to fit the size of the image, 
depending on the image orientation (portrait or landscape). 
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• Scale up only – A watermark image that is smaller than the source image is 
enlarged to provide the maximum overlay. Proportions are constrained.

NOTE: If you do not activate the scale option, watermark images larger than 
the source image will be cropped. 

The Previously selected image field will display an image only if the watermark-
ing parameters are defined for an Asset Action. Then the watermarking image 
will be provided by the Cumulus Server and the field displays a preview of the 
image that was transferred by the Cumulus Server.

Visible Text
The visible text can be entered by you and/or taken from a Cumulusrecord field. 
Using a record field enables you to have individual watermarks when batch pro-
cessing images. 
To include a record value as text, select the desired field from the Record field 
drop-down list and click Append. The corresponding placeholder entry will be 
inserted at the end of the Content field.
You are allowed to enter multiple lines of text in the Content field. Enter \n for 
carriage return. You can also type special characters (like ©, ®, etc.). They will be 
rendered properly in the processed images. 
You can control the position of the text. You can specify the Horizontal Position 
(Left, Center, and Right) and Vertical Position (Top, Middle, and Bottom) of the 
text. 
You define the opacity of the watermark from 0 to 100. If you set the opacity to 
0, the watermark will be totally transparent and you will not be able to see it. If 
you set it to 50, the watermark will be semi-transparent. The watermark will be 
completely opaque (solid) if the opacity level is set to 100. 
You can choose the font, style, size and color of the text. To have the text fit best 
to the image size independently of the font size setting, activate the Fit text to 
image size option.
Under Text Position, you define the area where the watermark text should be 
placed. The position of the text within the resulting image is defined by anchor 
points.

Employing Custom Record Fields 
The drop-down list for selecting a record field displays the Cumulus standard 
fields only. If you want to include a custom field, you must enter the GUID (Glob-
ally Unique Identifier) of the field into the Content field of the Watermark Assset-
Processor Parameter dialog.
To find out the GUID open the Properties of the field ( Cumulus / Edit > 
Preferences > Catalog Settings) and on the General tab double-click the field 
name of the field Field Name.  

This copies the GUID to the clipboard and you can paste it. A Cumulus GUID is 
composed of exactly 38 characters and looks like this: 
{af4b2e12-5f6a-11d2-8f20-0000c0e166dc}

Double-click to copy the GUID of a record field to 
the clipboard.
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Embedding Watermarks into Image Assets
You embed watermarks into image assets by employing the Convert menu com-
mand or by including the Watermark AssetProcessor in a Cumulus Asset Action. 
(For information on how to include an Asset Processor in an Asset Action, see 
“Cumulus Asset Actions,” p. 221.) 
To watermark image assets via the Convert menu command:

1. Select the record(s) representing the image asset(s) to be watermarked.

2. Select Asset > Convert To menu command.

The Browse for Folder dialog opens for choosing a destination folder for the 
watermarked asset(s). 

3. Select the folder and click Open / OK.

A dialog opens for choosing the converter. The dialog lists the Asset Proces-
sors available to you. Available to you for converting are the Asset Processors 
that are activated in the Asset Handling Set which is chosen for Asset Access 
in your User Settings. 

4. Select Watermark AssetProcessor as Asset Converter. 

The parameter dialog opens. 

5. Make your settings. For details, see “Watermarking Parameters,” p. 84.

6. Click OK.

The selected image asset(s) will be converted and the resulting images will be 
stored in the selected destination.

Creating Presentations
Within Cumulus you can create PowerPoint presentations from cataloged Pow-
erPoint assets (individual slides or entire presentations), image assets and pre-
views of other asset formats. 
Cumulus offers two Asset Processor modules for creating presentations. Both 
enable the user to create PowerPoint presentations from selected PowerPoint 
assets and image assets within Cumulus. They differ in the format of the presen-
tation they create: 
• The MS PowerPoint Asset Processor creates presentations in PowerPoint 97-

2003 format (*.ppt). It requires a Microsoft PowerPoint installation on the 
computer where you want to make use of it (e.g. Cumulus Client, Internet Cli-
ent Pro or Web Publisher Pro.)

• The Office Open XML Presentation Asset Processor creates presentations in 
Office PowerPoint 2007 format (*.pptx and *.ppsx).

Note that these modules are optional and may not be available with your 
Cumulus configuration.

When creating a new presentation with Cumulus, both Asset Processors offer a 
range of parameters to be defined. (For details, see “Office Open XML Presenta-
tion Processor Parameters,” p. 87, and “MS PowerPoint Asset Processor Parame-
ters,” p. 92.)
If your selection of assets includes presentations, you can define to exclude 
them, to include the entire presentations or just the first slides. 
If your selection of assets includes images, each image is placed on a separate 
slide. You can define the area where they will be placed and determine where 
they should be aligned. The images can be scaled down or up to fit this area. If 
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you do not activate a scale option, only large images will be scaled down to fit 
on the slide, according to the determined alignment. You can also have the 
images processed before they are included in the presentation. If you enable this 
option, the Parameters button lets you select the processing parameters. For 
details on the available parameters, see “Converting Image Assets,” p. 79.

SPECIAL TECH INFORMATION:  
You can use any asset format to be included as an image in a presen-
tation if a Cumulus Filter module is available that provides a preview.

You can create presentations by employing the Convert menu command or by 
including the Asset Processor in a Cumulus Asset Action. (For information on 
how to include an Asset Processor in an Asset Action, see “Cumulus Asset 
Actions,” p. 221.) The following section describe how to create presentations 
with the Convert menu command.

Creating Presentations in Office PowerPoint 2007 Format
To create an Office PowerPoint 2007 format presentation (*.pptx or *.ppsx) from 
selected assets within Cumulus:

1. Put the records of the assets you want to include into the order you want 
them to appear in the new presentation. 

2. Select the assets to be included in the new presentation

3. Select Asset > Convert To. 

The Browse for Folder dialog opens for choosing a destination folder for the 
presentation asset(s). 

4. Select the folder and click Open / OK.

A dialog opens for choosing the converter. The dialog lists the Asset Proces-
sors available to you. Available to you for converting are the Asset Processors 
that are activated in the Asset Handling Set which is chosen for Asset Access 
in your User Settings. 

5. Select Office Open XML Presentation Asset Processor and click OK. The 
dialog for the parameters opens. 

6. Enter a file name for the new presentation.

NOTE: If you enter the file name of an existing presentation, the new 
slides will be appended to the existing presentation.

7. Make your settings. For details, see “Office Open XML Presentation Processor 
Parameters,” p. 87. 

8. Click OK. 

NOTE: If your selection of assets includes presentations or slides in PowerPoint 
97-2003 format, a Microsoft PowerPoint 2007 installation is required to con-
vert such assets before they are embedded. It must be installed on the com-
puter where you want to make use of the processor (e.g. Cumulus Client, 
Internet Client Pro or Web Publisher Pro.) 

Office Open XML Presentation Processor Parameters 
The Office Open XML Presentation Asset Processor offers a range of parameters 
to be defined. The parameters are grouped by tabs:
•  – parameters referring to the entire new presentation
•  – parameters defining the slides created from presentation assets
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•  – parameters defining the slides created from image assets 

File Options
Define how the created presentation is composed. Decide on the name, the for-
mat and whether images are embedded or linked. 

File name – Enter the name for the presentation to be created or enhanced. If 
you enter an existing presentation, the new slides will be appended to the exist-
ing presentation

NOTE: The Asset Processors will not replace an existing presentation. They will 
append the new slides to the existing presentation. However, if included in an 
Asset Action, the Asset Processor will not append slides, as the Delivery module 
of the Action will save a new presentation (name of the existing one extended 
by a number.) 

Format 
Define the format of the presentation to be created: 
• Presentation (*.pptx) – Creates an Office PowerPoint 2007 presentation, 

which is an XML-enabled file format. 
• Show (*.ppsx) – Creates an Office PowerPoint 2007 presentation that always 

opens in Slide Show view rather than in Normal view.
Media Handling
The options for embedding or linking the images determine how the image is 
embedded in the presentation. 
• Embed media – Media such as images will be saved with the presentation.
• Link media – Media such as images will be linked to the presentation only. 
If you decide on linking the images, following options are available:
• Save presentation and link media in same folder – Images will be saved in 

separate files in the same folder where the presentation will be saved. 
• Save linked media images, placed in folder next to presentation – Images 

will be saved in separate files in a subfolder of the folder where the presenta-
tion will be saved. 
– Folder name – Enter a name for the subfolder where the images should be 
saved – either an existing folder or a new one. Entering a new name will cre-
ate a folder.
– Append name of presentation – The name of the presentation will be 
added to the name of the folder (existing or new).
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• Make presentation usable on any computer – The created presentation is 
prepared to work on other computers. The path information for the linked 
images are changed from absolute to relative paths. This enables the presenta-
tion to find the linked images relative to its location.
– Create ZIP archive containing presentation and linked media – 
The presentation and its linked media are compressed to a ZIP archive. 

Slide Handling
Define how to handle presentation assets (entire presentations or single slides). 

Presentations
If your selection contains presentations, decide on how to handle entire presen-
tations.
• Embed entire presentations – All slides of the presentations will be included 

in the new presentation.
• Embed first slide only – Only the first slide of a presentation will be included 

in the new presentation. 
• Ignore – Any selected presentations are ignored and will not be included in 

the new presentation.
Master and Layout 
Define master and layout for the slides included in the new presentation.
• Keep slides as they are (no changes) – Each slide selected to comprise the 

new presentation keeps its original master and layout. 
• Use from previous slide – Slides added will adopt master and layout from 

the last slide of the existing presentation. 
Example: If you are adding slides to enhance an existing presentation, the last 
slide of the existing presentation will determine Master and Layout of the 
slides added. 

• Use from other presentation – Enter the name or use the Browse button. If 
you want to use the same presentation master and layout as employed for 
slides created from images (Image Handling tab), the Same as Image Slide 
button makes this easy for you. It inserts the name of this presentation into 
the File field.
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Image Handling
Define how image assets are processed before they are placed on separate 
slides, where they are placed, how they are scaled, and the master and layout for 
the slide. 

Image Processing
Images can be processed before they are used for the presentation to be cre-
ated. The Cumulus Pixel Image Converter is employed for the preprocessing, so 
you can have a filter run, rotate and crop the image. If you activate the Perform 
Image Processing before insertion option and click the Parameters button, you 
can set the parameters available for preprocessing. (For details, see “Pixel Image 
Converter Parameters,” p. 79.)
Image Placement
Define the area where the images should be placed. The size of the area is 
defined by margins set corresponding to the slide size. The position of an image 
within this area is defined by anchor points. 

To define the area for the images on the slide, you determine the margins from 
the top, bottom, left and right edges of a slide. You can choose from different 
measurement units to determine the margins.
You can scale the images placed in the area up or down so that they fit within 
the area.
• Scale down larger images – The images that are larger than the area are 

made smaller. Proportions are constrained.
• Scale up smaller images – The images that are smaller than the area are 

enlarged. Proportions are constrained.
Master and Layout
Define master and layout for slides created from image assets.
• Use from previous slide – Image slides added will adopt master and layout 

from the last slide of the presentation. 
Example: If you selected Slide 1, Image 2, Slide 3, and Image 4 (in this sequence) to 
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comprise a new presentation and decided on the Keep slides as they are 
option for Master and Layout under Slide Handling, the slide for Image 2 will 
look like Slide 1 and the slide for Image 4 will look like Slide 3. 

• Use from other presentation – Enter the name or use the Browse button. If 
you want to use the same presentation master and layout as employed for 
the other slides (Slide Handling tab), the Same as Slides button makes this 
easy for you. It inserts the name of this presentation into the File field.

Creating Presentations in PowerPoint 97-2003 Format
The layout of a new presentation is determined by the first asset of the selection 
for the new presentation. If the first one is not a PowerPoint asset, the layout is 
determined by the standard layout of PowerPoint (depending on the settings of 
the PowerPoint installation).
To create a PowerPoint 97-2003 format presentation (*.ppt) from selected assets 
within Cumulus:

1. Put the records of the assets you want to include into the order you want 
them to appear in the new presentation. 

NOTE: Remember that the first asset of the selection determines the lay-
out. 

2. Select the assets to be included in the new presentation

3. Select Asset > Convert To. 

The Browse for Folder dialog opens for choosing a destination folder for the 
presentation asset(s). 

4. Select the folder and click Open / OK.

A dialog opens for choosing the converter. The dialog lists the Asset Proces-
sors available to you. Available to you for converting are the Asset Processors 
that are activated in the Asset Handling Set which is chosen for Asset Access 
in your User Settings. 

5. Select MS PowerPoint Asset Processor. The dialog for the parameters 
opens. (See “MS PowerPoint Asset Processor Parameters,” below, for details.)

6. Enter a file name for the new presentation.

NOTE: If you enter an existing presentation, the new slides will be 
appended to the existing presentation. 

7. Make your settings. For details, see “MS PowerPoint Asset Processor Parame-
ters,” p. 92.

8. Click OK. 
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MS PowerPoint  Asset Processor Parameters 
The MS PowerPoint  Asset Processor offers a range of parameters to be defined. 

Destination File
Enter the name for the presentation to be created.

NOTE: If you enter the name of an existing presentation, the Asset Processors 
will not replace an existing presentation. It will append the new slides to the 
existing presentation. However, if included in an Asset Action, it will not 
append slides as the Delivery module of the Action will save a new presenta-
tion (name of the existing one extended by a number.) 

Embedding PowerPoint Assets
Presentations – If your selection contains presentations, you can decide 
whether such presentations are to be included in the new presentation – either 
the entire asset or on the first slide. Activate the desired options. Remember: The 
layout of a new presentation is determined by the first asset of the selection for 
the new presentation. If the first one is not a PowerPoint asset, the layout is deter-
mined by the standard layout of PowerPoint (depending on the settings of the 
PowerPoint installation).

Image Asset Processing
The options for embedding or linking the images determine how the image is 
embedded in the presentation. 
• Embed images – Images will be saved with the presentation.
• Link images placed next to presentation – Images will be saved in separate 

files in the same folder where the presentation will be saved, and the images 
will be linked to the presentation only. 

• Link images, placed in folder next to presentation – Images will be saved in 
separate files in a subfolder of the folder where the presentation will be 
saved, and the images will be linked to the presentation only. 
– Folder name – Enter a name for the subfolder where the images should be 
saved – either an existing folder or a new one. Entering a new name will cre-
ate a new folder.
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NOTE: The options for embedding or linking images are disabled if the 
PowerPoint Asset Processor is used within an asset action. Embedding and 
linking will not work in this case. PowerPoint always uses the full path to linked 
/embeddes images, but the steps of an asset action are executed in a tempo-
rary folder which subsequently is deleted. This would lead to invalid file pahtes 
in the PowerPoint presentation.

The next step is to define the area where the images should be placed. The size 
of the area is defined by margins set corresponding to the slide size. To define 
the area for the images on the slide you determine the margins from the top, 
bottom, left and right edges of a slide. You can choose from different measure-
ment units to determine the margins. The position of an image within this area 
is defined by anchor points. 

You can scale the images placed in the area up or down so that they fit within 
the area.
• Scale down larger images – The images that are larger than the area are 

made smaller. Proportions are constrained.
• Scale up smaller images – The images that are smaller than the area are 

enlarged. Proportions are constrained.
• Image Preprocessing

Images can be processed before they are used for the presentation to be cre-
ated. The Cumulus Pixel Image Converter is employed for the preprocessing, 
so you can have a filter run, rotate and crop the image. If you activate the 
Image Processing option and click the Parameters button, you can set the 
parameters available for preprocessing. (For details, see “Pixel Image Con-
verter Parameters,” p. 79.)

Creating ZIP Archives
The ZIP AssetProcessor compresses assets into Zip archives. 
To compress cataloged assets into Zip archives:

1. Select the record(s) representing the asset(s) to be compressed.

2. Select Asset > Convert To menu command.

The Browse for Folder dialog opens for choosing a destination for the ZIP 
asset.

3. Select the folder and click Open / OK.

A dialog opens for choosing the converter. The dialog lists the Asset Proces-
sors available to you. Available to you for converting are the Asset Processors 
that are activated in the Asset Handling Set which is chosen for Asset Access 
in your User Settings. 

4. Select ZIP AssetProcessor as Asset Converter. 
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The ZIP AssetProcessor Parameter dialog opens. 

5. Select the parameters for the conversion:

• Under Archive Name you have to choose a name for your ZIP asset. The 
ZIP AssetProcessor will automatically add the extension ".zip" to the file 
name. On Mac OS this means that the name can be up to 27 characters in 
length without the extension.
NOTE: If you choose an existing ZIP asset as archive name, the ZIP 
AssetProcessor will update the already contained assets and append 
new assets. 

• Under Use Character Encoding you can define the character encoding 
used to save the file name(s) in the ZIP file. The default is your local system 
encoding – the encoding of the computer you are working with (this 
encoding would be used by WinZip and StuffIt also). The character encod-
ing chosen should account for the language and the operating system of 
the computer where the ZIP is to be unpacked. Find some common 
encoding recommendations listed below.
– Windows and West European languages: WinLatin1
– Windows and East European languages: WinLatin2
– Windows and 2 byte character encoding (e.g. Japanese): WinJapanese
– Mac OS X: UTF8
– Mac OS 9 and West European languages: MacRoman
– Mac OS 9 and 2 byte character encoding (e.g. Japanese): MacJapanese
– Mac OS 9 and Russian: MacRussian
– UNIX: Ask the person you will provide the ZIP archive with, which encod-
ing is needed.

• Under Macintosh Resource Support you can define how to support Mac-
intosh resources. 
– Activating the Store as MacBinary Format option determines the assets 
to be stored including the Mac OS resource fork, data fork and finder infor-
mation (e.g. File Type/Creator). This option should only be activated, if the 
file will definitely be extracted under Mac OS, as the MacBinary format 
often cannot be extracted properly under Windows or UNIX.
– Activating the Store as Mac OS X archive compatible option saves the 
files in the same structure as in an archive created with the Finder of Mac 
OS X (10.3 or later). 
NOTE: If you have activated the Macintosh Resource Support with 
the option Store as Mac OS X archive compatible, the character 
encoding is always UTF-8.

6. Click OK.

The selected asset(s) will be compressed and the ZIP asset stored in the selected 
destination.

 ZIP AssetProcessor Parameter dialog
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 WebAlbum
Cumulus WebAlbum enables Cumulus to output selected images’ records as a 
Web-ready album. This album is based on static HTML pages, complete with 
thumbnails, scaled versions of images and links to the original assets. You can use 
different skins for the layout and functionality of your album, such as those pro-
vided by Canto or other providers (e.g. by JAlbum), or those you develop your-
self. WebAlbum takes the selected records and converts their assets to files 
suitable for display on the Web. This includes the automatic creation of copies of 
the assets in the Web-ready JPEG image file format. You have full control of 
album design through the use of skins. WebAlbum will create thumbnails of your 
images and display them in index pages in HTML. WebAlbum can also produce 
slide shows of your images for easy navigation.
An album created with Cumulus WebAlbum can be uploaded on any common 
Web server (no special system requirements) and can be viewed with any stan-
dard Web browser. You can also use WebAlbum to create local albums on your 
hard disk or on CD-ROM. 
If you are looking for more features for your album uploaded on the Web than 
Cumulus WebAlbum provides (e.g. search functions, non-static pages, e-com-
merce), then have a look at the Cumulus Internet solutions that Canto provides. 
For details on all of Canto's Digital Asset Management products and services go 
to: www.canto.com

Creating an Album
When you create an album, WebAlbum uses the records you selected and:
• generates thumbnails in JPEG format (e.g. used for index pages) – always
• generates scaled images in JPEG format (e.g. used for slide pages) – if a cor-

responding option is activated
• copies the original assets to a defined output folder for the upload – if a cor-

responding option is activated
Furthermore WebAlbum generates:
• index page(s) – always
• slide pages – if a corresponding option is activated. Depending on the acti-

vated option, slides contain selected record fields’ information and scaled 
images or original assets.

NOTE: With this version of WebAlbum, do not employ WebAlbum if you are 
connected as Cumulus Administrator. 

To create an album:

1. Select the records of those images you want your album to consist of.

NOTE: You need the Transfer Assets permission for the catalogs that con-
tain the selected records. 

2. Select Asset > Create WebAlbum.

A dialog for configuring your album opens. Now you can either configure a 
new layout for your album or use a saved one by clicking the  (Open) 
button.

3. Configure the album.

Three sections provide access to the configuration options:
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The General Section

• Title: Enter a title for your album. Where this title is displayed depends on 
the selected skin.

• Output Location: Define the folder to hold the output of your configured 
album. This should be an empty folder when you start creating a new 
album.

• Output Options:
Make Slides – Enable this option, if you want your album to include slides 
(scaled images and contents of the selected record fields). If the selected 
skin supports these functions, next/previous buttons are provided to dis-
play the slides.
Upload via FTP – Enable this option if you want your album to be 
uploaded onto the Web directly after creation.
NOTE: This option can only be enabled if the settings on the FTP tab 
were tested and did not show any errors. 

• Link Options: Decide on one of the options (for further information on 
these options, see the section “Provided Skins and Link/Output Options”, 
below.)
Link to Originals – Clicking on a thumbnail will display the original asset. 
Link to Originals through Scaled Images – Clicking on a thumbnail will dis-
play the slide including the scaled image and clicking on this image will 
display the original.
NOTE: Albums that include links to the original are quite large in size. 

Link to Scaled Images Only – Clicking on a thumbnail will display the 
scaled image without any further link to the original.

• Image Size & Quality
Thumbnails – Select or enter the size for the thumbnails (left field) and 
select the compression quality (right field).
Images – Select or enter the size for the scaled images (left field) and select 
the compression quality (right field).
NOTE: Images will maintain aspect ratio and constrain their propor-
tions. 

• Page Layout (valid only if the skin interprets these values)
Columns – Enter the number of columns for the index page(s).
Rows – Enter the number of rows for the index page(s).
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• Image Order: Select the record field you want used for alphabetical sorting 
of the thumbnails.
Reverse Sorting Order – If this options is enabled the sorting order is Z to A 
or 9 to 0

• Skin
Name – Select the skin you want to use for this album. The selected skin 
defines the overall appearance of your album: layout and functionality.
Style – Select a style (e.g. color theme and look) for the above selected skin.
Automatically load Skin Settings – Enable this option, if you want the 
selected skin’s layout hints to be loaded automatically (valid only if there 
are any hints provided with the selected skin).

The Fields Section

Use the Add button to add the fields of the contents you want to include 
with the slides.
Use the arrow buttons to place the fields in order.

The FTP Section

• FTP Settings 
FTP Server – Enter the name of the FTP server you want to upload the 
album to. 
Port – If it is not the standard FTP port number 21, enter the required port 

An empty Fields tab. No record field information 
will be included in the album

A Fields tab with EXIF fields added. These fields’ infor-
mation will be included in the album – depending on 
the skin used.
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number of the FTP server you want to upload the album to.
User Name – Enter the user name of the FTP account. 
Password – Enter the password of the FTP account. 
Path – Enter the directory on the FTP server you want to upload the album 
to. Enter at least a slash (/) but be aware that an existing index.html will be 
overwritten.
Passive Mode – Enable this option if you expect any trouble when con-
necting through a firewall. 
Overwrite Existing Files – If this option is enabled, existing files will be 
overwritten when uploading a new album. If not enabled, existing files will 
not be overwritten with the new version.

To test your FTP settings you can click the Test Settings button. Only in 
cases where the settings do not include any errors, you can enable the 
Upload via FTP option on the General tab.

4. Click Start to create your album. 

If you have changed any setting of the album layout or if it is a new album 
layout, you are asked whether you want to save your changes. If it is a new 
album layout you want to save, you are asked to enter a name for it.

If the folder you defined under Output Location contains any files, you are 
asked whether this folder should be cleared. We recommend selecting Yes. 
If you select Yes, all files and subfolders in the output folder will be deleted 
before the new output files are created. If you select No, HTML files with the 
same names as the newly created ones will be overwritten and new copies 
of the assets will be added. If you select Cancel, the creation of your new 
album will be canceled.

The output files of your album are created in the folder you defined under 
Output Location. Start the index.html page in that folder to see (and test) 
your album.

You can save your album layout configuration by clicking the  (Save) button. If 
you want to save it under another name, click the (Save As) button. 

NOTE: You may select records of any file formats to create an album – not 
only images. However, in this case you should not include slides but use links 
that point directly to the originals. 

Provided Skins and Link/Output Options
The album design is controlled by skins. Canto provides different skins for 
Cumulus WebAlbum. The skin named “Canto” supports the following output 
depending on the selected link and output options:

~~~
~~~
~~~
~~~

Index page with thumbnail 
overview

Slide page with field information 
and scaled image

Original asset 

Link Option “Link to Originals through Scaled Images” (Output Option “Make Slides” ignored)
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Preferences
Within the Preferences dialog of your Cumulus application, you can define the 
startup settings for WebAlbum. WebAlbum can either be started with a new and 
empty album layout or with the last album layout you used.
To set WebAlbum to open the last album layout used when starting:

1. Select Cumulus / Edit > Preferences. The Preferences dialog window 
opens. 

2. Select User Settings and click WebAlbum on the General tab.

3. Enable the checkbox.

4. Click Apply to save your changes and select the next preference you want to 
edit.

~~~
~~~
~~~
~~~

Index page with thumbnail overview Slide page with field information and original asset

Link Option “Link to Originals” (Output Option “Make Slides” activated)

Index page with thumbnail overview Original asset 

Link Option “Link to Originals” (Output Option “Make Slides” not acti-

~~~
~~~
~~~
~~~

Index page with thumbnail overview Slide page with field information and scaled image

Link Option: “Link to Scaled Images Only” (Output Option “Make Slides” activated)

Index page with thumbnail overview Scaled image

Link Option “Link to Scaled Images Only” (Output Option “Make Slides” not activated)
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OR 
Click OK to save your changes and close the Preferences window.

Customize
You can easily customize your album by using different skins. You can either 
develop your own skins or use skins created by other providers. Check Canto’s 
website (Products & Services > EJaPs > EJaP Exchange Forum) from time to time 
to see if new skins have been developed that you could use.
A skin consists of a folder that contains subfolders for images included in the skin 
itself (the res folder) and cascading style sheets (the styles folder) as well as files 
that define special pages, e.g. the index pages and the slide pages. The About 
text file will inform you if the skin contains any extraordinary functions or defini-
tions.
The skins provided with Canto can be found in the skins folder inside the web-
album folder. The webalbum folder is located in the ejp folder in your Canto 
installation folder.

It is easy to customize the fonts (type, size and color) and the background colors 
of a skin by editing the cascading style sheet (.css). If you want to develop your 
own skins, you have to know how to do it on your own. Canto cannot give you 
any support for developing skins. 

TIP: Cumulus WebAlbum and JAlbum
You may use JAlbum skins with Cumulus WebAlbum. If you want to 
use JAlbum skins, you have to replace </ja: and <ja: with </wa: and 
<wa: in the index.htt and slide.htt files. Then test the skin. The follow-
ing skins seem to work with Cumulus WebAlbum: Mamba, Film, XP, 
and CameraGeek. 
You may look at the JAlbum skin repository site, the site that is 
intended to act as a central area where makers of skins for JAlbum can 
share their skins with others: http://jrepository.engblom.org 
However, note that Cumulus WebAlbum does not support all JAlbum 
skin possibilities. 

Configuring Web URL
If your Cumulus installation includes Cumulus Web Client or Sites, records – and 
potentially thumbnails, previews and assets – can be accessed via Web Links 
(URLs). For this purpose, Cumulus provides different kinds of URLs that can be 
sent via e-mail, or embedded in web pages, and that can be opened in any web 
browser, of course. 

NOTE: The Web Link feature only works if at least one Base URL has been 
defined by your Cumulus Administrator in the Cumulus Server Settings, if the 
respective catalog is marked to be published on the internet, and if the catalog 
contains specific fields for thumbnail, preview, and asset URLs. 
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Cumulus provides the following kinds of URLs 
• Record URL for Display in Web Clients – opens Cumulus Web Client or Sites 

displaying the selected record only
• Thumbnail URL – links to the thumbnail of the respective asset
• Preview URL – links to a preview of the respective asset
• Asset URL – links to the respective asset
While record URLs are always available, thumbnail, preview and asset URLs can 
be enabled / disabled (switched on and off) independently for every record.
To switch web URLs on and off:

1. Mark the record(s) for which you want to configure web links.

2. Select Asset > Configure Web URL. 

3. The Configure Web URL window is displayed. 

4. For each record, activate the check boxes for the URLs you want to enable, or 
deactivate the check boxes for the URLs you want to disable, respectively.

5. Confirm your settings with Apply. The URLs are enabled (or disabled, respec-
tively); the window remains open for further actions.

OR

Confirm your settings with OK. The URLs are enabled (or disabled, respec-
tively); the window is closed.

To copy or open an URL:

1. Mark the record(s) for which you want to copy or open an URL.

Select Asset > Configure Web URL. 

2. The Configure Web URL window is displayed.

3. If your Cumulus Administrator has defined more than one Base URL, check 
the Base URL list to make sure that the appropriate Base URL is selected.

4. From the URL Kind list, select the URL kind you want to copy or open.

5. Click Copy URLs to copy the corresponding URL(s) to the clipboard.
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6. Click Open URL to open the corresponding URL for a selected record in your 
Web browser (Open URL is disabled, if more than one record is selected in 
the Configure Web URL window!).

TIP: 
If Web URLs must be configured for lots of records, e.g. for whole cat-
alogs, it is more convenient to use a Metadata Template. 

Importing and Exporting
Cumulus can export and import records, categories and collections. Collections 
can only be imported and exported in Cumulus exchange file formats whereas 
records and categories can also be exported to and imported from XML files. 
Exported catalog metadata in XML files can be used by other programs as well 
as on other platforms. Paired with the metadata import options Cumulus offers, 
you have a complete metadata “round-tripping” solution to make integrations 
with your other systems easy.

Cumulus supports XSL Transformations (XSLT). XSLT is a programming language 
for transforming XML documents into other XML documents. XSLT was 
designed to be used with XSL, which is a stylesheet language for XML. With the 
Cumulus export function XSLT can be used for example to place images and 
metadata in InDesign documents.
Importing and exporting data with Cumulus is easy, but there are a few things to 
be aware of in order to avoid unexpected results, which are explained below.

Cumulus Exchange File Formats
XML is the recommened export format. But for special purposes Cumulus can 
also export and import records, categories and collections in special Cumulus 
exchange file formats. These files can be used on any supported Cumulus plat-
form. But note that records and categories do not support the Cumulus 8 Table 
fields. Canto recommends you use these formats only for special purposes con-
cerning Cumulus versions prior to 8. The Cumulus exchange file formats are:
• Categories – Cumulus exports categories in a Cumulus Category Exchange 

File. The file name extension is .cce

For exporting metadata from Cumulus into XML files 
select all or some asset records, and even choose the meta-
data fields you want included in the export file.
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• Records – Cumulus exports records in a Cumulus Record Exchange File. The 
file name extension is .cre

• Collections – Cumulus exports collections in a Cumulus Collection Exchange 
File. The file name extension is .cfe

Exporting data in this format can be used for transferring data between catalogs 
for archiving category listings. These archive files can be imported into any other 
catalog when you need them. (You could do the same thing with records, but it’s 
probably more convenient just to keep copies of the records in catalogs.) 

Character Encoding for Export
When exporting information in Cumulus exchange file formats, you can employ 
different character encoding. You should base your decision on how the 
exported file is to be used. Universal Encoding (UTF-8: Unicode characters coded 
as 8-Bit Transformation Form) makes sure that special characters are transferred 
correctly across platforms. Choose this format only if you want to use the 
exported file on another operating system.

Maintaining Category Assignments
The most important thing to know when you are exporting records to be 
imported into another catalog, is whether the new catalog already has the cate-
gories to which the records are assigned. If it does not, the categories assigned 
to the imported records will be created. But categories of the type “Folder” lose 
their type (assignment to the Source tab). They are created as normal categories. 
If you want to keep the type of these categories, you must first export and import 
the categories. 
Remember that it may be easier just to drag and drop records from one catalog 
to another, if both the source and destination catalogs are available to you. If they 
are not, or you are moving thousands of records at a time, then the export/
import route is the way to go.

Exporting and Importing Records and Categories 
The exporting and importing process is pretty much the same, regardless of the 
data type. Exporting goes like this:

1. Find and select the items you wish to export. (See “Searching,” p. 44, if 
needed, for a refresher on how to find records.)

2. Select File > Export and then the appropriate export option:

• Selected Records – Exports the currently selected records. (This menu 
item is disabled if no records are selected.)

• All Records – Exports all records of the active collection. If you want to 
export all records of the catalog(s) included in the collection, you have to 
perform Find > Find All Records first.

• Selected Categories – Exports the currently selected categories in the 
active collection. (This menu item is disabled if no categories are selected.)

• All Categories – Exports all categories of the Category pane. 
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3. Select the export format. Note that the XML format is recommended for 
most purposes. This format enables Cumulus to export from multiple cata-
logs and supports data from Cumulus Table fields.

• When exporting records into an XML file, a check box offers the option to 
have the export file compressed (*.zxml) . Another check box offers to 
enable XSL transformation by applying an XSLT stylesheet which describes 
the rules for the transformation.

• When exporting selected categories, a check box offers the option to 
export the subcategories as well. 

4. Click the  button for browsing for the location where the export file 
should be saved. 

5. Select the location, name the export file and click Save. Note that Cumulus 
will add the correct file extension.
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6. Click Next. If you are exporting into XML, you can select the fields that con-
tain the values to be included in the export file.

7. Make your selections and click Start. Messages inform you of the export pro-
cess. 

8. When you get the message that the process is finished, click Finish to close 
the dialog.

Importing is just as easy:

1. Select File > Import.

2. If you have multiple catalogs open in one window, select the catalog to 
which you want to import the data.

3. Click the  button for browsing to the location where the file to be 
imported resides. 

4. Select the file and click OK. 

5. Select the appropriate file format. Note that the XML format will also work for 
zipped XML files (*.zxml).

If your Cumulus configuration supports Permissions Templates, you can 
select one to be applied to the imported records/categories.

NOTE: Importing Categories
If a category in the import file has the same name as an existing category 
at the same hierarchy level, the category is not imported.

6. Click Next to start the import. Messages inform you of the import process. 

7. When you get the message that the process is complete, click Finish to 
close the dialog.
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Importing and Exporting Collections 
Collections stored with previous Cumulus versions on the computer running the 
Client application can be imported (File > Import  > Collections.) To store collec-
tions at any location other than the Cumulus Server, you can use the export func-
tion (File > Export  > Collections.) 
For sending a collection via email to another user, a special export function is 
provided (File > Export  > Mail Collection To.) With Cumulus 6.x this function 
was provided under Collection > Mail To. However, don’t forget: Since a collection 
is always connected to catalog(s), it is necessary for the recipient to have access to 
the catalog(s) ‘serving’ the collection.
To make use of a collection you received, you use the import function. 

IMPORTANT! If the your Connect to Server dialog, any collection you export or mail 
contains your login information. Opening such an exported or mailed collection will 
connect to the Cumulus Server with your login and password. This means that the 
user who opens the collection works as you and has your permissions. If this option is 
not activated, the Connect to Server dialog will appear when an exported or mailed 
collection is opened.

Importing from Text/CSV Files 
The Cumulus Importer utility enables the import of metadata from other data-
base systems into Cumulus catalogs. The metadata can be imported from text 
files (separated by delimiters.) You can assign the information to Cumulus fields. 
The data can be imported into record or category fields, into string list fields as 
values, or into the category tree, which enables the Importer to create hierarchi-
cal categories. The configuration for an import process can be saved as an Import 
Configuration Set. 
There are different types of import destinations available with the Cumulus 
Importer:
• Import of Categories into the Category Tree 

You can import data from an import file as categories to a Cumulus catalog. 
You specify the field of the import file which data is to be imported as cate-
gories. And you specify the hierarchy level where they shall be inserted.

• Import of Metadata into Record Fields
You can import data from an import file into record fields of a Cumulus cata-
log. You define relations between a record field and a field of the import file. 
Furthermore, you can create new records (records that are not related to 
assets) for entries in the import file that do not correspond to already existing 
records in the current catalog.

• Import of Metadata into Category Fields (Enterprise only)
You can import data from an import file into category fields of a Cumulus cat-
alog. You define relations between a category field and the field of the import 
file. The procedure is identical to the procedure necessary when importing 
information into record fields. Furthermore, you can create new categories 
for entries in the import file that do not correspond to already existing cate-
gories in the current catalog.

• Import of Values to String List Fields
You can import data from an import file as values into the properties of a 
string list field. The values can be imported to any category or record field of 
the type String List. It is not necessary that the newly created list entries are 
assigned to records. 
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Delimiters 
A lot of database systems use the tabulator as the field delimiter (even Cumulus 
while exporting data from a catalog). If your import text file uses another character 
as field separator, you can choose or enter another delimiter. Also, the delimiter 
for category levels can be set to any character.

Definition of Additional Information
For the import you can define additional information that is imported prior to the 
text that comes from the import file. The additional information may increase the 
readability of information in a field

EXAMPLE: Additional Text
If you import a lot of different data into the same text field, it might be 
helpful to define additional text that is imported prior to the informa-
tion from the import file. For example, if you want to import the price 
of a product into the notes field and your import file contains the fig-
ures only, you can define additional information like Price Euro: that is 
added to the text before importing it into the Cumulus catalog. After 
the import the notes field looks like this: Price Euro: 99

Running an Import Process from a Text File
IMPORTANT! Before you start importing information into a Cumulus catalog using 
the Cumulus Importer utility, you should make a safety copy. Make sure a current 
safety copy of the catalog exists before you go ahead and change the metadata in the 
catalog. There is no UNDO function for the import available. You can only go back to 
the initial version of the catalog if there is safety copy available that you can open 
instead of the changed catalog. 

To set up an Import Configuration Set and run an import process:

1. Open the Cumulus catalog, to which you want to import the information.

2. Select File > Import > From Text/CSV File. This opens a dialog that leads 
you through the steps required.

3. Choose whether you want to create a new set or load an existing one. 
To select an existing one, open the list with the arrow down button. This lists 
all sets that are available for you.

4. Click Next.

5. If you decided to load an existing set, go on reading with step 7.

If you are creating a new set, a dialog opens to choose the type of import 
destination – where you want to put the data. 
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For information on the different types see above.

6. Select the destination and click Next. 

This dialog lets you select the file you want to import from, choose the 
appropriate delimiter and the encoding of the import file.

7. Determine the import file, the delimiter its data contains and its encoding. 
You can see how the text is affected in the Data Preview below. 

• File
Choose the file you want to import the data from. Use the  button to 
browse for the file.

• Delimiter 
A lot of database systems use the tabulator as the field delimiter (even 
Cumulus while exporting data from a catalog). If your import file uses 
another character as separator, you can choose or enter another delimiter. 

• Character Encoding
Select the character encoding of the import file.

• Import Field Indentifier
Lists the field indentifiers from the chosen import file as interpreted using 
the defined delimiter.

• Import Field Value
Displays what the values of a field will look like. Use the arrow buttons to 
page through the data. 

8. If this is how you want to import the data, click Next.
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The next steps depend on the selected destination type.

See below for further information. In any case you, have to add entries for 
the fields to be imported. Use the Add button to do so. Use the Remove 
button to remove entries for fields.

If no more configurations are required, a Start button is displayed.

NOTE: Now you can save your Import Configuration set for the data 
import in an import scheme file by clicking the Save as button. This set 
holds information about the field assignments, the name of the import 
file and the appropriate delimiters. 

9. Click Start. The data will be imported.

Import to Category Tree
If you want to import data as categories to the Category Tree of a Cumulus cata-
log, you must specify the import field which holds the data to be imported as cat-
egories and the hierarchy level where you want the categories to be inserted. 

• Delimiter for Category Hierarchy 
What delimiter separates your category levels? By default, Cumulus uses a 
colon as separator for indicating the levels in the category hierarchy. If your 
import file uses a different character, enter the appropriate delimiter. 

• Skip First Line
Often the first line of the import file does not contain information that you 
want to import. You can disable the import of the data of the first line by acti-
vating the Skip First Line option.

• Import Field Pattern Preview
Displays how the data will be imported.

The different destinations for importing data require different specifications. However, 
the specifications are similar and so are the dialogs. 
Each line in the list of the different dialogs represents the specifications which field’s data 
will be imported and how it will be imported. 
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• Parent Category
Displays the category to which the data from the import field will go as sub-
categories. See below on how to define the parent categories.

• Import Field Pattern 
Lists the fields from which the values should be imported as categories. You 
can insert additional information by clicking in the field’s entry in this column.
If you want to import data from more than one field, use a right/alternate 
mouse click in a field’s entry in this column to get a list for selecting additional 
fields.

To add field entries, click the Add button. This displays a dialog that lets you: 
• Determine a parent category. You can import the categories as subcatego-

ries of a specific category. Determine this category either by entering the cat-
egory hierarchy data for the parent category or by using the currently 
selected category in the category pane. When entering the category hierar-
chy data you must use the displayed delimiter. 

• Select the field that contains the values to be imported as categories.

The Import Field Value column displays how the data will be imported. Use the 
arrow buttons to page through the data.
To have your selected field added to the selection of Import Fields, click OK. This 
brings you back to the main dialog. 

Import to Records/Categories
If you want to import data into a record field of the Cumulus catalog, you have 
to define a relation between the import text file and the Cumulus catalog by 
specifying one or more relations. In most cases, it will be the Asset Name to 
determine the record and in addition to that multiple relations that determine 
from which import field the data should be imported to which Cumulus field.) 

NOTE: You can assign fields of the import file to the Cumulus record field Cat-
egories. Then the affected Cumulus records will be assigned to these catego-
ries.

If you want to import information into category fields of the Cumulus catalog, 
you have to define a relation between a category field and the field of the import 
file. The procedure is identical to the procedure necessary when importing infor-
mation into record fields.

Dialog for selecting fields that contain metadata 
for the import into the category tree.
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• Skip First Line
Often the first line of the import file does not contain information that you 
want to import (e.g., column titles). You can disable the import of the data of 
the first line by activating the Skip First Line option.

• Create new records/categories for lines that do not correspond to existing 
records/categories.
Activating this option initiates the creation of a new record (without a related 
asset) or a new category for each line in the import file that does not corre-
spond to an already existing record/category.

• Import Field Pattern Preview
Displays how the data will be imported.

• Import Field Pattern 
Lists the fields from which the values should be imported. You can insert 
additional information by clicking in the field’s entry in this column.
If you want to import data from more than one field, use a right/alternate 
mouse click in the field’s entry in this column to get a list for selecting addi-
tional fields.

• Relation
If you want to import data into a record or category field of the Cumulus cat-
alog, you have to specify relations between the field of the import file and the 
Cumulus field. 
Two different relation types can be specified
= (equals) – The Cumulus Importer will only import the data if the value of 
the Cumulus field is equal to the value of the Import Field. This relation type 
is used to perform the search for the appropriate records.
-> (insert) – The Cumulus Importer will import the data of the Import field 
specified in the left hand column to the Cumulus field specified in the right 
hand column. 
NOTE: If you import data without identifying corresponding records by a 
= (equals) relation, the Cumulus Importer utility will create new records 
that are not assigned to any assets. You may do so if, for example, you 
want to import metadata for assets that are not cataloged yet. The corre-
sponding assets may be assigned to the records later. 

• Cumulus Field
Lists the Cumulus Fields into which the data of the import field shall be 
imported. As soon as a new Import Field entry is added, the field’s entry in this 
column is filled with the first field of the list of available Cumulus Fields 
(record or category field – depending on the destination type you have cho-
sen for the Import Configuration set.) Click in the field’s entry in this column 
to select the desired Cumulus Field.
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• Fill Mode
Displays how the field will be filled. For String fields, you can define whether 
you want the imported values to replace the existing value or to be added to 
the existing text (before or after.) Click in the field’s entry in this column to 
select the desired mode

Only if you are importing data to the Categories field of records (to assign records 
to categories), you must determine the delimiter that is used to separate the cat-
egory levels. 
To add field entries, click the Add button. This displays a dialog that lets you 
select the field that contains the metadata to be imported.

The Import Field Value column displays how the data will be imported. Use the 
arrow buttons to page through the data.
To have your selected field added to the selection of Import Fields, click OK. This 
brings you back to the main dialog. 

Import to String List Fields
If you want to import data as values of a String List field of the Cumulus catalog, 
you have to specify the assignments between the import fields and the Cumulus 
String List fields.

• Skip First Line
Often the first line of the import file does not contain information that you 
want to import. You can disable the import of the data of the first line by acti-
vating the Skip First Line option.

• Import Field Pattern Preview
Displays how the data will be imported.

Dialog for selecting the field that contains the meta-
data for the import into record or category fields.
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• Import Field Pattern 
Lists the fields from which the values should be imported. You can insert 
additional information by clicking in a field’s entry in this column.
If you want to import data from more than one field, use a right/alternate 
mouse click in a field’s entry in this column to get a list for selecting additional 
fields.

• Cumulus Field
Lists the Cumulus Fields into which the data of the import field shall be 
imported. As soon as a new Import Field entry is added, the field’s entry in this 
column is filled with the first field of the list of available Cumulus Fields. Click 
in the field’s entry in this column to select the desired Cumulus Field.

To add field entries, click the Add button. This displays a dialog that lets you 
select a field that contains the values to be imported.

The Import Field Value column displays how the data will be imported. Use the 
arrow buttons to page through the data.
To have your selected field added to the selection of Import Fields, click OK. This 
brings you back to the main dialog. 

Workflow Enhancements
Cumulus provides several possibilities to enhance your workflow. The next sec-
tion describes how to use color labels and star ratings to quickly organize, sort, 
and filter your files. For a description on how to use the work-in-progress man-
agement feature user comments in Preview view or window, see “User Com-
ments,” p. 70. 

Labeling 
The record field type Label enables users to label records by assigning colors. 
Each Cumulus catalog provides a standard Label field but the user can add more 
fields of this type. For any field of this type the user can define a color range. The 

Dialog for selecting the field that contains the meta-
data for the import of values into String List fields
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Label Editor tab of this field type’s properties window lets you determine the 
label colors. Additional colors can be defined by a color picker value. 

Label fields can be displayed in all views. For certain views you can select the col-
ors of a specific label field to be the background of the entire record or of the 
record’s name. 

Of course a label field itself can also be included in a view. To set up views that 
display labeling: Cumulus / Edit >  Preferences  > Record View Sets.
The labeling color for a record can be set in the Information window via list selec-
tion or by a menu item via the Asset menu. 
The menu item Assign Label will be available only if the effects of assigning the 
label can be immediately seen by the user. This means that it is available only if 
at least one label field is included in the catalog AND if at least one label field is 
included in the current view or set as background for records (entire record or 
record name) in the current view.

The menu item will assign the label set as background of the current view. If no 
label is set as background or for views where a label cannot be set as back-
ground, the menu item will assign the label from the first field of type Label from 

The Label Editor tab of the Field Proper-
ties window in the Catalog Settings.

View settings for labels

Label set background of the entire record 
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Metada
the current view. (The order refers to the field list of the view settings in the Pref-
erences dialog.) 

In the Information window, the field will be displayed as a drop-down list. The 
current color is displayed and the available colors are included in the hidden list. 
To select a color, open the list and select the desired label color. To remove a 
label, open the list and select the no value entry.
When printing labeled records, the label marks are printed as displayed (if the 
Label field is included in the fields to be printed.)

NOTE: Multiple Labeling Systems!
Each catalog can have its individual labeling system. However, be careful 
using multiple labeling systems. If you work with several catalogs in one col-
lection, you might not like to have different colors caused by individual label-
ing systems for the different catalogs. Label fields with the same name 
included in multiple catalogs but with their colors defined differently might 
cause confusion. The records will always show the label colors set for the cat-
alog they derive from. But if you have multiple records selected that come from 
different catalogs with different labeling systems the Assign Label menu item 
is of course disabled. 

You can search for labeled records and save such searches as search queries.

NOTE: Changing Label Color
Each label's value is defined by the label color. So, if you change a label color, 
make sure any saved queries that refer to the label are updated to use the new 
color value. 

Rating Assets
The rating system enables you (and your co-workers) to rate assets from 1 to 5. 
Rating values are searchable, so when you want to find your best assets, it's easy 
to do so. Each Cumulus catalog provides a standard Rating field (field name and 
type: Rating) but more fields of this type can be added. For example you can have 
one separate field for each member of your team. 
Ratings are displayed by star icons. A rating field can be displayed in Details View, 
Thumbnail View, Info View and in the Information window. The rating value for a 
record can be set in the Information window via clicking or by a menu item via 
the Metadata menu. The menu item employs the first field of type Rating from 
the current view. (The order refers to the field list of the view settings in the Pref-
erences dialog.)
In the Information window, clicking on a star in the rating row sets the rating 
value immediately to the selected value. Clicking close left of the first star 
removes the value. 

Label field included in view.

ta menu: rating options
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When printing rated records, the rating marks are printed as displayed (if the Rat-
ing field is included in the fields to be printed). 

Records with ratings and labels
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Workflow Automation with Cumulus
Cumulus provides various workflow support functions. Many of them are based 
on Action types. Workflow can be automated by:
• Event-based actions: Cumulus Trigger Actions
• Time-based actions: Cumulus Scheduler Actions
• User-defined actions: Cumulus Asset Actions 

(introduced with Cumulus 6 and then simply called: Cumulus Actions)

Trigger
A Trigger is a stored procedure that is activated automatically when a specified 
event occurs. Typically, there are three event types that activate Triggers: delete, 
insert or update. (Explained below.) Triggers can be used to perform many tasks, 
such as auditing catalogs, records and categories. Cumulus Triggers complement 
the capabilities of the Cumulus Scheduler. The Scheduler might cause an event 
that activates a Cumulus Trigger. 
Triggers can be set for catalogs, records and categories. Cumulus Triggers are 
defined by:
• Events — The event that will activate the Trigger.
• Trigger Actions — The function that will be performed when the Trigger is 

activated.
Trigger events for a catalog can be events that affect the catalog itself (updated 
Catalog Settings), or events that affect all records or all categories of the catalog. 
Event types that can be chosen for all records or all categories of a catalog are:
• Item Deleted — A record or category of the catalog was deleted.
• Item Inserted — A record was added or a category created.
• Item Updated — The value of a record or category field has changed. 

(Whether this refers to any field or to a specific field can be chosen as well. So 
the change of the value of a specified record or category field can activate a 
trigger.)

Similar event types can be chosen for selected records or categories. Event types 
set for a selected category or record are:
• Item Deleted — The selected record or category was deleted.
• Item Updated — The value of a record or category field has changed. 

(Whether this refers to any field or to a specific field can be chosen as well. 
This means that the change of a value of a specified record or category field 
of a specified record or category field can activate a trigger.)

The Trigger Actions available depend on the Cumulus Server you are connected 
to. Available actions are stored in a special folder. The following preconfigured 
trigger actions are included in:
• Apply Metadata Template: a specified metadata template is applied when 

the action is triggered by any event
• Apply Permissions Template: a specified permission template is applied 

when the action is triggered by any event
• Mail Notifier: with which an e-mail is sent to one or more specified recipients 

when the action is triggered by any event. 
• Rename Asset: the asset is renamed when the action is triggered by any 

event.
• Run Asset Action: a specified asset action is performed when the action is 

triggered by any event.
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BACKGROUND INFORMATION:  More Trigger Actions 
The Trigger Actions are based on modules which are implemented as 
ESPs. If you want to have more Trigger Actions available, check if 
Canto’s partners offer them or contact CDP support on how to 
develop an ESP that ’shows up’ as a Trigger Action.

PRECONDITIONS: Triggers can be created or edited only by users who are 
allowed to do so. To edit or create triggers, the user needs – depending on the 
kind of trigger – one or all of the following permissions:
• Manage Catalog Triggers 
• Manage Record Triggers 
• Manage Category Triggers 
These permissions are set for the user in the User Manager (Permissions > Appli-
cation Permissions.) With Enterprise, these permissions can also be set as Record 
or Category permissions for selected records or categories. Remember that 
Record or Category permissions for selected records or categories expand the 
record or category permissions a user has for the catalog in general.
The Trigger Administrator permission (set under Permissions > Administrator 
Permissions) allows a user to manage all triggers for a catalog. A user with this 
permission gets an additional option displayed when she/he opens the Proper-
ties dialog for a record, category or catalog. This option is called Show All Trig-
gers. If this option is enabled, all triggers are displayed to the user as well as an 
additional column displaying the name of the user who ‘owns’ the trigger (The 
user who created it.)

Setting Up Triggers for Records and Categories
To set up triggers for selected records/categories:

1. Select one or more records/categories.

2. Open the context menu for these records/categories (with the right 
mouse button /  Control key + mouse) and select Properties. The Proper-
ties dialog window opens.

3. Click the Triggers tab. 

The Triggers tab displays the triggers you have set up.

NOTE: Show All Triggers
If you have the Trigger Administrator permissions, the Show All Trig-
gers option is available to you. If this option is enabled, the Triggers tab 
displays all triggers defined for the catalog where the record/category 
resides. 
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4. Click Add. Add Trigger dialog appears. It lists the available event types. 

5. Select the type of event that activates the trigger. 

6. The next steps depend on the selected type of event. 

• If you select Item deleted, the trigger is activated when the selected record 
or category is deleted. Click Next. As this event type cannot be configured, 
this opens a dialog for selecting the action that is to follow the event.

• If you select Field Value Changed, the trigger is activated when the value 
of a field of the selected record or category has changed. To define this 
field, click Next. This opens a dialog that allows you to selecting a specific 
field. 
– If you want changes in any field to activate the trigger, click Next. 

– If you want only a certain field to activate the Trigger, activate the Wait 
for changes in a specific field option. This lets you select a specific field.

Select the field.
NOTE: Triggers can be based on specific field values. Then the Trigger 
will react when the field value is changed to a predefined value. To 
make use of this feature and define such a value, activate the option 
Wait for Specific Condition and then click Configure. This opens a 
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dialog that lets you define the value which you want the Trigger to 
react to.  

Set up your condition and click OK to save the condition. 
Click Next. This opens a dialog for selecting the Trigger Action. 

7. Select the action you want performed when the event for this trigger 
occurs.

8. The next steps depend on the selected Trigger Action. 

• If the selected action can be configured, click Next. This opens a dialog in 
which you can configure the action. Configure the action. (For details on 
how to configure the Mail Notifier action, see “Configuring Trigger 
Actions,” p. 123.)

• If no more configurations are required, a Close button is displayed.
9. Click Close. The Trigger is registered with your Cumulus installation and 

activated.

Setting Up Triggers for Catalogs
To set up triggers for a catalog:

1. In the category pane select the category that represents the catalog. (TIP: 
Categories that represent catalogs are displayed in bold.)

2. Open the context menu for these records/categories (with the right 
mouse button /  Control key + mouse) and select Properties. The Proper-
ties dialog window opens.

3. Click the Triggers tab. 

The conditions that can be set up for Triggers based on specific field 
values depend on the field types.
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The Triggers tab displays the triggers you have set up.

NOTE: Show All Triggers
If you have the Trigger Administrator permissions, the Show All Trig-
gers option is available for you. If this option is enabled, the Triggers tab 
displays all triggers defined for the catalog. 

4. Click Add. The Add Trigger dialog opens and prompts you to select the 
source for events to be selected. 

5. Select the source. The options are events performed on the catalog itself 
(updated Catalog Settings), or events on all records or all categories of the 
catalog (inserted, deleted or updated record/category). 

6. The Add Trigger dialog lists the event types available for the selection in the 
previous step and prompts you to choose one.

7. Select the event type.

8. The next steps depend on the selected type of event. 

• Item deleted activates the Trigger when a record or category is deleted 
from the catalog. Click Next. As this event type cannot be configured, this 
opens a dialog for selecting the action that is to follow the event.

• Item added activates the Trigger when a record or category was added to 
the catalog. Click Next. As this event type cannot be configured, this opens 
a dialog for selecting the action that is to follow the event.

• Field Value Changed activates the Trigger when the value of a field of the 
selected record or category has changed. To define this field click Next. 
This opens a dialog that allows you to select a specific field. 
– Select the In Any Field option if you want changes in any field to activate 
the Trigger. Then click Next. 
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– Select the In Specific Field option if you want only changes in a specific 
field to activate the Trigger. This lets you select a specific field.

Select the field. 
NOTE: Triggers can be based on specific field values. Then the Trigger 
will react when the field value is changed to a predefined value. To 
make use of this feature and define such a value, activate the option 
Wait for Specific Condition and then click Configure. This opens a 
dialog that lets you define the value which you want the Trigger to 
react to.  

Set up your condition and click OK to save the condition. 
Click Next. This opens a dialog for selecting the Trigger Action – the action 
that is to follow the event. 

9. Select the action you want performed when the event for this Trigger 
occurs.

10. The next steps depend on the selected action. 

• If the selected action can be configured, click Next. This opens a dialog in 
which you can configure the action. Configure the action. (For details on 
how to configure the Mail Notifier action, see “Configuring Trigger 
Actions,” p. 123.)

• If no more configurations are required, a Close button is displayed.
11. Click Close. The trigger is registered with your Cumulus installation and acti-

vated.

The conditions that can be set up for Triggers based on specific field 
values depend on the field types.
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Configuring Trigger Actions
The Trigger Actions available depend on the Cumulus Server you are connected 
to. An action available by default is Mail Notifier which will send you an e-mail 
when the action is triggered. If you select the Mail Notifier as Trigger Action 
when setting up a trigger, the following configuration dialog is displayed:

You can select the language of the message sent (the text is included in the Mail 
Notifier ESP.) If you have the Browse for Users permission, you can determine 
whether other Cumulus users get an e-mail as well. If you want other users to get 
e-mails, click the Add User button to select them. 

You can search for the login names of available users. Enter the search value (a 
matching string) and click the Find button. The result of this search is listed below. 
Select the user(s) you want and click OK. The users are added.

TIP: for the User Administrator:
The Browse for Users permission is set under File > Admin > Server 
Console > User Manager > Server Permissions > Administrator Per-
missions.

Cumulus Scheduler
The Cumulus Scheduler enables you to define and schedule tasks to be automat-
ically performed by Cumulus. It will save you time and increase your productivity 
by automating frequent tasks. The Scheduler enables you to run time consuming 
functions during off-peak hours, and also enables you to automate routine tasks. 
In combination with the Cumulus Trigger feature, the Cumulus Scheduler makes 
a powerful tool to automate business processes and save wasted resources.
The Cumulus Scheduler consists of the Scheduler Manager and the Scheduler 
Server Application. The Scheduler Manager lets you set up tasks that are to be 
performed by the Scheduler Server Application.
The Scheduler Manager utility is included in the Cumulus Server Console. For 
more information on the Cumulus Scheduler, see the Cumulus Administrator 
Guide.
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Managing Related Assets
Cumulus can manage related assets. With Cumulus versions prior to 7 there was 
no user interface to show this and any relations between assets were defined by 
program modules only (AssetStore modules or the AXR feature). Since version 7 
Cumulus offers enhanced management for related assets by providing a user 
interface that displays these relations and also enables the user to determine 
relations between assets. 

Relationships
Relations can be different, there are hierarchical and flat relations. In a hierarchical 
relations one is special, it might be the master or the preferred one, it might be 
the source... The different types of hierarchical relations between assets sup-
ported by Cumulus are:

1. Contain – An asset contains other assets: e.g. a Zip archive, a PowerPoint pre-
sentation that contains slides, a Quark XPress or PDF document that con-
tains pages.

2. References – An asset includes references to other assets: e.g. a PowerPoint 
presentation or a Quark XPress document that includes references to the 
images on the slides/pages.

3. Variants – Assets derive from the same source asset: e.g. the PDF of a Word 
document, an image stored in different file formats or renditions of an image 
(for example cropped or with a filter employed.)

4. Alternates – assets that you want to group concerning a certain topic and 
for which you have a preferred one that you want to represent the others. 
(For example, you have a series of images on the same topic and the pre-
ferred one is the one you decided to use for your current project.)

In addition to hierarchical relations you might want to determine groups of 
’equal’ assets. Assets that you want to group concerning a certain topic, theme 
or task but to which you don’t want to designate a preferred member. Cumulus 
offers support for this demand: assign the assets to the same category. However, 
this well-known way of defining groups is included in the Cumulus management 
for related assets (referred to as relation type 5). 
Another type of relation between assets is the versions managed by a Version 
Control System (e.g. Cumulus Vault). Support for this type of relation is not yet 
included in the Managing Related Assets concept of Cumulus. Use the Version 
History window to have the versions displayed. (See “The Version History Win-
dow,” p. 140, for details.)

Different Relations between Assets
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How does Cumulus Know about Relations between Assets?

1. Contain – The Cumulus Asset Storage modules detect if an asset contains 
other assets when the asset is cataloged.

2. References – The Cumulus AXR (Asset Cross References) function detects if 
an asset includes references to other assets when the asset is cataloged.

3. Variants – The user can determine that an asset derives from a source asset 
or Cumulus can ascertain that automatically if the deriving asset was created 
using a Cumulus function.(For a description on how to determine such a 
relation, see “Assigning Variants,” p. 130.)

4. Alternates – The user can create groups of alternate assets. An asset is deter-
mined as an alternate by assigning it to the ’preferred alternate’. (For a 
description on how to determine such a relation, see “Assigning Alternates,” 
p. 129.)

The information on an asset’s relations is stored in the asset’s record.

SPECIAL TECH INFORMATION:  
The information on an asset’s relations is stored in the record fields 
Related Master Assets and Related Sub Assets. The field Related Sub 
Assets stores the information which assets are contained, referenced, 
deriving, or alternates. Whereas the field Related Master Assets stores 
the information in which other assets the asset is contained in, refer-
enced by, derives from, or which asset is its preferred alternate.

BACKGROUND INFORMATION:  
AssetStores that can create records for “contained” items: 

Asset Store Items Asset Store  Items

Apple iWork Picture Images Office Open XML 
Pictures and Media

Images, media

Apple Keynote Slides Slides (pages) Open Document Images

HELIOS XPV Pages; QXP Pages (but 
D&D not possible)

PDF** Pages

InDesign Pages (but D&D not 
possible)

PDF Image** Images

Mac Binary Assets QXP Pages, layouts

MS PowerPoint Slides (pages) QXP Server** Pages, layouts (but 
D&D not possible)

MS PowerPoint Pic-
ture 

Images Video** Shots

Office Open XML 
Pages and Slides

Pages, sheets, slides ZIP Assets

** with Options only (not included in any standard edition/solution)
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There can be several relations between assets.

How does Cumulus Display Relations between Assets?
In a split view: an additional pane can be opened up below the Record pane. The 
additional pane displays the records that are related to the record selected in the 
main Record pane. How the assets of the additional pane are related to the 
selected record is determined by the display option that is set for the additional 
pane. 
So, having related assets displayed is as easy as: select a record, open up a sub-
pane and select what you want to see in it. 
You can select multiple assets in the upper pane and you can open up multiple 
sub-panes. Each sub-pane will display those assets that are related to the selec-
tion in its upper pane. How they are related is determined by the selected display 

et can have various relations. 

mple shows a PowerPoint presentation and its rela-
well as the relations of assets related to the presenta-

entation
s slides (pages)

ces images
e for variants

to find out about the different relations between the 
at are related to the presentation:
 are contained. 
es reference images.

One slide is also source of a variant.

Most images are referenced.
Some images are sources of variants.
A lot of images are variants.
One image is a variant and also the source of another variant.
And that’s why there is one image that has a variant source as 
well as a top level variant source.

Last but not least:
One image is a preferred alternate in a group of four alter-
nates.
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option. If the selection in the upper pane changes, the content of the sub-pane 
is synchronized. It changes simultaneously.

To open up a new sub-pane: Click the  button of the current sub-pane. To 
close a sub-pane: Click the  button of the pane. To refresh the display of a 
sub-pane: Click the  button of the pane. 

TIP: Resizing Panes
You can resize the panes by pressing the ALT / Option key and 
dragging the split bar. (Just clicking the split bar will resize the main 
pane and the sub-pane of the dragged split bar only.) 
Collapsing: Pressing the ALT / Option key and double-clicking in 
a pane’s statusbar will collapse the pane so that the statusbar only is 
displayed and the pane above will fill the area. (Just double-clicking 
lets the pane above remain its size and the main pane will be 
enlarged.) A double-click on the statusbar of the main pane (topmost 
pane) will collapse all panes below.
Expanding: Pressing the ALT / Option key and double-clicking in 
a collapsed pane’s statusbar will expand the pane again – using space 
from the above pane. (If you just click it – without the ALT / 

Option key – the pane will be expanded using space from the main 
window.) A double-click on the statusbar of the collapsed main pane 
will expand all panes below.
Minimizing: Double-clicking a pane’s split bar minimizes the pane or 
resizes it again.

For each pane you can choose the view, the sorting direction and an option for 
the content to be displayed. How the displayed assets are related to the asset 
selected in the upper pane is chosen from a menu that offers the following 
options by default:

 Cumulus display of related assets with split view.



128  CUMULUS® –  CLIENT USER GUIDE
The list options can be renamed, configured and assigned to specific users. The 
list options are configured via Sub-Pane Filter definitions. So you can customize 
it in wording and include search strategies for individual tasks. Sub-Pane Filters 
are created and edited in the Preference dialog window ( Cumulus / Edit > 
Preferences  > Sub-Pane Filters.) For details on how to set up a Sub-Pane Filter, 
see “Sub-Pane Filters,” p. 238. The availability of Sub-Pane Filters for users is 
defined with the User Manager in the each user’s properties.
You can get information on the different relations of an asset in the Info view or 
Asset Info window. If the fields Related Sub Assets and Related Master Assets 
are added to the corresponding view settings (and given more than 1 line), for 

RELA-
TION 
TYPE

Display options are: 

0 Selected Asset

1  Contained Pages/Slides
Contained Assets
Container Asset

2 All Referenced Assets
Referencing Documents
Referencing Pages/Slides

3 All Variants
Variant Source 
Top Level Variant Source 

4 – All Alternates
– Preferred Alternates

5 – Assets Assigned to the Same Categories
– Assets Assigned to at least One Same Category

The Selected Asset option will display the asset selected in the above pane 
in large size. So this option provides a kind of filmstrip view.
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each type of relation a tab is provided that displays the names of the related 
assets.

What else do you need to know? 
In the split view, Cumulus can only display related assets that are cataloged to 
the same catalog as the one selected. That’s why it is recommended that you use 
a simple collection and not a multi-catalog collection when your work includes 
the relation aspect.

Display of Master Assets Only
You don’t want to see any contained or referenced assets in the main pane? You 
want to see only the preferred alternate and not the others? Cumulus can help 
you. It provides a special display option for the main Record pane. You can have 
records of ’master assets’ displayed only. What are ’master assets’?
A ’master asset’ is defined by: 

•not contained in any other
•not a variant of
•preferred alternate or no alternate of 
The main Record pane provides the  button that lets the main 

pane display records of master assets only. If you activate this button, your cur-
rent collection will be filtered and only the master assets of the collection are dis-
played. Further search results will only display master assets. If you deactivate the 
button, your collection remains in its ’filtered’ version but further search results 
will display all matching assets again – whether they are master assets or not.

SPECIAL TECH INFORMATION:  Master Only button
The button can be activated only if the Related Master Assets field is 
indexed for Contain Search. Reason: The search that is started by this 
button checks the contents of the Related Master Assets field. 
NOTE for Migration: The field Related Master Assets must be included 
in the catalog(s) and indexed for Contain-Searching.

Assigning Alternates
You can manually group alternates of assets. When you group them as alternates 
you have to determine one as the preferred alternate. 

Relation tabs of the Asset Info window



130  CUMULUS® –  CLIENT USER GUIDE
Select the records of the assets you want to become alternates and select Meta-
data > Assign Alternates. Then a message prompts you to select the preferred 
alternate. From the selected records select the one you want to be the preferred 
alternate and click OK.
To delete such relations you must delete the corresponding entries in the 
Related Sub Assets and Related Master Assets fields from the Alternates tab in 
the Information window or view.
To get the alternates of an asset listed, use the split view and an according list 
option (Sub-Pane Filter). For more information, see “How does Cumulus Display 
Relations between Assets?,” p. 126.

Assigning Variants
You can manually assign variants to an asset. The asset you assign them to is 
called the source of the variant. 
Select the records of the assets you want to assign as variants to a source asset 
and select Metadata > Assign Variants. Then a message prompts you to select 
the source. Select the record you want to be the one assigned as the source of 
the variants and click OK.
To delete such relations you must delete the corresponding entries in the 
Related Sub Assets and Related Master Assets fields from the Variants tab in 
the Information window or view.
To get the variants of an asset listed, use the split view and an according list 
option (Sub-Pane Filter). For more information, see “How does Cumulus Display 
Relations between Assets?,” p. 126.

AXR
AXR (Asset Cross References) is the automatic detection of usage and cross-ref-
erences of assets within Cumulus. Cumulus is able to detect links and placed 
assets in compound documents such as QuarkXPress, EPS, Adobe InDesign, and 
Illustrator (version 8, 9) as well as Microsoft Word and PowerPoint documents. 
AXR requires that the filter employed for cataloging must support AXR (e.g. Com-
pound Document, EPS and InDesign filters). AXR works for assets that are man-
aged by the same catalog only. 
With a standard Workgroup installation the referenced assets must be cataloged 
before Cumulus can detect them in a compound document. The existence of 
the field Related Sub Assets is required for the information in the field Related 
Master Assets. 

TIP: 
If the field Related Sub Assets was not one of the record fields of the 
catalog when cataloging, you can employ the menu item Update 
Record from the File menu to re-catalog the assets.

With Enterprise or a corresponding add-product you make use of the AXR cata-
loging option. (For details, see below.) 

Automatic Cataloging of Referenced Assets
However, there are differences between AXR with a standard Workgroup instal-
lation and with an Enterprise or an enhanced Workgroup installation. With Enter-
prise or Workgroup enhanced with the corresponding add-on product, AXR 
provides the option that referenced assets can be cataloged automatically when 
detected by AXR. To have referenced assets that are not included in a catalog, 
cataloged automatically is defined in the Asset Handling Set. If you use an Asset 
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Handling Set with the option Also Catalog Referenced Assets not yet Cata-
loged activated when cataloging an asset that contains references, the refer-
enced assets will be cataloged automatically with the same cataloging process. 

TIP: Add Only in combination with AXR Also Catalog Referenced ... 
activated!
If you use the Add Only option and activate the Also Catalog Refer-
enced Assets not yet Cataloged option, you should also have the 
Skip Duplicates option activated. Otherwise Cumulus will catalog the 
referenced assets twice, if the referenced assets come later in the 
sequence of the selected assets than the asset that contains the refer-
ences.

Working Smart
Whether your workgroup consists of you alone, or you and a dozen others, fol-
lowing a few simple guidelines will ensure your workflow is as efficient as possi-
ble. 

Name a Catalog Manager
It’s best to assign one person in your workgroup to manage assets and Cumulus 
catalogs. Having one manager helps keep things consistent and provides your 
workgroup with a recognized source for asset and catalog information.

Develop an Effective File Naming Convention
Even though Cumulus makes it easy to keep track of assets with its thumbnail 
previews and wealth of search options, there is no substitute for a well planned 
filing system. There will be times when you must access files without the conve-
nience of the Cumulus interface. For example, when writing scripts to enable 
Cumulus to automate the workflow, a consistent and predictable filing system 
can not only save many hours of script debugging, but it can also enable func-
tionality that might not otherwise be possible.
How you name your files will depend on how you use them. A news agency may 
decide to name incoming news stories prefixed with the current date and affixed 
with the file type:

2003-06-01-ElectionResults.txt
2003-06-01-ElectionResults.tif

Using the date in this order lists the files chronologically when sorted alphabeti-
cally. It also makes it easier for Cumulus scripts to select files based on a date 
range.
A Web design group may chose to include an image’s file size in its name to 
make entering HTML size tags more convenient:

MainPageBanner200x50.gif
Or, to use this manual as an example, file names for screen shots of menus and 
dialogs each begin with either “M_” or “W_” to identify the platform from which 
the images come. For example, the file name for the Mac OS X File menu is:

M_FileMenu.tif
It’s Windows counterpart is called:

W_FileMenu.tif
Using the two file name prefixes not only helps differentiate the files at a glance, 
but also helps to make the filing system more predictable. From this one exam-
ple, you can probably guess the file names of most images in this document. 
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Consistency and predictability are key to developing a naming convention that 
will serve you and your workgroup well.

Develop an Effective Folder Naming Convention
Apply an equally clear naming convention to your folder (directory) structures. 
Cumulus can use your folder hierarchy to create categories when cataloging 
assets. This is a real time saver if your folder structure helps to identify your assets. 
Some users may choose to store assets in folders based on file type rather than 
project name. A sound clip of audience applause, for example, may be used in 
many projects, but it will always be a sound clip. You can use Cumulus’ catego-
ries to associate assets with one or more projects.

Cross-Platform Catalog Use
Though the catalogs that Cumulus creates are completely cross-platform com-
patible, it is up to you to use a catalog file naming convention compatible with 
each platform on which you plan to use your catalogs.
Keep in mind that catalog names and catalog file names are two different things. 
For cross-platform purposes, you need only be concerned with catalog file 
names. (See “Renaming Catalogs,” p. 194, for catalog naming information.)
Consult your operating system’s documentation for details on the range of char-
acters that can be used. In the meantime, here is one important tip: 
• Windows uses a backslash (\) to differentiate folder hierarchies. Mac OS X 

users should avoid using this character in their catalog names. (The Mac OS 
X uses a colon (:) to differentiate folder hierarchies, but this character is not 
allowed in file names on either platform, so it is of no real concern.)

Characters that are safe for use on all Cumulus platforms include all upper and 
lowercase letters, all numbers, the hyphen (-), and the underscore ( _ ).



Specialized Usage
This chapter covers Cumulus functions that help you with special

tasks. It includes descriptions on how to work with the revision control

system Cumulus Vault and the URL AssetStore, how to work with

Microsoft Office and Adobe Indesign documents within Cumulus, and

how Cumulus supports you working with images by providing a spe-

cial IPTC Information window and maintaining raw image formats of

digital cameras.

With certain Cumulus configurations user permissions can be defined

for individual asset records, categories and even subcategories. Per-

missions Templates makes this easy. The last section of this chapter

describes how to assign individual permissions for records and cate-

gories.
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Using Vault 
Cumulus® Vault is a revision control system that gives your workgroup added 
data security and up-to-the-minute information on the status of each asset. As 
its name suggests, Vault enhances the security of your team’s assets – controlling 
who accesses them, how and when. It also gives you more ways working with 
your assets in Cumulus, providing version retention and tracking, at-a-glance ver-
sion information, and integration into the existing Cumulus environment.
Cumulus Vault can control and monitor access to all assets. Think of it as the 
Cumulus librarian. Users check assets out for editing and check them back in 
again when they’re through. Vault allows only one user at a time to check out an 
asset. This prevents it from being edited by multiple persons simultaneously, 
possibly resulting in conflicting – and confusing – versions of the asset. If another 
user attempts to check the asset out, Vault informs the would-be editor which 
user is working on the file. 
When a user checks an asset back in, Vault saves the updated file as a new version 
without overwriting previous versions. It keeps all back revisions, making it pos-
sible to track changes to an asset during the production cycle – a concept 
referred to as a version control system. It also provides information on all ver-
sions: Who made the changes? When? With Vault, these questions are easy to 
answer, making last week’s edits just as accessible as today’s.

Organization
This chapter is one of two descriptions that cover Cumulus Vault:
• This description, which covers using it to track and control access to assets, 

and integrating it into your Cumulus environment.
• A description, which covers how to set up the Vault Server and how to con-

figure catalogs to work with Cumulus Vault. This description is included in the 
Administrator Guide.

This chapter covers everything you need to know about working with Vault in 
the following sections:
• Working with Vault– Gives you the basics on placing assets under Vault’s 

control, checking them in and out, and managing asset versions. (See “Work-
ing with Vault” section, starting on page 134.)

• Integration – Describes the effects Cumulus Vault has on existing Cumulus 
functions, and how you can integrate these new options into your existing 
workflow. (See “Integration” sections, starting on page 140.)

Working with Vault
This section covers the basics of working with Cumulus Vault. It describes how to 
place your assets under Vault’s control, and then how to work with Vault to check 
these assets in and out. It goes on to explain how you can view and manage the 
versions resulting from these check in/check out procedures. Once you’ve mas-
tered these functions, you’ll be ready to take advantage of the capabilities 
offered by Cumulus Vault.

Assets Controlled by Vault
Whether or not cataloged assets are controlled by Cumulus Vault depends first 
of all on whether the catalog that manages them is set up to work with Vault. If 
your Cumulus Administrator sets up a catalog to work with Vault, assets can be 
placed under Vault’s control when they are added (i.e., cataloged) to that catalog. 
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During the cataloging process, Cumulus hands the assets over to the location 
that Vault controls.
Your Cumulus Catalog Administrator sets up a catalog to work with Vault in one 
of the following ways:
• Always – whenever users catalog assets to that catalog, they are handed over 

to Vault. In this case, all you need to do is catalog the assets. (See the Cumulus 
Client User Guide for information on cataloging assets.)

• As Set in Asset Handling Set– users decide before cataloging assets whether 
or not the assets should be handed over to Vault. (See “Cataloging to Vault as 
Defined for the Employed Asset Handling Set,” below, for details.)

• Always and Exclusive – whenever users catalog assets to that catalog, they 
are handed over to Vault and their asset storage location is Vault exclusively. 
In this case, all you need to do is catalog the assets. 
For your information: A catalog that is set to the Always and Exclusive option 
has a forced 1-to-1relation with Vault: every record in the catalog represents 
an asset stored in Vault and each asset in the Vault folder assigned to this cat-
alog is represented by a record in this catalog. This is the guiding principle for 
all functions performed. For example, this means that assets managed by this 
catalog cannot be moved and that deleting the records which are represent-
ing them will always delete the assets as well.
NOTE: Catalog Housing Records from a Vault Exclusive Catalog!
If you have another catalog housing records that derive from a catalog 
set to Always and Exclusive, the permissions you have on these records 
(and their assets) are the permissions you are given for the catalog the 
records derive from. For example: you have all permissions for catalog A 
but if catalog A houses records from catalog B which is a Vault exclusive 
catalog, then the permissions for records may differ if you don’t have the 
same permissions for both catalogs. 

If you don’t know which of your workgroup’s catalogs are set up to work with 
Vault and how, ask your Cumulus Administrator. You should also ask your Cumu-
lus Administrator which Asset Handling Sets were adjusted for the use with Vault. 
The Asset Handling Sets you use with Vault must have the Asset Storage module 
Cumulus Vault activated. And if a catalog is set to let each user decide whether 
cataloged assets should be placed under Vault’s control or not, the Copy to Cen-
tral Asset Location option must also be activated. If working with assets stored in 
Vault, you should take care that the Asset Handling Sets defined in your User Set-
tings for cataloging and asset access are adjusted for the use with Vault. Asset 
Handling Sets also include the Vault settings for version handling. For details on 
how to set up Asset Handling Sets for version handling, see “Defining Asset Ver-
sion Handling,” p. 141.
If you’ve already cataloged assets to a catalog before it was placed under Vault’s 
control, and now want to hand them over to Vault, you can do that, too. You 
don’t have to re-catalog them, but can simply move them to the location which 
Vault stands guard over. To find out how, see “Adding Already Cataloged Assets 
to Vault,” below.

Cataloging to Vault as Defined for the Employed Asset Handling Set
For each catalog, the Cumulus Administrator has the option of letting Clients 
specify which assets should be cataloged to Vault. In this case, Clients can specify 
whether or not the assets will be placed under Vault’s control by selecting a cor-
responding Asset Handling Set. If you select an Asset Handling Set that has the 
Copy Asset to Central Location Option activated, the assets will be placed under 
Vault’s control. If this option in not activated, the assets will not be placed under 
Vault’s control.



136  CUMULUS® –  CLIENT USER GUIDE
To view the settings for cataloging of an Asset Handling Set:

1. Select Cumulus / Edit > Preferences. 

2. Click Asset Handling Sets.

3. Under Set, select the set you want to view.

4. Click Cataloging.

5. Check whether Copy Asset to Central Location under Central Asset Loca-
tion is activated.

If activated, Cumulus will add the assets to the catalog and copy them to the 
Vault location when this Asset Handling Set is used for cataloging (and if the 
catalog is set up for Vault).

However, you should also check that the Asset Storage module Cumulus 
Vault is activated (click Modules and then Asset Storage).

Adding Already Cataloged Assets to Vault
Just because your Cumulus Administrator has set up a catalog to work with Vault, 
it doesn’t necessarily mean that all of that catalog’s assets are controlled by Vault. 
For example, assets may have already been cataloged to the catalog before it 
was set up to work with Vault.
In this case, users have the option of placing already cataloged assets under 
Vault’s control. The assets don’t have to be re-cataloged, but can simply be 
moved to the location guarded by Vault.
To add already cataloged assets to Vault:

1. Open the catalog whose assets you would like to add to Vault. 

2. Select the record(s) representing the asset(s) you would like to hand over to 
Vault.

3. Select Asset > Move To.

The Select Asset Storage Module dialog appears.

4. Select Cumulus Vault and click OK.

The Vault AssetStore mod-
ule must be activated in 
Asset Handling Sets in 
order to catalog assets to 
Vault or access assets 
stored in Vault.
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The Select Remote Module dialog appears.

5. In the Computer field, select the computer running the Vault Server and 
click OK. 

Cumulus moves the selected assets to Vault, where they are now subject to 
access and version control.

Checking Assets In and Out
These two steps form the basis of the Cumulus Vault concept. They ensure that 
only one person can edit an asset at a time, and also provide the version informa-
tion associated with each asset. If you check an asset out but don’t need to check 
it back in as a new version, you can undo the check out (see “Undoing a Check 
Out,” p. 139).

Checking Assets Out
When you check an asset out, Cumulus places a copy of the latest version in a 
location you specify and locks the associated record in the Cumulus catalog for 
other users. You can then edit the copy you checked out, and later check it back 
in as a new version.
There are two things that you will be prompted to tell Cumulus when checking 
assets out:
• Which Asset Storage Module should be used to manage the access to the 

asset’s destination location. The destination location is typically the file sys-
tem – such as the Windows or Mac OS file system – to which the checked-
out asset will be copied. The destination is not Cumulus Vault.

• Where exactly in the destination location the copy of the asset should be 
placed, i.e., the specific folder on your hard disk or network.

If another user has already checked the asset out, you will not be able to check it 
out to yourself. In this case, Cumulus Vault informs you who has the asset and 
when it was checked out. If you would like to see whether or not assets are 
checked out without having to attempt a check out yourself, you can add the 
respective fields to your Collection and/or Asset Information view. For details, see 
“Viewing Asset Status,” p. 143.
To check assets out:

1. Select the record(s) representing the asset(s) you would like to check out.

2. Select Asset > Check Out. 

If you have defined a Check out Location in the Application Preferences 
(Cumulus/Edit > Preferences > User Settings > General > Application), 
Cumulus makes a copy of the latest version and inserts it in the defined loca-
tion. The asset is checked out and you can start editing it.

If you have no defined Check out Location, continue as follows. 

The Select Asset Storage Module dialog appears. This is a list of available 
Asset Storage Modules. One is Cumulus Vault, and others include the file sys-
tem you are currently using (such as the Windows or Mac OS File System, 
among others). 

3. Select the Module for the destination location and click OK. 
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NOTE: The destination is not Cumulus Vault. If you check the asset out to 
Vault, you will not be able to edit it! 

A window appears for you to select the target folder on the file system you 
selected.

4. Choose the desired folder and click OK.

Cumulus makes a copy of the latest version and inserts it where specified.

If you want to edit the asset now, open it with the application that created it and 
start editing.

TIP: 
Cumulus offers you a convenient way of combining check out and 
launching the application for editing the asset. The procedure is the 
same as described above, except that you select Edit With instead of 
Check Out from the Asset menu. Cumulus recognizes that the asset is 
controlled by Vault and automatically triggers a check out procedure. 
Once you’ve completed the check out steps, Cumulus launches the 
editing application and opens the checked-out asset in it. If you only 
want to view the asset without checking it out, use View With from 
the Asset menu.

Checking Assets In
When you have finished working with an asset and check it back in, Cumulus lets 
you enter comments on the new version (what sort of changes you made, etc.). 
It then moves the updated asset back to the Vault as a new version, and unlocks 
and updates the associated record in the catalog. Since a check in procedure 
moves the new version into the Vault, that version is removed from the location 
you checked it out to.
To check an asset in:

1. Select the record(s) representing the asset(s) you would like to check in.

2. Select Asset > Check In.

The Version Comment dialog appears. The asset’s name and your user name 
are entered automatically. 

You may enter your comments in the Comments field. If you want this com-
ment to be used for further selected assets to be checked in, activate the 
Use for All Remaining Items option.

If the Keep Checked Out option is activated, the changed asset is copied to 
Vault as a new version but also left checked out. So you can continue work-
ing on the asset.

3. Click OK.
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Cumulus moves the new version to Vault and updates the associated record 
in the catalog.

Checking an asset in moves the latest version to Vault. It doesn’t overwrite the 
previous versions, however, which are retained so that they can be viewed, 
tracked or used again. (See “Managing Versions,” below, for details.)

TIP: 
Cumulus gives you a quick and easy alternative to checking assets in 
via menu command: simply dragging and dropping the asset from 
your desktop into the associated catalog. Cumulus recognizes the 
checked-out asset and automatically triggers a check in procedure.

Undoing a Check Out
If you check an asset out and then realize that, for whatever reason, no changes 
are necessary, you can return it to Vault without checking it in as a new version. 
You simply need to undo the check out.
When you undo a check out, Cumulus deletes the asset from the location you 
checked it out to and unlocks the record in the catalog, but does not move the 
asset back to Vault or update the record.
To undo the check out of an asset:

1. Select the record representing the asset you previously checked out.

2. Select Asset > Undo Check Out.

Managing Versions
With your workgroup constantly checking assets out, editing them, and check-
ing them back in, it would seem easy to lose track of the many different versions. 
To exclude this possibility, Cumulus Vault includes a window that gives you an 
overview of each asset’s version history.
The Version History window shows you which version is the latest, who has 
edited the asset and when, and the comments that the users made on their ver-
sions. It is also the starting point for managing the various versions. From it you 
can:
• Edit the information included with each version. 
• Delete any versions you no longer need—thus saving storage space. 
• Designate an older version of an asset as the current version

Viewing an Asset’s Version History
The Version History window gives you a quick overview of who did what to an 
asset when. It also displays the comments the users who are checking in made.
To open the Version History window:

1. Select the record representing the asset whose version history you want to 
view.

2. Select Asset > Show History. The Version History window opens.
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The Version History Window

The columns in this window have the following meaning:
• Version – the number of the version. The higher the number, the later the 

version.
• Check In Date – the date and time at which the version was checked in.
• User – the user who checked that version in.
• Comment – any comments the users who were checking in made.
Since the Comment column is too small to hold the complete text of most com-
ments, an area is provided below the table for the full text.
Use the Delete button to delete a version. Since every version of an asset is an 
entire file in itself, it’s often a good idea to free up system space by deleting any 
versions you no longer need. You can delete a version directly from the Cumulus 
interface. Keep in mind that deleting a version in this manner moves every pre-
vious version “up” one space in the list. So if you delete the latest version, the 
next-latest version becomes the current version. If this is the case, Cumulus 
Server re-catalogs the “new” current version and updates the record represent-
ing it. 

NOTE: You need to have permissions to delete records from this catalog in 
order to use this function. To find out if you have this permission, ask your 
Cumulus Administrator. 

You also have the option of deleting not just one version, but every version asso-
ciated with an asset (and, of course, the asset itself). To find out how, see “Delet-
ing Assets Controlled by Vault,” p. 141.
Use the Edit button to edit comment of a version. The Version Comment win-
dow opens. Make your changes and click OK to save your changes and get back 
to the Version History window.
Use the Make Current button to designate an older version of an asset as the 
current version. The version number will increment, even though the asset is not 
physically changed by the designation. 

NOTE: The function is implemented as a ’virtual rollback’, which doesn't erase 
all versions and changes of an asset. 

Click OK to close the Version History window.

Integration
Cumulus Vault doesn’t just store and protect your assets—it also adds a new 
dimension to the way you manage your assets. This chapter explains the effects 
that working with Vault has on your asset management with Cumulus. It also 
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gives you tips for taking advantage of these effects so that you can optimally inte-
grate Cumulus Vault into your existing workflow.

Asset Version Handling
Cumulus Vault expands the functionality of your base Cumulus installation. By 
retaining and tracking assets in multiple versions, it adds a new dimension to 
your asset management solution.
This new dimension comes into play when you would like to preview, mail, copy 
and delete assets controlled by Vault. Since these assets may exist in multiple ver-
sions, you may have to make a choice between the different versions available.
Cumulus makes it easy for you to make this choice. It even enables you to pre-set 
your decision to best suit the way you work. If you want to preview, mail, copy or 
print an asset controlled by Vault, you can have Cumulus always get the latest 
version – without asking you any further questions. Or if you’re more interested 
in a previous version, you can have Cumulus provide you with a list of all versions 
that are available – complete with check-in times, users and comments – to 
make sure you get the right one.
You have a similar option when deleting assets. You can have Cumulus prompt 
you to select the version you would like to delete, or, if you’re trying to free up a 
lot of storage space at once, have Cumulus delete all versions without any fur-
ther questions.
The sections that follow explain how to define these version settings and then 
use them when working with your assets.

Defining Asset Version Handling
When you use standard Cumulus commands to access assets controlled by 
Vault, the assets you access may exist in multiple versions. Which version you use 
is up to you – but Cumulus provides the information to make the decision easy 
for you. You can even pre-set how you want these versions handled to best suit 
the way you work.
How asset versions should be handled is defined on the Cataloging tab of the 
Asset Handling Set you use to access the asset. (For the different options, see 
“Cataloging Tab,” p. 202.)

Deleting Assets Controlled by Vault
One option for deleting asset versions from Vault is to use the Version History dia-
log (see “Managing Versions,” p. 139). To delete a record and its asset including 
all asset versions, use the Delete command in the Edit menu.

NOTE: You need to have permission to delete records from this catalog in 
order to use this function. To find out if you have this permission, ask your 
Cumulus Administrator. 

Previewing, Mailing or Printing Assets Controlled by Vault
To preview a version of an asset controlled by Vault:

1. Select the record whose asset version you would like to preview, mail or 
print.

2. Select Asset > Preview or Mail To or Print.

If your version setting is Always Get Latest Version, Cumulus opens the pre-
view window with the latest version of the selected asset or mails or prints 
the latest version of the selected asset.
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If your version setting is Ask for Version to Get, Cumulus prompts you to 
choose the version you would like to preview/mail/print. Select the desired 
version and click OK to preview/mail/print it.

Outside the Revision Control
While Cumulus Vault gives your workgroup a secure way to manage your asset 
versions, it may be more security than you need in every instance. For example, 
your workgroup could use an existing asset for a new project, but it’s currently 
locked up in the catalog of another project. Or, you may want to give samples of 
your latest work to a client. Since the client won’t be updating the assets and 
checking them back in, you wouldn’t want to check the assets out.
Cumulus gives you a couple of options for accessing assets outside of Vault’s 
control system: you can either get a copy of an asset version controlled by Vault, 
or you can move an asset out of Vault’s control entirely.
There are a couple of important things to keep in mind, however, if you decide 
to copy or move an asset directly out of Vault:
• Asset versions copied or moved out of Vault in this manner are not checked 

out, meaning they cannot be checked back in! If you want to update the asset 
and return it to Vault, you will have to re-catalog it, possibly resulting in mul-
tiple records representing different versions of the same asset.

• Moving an asset version out of Vault deletes all versions from Vault. Make sure 
you want to take this asset out of the revision control system before proceed-
ing.

These functions give you extra flexibility when working with your Vault assets, 
but they also have the potential to undermine Vault’s access and version control. 
Make sure that you want to work outside of this control system before you pro-
ceed to copy or move.

Copying an Asset Controlled by Vault
One way to get an asset out of Vault without checking it out is to copy it to 
another location (such as your hard disk). In this procedure, Cumulus simply 
makes a copy of the asset and inserts it wherever you specify. The asset is not 
checked out, and the associated record in the catalog is not locked for other 
users.
To get a copy of an asset controlled by Vault:

1. Select the record whose asset version you would like to copy.

2. Select Asset > Copy To.

If your version setting is Always Get Latest Version, Cumulus gets the latest 
version of the asset for you to copy.

If your version setting is Ask for Version to Get, Cumulus prompts you to 
select the version to copy.

A list of available Asset Storage Modules appears. 

3. Select the Module for the destination location (not Vault) and click OK.

4. Choose the desired location and click OK.

Cumulus copies the latest/selected version to the location you specified.
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Dragging and Dropping Assets Controlled by Vault
One way to get an asset out of Vault without checking it out is to copy it to 
another location using the Copy To menu command. An other way is drag and 
drop. To copy any asset you can drag and drop a record into another drag and 
drop-supporting application. Dragging a record copies the asset into the target 
document. Dragging a record into the Windows Explorer or the Mac OS X Finder 
copies the asset into the selected folder. When dragging and dropping an asset 
controlled by Vault it works the same, Cumulus simply makes a copy of the asset 
and inserts it wherever you specify. The asset is not checked out, and the associ-
ated record in the catalog is not locked for other users. And when dragging the 
record of a Vault asset, Cumulus always gets the latest version of the asset for you 
to copy. 
When dragging the record of a Vault asset into a target document of another 
drag and drop-supporting application, be aware that most applications need a 
path to the “dropped” file which Vault does not provide. In this case you should 
copy the Vault asset to your file system first and then place this copy into the 
application. 
When dragging the record of a Vault asset into a drag and drop-supporting 
application that opens the asset, a temporary file will be created. Be aware that 
for Vault assets this is not the same function as the Edit With menu command 
where Cumulus recognizes that the asset is controlled by Vault and automati-
cally triggers a check out procedure. 

Moving an Asset out of Vault’s Control
Moving an asset out of Vault’s control destroys revision tracking and retention for 
the asset. The latest version will be moved out of the Vault location (to your hard 
drive, for example), and all versions will be deleted from that location. If you 
move it to a place that Clients cannot access, it will no longer be available to oth-
ers in your workgroup. 
Cumulus does provide you with some protection in this case, however. When 
you move an asset from Vault, Cumulus updates the asset reference in the cata-
log to “point to” the new location, i.e., the location you specified. Other users will 
still be able to see where the asset is located, even if they may not be able to 
access it. Remember, completing the following procedure deletes all versions of 
the asset from Vault. If this is not what you are trying to do, you may want to con-
sider simply getting a copy of the asset (see “Copying an Asset Controlled by 
Vault,” this page).
To move an asset out of Vault’s control:

1. Select the record whose asset you would like to move.

2. Select Asset > Move To.

A list of available Asset Storage Modules appears. 

3. Select the Module for the destination location and click OK.

4. Choose the desired location and click OK.

Cumulus moves the latest version to the location you specified. It then 
deletes all versions of the asset from Vault.

Viewing Asset Status
You can set up your catalogs to give you an at-a-glance view of whether or not 
assets are currently checked out and by whom, as well as who has previously 
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edited the various versions. You do this by adding the fields that contain this 
information to one of the views.
The following sections describe which fields provide what information. For infor-
mation on adding fields to a view, see “Adding a Field to a Record View,” p. 191.

Viewing Asset Availability
You can immediately see whether or not an asset is checked out – as well as by 
whom and when – by using a Review Set that includes the fields that contain this 
information. These fields are:
• Check out Date – contains the date and time the asset was last checked out. 

If the asset is not currently checked out, this field is empty.
• Check out User – contains the name of the user who checked the asset out. 

If the asset is not currently checked out, this field is empty.

Viewing Revision History
One way to view an asset’s revision history is from the Version History window, as 
described under “Viewing an Asset’s Version History,” on page 139. You can also 
customize the view of a Record View Set to give you this information directly. If 
you add the field Version History to either one of these views, you will be able to 
see right away how many versions exist as well as who edited each one.
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Using URL AssetStore
This chapter covers the basics of working with Cumulus URL AssetStore Module. 
It describes how to catalog assets from FTP or HTTP servers and how to work with 
them in Cumulus. Although the records of URL-cataloged assets behave just like 
any record which has been cataloged through the supported file systems – 
working with the assets themselves from within Cumulus is slightly different. 
This chapter also describes how to copy or move cataloged assets to FTP servers 
and how to set up the Central Asset Location for a catalog on an FTP server.

Cataloging Assets from FTP or HTTP Servers
If you want to catalog from FTP or HTTP servers or to work with URL-cataloged 
assets, you must use an Asset Handling Set that has the Asset Storage Module 
supporting URL activated. If you want an Asset Handling Set to neither work with 
URL-cataloged assets nor to catalog from FTP or HTTP servers, you may want to 
deactivate the URL AssetStore Module. For details on how to activate or deacti-
vate an Asset Storage module for an Asset Handling Set, see “(De)activating Asset 
Handling Modules,” p. 206.
There are two ways to catalog assets from FTP or HTTP servers: via menu item and 
with drag and drop. Let’s start with the menu item method. And remember: You 
need a fully licensed version of the URL AssetStore Module to catalog from FTP 
or HTTP servers.

NOTE: TAG Files!
Cumulus can create TAG files on an FTP server while cataloging, if the Asset 
Storage module Cumulus Metadata Support is activated for the employed 
Asset Handling Set and the user, who catalogs, is allowed to save files on this 
FTP server. 

Cataloging Assets via Menu Command
You can catalog employing any valid URL pointing to a file and starting with ftp:/
/ or http://. But you may not use localhost as IP address. You may even catalog a 
folder but only if it is on an FTP server.

NOTE: User Authentication
Some FTP or HTTP servers require user authentication. In this case, the host 
address must be prefixed with a user name and password like “user:pass-
word@host”. For example, the complete URL then looks like 
“ftp://smith:secret@server.com/path/file”. 

To catalog assets from FTP or HTTP servers via menu command:

1. Open the catalog to which you want to add the assets.

2. Select File > Add Assets To Catalog . 

If you are prompted to select an Asset Handling Set for this cataloging pro-
cess, make sure, you select an Asset Handling Set that has the URL Asset-
Store activated.

If multiple Asset Storage Modules are activated in the employed Asset Han-
dling Set a dialog appears. This lists the available Asset Storage Modules. 
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One is the URL AssetStore, and others include the file system you are cur-
rently using (such as the Windows or Mac OS File System, among others).

3. Select the URL AssetStore and click OK. 

A window appears which asks for an URL.

4. Enter the URL for the asset file (or folder – on FTP only) you want to catalog.

A window appears that shows the status of the cataloging process. 
After a moment, a thumbnail for the asset appears, indicating that the cata-
loging process was successful and a record has been created for the asset.

NOTE: If you catalog many or huge files, you can save time by deactivating 
the display of the cataloging progress. Before you start cataloging, disable the 
Show Progress Bar (General section of an Asset Handling Set definition, 
under While Cataloging). 

Cataloging Assets via Drag and Drop
To catalog assets from FTP or HTTP servers via drag and drop:

1. Open the catalog to which you want to add the assets.

2. Launch your Web browser application.

3. Navigate to the asset, FTP folder or Web page which you want to catalog.

4. Select the link for the asset or FTP folder and drag it into the Cumulus Collec-
tion window. 

The progress information window appears and records are created for each 
of the assets.
If you are prompted to select an Asset Handling Set for this cataloging pro-
cess, make sure you select an Asset Handling Set that has the URL AssetStore 
activated.

Working with URL-cataloged Assets
Certain functions in Cumulus work slightly different for assets stored on FTP or 
HTTP servers. The following sections describe only these slightly different func-
tions. All of these functions are options of the Asset menu. If you open, print or 
mail an URL-cataloged asset, Cumulus first makes a copy of the asset. 
To work with assets stored on FTP or HTTP servers you need to employ an Asset 
Handling Set with URL Support activated.
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NOTE: If assets were cataloged from FTP or HTTP servers requiring a user 
authentication, the Cumulus application knows about this protection. When 
you access such an asset, Cumulus will ask you to enter user name and pass-
word. During the same session Cumulus remembers the entered name and 
password and will not ask you again if you access an asset from this FTP or 
HTTP server. 

Opening Assets 
You can open an asset stored on an FTP or HTTP server with either the applica-
tion that created the asset, or another application of your choice. Applications 
you choose are added to the menu. You can add up to four. The fifth addition 
replaces the first, and so on. You cannot manually delete any of the added appli-
cations. 
To open an URL-cataloged asset from another application:

1. Select the record whose asset you would like to open.

2. Select Asset > Edit With and select the desired application from the sub-
menu.

A dialog appears from which you can select a location for the copy of the 
asset.

3. Choose the desired location and click OK.

Cumulus copies the asset to the specified location and opens it with the 
chosen application.

Printing Assets 
You can print an asset stored on an FTP or HTTP server with either the application 
that created the asset, or another application of your choice. Applications you 
choose are added to the menu. You can add up to four. The fifth addition 
replaces the first, and so on. You cannot manually delete any of the added appli-
cations. 
To print an URL-cataloged asset from another application:

1. Select the record whose asset you would like to print.

2. Select Asset > Print With and select the desired application from the sub-
menu.

A dialog appears from which you can select a location for the copy of the 
asset.

3. Choose the desired location and click OK.

Cumulus copies the asset to the specified location and prints it with the 
chosen application.

Mailing Assets 
As with other assets you can also attach an asset stored on an FTP or HTTP server 
to an outgoing e-mail message. 
To mail an URL-cataloged asset:

1. Select the record whose asset you would like to send as an e-mail attach-
ment.
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2. Select Asset > Mail To.

A dialog appears from which you can select a location for the copy of the 
asset.

3. Choose the desired location and click OK.

Cumulus copies the asset to the specified location and asks you to select 
an e-mail application / launches your default e-mail application and 
attaches the selected asset(s) to an outgoing message.

Storing Assets on FTP Servers
The URL AssetStore Module also enables you to upload cataloged assets to FTP 
servers by using the Cumulus menu commands. It also allows you to employ FTP 
servers as the Central Asset Locations for catalogs.

Moving an Asset to an FTP Location
To move an asset to an FTP location:

1. Select the record whose asset you would like to move.

2. Select Asset > Move To.

The Select Asset Storage Module dialog opens which lists all available Asset 
Storage Modules. 

3. Select the URL AssetStore and click OK. A window for entering an URL 
opens.

4. Enter a valid FTP-URL and click OK.

Cumulus moves the asset to the selected location and updates the refer-
ence of the selected record. 

Copying an Asset to an FTP Location
To copy an asset to an FTP location:

1. Select the record whose asset you would like to copy.

2. Select Asset > Copy To.
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The Select Asset Storage Module dialog opens which lists all available Asset 
Storage Modules. 

3. Select the URL AssetStore and click OK. A window for entering a URL opens.

4. Enter a valid FTP-URL and click OK.

Cumulus copies the asset to the selected location. 

Central Asset Location on FTP Server
Each individual catalog can be configured, so that Cumulus saves a copy of each 
cataloged asset to a specific location (called a ’Central Asset Location’). This 
option allows for the quickest possible way to locate and track a catalog’s assets. 
The URL AssetStore Module enables you to employ an FTP server as a Central 
Asset Location for a catalog.

NOTE: Only the Cumulus Administrator is allowed to change the properties of 
a catalog which define the Central Asset Location. 

To set a URL as Central Asset Location:

1. Make sure the collection window containing the catalog is the active win-
dow in Cumulus.

2. Select Cumulus / Edit > Preferences. 

3. Click Catalog Settings.

The Catalog Settings window is displayed. If the active collection window 
contains more than one catalog, select the catalog you want to edit under 
Catalogs.

4. Click General. This tab includes the options on central asset location. 

Three situations are possible. The following describes the actions necessary 
for each situation.

• When the Central Asset Location Option is active and only its settings need 
to be changed, you can continue with step 5 below. 

• When a Central Asset Location is defined but not active, enable the desired 
option and continue with step 5 below. 

• When configuring a Central Asset Location for the first time, enable the 
desired option. The Select Asset Storage Module dialog opens and you can 
skip step 5. 

5. Click Browse to choose the location.
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The Select Asset Storage Module dialog opens which lists all available Asset 
Storage Modules. 

6. Select the URL AssetStore and click OK. A window for entering an URL 
opens.

7. Enter a valid URL of an existing FTP directory and click OK.

8. Click Apply to save your changes.

Working with Images
Cumulus provides special functions for users who work with images: 
• The Cumulus Image Editor makes self-service image processing easy for any-

one.
• The IPTC Information window lets you easily view and edit metadata. 
• The Digital Camera Raw Filter enables Cumulus to capture information when 

cataloging raw image formats and to preview raw image formats. 
These special functions are described in the following sections. For a description 
on how to convert cataloged images, see “Converting Image Assets,” p. 79, and 
to learn how Cumulus supports Open Prepress Interface, see “OPI System Sup-
port,” p. 212.

Editing Images
The Cumulus Image Editor makes self-service image processing easy for anyone. 
Get the quick edits you need of your cataloged images. Cumulus offers image 
cropping as well as calibration tools that can enhance the color, sharpness and 
brightness of your images.
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Image Editor
The features of the Image Editor apply to any asset that can be previewed in 
Cumulus. Start the Image Editor by selecting Asset > Image Editor.

Use the slider of the Navigator to zoom in and out the selected image. Clicking 
on the icons at the edges of the slider also zooms in and out. Double-clicking the 
navigation image optimizes the display size of the image for the window size of 
the Image Editor. The statusbar at the bottom of the window displays the zoom 
factor, the size of the image, its color space and color mode.
The various tools for image editing are offered on the toolbar. Click the icons to 
activate a tool and see its options.
To save the image modifications performed with any of the tools described in 
the following sections, click the Save icon (  ) in the Image Editor toolbar. 
Then you may define the file format and color space (and compression rate or 
image quality, if applicable for the chosen file format) for the edited image. The 
following options for saving a file are offered:
• Save as new version of asset (only available if asset versioning is enabled for 

the respective catalog, either via Vault or via File System Versioning).
• Save as new asset – creates a new asset and, if desired, assigns it as variant 

to the original asset
• Overwrite asset – replaces the original asset with the modified file
• Export to file system – saves the modified file to any place on your file system

IMPORTANT! Embedded digital photo metadata (IPTC, XMP or EXIF) that may have 
existed in the original file, will not be saved with the edited image. 

The following sections describe how each of the Image Editor tools work. 

Cropping
The Crop tool is used to reduce the visible area of an image. 
To begin cropping, click the image and draw a box around the desired area. 
Before accepting the crop, you can adjust the edges of the selection to fall 
exactly on the desired location. Simply place the cursor over one of the four side 
handles and drag to the desired location. While adjusting the cropped area, you 
can review the coordinates of the crop in the fields on the right.
You can also enter the desired size of the area to be cropped. This is useful for 
cropping an image for specific print or screen sizes, such as 4x6 or 640x480. If you 
enter a size, a box according to the dimensions is displayed and can be dragged 
over the image. To add sizes click the  button.
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You can adjust the unit of dimension by selecting pixels, inches or centimeters in 
the Unit pull-down menu.
Select the resolution for the cropped area from the Resolution pull-down menu.
Click Crop to accept the crop.
Click Cancel to exit the Crop tool.

Rotating
The Rotate tool is used to adjust the angle of an image. You can rotate by 90 
degrees clockwise and counter clockwise, and by 180 degrees. You can flip the 
image horizontally (along the vertical axis) and vertically (along the horizontal 
axis.)

TIP: 
If you want to rotate JPEG images, you might prefer to use the Trans-
form JPEG Original command in the Asset menu.

Click the button for the desired rotation.

Adjusting Brightness and Contrast, Gamma and Colors
This tool offers to adjust the tonal range of your images through brightness and 
contrast, the gamma value and colors.
Select the desired adjustment from the pull down menu. Depending on the 
selected adjustment., you are offered different options.
To see the result of your modifications in real time, activate the Live Preview 
option.
Click Apply to accept the adjustments.
Click Cancel to exit the tool.

Brightness and Contrast
It can help to correct blurry images and bring out fine details in tone. Dragging 
the sliders to the left decreases the levels of brightness and contrast; dragging 
them to the right increases the levels.
When Preserve Color option is activated, you can change brightness and con-
trast without losing color. (Only the brightness information of the image is 
affected by the modification, the color shades are left unchanged.) 

Gamma 
The gamma value of an image affects the way how its colors are perceived.
Dragging the slider to the left decreases gamma value; dragging it to the right 
increases the value.

Color
The options offered depend on the color space of the asset. 
Dragging the sliders to the left decreases the levels; dragging them to the right 
increases the levels.

Resizing
The Resize tool is used to change the size of an image. To resize an image, define 
the new width and height in the corresponding fields. To maintain the current 
proportions of width to height, activate the Keep Proportions option.
The original resolution of images is not affected by resizing with Cumulus.
Click Apply to accept the resizing.
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Click Cancel to exit the tool.

Applying Filters
Select a filter type from the pull down menu. Depending on the filter type you 
can define the strength and the radius range for the filter (1-100.) The radius 
determines how far the filter considers surrounding pixels that affect the filter 
action. Select the radius according to the image resolution.
The following filters are available:
• Average Blur Filter 

Softens an image. It smoothes transitions by averaging the color values of 
surrounding pixels. Eliminates noise where significant color transitions occur 
in an image. 

• Median Filter
Reduces noise in an image by blending the brightness of pixels. The filter 
adapts the brightness of pixels to the median brightness value of the sur-
rounding pixels. 

• Gauss Filter
Works similarly to the Average Blur filter but uses a weighted average of the 
color values of the surrounding pixels. The weighting is determined using the 
Gaussian bell-shaped curve that is generated. 

TIP: 
The Average Blur as well as the Gaussian filter decrease high-fre-
quency details and can produce a hazy effect.

• Sharp Filter
Increases the visual sharpness of images by increasing the contrast at edges. 

TIP: 
Applying the Sharp filter is recommended when scaling up images to 
keep their visual sharpness as high as possible. 

• Unsharp Mask Filter
Makes images appear sharper by increasing the contrast of small brightness 
changes.

• Add Noise Filter
Applies random pixels to an image, simulating distortion or noise. You can 
also use the Add Noise filter to give a more realistic look to heavily retouched 
areas. 

To see the result of your modifications, you can activate the Live Preview option. 
To avoid time consuming live preview recalculations, you should activate this 
option after you changed the filter parameter values. 
Click Apply to have the filter applied.
Click Cancel to exit the tool.

Using the IPTC Information Window
This section covers the basics of working with IPTC metadata and the IPTC Infor-
mation window.

Preparation Steps
In order to make use of Cumulus IPTC data management capabilities, some prep-
arations have to be made. The Cumulus catalogs in which you want to store IPTC 
data from assets have to be prepared. If you want to capture IPTC data from 
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assets and to write back IPTC data to assets, the Asset Handling Set(s) and the cat-
alog(s) managing these assets must be prepared for this feature. IPTC record 
fields have to be added to the catalog(s) and their properties have to be enabled 
for field linking. The Writing back Metadata  option must be activated in the Asset 
Handling Sets used to handle the assets containing IPTC data. 
Cumulus provides a script to help make the process of preparation easy: Prepare 
Catalog For IPTC (found in the Administration submenu of the File menu; see 
“Prepare Catalog,” p. 257 for details). As image files often contain IPTC and XMP 
metadata, we recommend preparing the catalog for XMP as well. In order to 
know what you should be aware of when working with IPTC and XMP metadata, 
see the note that follows the description on how to prepare catalogs for meta-
data in your Cumulus edition’s user guide.

NOTE: Only the Cumulus Administrator or a user who has special permissions 
is allowed to change the properties of a catalog and add record fields. 

IPTC Information Window
This Information window is specially designed for displaying and editing the IPTC 
data of assets. Cumulus can read IPTC metadata information while cataloging. 
You can view and edit this metadata and Cumulus can write your changes back 
to the asset. Cumulus' management of IPTC information conforms with the IPTC 
standard. Being considered the industry standard, its specifications are available 
to the public. Adobe Photoshop also partially uses this standard, meaning that 
text in images captioned in Photoshop’s File Info will be displayed in the IPTC 
Information window. Photoshop only uses some of the available fields the IPTC 
standard comprises. Note that even if the other fields are not displayed in Photo-
shop, they are interchangeable between Cumulus and Photoshop.

NOTE: IPTC Data back to Assets
If you want to write back IPTC data to assets, your Cataloging Options (entry 
for the IPTC filter activated) and the catalog managing these assets must be 
prepared for this feature. IPTC record fields have to be added and their proper-
ties have to be enabled for field linking. Furthermore, writing back metadata 
must be enabled in the the Writing back Metadata  section of the Asset Han-
dling Set employed for asset access ( (Preferences > Asset Handling Sets > 
Asset Access).  Cumulus provides a utility to help make the preparation pro-
cess easy: Prepare Catalog For IPTC (found in the Administration submenu 
of the File menu; see “Prepare Catalog,” p. 257 for details). The IPTC data will be 
written back to the asset when any record information is changed.

To open the IPTC Information window:

1. Click once on a record to select it.

2. Select Metadata > IPTC Information. The IPTC Information window for the 
selected asset’s record opens.

If you selected more than one record before selecting IPTC Information, the 
IPTC Information window will be opened for the selected records and will 
display only values that the selected records have in common. To see or edit 
the IPTC data of one record only, use the arrow buttons.

Once the IPTC Information window is open, you can use the arrow buttons to 
load other records of the current collection into the window. 
Information can be added by entering text into the field or selecting from lists – so 
called 'quicklists'. Some fields provide prepared lists for immediate use. For some 
fields these quicklists are preset and contain values laid down by the IPTC norm. 
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Due to IPTC standards, the preset quicklists for some of the fields can't be edited. 
The quicklists for all other fields can be edited.
To open or edit a quicklist for a field, make a right /alternate mouse click in the 
field. This opens a drop-down list for selecting a value. The fields for which you 
can edit the corresponding quicklist provide an entry Edit Quicklist. If you select 
this entry, a dialog for editing the quicklist opens. See “Editing Quicklists,” below, 
for details.
See the following overview of the options available from the IPTC Information 
window. .

view: The IPTC Information Window
C Information window provides access to the IPTC data stored on an asset. The field contents are editable depe
field type and the properties set for it. However, to edit the metadata stored you need the appropriate permi
ify records.

n the IPTC Information window: Select a record first and then select Metadata > IPTC Information 

1 Name of the field (as defined in the IPTC Standard).
2 Content of the field for the selected record.

If the field background is dark gray it cannot be edited (editable or not de
on the field type and whether Allow User to Edit is checked in the reco
properties).

3 If a field is not included in the catalog, the field’s background is dark gra
displays “Field missing”.

4 An alternate mouse click (Windows: right click; Mac OS: CTRL-click) ope
quicklist for selecting a value. Clicking the desired value copies it to the
When selecting from a quicklist, all previous text in the field will be repl
(except in the Keywords and Supplemental categories fields where new 
will be added to the existing entries). 
NOTE: If a quicklist contains more than ten values for one field, the disp
the value is split into submenus.
The fields for which you can edit the corresponding quicklist provide an
Edit Quicklist. If you select this entry, a dialog for editing the quicklist o
(See “Editing Quicklists,” p. 156 for details.) If a field contains a value tha
included in the quicklist yet, an entry Add to Quicklist is provided. Use
entry to add the current entry of the field to the quicklist.

5 Saves the changes.
6 Loads the first record from the collection window’s current selection.
7 Loads the previous record from the collection window’s current selectio
8 Loads the next record from the collection window’s current selection.
9 Loads the last record from the collection window’s current selection.
10 Opens a dialog for importing a quicklist. (See “Exporting and Importing

lists,” p. 156 for details.)
11 Opens a dialog for exporting a quicklist. (See “Exporting and Importing

lists,” p. 156 for details.)
12 Lets you choose a Metadata Template to apply pre-configured metada
13 Saves the changes and closes the windows.
14 Closes the IPTC Information window without saving changes.
15 Saves the changes without closing the window.

2

3

107 8 9

13 14 15
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Editing Quicklists
The list displays the current values for the corresponding field. You can edit or 
delete these values or add new values to the list.

To add a new value: 
Enter the new value in the field above the list and press the Enter key or click the 
Add button. You can then start typing the next entry immediately.
To edit a value: 
Select the value. The value will be displayed in the field above the list. Edit the 
value in this field and then click Replace. The value in the field will replace the 
selected value in the list.
To delete a value: 
Select the value in the list and click Delete.

Exporting and Importing Quicklists
Once you have adapted a quicklist to suit your needs, you may want to save it for 
special purposes or provide other users with. That’s why Cumulus offers you the 
option of exporting and importing quicklists. When exporting a quicklist, it is saved 
into a document of the type QLS File (file extension: qls). To make use of such an 
exported quicklist with the IPTC window, you have to import this list by opening 
the document it is saved to.

The letters mark a few examples of the various field types.
A  Most of the fields in the IPTC Information window are text fields. They a

you to enter text of one or more words. You can enter characters, numbe
special characters. The Caption and Special Instructions fields allow yo
enter several lines of text.

B  Keywords and Supplemental Categories: These fields allow you to e
number of entries consisting of one or more words. You enter a keyword
ing the word and then pressing the Enter key or clicking the Add button
can then start typing the next entry immediately. 

C IPTC Category and Country Code: These fields can only contain a 3-cha
abbreviation. The corresponding quicklist only lets you add 3 character

D These Date fields only allow values that are laid down by the IPTC norm.
this, you can only choose one of the standardized values for them after
forming a right mouse click /alternate mouse click. 

E These Time fields can either be filled from the menu opened after perfor
right mouse click /alternate mouse click or by entering a time value. If yo
a value for the time, use the format: hh:mm:sec

F Urgency and Object Cycle: These are record fields of the type String Li
can select a value from the list opened after clicking the arrow button. T
the provided values, you have to edit the record field properties (for a d
tion on how to do this, see the Administrator Guide of your Cumulus Ed

view: The IPTC Information Window

F F

C

D

D

E

E

ED
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To export a quicklist (saving it to a document): 

1. Select the  button in the IPTC Information window. 

The standard dialog for selecting a location and saving a file opens.

2. Enter a name, select a location and click Save. 

Now the list is saved and can be imported.
To import a quicklist:

1. Select the  button in the IPTC Information window. 

2. The standard dialog for choosing a file opens. 

3. Select the desired list and click Open. 

Your quicklist will then be available in the IPTC Information window. 

Working with Raw Images
Cumulus supports raw image formats of a wide array of digital cameras. You can 
find and organize raw image formats efficiently. Cumulus can extract metadata 
of raw image formats and store it in Cumulus catalogs. Additionally, EXIF infor-
mation (camera settings, date, aperture and shutter speed etc.), and depending 
on the camera model, annotations and GPS are also captured when cataloging. 
Even Canon thumbnail files (THM) are supported. Converting assets stored in raw 
image format to JPEG and TIFF images on-the-fly is a breeze with Cumulus. 
The Digital Camera Raw Filter enables Cumulus to capture information when cat-
aloging raw image formats and to preview raw image formats. The captured 
information will be stored in Cumulus record fields. 
The Digital Camera Raw Filter can capture metadata from the different raw 
image formats defined by leading camera manufacturers, namely, Canon, Fuji, 
Kodak, Minolta, Nikon, Olympus, Sigma, Sinar and Sony. Check Canto’s website 
for a detailed list of which cameras are supported.
Most cameras supporting Canon CRW files create additional thumbnail files 
(THM files). The Canon Raw Metadata Support enables Cumulus to capture meta-
data from these files and to manage these files. For more information, see “Canon 
DC Raw Image & Thumbnail File,” p. 159

Cataloging Raw Image Formats
When cataloging raw image formats, your catalogs and Asset Handling Sets have 
to be prepared for this. The catalogs in which you want to manage your raw 
images must provide the corresponding record fields to store the special raw 
image information and the Asset Handling Sets you want to employ must have 
the Digital Camera Raw Filter activated. Its format entries must be in a certain 
sequence to achieve best results. 
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Captured Information
When cataloging, the Digital Camera Raw Filter can capture the following infor-
mation from your raw images:

Of course the filter can only capture the information contained in the cataloged 
images. The captured information will be stored in Cumulus record fields. The 
corresponding record fields have to be included in the catalog to which you 
want to add the raw images.
Some of the fields above may not be active in the catalog to which you want to 
add the raw images. To include them in a catalog, you have to add the corre-
sponding fields to the Record Fields in the Catalog Settings dialog before cata-
loging your documents or updating your records. (For details on how to add 
record field to a catalog, see the Administrator Guide.) Note that only the Cumu-
lus Administrator or a user who has the appropriate permissions is allowed to 
change the settings of a catalog and add record fields. 

Format Entry Order
The Digital Camera Raw Filter is the only Cumulus filter that can read raw images. 
However, the entry numbers of the formats supported by this filter are important. 
When cataloging, Cumulus starts searching for matching formats at the lowest 
entry number. It employs the formats according to their entry numbers (lowest 
entry number first). If you want the Digital Camera Raw Filter to be employed for 
assets, check the order of the format entries in the Asset Handling Set you use for 
cataloging.
In order to ensure the Digital Camera Raw Filter works ideally for cataloging 
assets, you have to move the entries for the formats supported by it up in the list, 
so that they are at least before the first format supported by the TIFF Filter. The 
Sinar DC Raw Image Format should have a lower entry number than the first for-
mat supported by the Photoshop Filter.

Defining Filter Properties
The Digital Camera Raw Filter allows you to define properties for the different for-
mats supported by this filter.
• Canon DC Raw Image (extension: crw, Mac File Type: CCDR)
• Fuji DC Raw Image (extension: raf, Mac File Type: RAF *)
• Kodak DC Raw Image (extension: dcr, Mac File Type: KDCR)
• Minolta DC Raw Image (extension: mrw, Mac File Type: MRW *)
• Nikon DC Raw Image (extension: nef, Mac File Type: NEF *)
• Olympus DC Raw Image (extension: orf, Mac File Type: ORF *)
• Sigma DC Raw Image (extension: x3f, Mac File Type: FOVb)
• Sinar DC Raw Image (extension: sti, Mac File Type: TIFF)
• Sony DC Raw Image (extension: srf, Mac File Type: SRF *)

* Mac File Types with 3 characters only end with a space
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These properties are important for cataloging and previewing. For cataloging 
they are important only if you have activated the option Entire Asset under Cre-
ate Thumbnail from on the Thumbnail tab of the Asset Handling Set employed 
for cataloging. Then the values set for the color settings and the color interpola-
tion are used for creating the thumbnail.
For the previewing of each of the formats, you can define the source for a pre-
view (thumbnail or entire image). If the source for the thumbnail to be created 
or the preview to be shown is the entire asset, the color settings and the color 
interpolation can be set.
For details on how to define these properties, see the Cumulus Filters Guide.

Canon DC Raw Image & Thumbnail File
Most cameras supporting Canon CRW files create additional thumbnail files. 
Along with a 160 x 120 JPEG thumbnail of the original image in the associated 
CRW file, these files contain the EXIF information and optionally IPTC information. 
They always have the same name as the original CRW file, but with a THM file 
extension.
Cumulus supports these THM files. If the Canon Raw Metadata Support is acti-
vated in the Asset Handling Set employed for the CRW image, the THM files are 
treated as follows:
• If an image of this format is cataloged, the associated THM file will not be cat-

aloged but the information it contains will be captured by Cumulus and 
stored in the record for the image.
NOTE: If the Canon Raw Metadata Support is activated when cataloging, 
you get a list displayed that informs you of the THM files that have not 
been cataloged. 

• If you employ Cumulus to manage the cataloged image (copy, move, e-mail 
or delete), the associated THM file will be processed as well. Only when you 
employ the special copy function to select a category and then copying the 
associated assets by dragging this category on your desktop, the THM files 
will not be copied as well. 

• If you rename the assets employing the Cumulus Rename To function, the 
THM files will not be renamed as well.

The Canon Raw Metadata Support is activated by default. If you want to deacti-
vate it for certain Asset Handling Sets, see “(De)activating Asset Handling Mod-
ules,” p. 206.
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Working with Office Documents
Cumulus provides special support for documents of certain office systems. This 
special support is based on specific support modules.
Special support is provided for documents of the following office systems:
• 2007/8 Microsoft Office System or later
• Microsoft Office (2003 or prior for Windows, 2004 or prior for Mac OS)
• Apple iWork 
• OpenOffice.org
When cataloging, Cumulus can capture all office document information such as 
author, dates and version, and even all text contained in the document. 
If you have installed PowerPoint on the Client machine, the Cumulus PowerPoint 
Filter will create high quality previews and thumbnails for PowerPoint assets. You 
can also create new presentations out of your cataloged single slides directly in 
Cumulus. When you are working with Microsoft PowerPoint, Cumulus allows you 
to insert cataloged assets into presentations. For more details see “PowerPoint 
Support,” p. 164, and “The PowerPoint Add-In,” p. 166.

Special Modules for Office Documents
The special modules for office documents are:

• AssetStore modules for office documents
• AssetProcessor modules for presentations 
• Filter modules for office documents
• Add-Ins for PowerPoint presentations

Note that some of these are optional add-ons which may not be available with 
your Cumulus configuration.

Asset Store Modules for Office Documents
Some of the special AssetStores for office documents enable Cumulus to create 
records for pages, sheets or slides of office documents. These records are created 
in addition to a record for the entire document. Other special AssetStores enable 
Cumulus to create one record for each picture embedded in an office document 
while cataloging. All these records are created in addition to a record for the 
entire document and in addition to separate records for pages or slides. The 
records will be assigned to the corresponding document as “related sub asset”. 
A category for each document will automatically be created and the records are 
assigned to these categories. For further details on such AssetStores, see “Asset 
Storage Modules,” p. 206.

NOTE: If none of the special AssetStores is activated for the Asset Handling Set 
used, Cumulus will just create one record for the entire asset.

NOTE: Apple QuickTime must be installed on your Windows system to extract 
previews for some file formats embedded in Microsoft Office for Mac OS X doc-
uments. 

Asset Processor Modules for Presentations 
The MS PowerPoint Asset Processor and Office Open XML Presentation Proces-
sor enable the user to create PowerPoint presentations from selected Power-
Point assets (slides, presentations) and image assets within Cumulus. For further 
details on such Asset Processors, see “Asset Processor Modules,” p. 211. (For more 
information on how to use the PowerPoint/Presentation Asset Processors, see 
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“Creating Presentations,” p. 86.)

Cumulus Office Document Filters
The office document filters can capture: 
• Document description information (such as Title, Subject, Keywords, Head-

ings ...) 
• Document origin information (such as Author, Document Creation Date, 

Revision Information) 
• Document text
• Custom document properties as defined by a user

NOTE: All office document filters support AXR (Asset Cross References). 

The following formats are supported by Cumulus office document filters:

File Format Exten-
sion

Mac File 
Type

Cumulus Filter

Apple Pages pages Apple iWork Filter

Apple Keynote key     Apple iWork Filter

Apple Keynote Slide     Apple iWork Filter

MS Office Binder Wizard obz Compound Document Fil-
ter

MS Office Binder Template obt Compound Document Fil-
ter

MS Access Project adp Compound Document Fil-
ter

MS Access Wizard mdz Compound Document Fil-
ter

MS PowerPoint Add-In ppa PPPA Compound Document Fil-
ter

MS PowerPoint Wizard pwz Compound Document Fil-
ter

MS PowerPoint Template pot PPOT Compound Document Fil-
ter

MS PowerPoint Show pps PPSS Compound Document Fil-
ter

MS PowerPoint Slide ppt SLD3 Compound Document Fil-
ter

MS PowerPoint Presentation ppt SLD8 Compound Document Fil-
ter

MS Excel Add-In xla XLA8 Compound Document Fil-
ter

MS Excel Template xlt sLS8 Compound Document Fil-
ter

MS Excel Document xls XLS8 Compound Document Fil-
ter

MS Word Wizard wiz Compound Document Fil-
ter

MS Word Template dot W8TN Compound Document Fil-
ter

MS Word Document doc W8BN Compound Document Fil-
ter
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MS Outlook Item msg Compound Document Fil-
ter

MS Outlook Item Template oft Compound Document Fil-
ter

Compound Document Format Compound Document Fil-
ter

MS Picture It! Image mix Compound Document Fil-
ter

Text Document docx/
docm

Office Open XML Filter

Text Template dotx/
dotm

Office Open XML Filter

Spreadsheet Workbook xlsx/
xlsm/xlsb

Office Open XML Filter

Spreadsheet Workbook Tem-
plate

xltx/xltm Office Open XML Filter

Spreadsheet XLSX Office Open XML Filter

Presentation pptx/
pptm

Office Open XML Filter

Presentation Template potx/
potm

Office Open XML Filter

Presentation Show ppsx Office Open XML Filter

Presentation Slide SLDX Office Open XML Filter

XPS Document xps Office Open XML Filter

XPS Page XPSP Office Open XML Filter

Open Document Text odt     Open Document Format 
Filter

Open Document Text Template ott     Open Document Format 
Filter

Open Document Spreadsheet ods     Open Document Format 
Filter

Open Document Spreadsheet 
Template

ots     Open Document Format 
Filter

Open Document Presentation odp     Open Document Format 
Filter

Open Document Presentation 
Template

otp     Open Document Format 
Filter

Open Document Drawing odg     Open Document Format 
Filter

Open Document Drawing Tem-
plate

otg     Open Document Format 
Filter

Open Document Formula odf     Open Document Format 
Filter

Open Document Master Docu-
ment

odm     Open Document Format 
Filter

Open Document Database odb     Open Document Format 
Filter

OpenOffice 1.0 Text sxw     Open Document Format 
Filter

File Format Exten-
sion

Mac File 
Type

Cumulus Filter
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Some office document filters have properties that you can change. The range of 
options depends on the filter. For details on how to define the properties of fil-
ters, see the Cumulus Filters Guide.

Configuring 
To have the fully functional range of Cumulus for office documents available, the 
Cumulus catalogs in which you want to store special additional information on 
cataloged documents have to be prepared. (See “Preparing Catalogs,” below, for 
details.)

Preparing Catalogs
Of course the office document filters can only capture the information contained 
in the cataloged documents. The captured information will be stored in Cumulus 
record fields. The corresponding record fields have to be included in the catalog 
to which you want to add the office documents. 
Some of the fields ’fed’ by the special office filters and support modules may not 
be active in the catalog to which you want to add the documents. To include 
them in a catalog, you have to add the corresponding fields to the Record Fields 
in the Catalog Settings dialog before cataloging your documents or updating 
your records. (For details on how to add record field to a catalog, see the Admin-
istrator Guide.) Note that only the Cumulus Administrator or a user who has the 
appropriate permissions is allowed to change the settings of a catalog and add 
record fields. 

OpenOffice 1.0 Text Template stw     Open Document Format 
Filter

OpenOffice 1.0 Spreadsheet sxc     Open Document Format 
Filter

OpenOffice 1.0 Spreadsheet 
Template

stc     Open Document Format 
Filter

OpenOffice 1.0 Presentation sxi     Open Document Format 
Filter

OpenOffice 1.0 Presentation 
Template

sti     Open Document Format 
Filter

OpenOffice 1.0 Drawing sxd     Open Document Format 
Filter

OpenOffice 1.0 Drawing Tem-
plate

std     Open Document Format 
Filter

OpenOffice 1.0 Formula sxm     Open Document Format 
Filter

OpenOffice 1.0 Master Docu-
ment

sxg     Open Document Format 
Filter

MS PowerPoint Template pot PPOT PowerPoint Filter

MS PowerPoint Show pps PPSS PowerPoint Filter

MS PowerPoint Presentation ppt SLD8 PowerPoint Filter

MS PowerPoint Slide ppt SLD3 PowerPoint Filter

File Format Exten-
sion

Mac File 
Type

Cumulus Filter
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Cataloging Outlook Messages
Cumulus lets you catalog mail messages stored in the Microsoft Office Outlook 
Message Format (file extension: msg) and all attachments or embedded images 
as separate assets along with it. The Compound Document Filter will capture 
mail addresses to the record fields Email CC, Email From, Email To and the text 
of the message to the Document Text record field. 
The Outlook Message AssetStore enables Cumulus to create one record for each 
attachment or embedded image of a Microsoft Office Outlook message while 
cataloging – in addition to creating a record for the message. These records will 
be assigned to the corresponding message as “related sub assets”. A category for 
each message will automatically be created and the images’ and attachments’ 
records are assigned to these categories. The record name of an attachment or 
an embedded image is the name of the image as saved with the message. 
To have the full support for Outlook messages, you must use an Asset Handling 
Set that has the Outlook Message AssetStore activated for cataloging and the cat-
alog must provide the corresponding record fields. (For details on how to add 
record fields to a catalog, see the Administrator Guide. For a description on how 
to customize an Asset Handling Set see “Editing An Asset Handling Set,” p. 200.)

PowerPoint Support
This section covers the basics of working with the Cumulus PowerPoint support 
modules for Windows and Mac OS X. It describes how to catalog PowerPoint 
presentations including slides, how to work with cataloged slides in Cumulus 
and how to import cataloged graphic files and slides directly into Microsoft Pow-
erPoint presentations. 
For information on how to use the Presentation Asset Processors to create Pow-
erPoint presentations from selected PowerPoint assets (slides, presentations), 
image assets and previews of other asset formats within Cumulus, see “Creating 
Presentations,” p. 86.

Formats and Requirements
Cumulus offers different modules for supporting the different PowerPoint for-
mats:
• The MS PowerPoint AssetStore, the MS PowerPoint Picture AssetStore and 

the PowerPoint Filter handle presentations in PowerPoint 97-2004 format 
(*.ppt). 
To have full support for files of this format, a Microsoft PowerPoint installation 
is required on the computer where you are working. Microsoft PowerPoint 

97/2000/XP/2003/2007/2010 or 2004/2008 is required. 
• The Office Open XML Pages and Slides AssetStore, the Office Open XML 

Pictures and Media AssetStore and the Office Open XML Filter handle pre-
sentations in Office PowerPoint 2007/8 format (*.pptx and *.ppsx). If you are 
working with Office PowerPoint 2007/8 formats, a PowerPoint installation is 
not required – unless you want to generate high quality previews or thumb-
nails for slides.

The PowerPoint support AssetStore modules enable Cumulus to create records 
for slides as well as for images and objects embedded in a presentation. The 
PowerPoint support filter modules create high quality previews and thumbnails 
if the corresponding PowerPoint application is installed on the Client machine.
Most Cumulus PowerPoint support modules run on Windows and on Mac OS X. 
Under UNIX, only the Office Open XML Presentation Processor and the docu-
ment filters (Compound Document and Office Open XML) are available. 
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The fact that some PowerPoint support components employ Microsoft Power-
Point in the background may sometimes result in slow performance of some 
functions.

Employing the PowerPoint Support Filter Modules
The PowerPoint support filter modules (PowerPoint Filter, Office Open XML Fil-
ter) deliver better thumbnail and preview quality for PowerPoint assets than the 
Compound Document Filter, but the Compound Document Filter is faster, does 
not require PowerPoint and works on all platforms. To employ the PowerPoint 
support filter modules for cataloging those formats it supports, you have to 
move the format entries up in the list at least before the corresponding entries 
of the Compound Document Filter.

BACKGROUND INFORMATION:  
When cataloging, Cumulus starts searching for matching formats. 
Cumulus employs the formats according to their entry numbers (low-
est entry number first) in the Asset Formats list of the employed Asset 
Handling Set. 

NOTE: for Mac OS X only 
For PowerPoint 2008 assets (*.pptx and *.ppsx) numbered thumbnails will be 
created for slides, no individual ones. Previewing a slide will display its thumb-
nail. These restrictions are due to the fact that Microsoft decided to remove the 
VBA/OLE technology from Office 2008 for Mac OS X. 

Cataloging the Slides of a Presentation
To catalog the slides of a PowerPoint presentation, you simply catalog the Pow-
erPoint presentation file – using an Asset Handling Set that has the correspond-
ing office AssetStore(s) activated. Then Cumulus will automatically catalog the 
presentation and all slides contained. A root category named PowerPoint is then 
automatically created as well as a subcategory with the same name as the pre-
sentation. All slides will be assigned to the presentation’s category. If the slides 
contain embedded pictures or other media and the corresponding Picture or 
Pictures and Media AssetStore is activated, a record of embedded media will be 
created. A subcategory for each slide of the presentation file is automatically cre-
ated and the media’s records are assigned to these categories.
Records for the PowerPoint presentation file and each of its slides will be created, 
indicating that the cataloging process was successful.

NOTE: No Individual Thumbnail!
If no individual thumbnail was created for a slide’s record – although Power-
Point is installed –, the reason could be that the slides contain one or several 
media that can’t be opened by the PowerPoint application (e.g. linked images 
or embedded objects). If such an individual record could not be created, a 
default thumbnail is used. For PowerPoint 2007 assets (*.pptx and *.ppsx) the 
slide number is added to the thumbnail embedded in the presentation. 

Working with Records of Slides
Certain functions in Cumulus work slightly differently for records of PowerPoint 
slides. The following sections describe only these specific functions.
• Showing Location

If you select Asset > Show Location for the record of a cataloged slide, 
Cumulus opens the presentation in PowerPoint and displays the selected 
slide – if the corresponding PowerPoint application is installed on the com-
puter running the Cumulus Client.
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• Copying Slides or Creating New Presentations
If you select Asset > Copy To for the record of a cataloged PowerPoint slide 
and select a folder as the destination, Cumulus creates a new presentation 
containing the selected slide. If you select an existing presentation as the 
destination, Cumulus adds the selected slide at the end of the presentation 
if the corresponding PowerPoint application is installed on the computer 
running the Cumulus Client.

• Deleting 
If you select Edit > Delete for the record of a cataloged PowerPoint slide and 
select the option Delete Record and Asset, the selected slide will be deleted 
from the catalog as well as from the presentation (with PowerPoint 97-2004 
format (*.ppt) only.)

The PowerPoint Add-In 
The Cumulus PowerPoint Add-In enhances your Microsoft PowerPoint applica-
tion with additional functions. It enables you to import cataloged slides, pictures 
and media from Cumulus into Microsoft PowerPoint presentations. You may 
import all picture and media formats which PowerPoint supports. 
These functions are accessible within the PowerPoint application. They are 
added as an icon to the toolbar  and as options to the menus. Different ways 
are offered to import cataloged assets: 
• via the Insert menu options 

Slides from Cumulus or Picture > From Cumulus
• via the toolbar: 

Example of a cataloged PowerPoint presentation and its slides.

The name of the presentation is Example. You can see the record created for the pre-
sentation file and the records created for each slide. The records of the slide are all 
named Slide ... of Example.ppt. The file format of the cataloged slides is MS Pow-
erPoint Slide and the file format for the presentation file is MS PowerPoint Presen-
tation. The thumbnail for the presentation file is the thumbnail of the first slide.

A root category named PowerPoint has been created as well as a subcategory 
named the same as the presentation file: Example.ppt. The records of the slides have 
automatically been assigned to this subcategory.
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NOTE: Drag and Drop without Add-In
– Microsoft PowerPoint 2008 supports drag & drop of cataloged pictures 
and media from Cumulus into the PowerPoint application. Click the ALT key 
and drag & drop the record into the PowerPoint presentation. 
– Microsoft PowerPoint 2007 supports drag & drop of cataloged pictures 
and media from Cumulus into the PowerPoint application. 

Integrating the PowerPoint Add-In 
The installation and integration of the Cumulus PowerPoint Add-In is different for 
the each operating system. 

Under Windows
Under Windows the Cumulus PowerPoint Add-In is available for Microsoft Pow-
erPoint 97/2000/XP/2003/2007/2010 (32-bit only). It can be installed and inte-
grated with the standard Cumulus Client installation process. If the PowerPoint 
Add-In option of the Choose Install Set dialog was activated during installation, 
the Cumulus menu entries and icons will be available in PowerPoint application. 
But you can also install and integrate the add-in later. For this purpose Canto pro-
vides a script for installation. This script as well as one for uninstalling can be 
found in the corresponding language subfolder of the PowerPoint folder in the 
Adapters folder inside the Cumulus Client installation folder, e.g. C:\Program 
Files\Canto\Cumulus Client\Adapters\PowerPoint\en 
Any script has to be executed with administrator permissions. Use right-click to 
invoke them.
Use the script InstallAddin.cmd to install the Cumulus PowerPoint Add-In. The 
Cumulus PowerPoint Add-In will be installed for all users on the machine and the 
Cumulus menu entries and icons will be available to any user of the PowerPoint 
application. To uninstall the add-in, use the UninstallAddin.cmd script. 

NOTE: Macro Security of Microsoft PowerPoint
For adding the Cumulus PowerPoint Add-In, the macro security level of your 
PowerPoint application must either be set to medium or low. To set the secu-
rity level, you have to open your PowerPoint application and select Tools > 
Macro > Security. 

Under Mac OS X
To integrate the Cumulus PowerPoint Add-In with the PowerPoint application of 
MS Office:

1. Open your PowerPoint application.

2. Select Tools > Add-Ins. A dialog opens that lists all available Add-Ins for your 
PowerPoint installation.

3. Click the Add button. A standard dialog for selecting opens.

4. Navigate to the Adapters folder of your Cumulus Client installation folder. 
Open the Adapters folder, then the PowerPoint folder and finally the en 
folder. Select Import from Cumulus and click Open.

The list with all available Add-Ins for your PowerPoint installation is displayed 
and now contains the entry Import from Cumulus. Make sure the Import 
from Cumulus checkbox is activated.

If a warning appears that it is dangerous to install any macros, click Enable 
Macros.

5. Click OK. 
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Now your PowerPoint application is aware of the Cumulus PowerPoint Add-In 
and the menu entries and icons will be available accordingly. 

Importing Cataloged Slides, Images or Objects
You can import cataloged slides, images and objects (media) from Cumulus into 
Microsoft PowerPoint presentations. You may import all image and object for-
mats which PowerPoint supports.
When you import cataloged slides, they are always added at the end of the cur-
rent presentation and the layout of the master slide is applied. When you import 
cataloged images or objects, they are inserted into the current slide. To import 
cataloged slides, images or objects:

1. Start your Cumulus application if it is not already running.

2. Select the record of the asset to be imported.

NOTE: Cumulus must have access to the assets – wherever it is stored: on 
your hard disk, in Cumulus Vault, on an FTP server... 

3. Open the PowerPoint presentation to which you want to add the cataloged 
asset.

4. If you are importing pictures or media:
Select the slide in which you want to place the picture or media.

5. Click on  or select 
Insert > Slides from Cumulus or 
Insert > Picture > From Cumulus
(in 2007/8 MS Office System to be found on the Add Ins tab).

NOTE: For Cumulus Vault Users Only!
If the asset is stored in Cumulus Vault and the option Ask for Version to 
Get is activated Cumulus will prompt you to select the version. 

You are asked whether images or objects should be embedded or linked. 

Embedded images and objects will be stored with the presentation whereas 
linked ones require access to the files themselves to be displayed. (For more 
information on linked and embedded objects, see the background informa-
tion below.

6. Click the desired button.

The asset will be inserted into the current slide.
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NOTE: You may also select multiple assets to be imported. Cascading files will 
be inserted on top of each other in the same order as viewed in Cumulus (last 
on top.) 

BACKGROUND INFORMATION:  Linked and Embedded Objects
The main differences between linked objects and embedded objects 
are where the data is stored and how it is updated after it is placed. 
Linked: When an object is linked, information is updated if the source 
file was updated. Linked data is stored in the source file only. The pre-
sentation stores only the location of the source file and displays a rep-
resentation of the linked data. Use linked objects if file size is a 
consideration. But be aware that you have to copy the linked objects 
separately if you copy the presentation to another storage media or 
computer.
Embedded: When an object is embedded, information in the presen-
tation doesn't change if you modify the source file. Embedded objects 
become part of the presentation and, once inserted, are no longer 
part of the source file. 

Slide of a PowerPoint presentation with pictures 
imported from Cumulus (in Palette Mode).
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Working with InDesign Documents
Cumulus provides special support for InDesign documents. This support is based 
on specific modules which allow:
• multipage previews 
• separate records for pages
• full text search in captured document text
• detection of contained and referenced assets
Cumulus’ enhanced support for InDesign documents is provided for documents 
of InDesign version 1.x, 2, CS, CS 2, CS 3, CS 4 and CS 5.
When cataloging, Cumulus can capture general document information. If you 
have installed the Cumulus Plug-in for Adobe InDesign on the machine where 
the InDesign documents are created and edited, Cumulus can also capture spe-
cific document information. (See “Plug-in for InDesign,” below, for details.)

Special Modules for InDesign Documents
The special modules for InDesign documents are:
• Plug-in for Adobe InDesign
• InDesign AssetStore module
• InDesign Filter module

Note that some of these are optional add-ons which may not be available with 
your Cumulus configuration.

Plug-in for InDesign
The Cumulus Plug-in for Adobe InDesign enables Cumulus to embed the meta-
data of an InDesign document into the XMP (EXtensible Metadata Platform) part 
of the document. The Cumulus InDesign Filter and InDesign AssetStore can 
make use of such metadata and capture information on InDesign documents 
when cataloged or previewed. The InDesign AssetStore requires such metadata 
to extract pages in order to provide separate records for these pages.

Installing the InDesign Plug-in
The Cumulus Plug-in for Adobe InDesign has to be installed on each computer 
where the InDesign documents you want to catalog are created or edited.
The Cumulus Plug-in for Adobe InDesign is provided with any Cumulus standard 
installation. You find them in the Adapters folder in your Cumulus installation 
folder. 
Under Windows different files or folders are provided for the different Adobe 
InDesign versions:
• InDesign CS5.5 (CumulusDocWatch CS5.5.pln)
• InDesign CS5 (CumulusDocWatch CS5.pln)
• InDesign CS4 (CumulusDocWatch CS4.pln)
• InDesign CS3 (CumulusDocWatch CS3.pln)
• InDesign CS2 (CumulusDocWatch CS2.pln)
• InDesign CS (CumulusDocWatch CS.pln)
• InDesign 2 (CumulusDocWatch 2.pln)
• InDesign 1.x (CumulusDocWatch 1.x.pln)
Under Mac OS, different files are provided for the different Adobe InDesign ver-
sions:
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• InDesign CS5.5 (CumulusDocWatch CS5.5.InDesignPlugin)
• InDesign CS5 (CumulusDocWatch CS5.InDesignPlugin)
• InDesign CS4 (CumulusDocWatch CS4.InDesignPlugin)
• InDesign CS3 (CumulusDocWatch CS3.InDesignPlugin)
• InDesign CS2 (CumulusDocWatch CS2.pln.framework)
• InDesign CS (CumulusDocWatch CS)
• InDesign 2 (CumulusDocWatch 2)
• InDesign 1.x (Mac OS: CumulusDocWatch 1.x)
To install the plug-in for Adobe InDesign:

1. Copy the CumulusDocWatch file for your InDesign version to the Plug-Ins 
folder of the Adobe InDesign installation.

Captured Information 
The Cumulus Plug-in for Adobe InDesign stores the following information from 
an InDesign document to a Cumulus TAG file: 
• Document Text
• Font Names 
• Image Height 
• Image Width
• Number Of Pages 
• Number Of Layers 
• Preview/Thumbnail of the first page (InDesign version 2.0 or later)
• Preview/Thumbnail of all pages (InDesign version CS2 or later)
• Software 
• Related Sub Assets (called ’Contained Assets’ in versions prior to Cumulus 7)
With CS2 or later a TAG file provides the information for a multipage preview of 
an InDesign asset to the InDesign Filter.

InDesign AssetStore Module
Based on the information stored in the TAG file (created by the Cumulus Plug-in 
for Adobe InDesign), the InDesign AssetStores enables Cumulus to create one 
record for each page of the InDesign document during the cataloging process. 
All these records are created in addition to creating a record for the entire docu-
ment. The records will be assigned to the corresponding document as “con-
tained”. A category for each document will automatically be created and the 
records are assigned to these categories.
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NOTE: If InDesign AssetStore is not activated for the Asset Handling Set used, 
Cumulus will just create one record for the entire asset.

InDesign Filter
The Cumulus Filter for Adobe InDesign captures the following information from 
an InDesign document:
• File Format 
• Horizontal Resolution 
• Thumbnail 
• Vertical Resolution 
Based on the information stored in the TAG file (created by the Cumulus Plug-in 
for Adobe InDesign), the InDesign Filter can also capture the following informa-
tion:
• Document Text
• Font Names 
• Image Height 
• Image Width
• Number Of Pages 
• Number Of Layers 
• Thumbnail
• Software 
• Related Sub Assets (with versions prior to Cumulus 7 called ’Contained 

Assets’)

The Category pane on the left includes a category for the document and 
the Record Pane on the right displays the records of a cataloged Indesign 
document and pages it contains. 
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Defining Filter Properties
The Cumulus InDesign Filter allows you to define properties of assets cataloged 
with this filter. Under Preferences > Asset Handling Sets > Asset Formats tab, 
select the InDesign Filter entry and click on Properties. The Filter Setup dialog 
opens. 

You can decide whether the thumbnail and preview for an asset should be cre-
ated from page or spread. Note that thumbnail and preview creation is only pos-
sible for the entire document and not for induvidual pages. Another setup 
definition enables Cumulus to extract the text contained in the file to the Docu-
ment Text record field. If this option is activated, you can enter the maximal 
number of characters you want to extract. 

Configuring 
To have the fully functional range of Cumulus for InDesign documents available, 
some configurations have to be made:
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• The Cumulus catalogs in which you want to store special additional informa-
tion on cataloged documents have to be prepared. (See “Preparing Cata-
logs,” below, for details.)

• Windows and Mac OS X only:
To capture additional information while cataloging, the Cumulus plug-in for 
Adobe InDesign has to be installed on each computer where the InDesign 
documents you want to catalog are created. (See “Installing the InDesign 
Plug-in,” p. 170, for details.)

• The Asset Handling Set(s) used for cataloging InDesign assets must be set up 
for optimized InDesign support. (See “Optimizing Asset Handling Sets for 
InDesign Support,” below, for details.)

Preparing Catalogs
Of course, Cumulus can only capture the information contained in the cataloged 
assets. The captured information will be stored in Cumulus record fields. The cor-
responding record fields have to be included in the catalog to which you want 
to add the assets.

Some of the fields “fed” by the special InDesign modules may not be active in the 
catalog to which you want to add the InDesign documents. To include them in 
a catalog, you have to add the corresponding fields to the Record Fields in the 
Catalog Settings dialog before cataloging your documents or updating your 
records. (For details on how to add record fields to a catalog, see the Administra-
tor Guide.) Note that only the Cumulus Administrator or a user who has the 
appropriate permissions is allowed to change the settings of a catalog and add 
record fields. 

Optimizing Asset Handling Sets for InDesign Support
To optimize an Asset Handling Set for InDesign support:
• Activate the InDesign Filter and define its properties (as described above.)
• Activate the InDesign AssetStore module (in order to have separate records 

for the document pages.)
• Activate the Cumulus Metadata Support module in order to have Cumulus 

TAG files created by the InDesign Plug-in properly handled (recognized as 
special metadata files: not cataloged and when you copy, delete or move an 

Record fields that a catalog optimized 
for InDesign support should include.
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asset, Cumulus takes care of its TAG file at the same time, treating it accord-
ingly.) 

Further Special InDesign Support
The following modules also provide special support for InDesign documents:
• Cumulus AXR™ (Asset Cross References) is able to detect links and place 

assets in Adobe InDesign documents. Note when using Cumulus Work-
group, the referenced assets must be cataloged before Cumulus can detect 
them.

• The HELIOS Filter supports HELIOS XPV preview files. This enables Cumulus to 
provide multipage previews for Adobe InDesign documents. If an XPV pre-
view file for such a document is available, the HELIOS Filter will extract the 
data that Cumulus requires to provide a multipage preview. 

• The CumulusXMP (Extensible Metadata Platform) Filter extends Cumulus' 
functionality, when adding XMP files (e.g. Adobe Sidecar) to your catalogs. 
This filter is primarily employed as sub filter for embedded XMP data in any 
file format like PDF, JPEG, TIFF and Adobe Photoshop, Illustrator and InDe-
sign. This means first the filter for the file format is invoked and then this filter. 

Assigning Individual Permissions for Records and 
Categories 

User permissions can be defined for individual asset records, categories and even 
subcategories. Permissions Templates enable you to assign, remove or explicitly 
set asset or category permissions for users or entire groups at once. Make an 
asset record (or category) selection and choose a template to apply. This greatly 
reduces the tedium of making permission assignments to individual asset 
records or categories. 

Optional feature! May not be available with your Cumulus configuration.

Individual Record/Category Permissions 
This feature enables you to assign individual permissions to selected records or 
categories. These permissions can expand the record or category permissions set 
for a user (or user group) for the catalog in general. For each record and category, 
you can define permissions for functions and the users who are allowed may per-
form the allowed functions. For categories, you can also pre-define the permis-
sions for subcategories created under the selected category. 
The individual record or category permissions are always added to the permissions 
a user has in general for all records and categories of the catalog. A user’s permis-
sions cannot be reduced by individual record or category permissions. If a user is 
given an Application permission for the records or categories of a catalog, he/she 
will have this permission – no matter if this permission is set with individual record 
or category permissions or not.

EXAMPLE: 
You have a student working with you temporarily. This person is 
allowed to open all catalogs, but is not allowed to delete records from 
any of the catalogs. For testing purposes, you can give this person the 
Delete Record permission for selected records only.
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Cumulus provides a Properties dialog for each record and category where you 
can define the permissions. You define which users are allowed to perform 
selected functions. The functions for records and categories are different.

With User Manager in standard mode, you can assign specific users to the record 
or category permissions you define. With User Manager in advanced mode, you 
can also assign roles to the permissions for the selected record/categories. When 
assigning roles, a list of available roles is displayed for selection. When assigning 
users, you can use search criteria to get a list of available users. The possible 
search criteria depend on the authentication method. With the Cumulus Built-in 
and LDAP authenticators, you can search for login names by default. The System 
authenticator is not supported for user identification. The search criteria for both 
the Cumulus Built-in and LDAP authenticators, can be configured. (For details, 
see page 178.)
Assigning permissions to selected records can only be done by users who are 
given the permission Modify Record Permissions for the selected records. The 
same goes for categories: assigning permissions to selected categories can only 
be done by users who are given the permission Modify Category Permissions 
for the selected categories. 
You can allow users to modify record and/or category permissions in general by 
assigning them the Application permissions Modify Record Permissions and/or 
Modify Category Permissions (User Manager: User/Role Properties > Permis-
sions > Application Permissions.) These Application permissions can be 
restricted to certain catalogs only.

Additional Information on Category Permissions
• Categories Representing Catalogs

The properties for a category representing a catalog (a “root” category) do 
not provide a Permissions tab. Because such a category is on the highest hier-
archical category level, only child permissions can be defined for it. (For 
details on child permissions, see “Permissions for Subcategories,” p. 176.)

• Moving Categories
To move a category, the user needs the permission Modify Category for the 
category to be moved and the permission Create Category for the ’absorb-
ing’ category (the category which will house the moved category). A moved 
category maintains its permissions.

Permissions for Subcategories 
This new feature, also called child permissions, enables you to define permissions 
for any subcategory created under the selected category. The Properties dialog 

The Permissions tab of the Properties dialog 
for records.

The Permissions tab of the Properties dialog 
for categories.
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window for categories offers a Permissions for Subcategories tab to define 
these permissions. Subcategories can either inherit the permissions defined for 
the ‘parent’ category, or they can have their own permissions. Note that once a 
subcategory is created, its permissions can be modified individually. 
By default, permissions are copied from the parent category. Any subcategory 
created under this parent category will have the same permissions as its parent 
category.

If you want define explicit permissions for subcategories created under the 
selected parent category, activate the Defined below option. Then the permis-
sions as defined under Subcategory Permissions are copied for a subcategory 
when it is created. How to define the explicit permissions, is explained on 
page 179.

NOTE: If you change any permission settings for a ’parent’ category, you will 
be asked whether these changes should be applied to its subcategories as well. 

Record and Category Permissions with Cumulus 7 Clients only
Application Permissions for users include Open Catalog with any Cumulus Cli-
ent (needed to get access to the catalog in order to open it; e.g with a Cumulus 
Client application to get the catalog displayed in the Catalog Access window.) 
“Any Cumulus Client” includes the Cumulus Client application, Web Publisher 
Pro, Internet Client Pro, Web Client, Sites, HELIOS Companion, and any individu-
ally programmed application based on Cumulus Java Classes. However, Record 
and Category permissions are valid with Cumulus 7 Clients only. 
If you make use of this feature, you should restrict the Open Catalog permission 
to Cumulus 7 Clients only. The access can be restricted to certain Cumulus Client 
versions and variations. See the “Client Groups” section in the Cumulus Adminis-
trator Guide, for further information. If you have set up any Client Group, the 
options for the Catalog Permissions will be enhanced with an entry Open Cata-
log with for this group.
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SPECIAL TECH INFORMATION:  
Configuring Authenticators’ User Search Criteria
When searching for users on the Record/Category Properties Permis-
sions tab, the Cumulus Built-in and LDAP authenticators search for 
login names by default. The default search criteria with the LDAP 
authenticator can be changed in the LDAP.xml file (located in the conf 
folder inside the Cumulus Server installation folder.) The default search 
criteria for the Cumulus Built-in authenticator can be extended. 
Cumulus can also search for first, middle or last name. In order to acti-
vate these search criteria, you have to open the Users catalog with a 
Cumulus Client and enable the corresponding record field (First 
Name. Middle Name and/or Last Name) for contain-searching.

Setting Permissions for Selected Records and Categories
To set individual permissions for selected records/categories that define permis-
sions for functions and the users who are allowed to perform the allowed func-
tions:

1. Select one or more records/categories.

2. Open the context menu for these records/categories (with the right 
mouse button /  Control key + mouse) and select Properties. The Proper-
ties dialog window appears.

3. Click on the Permissions tab. 

4. Define the users and permissions you want to assign to the selected 
records/categories. You can individually define the users, roles and permis-
sions, or you can use a Permissions Template. Using a Permissions Template 
will fill in the permission properties saved with the record. However, you can 
edit permission properties individually.

If you want to use a Permissions Template, click on the Use Template but-
ton. This opens a dialog for selecting the desired template. For a description 
on how to set up Permissions Templates, see “Permissions Templates,” 
p. 241.)

If you want to set up permissions individually:

• Add the user(s) and/or role(s) to which you want to assign the record/cat-
egory permissions by clicking the appropriate button (Add User or Add 
Role). (The Add User button is available only if you have the Browse for 
Users permission.) These buttons open a corresponding dialog.

The Permissions tab of the Properties dialog 
for records.

The Permissions tab of the Properties dialog 
for categories.
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To add users, you can search for available users. The possible search criteria 
depend on the authentication method (see above). Default search criteria 
is the login name. Enter the search value (a matching string) and click the 
Find button. The result of this search is listed below. Select the user(s) you 
want and click OK. The users are added.
When adding roles, Cumulus will list the available roles. Select the role(s) 
you want and click OK. The roles are added.

• Select the user/role you want to assign permissions to.
• Enable the permissions you want the user(s) to have (in addition to the per-

missions already given). (For more information on the permissions, see 
“Overview: Permissions Templates,” p. 243.)

5. Click Apply to save your changes and select the next user/role you want to 
assign permissions to.
OR 
Click OK to save all changes and close the Properties window.

To define explicit permissions for any subcategories created under a selected 
category:

1. Select the category.

2. Open the context menu for these records/categories (with the right 
mouse button /  Control key + mouse) and select Properties. The Proper-
ties dialog opens.

3. Click on the Permissions for Subcategories tab.

4. Activate the Defined below option.

5. Define the users and permissions you want to assign to any subcategory of 
the selected category. You can individually determine users, roles and per-
missions, or you can use a Permissions Template. Using a Permissions Tem-
plate will fill in the permission properties saved with the record. However, 
you can edit permission properties individually.

If you want to use a Permissions Template, click on the Use Template but-
ton. This opens a dialog for selecting the desired template. For a description 
on how to set up Permissions Templates, see “Permissions Templates,” 
p. 241.)

If you want to set up permissions individually:
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• Add the user(s) and/or role(s) to which you want to assign the category 
permissions by clicking the appropriate button (Add User or Add Role). 
(The Add User button is available only if you have the Browse for Users per-
mission.) These buttons open a corresponding dialog.
To add users, you can search for available users. The possible search criteria 
depend on the authentication method (see above). Default search criteria 
is the login name. Enter the search value (a matching string) and click the 
Find button. The result of this search is listed below. Select the user(s) you 
want and click OK. The users are added.
When adding roles, Cumulus will list the available roles. Select the role(s) 
you want and click OK. The roles are added.

• Select the user/role you want to assign permissions to.
• Under Subcategory Permissions, enable the permissions you want the 

user(s) to have (in addition to the permissions already given). (For more 
information on the permissions, see “Overview: Permissions Templates,” 
p. 243.)

6. Click Apply to save your changes and select the next user/role you want to 
assign permissions to.
OR 
Click OK to save all changes and close the Properties window.

Migrating from Cumulus 6
Even when migrating from Cumulus 6.x you need not change anything. The per-
missions for users on records and categories are as defined in the Application 
permissions. However, if you want to make use of this feature, you can follow two 
different concepts:
• You keep your permissions concept and use the new feature to add permis-

sions for selected records and categories due to special purposes.
• You change your concept and restrict the Application permissions to a min-

imum of permissions and use the new feature to set permissions on the 
record/category level.



Customize Cumulus
A little up-front planning can save countless hours of work and frustra-

tion further down the road. This section explains the setting up of pref-

erences to suit your needs and also offers some information on Asset

Handling modules and Asset Format support.



182 CUMULUS® –  CLIENT USER GUIDE
Preferences 
There is no best way to use Cumulus. Many aspects of the program can be 
changed to adapt to your way of managing your assets. Fundamental changes 
can be made by modifying the preferences. 
The Preferences window is available only from within the Cumulus Client appli-
cation. All user settings and catalog settings are configured from within this sin-
gle window. The options that appear to any given user depend on that user’s 
permissions. You must be connected to a Cumulus catalog in order to access the 
Preferences window. When making catalog-specific changes and more than one 
Cumulus catalog is open, a drop-down list enables you to select the catalog you 
want your changes to affect. (You cannot make changes to a catalog you are not 
connected to.)
The left column of the Preferences window displays icons for sections the con-
nected user has permissions to access. These permissions are Server permissions 
and they are defined employing the User Manager module of the Server Con-
sole.
To edit any of the preferences:

1. Select Cumulus / Edit > Preferences. The Preferences window opens. 
What you can see in the window and what you are allowed to edit depends 
on the permissions you have for viewing, modifying and creating the differ-
ent preferences. 

2. Select the sets or settings you want to edit. Make your changes. 

For details on the different sets or settings see: 

• “User Settings,” p. 183
• “Record View Sets,” p. 188
• “Category View Sets,” p. 195
• “Asset Handling Sets,” p. 199
• “Cumulus Asset Actions,” p. 221
• “Metadata Templates,” p. 226
• “Print Templates,” p. 229
• “Sub-Pane Filters,” p. 238

The Preferences window displayed for a 
user who has viewing, modifying and 
creating permissions for all preferences.

The Preferences window displayed for a 
user who has nearly no permissions – only 
the User Settings can be viewed and 
changed.
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• “Permissions Templates,” p. 241
• “Catalog Templates” (Available for the users with the appropriate permis-

sions only. For more information, see Administrator Guide.)
• “Catalog Settings” (Available for the users with the appropriate permissions 

only. For more information, see Administrator Guide.)
3. Click Apply to save your changes and select the next preference you want to 

edit.
OR 
Click OK to save your changes and close the Preferences window.

TIP: Properties for Sets, Templates and Actions
Clicking on the  icon opens the Properties dialog of the selected 
set, template or action – offering two tabs. The Description tab  allows 
you to enter a display name and a description for the item in each lan-
guage supported by Cumulus. The Sharing tab allows you to define 
whether you want to share an item with others. And if you want to 
share, you may define specific users or roles that are allowed to use the 
item.

User Settings
The User Settings of the Cumulus Preferences provide access to your individual 
user settings – at least your personal settings for the Cumulus application. It can 
also provide access to other user settings for other applications integrated in 
Cumulus.
The settings made for the Cumulus application affect global application behavior. 
They are specific to the connected user. They are not specific to any one catalog. 
Included here are options that control the way Cumulus conducts application 
category searches. 
User settings are not specific to computer platform, Client software or catalog. 
This means that settings made by a user at one workstation will be active when 
that user logs in to Cumulus from another workstation, no matter which catalog 
is used. Settings made in the Client application also apply when the user is con-
nected via a Cumulus Web client (Sites/Web Client/Web Publisher Pro/Internet 
Client Pro), where applicable.
The User Settings section of the Preferences window contains tabs that separate 
sections. Beneath each tab are one or more sections that further organize options 
available. See the following overview on the options available.
PRECONDITIONS: To modify your User Settings, you must have the appropriate 
permissions (Server Permissions > User Permissions > Modify [tab name] User 
Settings.) 

Overviews on User Settings
For detailed information on the options available, see the following overviews. 
The “Overview User Setting (1)” gives informations on all options except the Dis-
play tab. The multifaceted option of the Display tab are described in the “Over-
view User Setting (2)” 
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ighlights the active sub-pane in the color selected in the field on 

he right. Click the button to select a color.
r Management
hows preview with color management profile used by asset and 
ighlights any part of the image that is beyond the printable color 
pectrum of the printer selected in # 5, below.
elects a color management printer profile - Mac OS: ColorSync; 

indows: ICM. (Disabled if # 4 is not selected.)
lick to select a warning color for unprintable shades in an asset.

sparency
e asset formats create transparent areas in an image’s preview or 

bnail. For these you can specify how the transparent areas are 
layed. Such formats are: Portable Network Graphics (PNG), GIF 
ge, Photoshop (PSD, PSB), TARGA Image (TGA, TPIC), Windows 
or (CUR) and Windows Icon (ICO).
sparency Grid Display

f activated, the transparent areas of a preview are displayed as a 
rid and you can select the grid size. If not activated, the back-
round color selected for the Record View Set is used for transpar-
ncy display of a preview.

f activated, the transparent areas of a thumbnail are displayed as 
 grid and you can select the grid size. If not activated, the back-
round color selected for the Record View Set is used for transpar-
ncy display of a thumbnail.
llows you to choose colors for the grid. You can either choose a 
re-defined color combination or define your own custom combi-
ation. Click the buttons to select the colors for your custom com-
ination.

 Modes – Groups of Options 
options for the different view modes– that is, the Info View, the Asset Info Window, the Preview View, the preview Window a

ategory Info Window – comprise one or more of the following groups. 

io
hen you open the view, the voice annotation in the first Audio 

ield of the Information window will be played.
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ts/Categories
ifies what happens once you open an Information window 
umulus opens a new Information window for each asset/cate-
ory.
umulus uses one window to show information on all currently 
elected assets/categories. Displays and lets you edit common 
nformation for multiple records/categories.
he open window displays the records/categories currently 
elected in the Collection window and follows any selection 
hanges.
he open window displays the values that are identical for all cur-
ently selected records/categories.

dow Position
lways displays the window on top of all other windows.

iew Window Mode
lways opens a preview in fullscreen.
lways opens a preview in a separate preview window .
eeps the Preview window always on top of the Cumulus main 
indow (Default). – If deactivated, the preview window remains 

nside the Cumulus main window, as in earlier versions of Cumulus.

iew View Size
efines the sizes of small, medium and large preview views. The 

izes defined here for preview views are those displayed when the 
espective size is selected.

iew Image Size
 can select one of the following options:
hows asset previews at the selected predefined preview view size.
hows asset previews at the actual size of the asset. (For large 

mages with high resolution, this could result in a very large pre-
iew.)
nables selecting whether previews are enlarged or reduced to fit 
he size of the preview window.
nables selecting whether the width of previews is enlarged or 
educed to fit  the size of the preview window.
nables selecting whether the height of previews is enlarged or 
educed to fit  the size of the preview window.
elects a predetermined size for all previews.

itional Preview Settings
ides the toolbar when the preview is displayed fullscreen (only 
vailable with the Preview Window settings).
hows an error message if a preview can’t be generated.

 Mouse Wheel in Preview For
oggle the mouse wheel function: Either use the mouse wheel to 
ycle between records, or between the pages of multi-page 
ecords. 
IP: Press Ctrl while using the mouse wheel to invert the way it 
orks. 

erview: User Settings (2) – Display Tab
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Record View Sets
Cumulus offers different views for records. The following views are defined in a 
Record View Set:
• Thumbnail View
• Report View
• Details View
• Info View 
• Asset Info Window 
• Palette Mode
• Preview View
• Preview Window
View Sets make it easy for you to switch between different views that are set up 
for certain formats or tasks. Once View Sets have been appropriately defined to 
meet differing demands, you can switch between them with just a mouse click.
If you have the appropriate rights, you can extensively customize most views. 
There are view sets for individual use and view sets that are shared with other 
users. Shared view sets are displayed in italics. 

Overview on Customization Options
For Thumbnail, Details and Information view as well as for Asset Information win-
dow and Palette Mode you can decide which record fields are displayed, their 
order and how they are displayed: font type, style, size, and color. You can also 
choose a background color for most of the views.

IMPORTANT! Font Settings are Operating-System Specific!
Cumulus uses different font settings depending on the operating system the Client 
runs on. Changing these settings in a Record View Set on a Windows Client will not 
take effect with Clients on Mac OS X, and vice versa. To customize Record View Sets to 
have the same look and feel both on Windows and Mac OS X, you have to perform 
appropriate changes twice, on a Mac Client as well as on a Windows Client.

For some views you can even choose to use the color of a Label field as back-
ground color. For many views you can select the spacing around it and whether 

For most views you can select the Record fields to be displayed and a color for the background. The images 
show the settings (left) and the result (right).
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the record is displayed within a frame. For certain views you can also define that 
the field names are displayed along with the field values. 

For Preview view and Preview window you can choose a background color. For 
Preview window you can choose whether and how the values (and names) of 
record fields should be displayed. 

For each view set you can define the view that is to be displayed when the view set 
is selected. As soon as you have selected a view set from the drop-down list, the 
view will switch. This action is not activated by default. To activate this feature for a 
view set, you have to activate this option in the Set Properties section and then 
select the desired starting view. 

Whether all views will change when changing the Record View Set or only the 
current one is determined by each user individually in her/his User Settings. (For 
details, see see “Overview: User Settings (2) – Display Tab,” p. 186.)

Record View Sets and Multilingual Working Environment
For users working in a multilingual working environment certain view settings 
offer an Allow language switch for multilingual fields option. This option 
enables users to switch the language in which multilingual metadata fields are 
displayed. If this option is not activated, multilingual fields are always displayed 
in the language of the field that was added to the view.

Creating and Editing Record View Sets
You can either change existing View Sets or create new ones – if you have the 
appropriate permissions for changing or creating View Sets. You may have the 

Customizing options for Thumbnail view: 
settings (left) and result (right)

Customizing options for Preview window: settings (left) and result 
(right)
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permissions to define and customize your individual sets only or may even have 
the permissions to edit all sets. 

NOTE: When renaming a shared set, remember to update users’ permissions 
for this set. 

Record View Sets are created and edited in the Preference dialog window 
( Cumulus / Edit > Preferences > Record View Set.)
PRECONDITIONS: To view and modify Record View Sets, you must have the 
appropriate permissions (Server Permissions > Record View Set Permissions.) 
To change an existing set:

1. Select Cumulus / Edit > Preferences. 

2. Click Record View Sets.

3. Under Set, select the view set you want to edit.

4. Click the icon for the view you want to change.

5. Make the changes. For details see

• “Adding a Field to a Record View,” p. 191
• “Changing the Properties of a Displayed Field,” p. 193

6. Click Apply to save your changes.

TIP: Customize Entry in List for Selecting 
If you have the appropriate permissions, you can easily access the 
preferences of Record View Sets by selecting the Customize entry in 
the list for selecting Record View Sets (e.g. in the Collection window or 
the Asset Information window). This entry opens the preferences for 
the current Record View Set.

A new view set is created by duplicating an existing one and adapting its set-
tings:

1. Select Cumulus / Edit > Preferences. 

2. Click Record View Sets.

3. Under Set, select the set to use as a basis for the new one.

4. Click the Duplicate button.

The Name and Settings dialog opens.

5. Enter a name for the new view set, and optionally

• Activate the Allow Sharing option, if you want this view set to be available 
to other users.

• Activate Copy display names only, if you also want to take over the lan-
guage-specific display names from the original (not recommended for 
new view sets).

• Activate Copy description only, if you also want to take over the descrip-
tions specified for other languages from the original (not recommended 
for new view sets).

6. Click OK.

7. Define the new view set. (For details see “Adding a Field to a Record View,” 
p. 191, and “Changing the Properties of a Displayed Field,” p. 193.)

8. Click Apply to save your changes.
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Setting A Default Record View Set
You can define one view set to be the default view set. This default view set will 
be used in case no other set is available or the selected set is not accessible. For 
example, a set that is stored with a collection was deleted after the collection had 
been saved. The default view set is denoted by bold characters in the list for 
selecting a view set.
To set the default view set:

1. Select Cumulus / Edit > Preferences. 

2. Click Record View Sets.

3. Under Set, select the view set you want to be the default one. This should be 
a shared set (denoted by italics).

4. Click the Set as Default button.

5. Click Apply to save your changes.

Adding a Field to a Record View
To add a field to one of the views:

1. Select Cumulus / Edit > Preferences.

2. Click Record View Sets.

3. Under Set, select the view set you want to edit.

4. Click the icon of the view to which you want to add a field.

A list of fields that are shown in the selected view is displayed.

5. Optionally: select the entry of the field after which you want to place the 
new field. If no entry ist selected, new fields will be added at the bottom of 
the list. (A field’s position can be adjusted anytime with the buttons on the 
right side.)

6. Click the Add button.

The Add Fields to View window appears, providing two tabs:

• The Fields tab, displaying a list of all fields contained in the catalogs of the 
active collection that are not yet included in the view. 

• The Modules tab, displaying the nodes: Catalogs, Modules and Lan-
guages.
– The Catalogs node expands to a list of all catalogs open in the active col-
lection. Clicking the plus sign in front of a catalog’s name displays all fields 
contained in that catalog, but not yet included in the view. Either select the 
name of a catalog to add all contained fields, or select the individual fields 
you want to add.
– The Modules node expands to a list of all Cumulus modules that provide 
fields. Clicking the plus sign in front of a module’s name displays the fields 
supported by the respective module but not yet included in the view. Either 
select the name of a module to add all fields supported by that module, or  
select the individual fields you want to add.
– The Languages node expands to a list of all languages configured for 
string field values. Clicking the plus sign in front of a language name dis-
plays the fields that support values in the respective language, but are not 
yet included in the view. Either select the name of a language’s  to add all 
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respective fields, or  select the individual language-specific fields you want 
to add.
Additionally, all language independent fields that are not yet included in the 
view are listed and can be added.

7. Select the field(s) you want to add.

8. Click OK to add the field(s) to the list of shown fields. 

9. Click OK or Apply. Your changes take immediate effect.

TIP: Copying/Replacing The Fields From Another View
You can copy the fields included in one view to another view of the 
same Record View Set or you can replace all fields. Select the icon for 
the view you want to have the same fields as another view and use the 
alternate (right) mouse button to open a context menu. Select first the 
desired function and the view from which you want to copy the fields.

Adding a Separator to a View
Separators in views can make it clear to users which metadata fields belong 
together. Users can close a separator to hide its fields and make metadata editing 
much easier on views that contain many fields. You can add as many separators 
as you need, and make it easy to focus on only the fields that matter at the 
moment.
The Asset and the Category Info window as well as Info view support a delimiter 
element that allows to group fields. 

You can add and remove a separator just as any other  field.
To add a separator to an Info window or Info view:

1. Select Cumulus / Edit > Preferences.

2. Click Record View Sets or Category View Sets.

3. Under Set, select the view set you want to edit.

4. Click the icon for the view to which you want to add the separator.

A list of fields shown in the selected view is displayed.

5. Select the entry for the field after which you want to place the separator.
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6. Click the Add Separator button. A dialog for entering a name for the separa-
tor is opened.

7. Enter a name and click OK.

The separator is added to the view. 

To change the properties of a separator:

1. Select Cumulus / Edit > Preferences. 

2. Click Record View Sets or Category View Sets.

3. Under Set, select the view set you want to edit.

4. Click the icon for the view you want to edit.

5. Select the entry for the separator whose properties you want to change.

6. Click the Properties button.

This opens a dialog for defining the font attributes and changing the name 
of the separator.

7. Make your selections.

8. Click OK to assign the selected properties to the separator. 

9. Click the Apply button. The separator will be displayed according to your 
settings. 

Changing the Properties of a Displayed Field
The properties of a displayed field define the font (type, style, size, and color) 
used to display the field contents. 

Properties for the display of a separator.
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IMPORTANT! Font Settings are Operating-System Specific!
Cumulus uses different font settings depending on the operating system the Client 
runs on. Changing these settings in a Record View Set on a Windows Client will not 
take effect with Clients on Mac OS X, and vice versa. To customize Record View Sets to 
have the same look and feel both on Windows and Mac OS X, you have to perform 
appropriate changes twice, on a Mac Client as well as on a Windows Client.

To change the display properties of a field: 

1. Select Cumulus / Edit > Preferences. 

2. Click Record View Sets.

3. Under Set, select the view set you want to edit.

4. Click the icon for the view you want to edit.

5. Select the entry for the field whose properties you want to change.

6. Click the Properties button.

This opens a dialog for defining the font attributes and – depending on the 
field type – additional properties.

7. Make your selections. The options differ depending on the field type. (See 
“Additional Display Properties for Different Field Types,” p. 194, for more 
information on additional properties.)

8. Click OK to assign the selected properties to the field. 

9. Click the Apply button. The field is displayed according to your settings. 

Additional Display Properties for Different Field Types
In addition to choosing the font, the Properties dialog offers different options 
depending on the field type:
• String Fields – With Info View or Info Window only

You can define the number of lines to display the contents of the field. For 
String List fields you can define the number of lines as well as display options. 
For String List fields that do not allow multi-select, you can decide to have the 
values displayed as drop-down list or radio buttons. 

Properties for the display 
of a String List field.
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NOTE: String Fields – Scroll Bar Display for Info View/Window on 
Mac OS!
To have a scroll bar available for a String field in Info View or Info Win-
dow, you need to give it at least 5 lines. 

• Picture Fields – With Info Window, Thumbnail, Report and Info View
Icons can be displayed to quickly inform about embedded metadata (e.g. 
EXIF, IPTC and XMP data as well as included color profiles, multi-page assets 
or the availability of versions). 

NOTE: 
To display icons for embedded metadata, a catalog must contain the 
Embedded Metadata Standards field. If you add this field to an existing 
catalog, make sure to subsequently update all records of the respective 
catalog in order to have the new field taken into account. 
To do so, select Metadata > Update Record > Advanced. Activate the 
Update even if assets are unchanged option and restrict the update to 
the Embedded Metadata Standards field, then click OK.

The following icons can be displayed:
EXIF data available
XMP data available
IPTC data available
ICC data available
Multipage asset (only if catalog contains the Number of Pages field 

and its value is > 1.)
Versioned asset (only if catalog contains the Version History field and 

it contains more than one line)
Photoshop resource available

• Categories Field – With Info Window and Info View only
The language of Category tabs in the Asset Info window and in the Info view 
can be set via the Properties dialog of the Categories field. The set language 
governs the names of the Category tabs as well as the names of the catego-
ries displayed in the tabs. To specify a preferred language for the names acti-
vate Preferred language and select the desired language from the list. To 
automatically have displayed the language chosen in the View menu select 
As defined in View Menu. 

Category View Sets
A Category View Set defines the display options for the Category Information 
window and the Category pane display. For each tab you can define different dis-
play options. You need the appropriate permissions for changing the Category 
View Sets.
Category View Sets are created and edited in the Preference dialog window 
( Cumulus / Edit > Preferences  > Category View Set.)
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PRECONDITIONS: To view and modify Category View Sets, you must have the 
appropriate permissions (Server Permissions > Category View Set Permis-
sions.) 
To change a Category View Set:

1. Select Cumulus / Edit > Preferences. 

2. Click Category View Sets.

3. Under Set, select the tab whose view set you want to edit.

4. Make the changes. 

For details on changes for the Category Info window see: 

• “Adding a Field to the Category Info Window,” p. 196
• “Changing the Properties of a Displayed Field,” p. 197
For details on changes for the Category pane see: 

• “Changing the Category Pane Display,” p. 198
5. Click Apply to save your changes.

Category Info Window
You can add fields to the display and change the properties of a displayed field.

Adding a Field to the Category Info Window
To add a field to a Category Information window:

1. Select Cumulus / Edit > Preferences. 

2. Click Category View Sets.

3. Under Set, select the view set you want to edit.

4. Click Category Info Window.

A list of fields that are shown in the Category Info window is displayed.

5. Optionally: select the entry of the field after which you want to place the 
new field. If no entry ist selected, new fields will be added at the bottom of 
the list. (A field’s position can be adjusted anytime with the buttons on the 
right side.)

6. Click the Add button. 

The Add Fields to View window appears, providing two tabs:

• The Fields tab, displaying a list of all category fields contained in the catalogs 
of the active collection that are not yet included in the Category Info window. 

• The Modules tab, displaying the nodes Catalogs, Modules and Lan-
guages.
– The Catalogs node expands to a list of all catalogs open in the active col-
lection. Clicking the plus sign in front of a catalog’s name displays all fields 
contained in that catalog, but not yet included in the Category Info win-
dow. Either select the name of a catalog to add all fields contained in that 
catalog, or select the individual fields you want to add.
– The Modules node expands to a list of all Cumulus modules that provide 
fields. Clicking the plus sign in front of a module’s name displays the fields 
supported by the respective module but not yet included in the Category 
Info window. Either select the name of a module to add all fields supported 
by the module, or select the individual fields you want to add.
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– The Languages node expands to a list of all languages configured for 
string field values. Clicking the plus sign in front of a language name dis-
plays the fields that support values in the respective language, but are not 
yet included in the Category Info window. Either select the name of a lan-
guage’s  to add all respective fields, or select the individual language-spe-
cific fields you want to add.
Additionally, all language independent fields that are not yet included in the 
view are listed and can be added.

7. Select the field(s) you want to add.

8. Click OK to add the field(s) to the list of shown fields. 

9. Click OK or Apply.  Your changes take immediate effect.

Changing the Properties of a Displayed Field
The properties of a displayed field define the font (type, style, size, and color) 
used to display the field contents.

IMPORTANT! Font Settings are Operating-System Specific!
Cumulus uses different font settings depending on the operating system the Client 
runs on. Changing these settings in a Record View Set on a Windows Client will not 
take effect with Clients on Mac OS X, and vice versa. To customize Record View Sets to 
have the same look and feel both on Windows and Mac OS X, you have to perform 
appropriate changes twice, on a Mac Client as well as on a Windows Client.

To change the display properties of a field: 

1. Select Cumulus / Edit > Preferences. 

2. Click Category View Sets.

3. Under Set, select the tab whose view set you want to edit.

4. Click Category Info Window.

5. Select the entry for the field whose properties you want to change.

6. Click the Properties button.

This opens a dialog for defining the font attributes and – depending on the 
field type – additional properties.

7. Make your selections.

8. Click OK to assign the selected properties to the field. 

9. Click the Apply button. The field is displayed according to your settings. 
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Category View Sets and Multilingual Working Environment
For users working in a multilingual working environment view settings offer an 
Allow language switch for multilingual fields option. This option enables users 
to switch the language in which multilingual metadata fields are displayed. If this 
option is not activated, multilingual fields are always displayed in the language 
of the field that was added to the view.

Changing the Category Pane Display
To set up the display of the Category Tree to your needs you can select a back-
ground color and define the font type, size and color.
To change the display: 

1. Select Cumulus / Edit > Preferences. 

2. Click Category View Sets.

3. Under Set, select the tab whose view set you want to edit.

4. Click Category Pane.

5. Make your selections:

• To change the background color, click the  button next to the Back-
ground Color field.

• To change the font, click the  button next to the Font field.
NOTE: Font Settings are Operating-System Specific! 
Cumulus uses different font settings depending on the operating sys-
tem the Client runs on. Changing these settings in a Category View Set 
on a Windows Client will not take effect with Clients on Mac OS X, and 
vice versa. To customize Category View Sets to have the same look and 
feel both on Windows and Mac OS X, you have to perform appropriate 
changes twice, on a Mac Client as well as on a Windows Client. 

• To change the default display of the category pane, you can enable/dis-
able various display options. You can activate the option to display the 
number of records assigned to the category right next to the category 
name. You can decide which tabs are to be displayed and which tab will 
be displayed when the current view set is selected by a user. 
NOTE: These are view option for the display of tabs only. The user per-
missions set in the User Manager and Live Filtering can also influence 
the display of categories. 
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For details on options only important if working in a multilingual environ-
ment see “Category Pane and Multilingual Working Environment,” p. 199

6. Click the Apply button. The Category pane is displayed according to your 
settings. 

Category Pane and Multilingual Working Environment
For users working in a multilingual working environment the settings for the Cat-
egory pane offer following options:

• To allow sorting of categories according to the rules of a specific language 
and to enable the display of a manually re-ordered category tree, activate 
Enable/View language specific category sorting and custom ordering. 
NOTE: Language-specific sorting is performed either according to the 
rules of the application language or according to the rules of the 
selected preferred language, if a preferred language is specified. 

• To specify a preferred language for the display of categories, activate Pre-
ferred language and select the desired language from the list. To automat-
ically have displayed the language chosen in the View menu select As 
defined in View Menu.

• If for any reason the name of a category is not available in the preferred lan-
guage, it is displayed in the base language. To have additonally displayed 
the name of the used base language, activate the If not available ... option.

Asset Handling Sets
An Asset Handling Set affects how Cumulus deals with your assets – during the 
cataloging process and when accessing assets. The options of a set are not spe-
cific to any one catalog. 
In the Asset Handling Sets section of the Cumulus Preferences you can define dif-
ferent Asset Handling Sets. When a certain set is used depends on the individual 
user settings defined by the user. 
In the User settings of the Cumulus Preferences, each user can define one Asset 
Handling Set for the cataloging done in all catalogs and one Asset Handling Set 
for the asset access done in all catalogs. Each user can also assign different Asset 
Handling Sets to different catalogs (even different ones for cataloging and asset 
access). And each user can define to be asked for an Asset Handling Set when 
cataloging assets. (See “Overview: Asset Handling Sets,” p. 202 for details.) You 
can either change existing sets or create new ones – if you have the appropriate 
permissions for changing or creating Asset Handling Sets. There are Asset Han-
dling Sets for individual use and Asset Handling Sets that are shared with other 
users. Shared sets are displayed in italics. You may have the permission to define 
and customize your individual sets only or may even have the permissions to edit 
all sets. 

NOTE: When renaming a shared set remember to update users’ permissions 
for this set. 

Asset Handling Sets are created and edited in the Preference dialog window 
( Cumulus / Edit > Preferences > Asset Handling Set.)
PRECONDITIONS: To view and modify Asset Handling Sets, you must have the 
appropriate permissions (Server Permissions > Asset Handling Set Permis-
sions.) 
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Editing An Asset Handling Set
To change an existing Asset Handling Set:

1. Select Cumulus / Edit > Preferences. 

2. Click Asset Handling Sets.

3. Under Set, select the set you want to edit.

4. Make the changes. 

5. Click Apply to save your changes.

See “Overview: Asset Handling Sets,” p. 202, for an overview of the options avail-
able for Asset Handling Sets. Asset Handling Sets can only be defined by the 
Cumulus Administrator or users who have the right to do this.
Of all the various settings available within an Asset Handling Set, those concern-
ing Asset Storage modules are described in detail in the section “Asset Handling 
Modules,” p. 205. Asset Formats are described in the section “Asset Format Sup-
port,” p. 217.

Creating An Asset Handling Set
A new Asset Handling Set is created by duplicating an existing one and adapting 
its settings:

1. Select Cumulus / Edit > Preferences. 

2. Click Asset Handling Sets.

3. Under Set, select the set to use as a basis for the new one.

4. Click the Duplicate button.

The Name and Settings dialog opens.

5. Enter a name for the new set, and optionally

• Activate the Allow Sharing option, if you want this set to be available to 
other users.

• Activate Copy display names only, if you also want to take over the lan-
guage-specific display names from the original (not recommended for 
new sets).

• Activate Copy description only, if you also want to take over the descrip-
tions specified for other languages from the original (not recommended 
for new sets).

6. Click OK.

7. Define the new set. (See “Overview: Asset Handling Sets,” p. 202, for an over-
view of the options available.)

8. Click Apply to save your changes.

Setting A Default Asset Handling Set
You can define one Asset Handling Set to be the default set. This default set will 
be used:
• when the Cumulus Server uses an Asset Handling Set, e.g. for Server/Client 

Asset Transfer.
• when the set defined in the User Settings is not available.
• when records are imported.
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The default set is denoted by bold characters in the list for selecting a set. 
To determine the default set:

1. Select Cumulus / Edit > Preferences. 

2. Click Asset Handling Sets.

3. Under Set, select the set you want as default. This should be a shared set 
(denoted by italics).

4. Click the Set as Default button.

5. Click Apply to save your changes.

Thumbnail Size and Quality 
The thumbnail size and quality that you select when setting up an Asset Han-
dling Set influences the size of a typical record and thus Cumulus’ overall perfor-
mance. Since Cumulus uses JPEG compression for grayscale and color 
thumbnails, the size of individual records varies depending on the thumbnail 
content. Higher quality thumbnails typically create larger records.
For example, a catalog containing 4,000 records and normal thumbnail quality 
(i.e., 128 x 128 pixels) yields a catalog that is approximately 50 MB in size. The 
same catalog with high thumbnail quality (i.e., 192 x 192 pixels) is 70 MB in size.
To find out how much space thumbnails take up in a catalog, first select the 
thumbnail size and thumbnail quality on the General tab. As you make your 
selections, the disk space required for each thumbnail (in bytes) is displayed in 
the Thumbnail Preview area.



202 CUMULUS® –  CLIENT USER GUIDE

Ov
Asse re 
acce n 
cata

Thu
Crea
1 S

T
a

2 U
m

3 C
t
l
t

Thu
4 S

C
u

Opt
5 E

a
m

Qua
6 S

(
g
p
H
N

e 

Cata
Whe
1 C

w
2 C

a
N
h

3 C
a

Add
4 W

b
N
w
r

5 W
b

the 
s to 

y 
erview: Asset Handling Sets 
t Handling Sets control the way the records of newly cataloged assets are created and how cataloged asset a
ssed. The Asset Handling Sets defined here can be selected in the User Settings dialog or within dialogs whe
loging or accessing assets.

mbnails Tab 
te Thumbnails from
ome programs can save images with embedded thumbnails. 
his option uses those thumbnails, if available, instead of cre-
ting new ones. Stored thumbnails may differ in size.
ses embedded thumbnails, if available and large enough (the 
inimum is the size defined in the section below, see # 4).

reates thumbnail images of the entire asset’s content. These 
humbnails are of best quality, but this option slows the cata-
oging process. If a thumbnail cannot be created, the stored 
humbnail is used. 
mbnail Size
elects default thumbnail size for all newly cataloged assets. 
urrent records’ thumbnails can be adjusted to the new size by 
pdating the record. (See “Update Record,” p. 274.)

imize Thumbnail
qualizes the thumbnail images for newly cataloged assets 
utomatically. This can also be done afterwards. (See “Opti-
ize Thumbnail,” p. 277.)

lity
ets thumbnail quality for the different color modes: Line art 
NORMAL=2 color / HIGH=4 color), grayscale (NORMAL=8-bit 
rayscale, more compression / HIGH=8-bit grayscale, less com-
ression), Color (NORMAL=24-bit color, more compression / 
IGH=24-bit color, less compression.) 
OTE: High-quality thumbnails make records larger.

Thumbnail Preview
7 Displays the thumbnail quality and the disk space 

required for each thumbnail (in bytes) according to th
selected options.

loging Tab 
n Cataloging
umulus adds new records but doesn’t update existing records 
hose assets have changed.
umulus adds new records and updates those records whose 
ssets have changed.
OTE: For updating existing records the cataloging user must 
ave the Update Records permission.
umulus updates existing records only. No new records are 
dded.

 only – Asset Duplicates Handling
hen cataloging, if Cumulus finds an asset that has already 

een cataloged, a duplicate record is created for the asset.
OTE: This is possible only when Add Only is selected, other-
ise Cumulus thinks you’re trying to update the existing 

ecord.) 
hen cataloging, if Cumulus finds an asset that has already 

een cataloged, it does not create a duplicate record.

Operating System Shortcuts/Aliases/Links
6 Cumulus resolves any links/shortcuts/aliases found in 

selected assets being cataloged. This enables Cumulu
catalog the asset that the shortcut/alias points to.

7 Links/shortcuts/aliases are not resolved and assets the
represent are not cataloged.

1
2
3

5

4

6

7

16

2
1

3

4
5

6
7

8

15
14

10
9

11
12

13



CUSTOMIZE CUMULUS –  THUMBNAIL SIZE AND QUALITY 203

AXR
8 O

t
s

Cen
9 C

i
e
A
a
t

10 T
a

11 T
a

12 C
a
a
r
a
T
u
c
m
c

lds 

et. 
ith 
an 
re 
or-

e 

Ass
Writ
1 R
2 R
3 I

r
4 I

m
t

5 R
m

Acce
If yo
your
dete
selec
To, C
men
6 C

p
7 C

p

Ov

 Options
ptional: When cataloging an asset that contains references, 

he referenced assets will be cataloged automatically with the 
ame cataloging process. 
tral Asset Location
opies all newly cataloged assets to a central location specified 

n the Catalog Settings and makes the newly created record ref-
rence the copied asset. If you enable the Delete Original 
sset option, the asset will be deleted at its original location 
fter it was copied to the central location. Can be overridden by 

he Catalog Settings.
his is the “off” position for #9. Assets are cataloged normally 
nd not copied to a central location.
he original asset will be deleted after the asset was cataloged 
nd successfully copied.
umulus also copies assets that are contained in a cataloged 
sset to the Central Asset Location – as discrete assets. Requires 
n activated corresponding AssetStore that can detect this 

elation and extract sub-assets that can be saved as discrete 
ssets. (Appropriate AssetStores are available e.g for ZIP and 
AR files as well as for PDF, PowerPoint,, and Quark XPress doc-
ments.) Canto recommends to activate this option only in 
onjunction with a Sites/Web Client installation where the 

achine running the Web application does not support the 
orresponding applications, e.g. PowerPoint.

Adding Metadata 
13 Define the view set used for the Metadata Editor. The fie

included in the Information window of this set define 
what can be edited with the Metadata Editor.

14 Assigns a Metadata Template to the Asset Handling S
This template will be used when an asset is cataloged w
the Asset Handling Set. If this option is activated, you c
select the Metadata Template to be assigned. Make su
the permissions for the assigned Metadata Template c
respond to those for the Asset Handling Set.

15 Metadata Editor will be activated when new assets ar
cataloged and new records get created.

16 Metadata Editor will be activated when records are 
updated.

et Access Tab 
ing back Metadata 
ecord-field content is never written back.
ecord-field content is written back to assets if possible.

f activated, the asset modification date will be updated when 
ecord-field content is written back to an asset.
f activated, record-field content is written back to external 

etadata container only, e.g sidecar files, without modifying 
he assets.
ecord-field content is written back to assets if possible, dialogs 
ay appear while resolving connection to assets.

ssing Versions
u employ a licensed and activated version control system with 
 Cumulus installation (e.g. Cumulus Vault), Cumulus lets you 
rmine how to deal with versions of an asset. The option 
ted under When Getting Assets affects the Preview, Mail 
opy To and Print With commands in the Cumulus Asset 

u.
umulus always uses the latest version of the asset when you 
review, mail, copy or print it. 
umulus prompts you to choose the desired version when you 
review, mail, copy or print it. 

erview: Asset Handling Sets 
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t Formats Tab 

list in this tab displays all formats configured for the selected 
t Handling Set. Formats, that are supported by filters that are 
nstalled on the machine you are working with, are displayed in 
s. You can click on each column heading to re-sort the list by 

 field. A green marker indicates formats that are active. Deacti-
d formats are indicated by red markers. Activate and deactivate 
ats for the selected Asset Handling Set using the button #6. 
utomatically adds formats supported by newly installed fil-

ers to the list and activates them.
ll formats will be cataloged. For unknown formats (not listed), 

he Cumulus Generic filter will be used. If this option is not acti-
ated, only those formats which are listed and activated in the 

ist will be cataloged.
pens the properties window for the format. (Only available if 

he filter provides any properties.)
pens a dialog displaying available formats that are not 

ncluded in the list.
emoves a format from the list. You can add it again using the 
dd button, but then it is appended to the list. 
ctivates/deactivates the selected format for the selected Asset 
andling Set.
hese buttons change the selected entry’s position in the list. 
hen cataloging assets Cumulus uses the filters in the order of 

he entry numbers of formats they support. This is important if 
ou have multiple filters for the same file type. Starting from the 
op: move to top of list, move before current position, move 
ehind current position, and move to end of list. (Disabled if no 

ilter is selected.)

Active formats are indicated by a green marker to the left 
the format. Formats that have been deactivated have a re
marker to their left.
Formats that are indicated by italics are currently not sup
ported (not installed on the machine you are working on), 
are included in the list so they will be activated in that posit
when the filter is available.

ules Tab 
Modules tab includes multiple icons that provide access to the 
rent modules. Asset Storage, Asset Processor and Metadata 
ules can be activated for the selected Asset Handling Set. 
etails on the Asset Storage, Asset Processor and Metadata 
ules, see “Asset Handling Modules,” p. 205.
isplays a window that shows the version of the module. 
pens the properties window for the format. (Only available if 

he module provides any properties.)
ctivates/deactivates the selected module for the selected 
sset Handling Set.
e modules are indicated by a green marker. Modules that 
 been deactivated have a red marker.
ules that are indicated by italics are currently not supported 
 installed on the machine you are working on.)

er Filter you can see the Filter Modules that are available on 
achine you are working on. Modules that are indicated by 

s are currently not supported (not installed on the machine 
are working on.)

isplays a window that shows the version of the module. 
pens the properties window for the format. (Only if available.)

erview: Asset Handling Sets 
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Asset Handling Modules
When cataloging and accessing assets, Cumulus uses different modules: Asset 
Storage, Asset Processor, Metadata and Filter modules. 
• Asset Storage modules manage the asset’s storage (the access to its loca-

tion), whereas a Filter module analyzes the asset’s contents. For example, if 
you catalog a file from the file system of your computer, the Asset Storage 
module manages the access to the file system of your computer, and the 
employed filter reads the file’s content.

• Asset Processor and Metadata modules are special modules for special 
tasks, e.g. to handle DCS (Desktop Color Separation) files and OPI (Open Pre-
press Interface).

• Cumulus Filters extract file-type specific metadata from assets. This informa-
tion can include color mode, resolution, file type, font names, etc., depending 
on the type of asset. 
Users who are allowed to define Asset Handling Sets can create their own Fil-
ter format options for specific file types (see “Extending Generic Filter 
Options,” p. 219), and Canto is always updating existing Filters and creating 
new ones. Check Canto’s Website (www.canto.com) for the latest Filter ver-
sions.

Cumulus makes it possible for you to determine precisely what sort of informa-
tion should be kept on the assets. This can be defined differently for each catalog 
as each catalog has its own properties. It is the catalog properties that determine 
what information is stored on the assets in the record fields. (For further informa-
tion, see “Catalog Settings,” p. 168.) Linking metadata fields to record fields 
“feeds” the record with asset metadata during cataloging. The link can work in 
both directions—if supported by the corresponding Filter or Asset Storage Mod-
ule—meaning that you can also write modified record field contents back to 
asset fields. By default, all Cumulus-supported record fields are linked to the 
matching asset fields. This also applies to fields that are included with Cumulus 
but not activated by default in every catalog. When you set up a catalog for your 
workgroup, you can define how these asset fields (from both Asset Storage mod-
ules and Filters) should be linked to the catalog’s record fields. You can also 
define how to link the custom fields you define to asset metadata. 
If you want to learn more about Cumulus’ various modules, what they do and 
how they are configured to customize Cumulus to your specific workflow, then 
please continue reading the following sections that describe these modules.

The Modules section of an Asset Handling Set lists under 
Asset Storage the Asset Storage modules that manage the 
access to an asset. 
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(De)activating Asset Handling Modules
Depending on your workflow requirements, you may not need to use some of 
these Asset Handling modules. If, for example, you are not using services from a 
prepress service provider and do not have access to an OPI server, you should 
deactivate the OPI System Support. Deactivating modules which are not needed 
for your specific workflow enhances productivity by freeing up Cumulus’ 
resources and speeding up the cataloging process. To meet individual workflow 
requirements Asset Storage, Asset Processor and Metadata modules can be acti-
vated and deactivated for each Asset Handling Set individually. Note that you 
need the appropriate permissions to change Asset Handling Sets. 
To activate or deactivate an Asset Handling module for an Asset Handling Set:

1. Launch your Cumulus application and open any one catalog.

2. Select Cumulus / Edit > Preferences. 

3. Click Asset Handling Sets.

4. Under Set, select the set you want to edit.

5. Click Modules and select the icon for the module type.

6. Select the desired module and click the Activate /Deactivate button.

7. Click Apply or OK to save your changes.

Now the module is (de)activated for the selected Asset Handling Set.

Asset Storage Modules
The Asset Storage module manages the access to files. To catalog a file from the 
file system of a computer, the Asset Storage module for that computer’s operat-
ing system must be activated for the Asset-Handling Set used. It must also be 
activated to enable you to access this file. If you are working in a cross platform 
environment you should have the Asset Storage modules for the other platforms 
activated as well so that you can access assets that are stored on other operating 
systems.

Apple iWork Picture AssetStore (optional)
The Apple iWork Picture AssetStore enables Cumulus to create one record for 
each picture embedded in a Apple iWork document while cataloging. These 
records are created in addition to creating a record for the entire document and 
in addition to separate records for pages or slides. The records will be assigned 
to the corresponding document as “contained images”. A category for each doc-
ument will automatically be created and the images’ records are assigned to 
these categories. The record name of an embedded image is either the name of 
the image inserted in the document, or “image” and a corresponding number. 
(No properties to be defined.) 

Apple Keynote Slides AssetStore (optional)
This Asset Storage module allows you to efficiently manage slides created with 
Apple Keynote. It automatically catalogs all slides of a Keynote presentation and 
in addition to creating a record for the entire presentation document, a record 
for each slide is created. (No properties to be defined.) For more information, see 
“Working with Office Documents,” p. 160.
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HELIOS XPV AssetStore (optional)
This Asset Storage module enables Cumulus users to catalog pages within 
Adobe InDesign and Quark XPress documents. If an XPV preview file for such a 
document is available, in addition to creating a record for the entire document, 
the XPV Support module creates records for each page of the document.
An XPV preview file also contains information on referenced assets. This informa-
tion can be captured by Cumulus filters (such as HELIOS, Indesign and Quark 
XPress) and enables Cumulus AXR (Asset Cross References.)
Because the XPV AssetStore does not use the original Quark XPress documents, 
you cannot use the ’normal’ functions for the pages, e.g. copy, move and drag & 
drop. [Whereas the Cumulus QXP AssetStore, for Mac OS only, that also catalogs 
pages within Quark XPress documents, can create a new one-page Quark XPress 
document from the record of a page.]

NOTE: The XPV Support module is available only to computers in network 
environments in which the HELIOS ImageServer is licensed and installed on 
the same computer as a Cumulus Server. 

InDesign Asset Store (optional)
The InDesign AssetStores enables Cumulus to create one record for each page 
of an InDesign document while cataloging. For more information, see “Working 
with InDesign Documents,” p. 170.

Mac OS File System AssetStore
This Asset Storage module manages the access to files accessible from a Mac OS 
computer. You can define the following properties:
• Preferred Resolving Method – If By Alias with Pathname Fallback is 

enabled, Cumulus will resolve the asset reference using the alias first and if 
this fails then using the pathname. If By Pathname with Alias Fallback is 
enabled, Cumulus will resolve the asset reference using the pathname first 
and if this fails the alias. But if By Pathname is enabled, you can avoid a fall-
back by enabling the option No Fallback. Then only the pathname will be 
used for resolving the asset reference.

• Alias Search Method – If Fast Search is enabled, Cumulus will only search at 
the original location. If Extensive Search is enabled, Cumulus will also search 
all mounted volumes in case the file wasn’t found at the original location.

• Mount Dialogs – Dialogs prompted by the operating system when mount-
ing volumes can either be shown or suppressed. If you choose Suppress, fail-
ures might occur, when mounting volumes (especially removable volumes 
such as CD-ROMs), is required for Cumulus functions such as previewing, 
copying and transferring. That’s why you should only choose the Suppress 
option if you are working in a network environment and want to avoid all dia-
logs about mounting when accessing the server. In case the server can’t be 
mounted you will access the assets via Server Client Asset Transfer.

MacBinary AssetStore
The Mac Binary AssetStore enables Cumulus to catalog MacBinary converted 
assets even on Windows machines. In addition to creating a record for the entire 
BIN file, it creates records for the compressed file in the BIN file. (No properties to 
be defined.)
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MS PowerPoint AssetStore (optional)
This Asset Storage module allows you to efficiently manage slides created with 
Microsoft PowerPoint. It automatically catalogs all slides of a PowerPoint presen-
tation in addition to creating a record for the entire presentation document. 
Such cataloged slides can be added to existing PowerPoint presentations – 
within Cumulus as well as within Microsoft PowerPoint. Within Cumulus you may 
even create new PowerPoint presentations out of cataloged slides. (No proper-
ties to be defined.) For more information, see “Working with Office Documents,” 
p. 160.

MS Power Point Picture AssetStore (optional)
The MS Power Point Picture AssetStore works in conjunction with the MS Power 
Point AssetStore only. It enables Cumulus to create one record for each picture 
embedded in an MS Power Point presentation while cataloging. These records 
are created in addition to creating a record for the entire document and in addi-
tion to separate records for pages or slides (created by the MS Power Point Asset-
Store.) The images’ records will be related to the corresponding slide/page as 
“contained images”. A subcategory for each slide/page of the presentation file is 
automatically created and the images’ records are assigned to these categories. 
The record name of an embedded image is the name of the image inserted in 
the document, or “image” and a corresponding number. (No properties to be 
defined.) 

Office Open XML Pages and Slides AssetStore
The Office Open XML Pages and Slides AssetStore enables Cumulus to create 
one record for each page, sheet or slide of a 2007 MS Office System document 
(*.DOCX, *.XLSX, *.PPTX) or XML Paper Specification document (*.XPS) while cat-
aloging. These records are created in addition to creating a record for the entire 
document. The records will be assigned to the corresponding document as 
“contained pages”. A category for each document will automatically be created 
and the images’ and pages’ records are assigned to these categories. The record 
name of the pages/slide is the name of the document and a corresponding 
number. (No properties to be defined.) 

Office Open XML Pictures and Media AssetStore (optional)
The Office Open XML Pictures and Media AssetStore enables Cumulus to create 
one record for each picture or media embedded in a 2007 MS Office System doc-
ument or XML Paper Specification document (*.XPS) while cataloging. These 
records are created in addition to creating a record for the entire document and 
in addition to separate records for image or media assets. The records will be 
assigned to the corresponding document as “contained images”. A category for 
each document will automatically be created and the media’s/images’ records 
are assigned to these categories. The record name of an embedded image/
media is the name of the image/media inserted in the document or “image” and 
a corresponding number. (No properties to be defined.) 

Open Document AssetStore (optional)
The Open Document AssetStore enables Cumulus to create one record for each 
image embedded in an Open Office document while cataloging – in addition to 
creating a record for the entire document. The records will be assigned to the 
corresponding document as “contained assets”. A category for each document 
will automatically be created and the images’ records are assigned to these cat-
egories. The record name of an embedded image is the name of the image as 
saved with the document. (No properties to be defined.) 
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Outlook Message AssetStore (optional)
The Outlook Message AssetStore enables Cumulus to create one record for each 
attachment or embedded image of a Microsoft Office Outlook message while cat-
aloging – in addition to creating a record for the message. The records will be 
assigned to the corresponding message as “related sub assets”. A category for each 
message will automatically be created and the images’ and attachments’ records 
are assigned to these categories. The record name of an attachment or an embed-
ded image is the name of the image as saved with the document. (No properties 
to be defined.) 

TIP: Auto-cataloging Emails
Another optional feature provides a Cumulus Scheduler Action that 
enables Cumulus to check a standard POP3 email account and 
retrieve and automatically catalog any email it finds. For more infor-
mation, see the Administrator Guide.

PDF AssetStore (optional)
This Asset Storage module enables Cumulus users to catalog pages within PDF 
documents. In addition to creating a record for the entire PDF document, it cre-
ates records for each page of the PDF document. 

PDF Image AssetStore (optional)
The PDF Image AssetStore works in conjunction with the optional PDF Asset-
Store only. It enables Cumulus to create one record for each image embedded 
in the PDF file while cataloging – in addition to separate records for pages cre-
ated by the PDF AssetStore. The records will be assigned to the corresponding 
page as “related sub assets”. If you want to have separate records for embedded 
images, you need to use an Asset Handling Set for cataloging that has the PDF 
Image AssetStore, the PDF AssetStore and the format Embedded PDF Image 
(provided by the PDF Filter) activated. A subcategory for each page of the PDF 
file is then automatically created and the images’ records are assigned to these 
categories. The record name of an embedded image consists of the word Image 
and its internal PDF ID number.

QXP AssetStore (optional, Mac OS only)
The Cumulus QXP AssetStore module enables Cumulus users to catalog pages 
within QuarkXPress documents. In addition to creating a record for the entire 
QuarkXPress document, it creates records for each page of the QuarkXPress doc-
ument.
The Cumulus QXP AssetStore is designed specifically for use in conjunction with 
QuarkXPress. To employ the functionality of the Cumulus QXP AssetStore, 
QuarkXPress must be running in the background while accessing your QuarkX-
Press page assets (e.g. for cataloging or previewing.)

QXP Server AssetStore (optional)
The QXP Server AssetStore module enables Cumulus users to catalog pages and 
layouts within QuarkXPress documents. In addition to creating a record for the 
entire QuarkXPress document, it creates records for each page and each layout 
of the QuarkXPress document. The QXP Server AssetStore module is available for 
Mac OS X, Windows and UNIX. 
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SCORM AssetStore
The SCORM AssetStore module enables Cumulus users to catalog resources con-
tained in a SCORM (Sharable Content Object Reference Model) package. (No 
properties to be defined.)
The SCORM AssetStore automatically creates categories when cataloging files. 
On the Categories tab under a category named Scorm, for each cataloged 
SCORM file a category is created named after the SCORM file (e.g. sample.scorm). 
If a SCORM file contains another SCORM file, a subcategory named after this addi-
tional file will also be created. 
If any files contained within a SCORM file are archived with subfolder references, 
the SCORM AssetStore creates a category tree resembling this subfolder struc-
ture. 

TAR AssetStore
The TAR AssetStore enables Cumulus to catalog and access assets compressed 
within TAR archive files. It automatically catalogs all files in a TAR file. In addition 
to creating a record for the entire TAR file, it creates records for each file included 
in the TAR file - even for files in a TAR file within another TAR file. The Cumulus 
TAR AssetStore supports Bzip2, gzip and uncompressed TAR files.
The TAR AssetStore automatically creates categories when cataloging TAR files. 
On the Categories tab, under a category named tar for each cataloged TAR file, a 
category is created named after the TAR file (e.g. sample.tar). If a TAR file contains 
another TAR file, a subcategory named after this additional file will also be cre-
ated. 
You can define the character encoding used to create the TAR file that is to be 
unpacked by the TAR AssetStore. To know for sure, you should ask the person 
who packed it. If you aren’t sure the character encoding used to pack the TAR file, 
you should use the default: Local Encoding

UNIX File System AssetStore
This Asset Storage module manages the access to files accessible from a UNIX 
computer. (No properties to be defined.)

URL AssetStore
This Asset Storage module manages the access to files accessible from FTP or 
HTTP servers. (No properties to be defined.) For more information, see “Using 
Vault,” p. 134.

Vault AssetStore
The Cumulus Vault Asset Storage module enables you to use the version control 
system Cumulus Vault. For more information, see “Working with Vault,” p. 134.

Video AssetStore (with Video Suite Option only)
The Video AssetStore module enables Cumulus to perform shot determination. 
It also provides the necessary record fields. The parameters for shot determina-
tion can be configured in the Video AssetStore settings. That’s why you should 
set up the Video AssetStore settings according to your needs before you start 
cataloging. 

NOTE: If you haven’t a licensed and activated Video Suite Option, it will run in 
demo mode only (full functionality except shot determination will not create 
shots). 



CUSTOMIZE CUMULUS –  ASSET PROCESSOR MODULES 211
Windows File System AssetStore
This Asset Storage module manages the access to files accessible from a Win-
dows computer. You can define the resolving method for assets stored on CD 
ROMs. If enabled, Cumulus checks for the CD-ROM label.

ZIP AssetStore
The ZIP AssetStore enables Cumulus to catalog and access assets compressed 
within ZIP files. It automatically catalogs all files in a ZIP file. In addition to creating 
a record for the entire ZIP file, it creates records for each of the compressed files 
in the ZIP file - even for files in a ZIP file within another ZIP file. The Cumulus ZIP 
AssetStore has been tested with ZIP compressed assets created with WinZip®, 
PKZIP® and WinRAR.
The ZIP AssetStore automatically creates categories when cataloging ZIP files. On 
the Categories tab, under a category named Zip for each cataloged ZIP file, a cat-
egory is created named after the ZIP file (e.g. sample.zip). If a ZIP file contains 
another ZIP file, a subcategory named after this additional file will also be created. 
If any files contained within a ZIP file are archived with subfolder references, the 
ZIP AssetStore creates a category tree resembling this subfolder structure. (No 
properties to be defined.)

NOTE: Password Protected ZIP Files 
If the ZIP file to be cataloged contains a password protected file, Cumulus will 
ask you for the password. Cumulus remembers this password and if there is 
another password protected file within a ZIP file, it will try the password for 
that file. If it doesn’t fit, Cumulus will also ask you for the password to that file. 
Then you can either type in the password and the file will be cataloged, or skip 
the password request and file will not be cataloged. The passwords are also 
requested for any preview of a password protected asset. Cumulus remembers 
passwords only for as long as the current session. 

NOTE: Cumulus Internet Solutions and Password Protected ZIP Files
Users of Cumulus Internet Solutions who use a Web browser cannot get a pre-
view of any password protected asset. 

You can define the character encoding used to create the ZIP file that is to be 
unpacked by the ZIP AssetStore. To know for sure you should ask the person who 
packed it. If you don’t know for sure the character encoding used to pack the ZIP 
file, you should use the default: DOS Latin US

Asset Processor Modules
Asset Processor modules enable Cumulus to perform processes on cataloged 
assets, e.g. to convert them.

DCS File Support
The DCS File Support module enables Cumulus to recognize CMYK Desktop 
Color Separation files so that it can effectively catalog and manage multiple-file 
DCS assets. This module supports DCS version 1.0. These DCS assets consist of 
one main file (which may contain a preview image) and the four standard color 
separation files.
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When cataloging a DCS asset, this module creates a record for the main file only. It 
is important to be aware of this when viewing the Asset Information window, as 
the information such as file size, etc. only pertain to the main file. Although only 
one file is cataloged, Cumulus still manages all five. For example, if you move or 
copy the cataloged DCS asset with Cumulus, all five DCS files will be moved or cop-
ied. (No properties to be defined.)

Generic Asset Processor (optional)
Enables Cumulus to call external applications from within Asset Actions. It can be 
used for processing, packaging, and delivering tasks.
For each platform you specify the commands to be executed. (The same param-
eters have to be defined for the External Application used by the Generic Filter 
for thumbnail generation.) For details, see the appendix of the Administrator 
Guide.

MS PowerPoint Asset Processor (optional)
The MS PowerPoint Asset Processor enables the user to create PowerPoint pre-
sentations in PowerPoint 97-2003 format from selected PowerPoint assets 
(slides, presentations), image assets and previews of other asset formats within 
Cumulus. For more information on how to use the processor, see “Creating Pre-
sentations,” p. 86.

Office Open XML Presentation Asset Processor (optional)
The Office Open XML Presentation Asset Processor enables the user to create 
presentations in Office PowerPoint 2007 format from selected presentations 
(slides, presentations), image assets and previews of other asset formats within 
Cumulus. For more information on how to use the processor, see “Creating Pre-
sentations,” p. 86.

OPI System Support
The OPI System Support module enables Cumulus to be OPI-aware. The Open 
Prepress Interface (OPI) is a technology that allows placing low resolution ver-
sions of image files into page layouts and letting an OPI print spooler automati-
cally replace them with the high resolution versions of the files for printing. If the 
OPI System Support module is activated, Cumulus will be able to recognize OPI 
files and carry through the correct handling of high and low resolution versions of OPI 
files.
The module is able to read path name information and lets Cumulus manage 
both high resolution and low resolution files from OPI systems like Imation Color 
Central™, Nine Bits PrintDesk, 4-Sight OPI™ , HELIOS EtherShare OPI, and HELIOS 
Image Server. 
Cumulus is also OPI-compatible with many other OPI systems that use EPSF or 
TIFF format files as their low resolution file, like Scitex® APR. With these OPI sys-
tems, low resolution files are handled as expected, but the path to the high res-
olution file might not be automatically recognized.
The OPI System Support module is used for asset access in two different ways: 
• If used with a Cumulus Action, it provides access to OPI assets as set in the 

module’s properties within the Cumulus Action. There you can define 
whether the action will access the high resolution or the low resolution file 
when being performed - regardless of how the module is set up for the Asset 
Handling Set used with the action. 

• If used along with an Asset Handling Set (e.g. for cataloging, previewing or 
copying OPI assets), it provides access to OPI assets as set in the module’s 

OPI System Support 
properties for a 

Cumulus Action
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OPI S
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properties for the Asset Handling Set. How to set up these properties is 
described below. 

The module offers special support for the following versions of HELIOS and Ima-
tion OPI systems
• HELIOS EtherShare OPI version 1.0 up to 2.1 
• HELIOS ImageServer 2.5 
• HELIOS ImageServer UB 
• Imation Color Central 2.1 up to 2.5
For both OPI systems you can define additional properties.
If you select the OPI Support entry in the list of Asset Processor modules and then 
select the Properties button, the OPI Support Setup window opens.
The OPI System Support Setup window has three sections: 
• General 
• HELIOS 
• Imation 
In the section General you can set up the module: 
• to run in silent mode when accessing an OPI asset or not. If Silent OPI File 

Access is not activated, you will be prompted to choose a version when 
accessing an OPI asset. If Silent OPI File Access is activated, Cumulus uses the 
version chosen below when accessing an OPI asset (e.g. for previewing or 
copying).

• to use either the low resolution file or the high resolution file when in silent 
mode or when dragging and dropping an OPI asset. 

Normally you choose to use the low resolution file. The chosen file version is also 
used in silent mode. If silent mode is not activated, you will be prompted to 
choose a version when accessing an OPI asset. Regardless of whether silent 
mode is activated or not, when you drag and drop assets you will never be 
prompted to choose the version – with one exception which refers to Mac OS X 
only (see below). Under Mac OS X special functions for dragging and dropping 
OPI files are provided. These are as follows:
• Under Mac OS X, if Silent OPI File Access is activated, you must use the 

ALT key when dragging to have the version dropped that is defined for silent 
mode.

• The exception to the rule that you will never be prompted to choose the 
version when you drag and drop assets: Under Mac OS X, if Silent OPI File 
Access is not activated and you did not use the ALT key for dragging, you will 
be prompted to choose the version when dropping the asset into the Finder. 
If you have selected multiple assets, you will be prompted once and the cho-
sen version will be taken for all. 

• Under Mac OS X you have an additional option to choose between high 
and low resolution files when dragging and dropping assets into other appli-
cations: keyboard shortcuts. To place the high resolution file press ALT+H 
and then start dragging. To place the low resolution file press ALT+L and 
then start dragging. 

ystem Support proper-
r an Asset Handling Set
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TIP: Drag& Drop of High Resolution Files
If you have chosen to use the low resolution files but in contrary to 
your normal workflow you want to drag & drop the high resolution 
files, you can proceed as follows: Select the records representing the 
assets and select the Show Location menu command ( Apple / 

CTRL + R). This command locates the selected records’ assets and 
displays them in Mac OS X Finder or Windows Explorer. Now you can 
select the desired asset version in Mac OS X Finder or Windows 
Explorer and drag and drop it from there. 

For HELIOS OPI system it is recommended to catalog the high resolution file as 
the information on this file will then be available with the catalog. 
For all OPI systems (except HELIOS) it is recommended to catalog the low reso-
lution file as only the low resolution file leads to the high resolution file – and not 
vice versa. If you have cataloged the low resolution files, do not enable Silent OPI 
File Access along with the option High Resolution File for these OPI systems 
since this combination will not work.
In the section HELIOS you can set up special properties for HELIOS EtherShare 
OPI and HELIOS Image Server. Only if the option HELIOS EtherShare OPI Aware 
is activated will Cumulus catalog either the low resolution layout file or the high 
resolution file. Although the module recognizes layout files generated in the lay-
outs folder it also supports a name extension for layout files. In the field Layout 
file name extension (default: .lay) you specify the name extension to identify OPI 
layout files. You should always specify the same name extension that is used by 
the HELIOS EtherShare OPI system. A file in the same folder as the high resolution 
file that has this name extension will be treated as the layout file for this high res-
olution file. The following two options are important to avoid duplication when 
cataloging a whole folder. They can be used to create only one record for a pair 
of high- and low resolution files when cataloging. The option Catalog High Res-
olution Files Only (default) allows you to catalog only high resolution files. This 
is useful to get the information (size, resolution) about those files into the 
Cumulus catalog. By choosing the option Catalog Layout Files Only you can 
build a catalog of only the layout files. 
In the section Imation you can set up special properties for Imation Color Central. 
Only if the option Imation Color Central Aware is activated, will Cumulus read 
the IPTC information from the high resolution file while cataloging the sample 
file. 

NOTE: This option can only work properly when the high resolution file and 
the sample file reside in the same folder. 

If the option Add Category for Sample Files is activated, Cumulus will assign 
every ColorCentral sample file to a special category while cataloging. The cate-
gory name can be specified in the field below this option (default: Imation Color 
Central). This option is useful when you catalog both the high resolution and the 
sample file of an image and you want to distinguish between the corresponding 
records.

PDF Page Merge AssetProcessor (optional)
The PDF Page Merge Asset Processor enables the user to create PDF documents 
from selected PDF page assets and image assets within Cumulus. (No properties 
to be defined.) 
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Pixel Image Converter
The Pixel Image Converter enables Cumulus to convert any cataloged pixel 
image into the different formats on the fly: e.g. JPEG, TIFF, BMP, GIF, ScitexCT, 
PNG, PCX, and PDF. (No properties to be defined.) For more information on how 
to use the Pixel Image Converter, see “Converting Image Assets,” p. 79.

QXP Server AssetProcessor (optional)
The QXP Server Asset Processor converts QXP documents, layouts or pages to 
PDF using a QXP Server installed in the network. (No properties to be defined.) For 
more information on the parameters available for the conversion, see the QXP 
Server documentation.

Thumbnail Provider
The Thumbnail Provider is used with Cumulus Actions only. It provides the 
thumbnail stored in the asset’s record for a Cumulus Action. Using the thumbnail 
that is stored in the record might be faster than having the asset converted, e.g 
with the Pixel Image Converter. (No properties to be defined.)

Watermark AssetProcessor
The Watermark AssetProcessor enables you to embed digital watermarks into 
the following pixel image formats: JPEG, TIFF, BMP, GIF, PNG, and PCX. You can 
embed visible text and image watermarks. For more information on the proces-
sor and on how to use it, see “Watermarking Assets,” p. 83.

ZIP Asset Processor
The ZIP AssetProcessor enables Cumulus to compress cataloged assets into Zip 
archives. (No properties to be defined.) For more information on how to use the 
ZIP AssetProcessor, see “Creating ZIP Archives,” p. 93.

Metadata Modules
The Metadata modules are used for retrieving and managing special metadata 
information.

Canon Raw Metadata Support
Most cameras supporting Canon CRW files create additional thumbnail files 
(THM files). The Canon Raw Metadata Support module enables Cumulus to cap-
ture metadata from these files and to manage these files. For more information, 
see “Canon DC Raw Image & Thumbnail File,” p. 159

Cumulus Metadata Support
The module Cumulus Metadata Support supports the storing of an asset’s 
metadata in a separate TAG file for each asset. This makes it possible for stored 
metadata to be used externally (e.g. by other applications). Only if the Cumulus 
Metadata Support module is activated, will Cumulus be able to create a TAG file 
for each asset cataloged. (For further information on TAG files, see “Assets/
Records,” p. 23 and “Browse for Assets,” p. 251.) You can define the following 
properties for the Cumulus Metadata Support:
• Never – If a TAG file exists, Cumulus Metadata Support will read it, but no TAG 

files will be created. 
• Only if Metadata Exists – If metadata in a TAG file exists, it will be updated.
• Always – A TAG file for metadata will be created and continuously updated.
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For Directory Categories, Folder TAG files can be created. Remember, Directory 
Categories are automatically created and resemble the folder hierarchy in which 
the assets reside. The Folder TAG file for a Directory Category is called Cumulus 
Metadata.tag and resides in the corresponding folder. If the Cumulus Metadata 
Support is activated and the option Always is enabled, a Folder TAG file will be 
created as soon as you change the Category information of a Directory Category.
Folder TAG files are also created if you Drag & Drop a category to your Desktop 
or if you employ the menu item Copy Assets Assigned to Category To (for 
details, see “Copy Assets Assigned to Category To,” p. 281). And note that if you 
use this way of copying assets, the TAG files associated to the assets themselves 
will not be copied even if the Cumulus Metadata Support module is activated.

HELIOS AssetProcessor (optional)
The HELIOS AssetProcessor enables you to convert cataloged assets into the fol-
lowing file formats: TIFF, JPEG, EPS, PNG, BMP, Scitex CT, Photoshop (PSD), and 
Macintosh PICT. Considering the ICC (International Color Consortium) profile you 
can select different color spaces and compressions supported by the OPI system. 
Rotation, flipping and cropping are also possible. The conversion produces a 
new file that can be stored wherever you want.
The HELIOS AssetProcessor can be used with Cumulus Clients under Windows or 
Mac OS X as well as with Cumulus Sites or Web Client  and additional EJaPs or 
applications based on the Cumulus Java Classes. With the Cumulus Options, 
Web Client and Sites, all functions are also available on the Internet, e.g. prior to 
a download.
For details on how to use the HELIOS AssetProcessor, see the Cumulus HELIOS 
Companion Administrator Guide.

XML Metadata Prefiller
The XML Metadata Prefiller module enables Cumulus to capture additional 
metadata for an asset from a special XML file. When the asset is cataloged, the 
Prefiller looks for an XML file called “.CumulusPrefill.xml” in the file hierarchy 
above the asset’s location. If it is found, the metadata from this file is added to the 
asset’s record. (No properties to be defined.)

NOTE: The “.CumulusPrefill.xml” file will be hidden on most platforms due to 
the dot at the beginning of its file name. 

XML MetadataBridge
The XML MetadataBridge module enables Cumulus to retrieve additional infor-
mation from an asset during cataloging and store this information within XMD 
Metadata files in XML format. The XMD Metadata files are stored in the same 
location as the original asset. The XML MetadataBridge also allows you to write 
metadata, which has been changed within Cumulus, back to these XMD Meta-
data files. These files store the metadata in XML format so that it can be viewed 
in a Web browser.
The XML MetadataBridge module supports the storing of an asset’s metadata in 
a separate XMD file for each asset. This makes it possible for stored metadata to 
be used externally (i.e., by other applications). If you catalog assets from a loca-
tion where you are allowed to save files, the XML MetadataBridge can create an 
XMD file for each asset cataloged. The file is named the same as the asset but 
with the extension .xmd added and is saved in the folder where the asset resides. 
XMD files hold all of the information that can be viewed in the Information win-
dow and more. For example, if a particular asset has been cataloged in different 
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catalogs, this information is stored in that asset’s XMD file. XMD files store the 
metadata in XML format so that it can be viewed in a Web browser.
You can define the following properties:
• Never – If an XMD file exists, the XML MetadataBridge module will read it, but 

no XMD files will be created. 
• Only if Metadata Exists – If metadata in an XMD file exists, it will be updated.
• Always – An XMD file for metadata will be created and continuously 

updated.
• Under XML Metadata Viewer, it is also possible to specify an XML Style Sheet 

file for viewing your XMD files in an Internet Browser (e.g. Microsoft Internet 
Explorer version 6 or later). The XML MetadataBridge writes its location as a 
'Processing Instruction' in the head of the XMD file. When installing the Meta-
dataBridge, the file CumulusXMLMetaViewer.xsl is installed by default and 
its path is displayed in the corresponding field. If you would like to define a 
different XML Style Sheet, type the file's path directly into the corresponding 
field or click Browse to navigate to it. 

Writing metadata (e.g. to an XMD file) requires two preparatory steps. First the 
Asset Handling Set for accessing the asset must be set to allow the writing of 
metadata. Then each record field - with contents which should be written back 
as metadata - must have the When Saving Assets option enabled for its field 
linking.

NOTE: Assets in Multiple Catalogs
There is one XMD file for each asset. If the asset is cataloged in various cata-
logs, the XMD file contains which catalogs the asset is included in and all 
metadata of the asset contained in each of the various catalogs. 

XMP Metadata Support
The XMP Metadata Support module enables Cumulus to manage XMP files (e.g. 
Adobe Sidecar). (No properties to be defined.)

XUSR MetadataBridge
The XUSR MetadataBridge module is used for the Cumulus User Manager appli-
cation. It enables Cumulus to import user information from XML structured files. 
(No properties to be defined.)

Asset Format Support
Probably one of the first questions you had about Cumulus was “What kinds of 
assets does it support?” Plain and simple, Cumulus supports all kinds of assets, in 
one way or another.
Enhanced support is offered for most popular formats, meaning that Cumulus is 
aware of them and knows what information to extract from them. Others are 
supported only to the extent that they can be added to a catalog, assigned to 
categories, and searched, but no preview or automatic in-depth asset informa-
tion is available. And in some rare cases, an asset’s record will feature a thumbnail 
on one platform, but not on another. For an overview on Cumulus enhanced for-
mat support see Canto’s website.
Cumulus uses what are called filters to help it catalog the contents of an asset. 
Cumulus tells these filters what information to look for in that asset type so that 
it can become part of the asset’s record. Cumulus comes with a number of filters 
that can capture detailed information about particular assets. You can also create 
your own format support for assets that are not particularly supported. 

http://www.canto.com/en/docs/cumulus/CumulusCoreEnhancedMetadataSupport.pdf
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To see the list of file formats with enhanced support:

1. Select Cumulus / Edit > Preferences. 

2. Click Asset Handling Sets.

3. Click Asset Formats. The list of all supported file formats is displayed.

Active formats are indicated by a green marker to the left of the format. Formats 
that have been deactivated have a red marker to their left.
Formats that are indicated by italics are currently not supported (not installed on 
the machine you are working on), but are included in the list so they will be acti-
vated at that position when the filter is available.
When cataloging, Cumulus starts searching for matching formats at the lowest 
entry number. It employs the filters in the order in which the formats they sup-
port are found. If you are not satisfied with the result of cataloging certain asset 
types, check the order of the formats (and the filter that support these formats). 
The format entry that is supported by a filter that best suits your needs may come 
later in the order than other matching filters. 
Use the arrow buttons to the right of the list to change the order of the entries.

NOTE: Record Field Linking
If the Read One option in the Record Field Properties is activated for the field 
link, only the metadata read by the first matching filter will be stored within the 
record.  

If you only want to use a few of the formats on the list for the selected Asset Han-
dling Set, you can disable the others to increase program performance. 

Adding Formats to the Asset Formats List
To add new or not used formats to the Asset Formats list to have them available 
for Asset Handling Sets: 

1. On the Asset Formats tab click Add.The Add Format dialog opens. It dis-
plays a list of all Cumulus modules that provide formats which are not 
included in the Asset Formats list. If you click the plus sign in front of a mod-
ule’s entry, the list expands and displays the formats supported by this 
selected module. You can either select a module’s entry itself and all formats 
supported by the module will be added. Or you can expand the list and 
select a certain format to be added.

2. Select the format(s) you want to add and click OK. 

New formats are placed at the end of the list by default. Use the arrow buttons 
to the right of the list to move the format, if necessary.

Example Asset Format list of an Asset Handling Set.
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Changing Format Options
Some filters have options that you can change. The range of options depends on 
the filter. 
To access a filter’s options:

1. Select Cumulus / Edit > Preferences and then click Asset Handling 
Sets. 

2. Click Asset Formats. The list of all supported file formats is displayed.

3. Select the entry for the desired format in the list. If the filter supporting it has 
options that you can change,  Properties is activated.

4. Click Properties. The Filter Setup dialog is opened.

5. Make your selections and click OK.

Extending Generic Filter Options
Cumulus can catalog any digital asset. If Catalog Unknown Formats (below the 
list of asset formats) is activated and Cumulus encounters an asset for which no 
specific filter is available, then it uses its Generic Filter. You can expand the 
Cumulus Generic Filter’s capabilities to create your “own formats.” For assets that 
don’t have specific format provided by Cumulus, you can define a thumbnail for 
the asset format by using the Generic Filter. 
If you use formats that you’ve created on your own, check the Canto Website 
from time to time to see if a filter has been developed that supports this format 
and you could use.
To set up a new format:

1. Select Cumulus / Edit > Preferences and then click Asset Handling 
Sets. 

2. Click the Modules tab and then on the Filter icon to see the list of installed 
filters.

The options that can be 
changed for the EPS Filter.
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3. Select the Generic Filter in the list and click Properties. The window to set 
up the properties for the new format appears. 

4. Enter your format’s file name extension in the File Extension field. Do not 
enter the period.

5. Type a name for the format in the File Format field. If your system is 
aware of the asset type, its name may be entered for you.

6. Enter the Mac OS file type in the Mac OS File Type field. The file type will 
always be 4 characters in length.

7. Enter the file format identifier (typically the mime type) in the File Format 
Identifier field.

8. Choose the kind of thumbnail you want to be displayed for the assets. You 
can use either the asset’s Finder / Windows Explorer icon, a thumbnail 
generated by an external application, or an image that you specify.

If you want to specify a thumbnail image to be used for the assets of the 
specified format, activate the Static Thumbnail option, which enables the 
Browse button. Then click the Browse button to select an image. You can 
use any JPEG file as a static thumbnail. The image is resized, if necessary, and 
pasted into the thumbnail image area. Each asset cataloged with this format 
will use this image as its thumbnail.

If you want a thumbnail image generated by an external application, acti-
vate the Call External Application option, which enables the Configure 
button. Then click the Configure button to specify the external application. 
For details on the parameters, see the Appendix of the Administrator Guide.

9. Click OK to save your new format. 

To have the new format available for Asset Handling Sets you have to add it to 
the Asset Formats list: 

1. Click the Asset Formats tab and click Add.The Add Format dialog opens.

2. Expand the Generic Filter entry by clicking on the plus sign on its left. The 
formats available are displayed.

3. Select the format you want to add and click OK. 

New formats are placed at the end of the list by default. Use the arrow buttons 
to the right of the list to move the format, if necessary.

TIP: 
If anything goes wrong while cataloging, check the file extension!



CUSTOMIZE CUMULUS –  EXTENDING GENERIC FILTER OPTIONS 221
Cumulus Asset Actions
Cumulus Actions simplify daily workflow needs. An Asset Action refers to a com-
bination of certain functions and can be saved under a chosen name. Whenever 
you wish to perform this combination of functions, all you need to do is select 
the corresponding action and it will be done. An Asset Action can include three 
different types of functions: Processing, Packing, Delivering
Firstly, you can have the selected assets processed, then you decide whether the 
result of this process should be packed into one file and finally, you define where 
this file should be delivered. By default the delivery destination is the file system 
and the only packing possibility is the ZIP AssetStore. 
• Processing

Defining a processing module for an Action is optional. Processing modules 
will always produce as many files as records were selected for the Action. For 
processing, a list of possible modules is provided from which you can choose 
the module you want to use. (For descriptions of the modules, see “Asset Pro-
cessor Modules,” p. 211.) If you select more than one processing module for 
an Action, the sequence is important. 
NOTE: The sequence of the processing modules must make sense. For 
example, having the Zip AssetProcessor as the first processing module 
and then using the Pixel Image Converter to produce JPEG files does not 
make any sense. However, doing it the other way around is fine. Then you 
will get one ZIP file for each selected record and each ZIP file will contain a 
JPEG image. 

• Packing
Packing modules pack the selected assets (or the files resulting from the pro-
cessing) into one file. For example: if you have selected Pixel Image Converter 
for processing (to produce TIFF files) and then Zip AssetProcessor for packing, 
the result will be TIFF files for each selected record packed in one Zip file. 
Another example that might sound odd but also might make sense in certain 
circumstances: if you have selected the Zip AssetProcessor for processing as 
well as for packing, the result will be Zip files for each selected record packed 
in one easy to handle Zip file. 
NOTE: The sequence of the processing modules must make sense. For 
example, having the Zip AssetProcessor as the first packing module and 
then using the PDF Page Merge AssetProcessor does not make any sense. 
However, doing it the other way around is fine. Then you will get one PDF 
compressed into a ZIP archive. 

• Delivering
Defining a delivering module for an Action is not optional. You have to define 
a delivering module for every Action. 

• Asset Handling Set
You can also select a specific Asset Handling Set to be used for the Action. If 
you don’t specify one, the Asset Handling Set will be used that is defined in 
the User Settings of the user who uses the Action. As this Asset Handling Set 
might have some modules not activated that are needed for the action, we 
recommend selecting a certain Asset Handling Set. (We strongly recommend 
this for Actions that are set up to be used by different users.) The Asset Han-
dling Set selected for an Action should be a shared one and should be avail-
able for those you want to perform the Action on. And it should correctly 
support the modules chosen for the Action.

See “Overview: Cumulus Asset Actions,” p. 223, for an overview of the options 
available for a Cumulus Action. 
You can either change existing Actions or create new ones – if you have the 
appropriate permissions for changing or creating Actions. There are Actions for 
individual use and Actions that are shared with other users. Shared Actions are 
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displayed in italics in the list for selecting the one to be edited. You may have the 
right to define and customize your individual Actions only or may even have the 
right to edit all Actions. 
Asset Actions are created and edited in the Preference dialog window 
( Cumulus / Edit > Preferences  > Asset Actions.)
PRECONDITIONS: To view and modify Asset Actions, you must have the appro-
priate permissions (Server Permissions > Asset Actions Permissions.) 

Creating an Asset Action
A new Asset Action is created by duplicating an existing one and adapting its set-
tings: 

1. Select Cumulus / Edit > Preferences. 

2. Click Asset Actions.

3. Under Action, select the Action to use as a basis for the new one.

4. Click the Duplicate button.

The  Name and Settings dialog opens.

5. Enter a name for the new Action, and optionally –

• Activate the Allow Sharing option, if you want this action to be available 
to other users.

• Activate Copy display names only, if you also want to take over the lan-
guage-specific display names from the original (not recommended for 
new Asset Actions).

• Activate Copy description only, if you also want to take over the descrip-
tions specified for other languages from the original (not recommended 
for new Asset Actions).

6. Click OK.

7. Define the new Action. (See “Overview: Cumulus Asset Actions,” p. 223, for 
an overview of the options available.)

8. Click Apply to save your changes.

Editing an Asset Action
To change an existing Asset Action:

1. Select Cumulus / Edit > Preferences. 

2. Click Asset Actions.

3. Under Action, select the Cumulus Action you want to edit.

4. Make the changes. 

5. Click Apply to save your changes.

See “Overview: Cumulus Asset Actions,” p. 223, for an overview of the options 
available for Actions. With Workgroup or Enterprise, Actions can only be defined 
by the Cumulus Administrator or by users who have the right to do this.
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Overv
Asset Acti nu item 
Asset > P
TIP: 
If you have the appropriate permissions, you can easily access the 
preferences of Cumulus Actions by selecting the Customize entry in 
the submenu for selecting an Action. This entry opens the preferences 
for the current Action.

Setting A Default Asset Action
You can define one Asset Action to be the default. This default is not used with 
any standard function of this Cumulus version but may be used by any additional 
function, e.g. provided by a third party partner.
The default Asset Action is denoted by bold characters in the list for selecting the 
Action. To set the default Action:

1. Select Cumulus / Edit > Preferences. 

2. Click Asset Actions.

3. Under Action, select the Action you want as default. This should be a shared 
Action (denoted by italics).

4. Click the Set as Default button.

5. Click Apply to save your changes.

iew: Cumulus Asset Actions 
ons refer to a combination of certain functions. Asset Actions defined here can be selected when using the me
erform Asset Action, when e-mailing assets and in the Collection Basket.
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On Error
14 If an error occurs, the whole asset action is aborted.
15 If an error occurs, the erroneous asset is skipped, but t

action is continued.
Additional Properties
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Delivering
12 Displays the selected delivering module.
13 Opens a list of available delivering modules for select
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Metadata Templates
Metadata Templates are used to add information to the metadata information 
that is stored on an asset. To make use of such a template, you can either use it 
while cataloging (along with an Asset Handling Set or the Prefiller Utility) or apply 
the metadata information to records of already cataloged assets. For a descrip-
tion on how to use Metadata Templates to apply metadata information to the 
records of already cataloged assets, see “Using a Metadata Template,” p. 26. For 
a description on how to use Metadata Templates while cataloging, see “Employ-
ing the Metadata Editor,” p. 253.
For defining a Metadata Template you can select record fields that should be 

filled when the Metadata Template is employed. These record fields can be all 
available field types except Binary fields. Clicking the Add button reveals a list of 
all available fields (provided by filters or by currently opened catalogs). For each 
field added to the template, you can enter a value. For String fields you can also 
define whether you want the new text to replace the existing value or to be 
appended to the existing text. Clicking in a String field’s entry in the column Fill 
Mode allows you to select the desired mode. For all other field types, the entered 
value will replace the existing value. For date field types, the current date is 
shown initially. illustrating the date format  to be entered. A date may be entered 
manually in the given format or selected with a date picker.
To have a field filled when the Metadata Template is used, the Use option for the 
field must be enabled.
You can either change existing templates or create new ones – if you have the 
appropriate rights for changing or creating templates. There are templates for 
individual use and templates that are shared with other users. Shared templates 
are displayed in italics in the list for selecting the one to be edited. You may have 
the right to define and customize your individual templates only or may even 
have the right to edit all templates.
Metadata Templates are created and edited in the Preference dialog window 
( Cumulus / Edit > Preferences > Metadata Templates.)
PRECONDITIONS: To view and modify Metadata Templates, you must have the 
appropriate permissions (Server Permissions > Metadata Templates Permis-
sions.) 

Creating A Metadata Template
A new Metadata Template is created by duplicating an existing one and adapt-
ing its settings:

1. Select Cumulus / Edit > Preferences. 

2. Click Metadata Templates.

3. Under Metadata Template, select the Metadata Template to be used as the 
basis for the new one.
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4. Click the Duplicate button. The  Name and Settings dialog opens.

5. Enter a name for the new template and optionally 

• Activate the Allow Sharing option, if you want this template to be avail-
able to other users.

• Activate Copy display names only, if you also want to take over the lan-
guage-specific display names from the original (not recommended for 
new templates).

• Activate Copy description only, if you also want to take over the descrip-
tions specified for other languages from the original (not recommended 
for new templates).

6. Click OK.

7. Define the new Metadata Template. (See “Overview: Metadata Templates,” 
p. 228, for an overview of the options available.)

8. Click Apply to save your changes.

Editing A Metadata Template
To change an existing Metadata Template:

1. Select Cumulus / Edit > Preferences. 

2. Click Metadata Templates.

3. Under Metadata Template, select the template you want to edit.

4. Make the changes. (See “Overview: Metadata Templates,” p. 228, for an over-
view of the options available.)

5. Click Apply to save your changes.

TIP: 
If you have the appropriate permissions, you can easily access the 
preferences of Metadata Templates by selecting the Customize entry 
from the list for selecting Metadata Template (e.g. in the Asset Infor-
mation window). This entry opens the preferences for the current 
Metadata Template.

Setting A Default Metadata Template
You can define one Metadata Template to be the default template. This default 
is not used with any standard function of this Cumulus version but may be used 
by any additional function, e.g. provided by a third party partner.
The default set is denoted by bold characters in the list for selecting a set. To set 
the default set:

1. Select Cumulus / Edit > Preferences. 

2. Click Metadata Templates.

3. Under Metadata Template, select the template you want as default. This 
should be a shared template (denoted by italics).

4. Click the Set as Default button.

5. Click Apply to save your changes.
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adata Templates are used to add information to the metadata information that is stored on an asset. They can
 while cataloging or for applying metadata information to records of already cataloged assets.
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olumn Value. 
OTE: For date field types, the current date is 

hown initially, illustrating the date format 
o be entered. A date may be entered manu-
lly in the given format or selected with a 
ate picker.

f a fields type String List is selected, the arrow 
pens a list containing the values of a String 
ist field. 

12 Displays how the field will be filled. For all field types except String fields,
entered value will replace the existing value. For String fields you can def
whether you want the new text to replace the existing value or to be add
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Print Templates 
Cumulus provides enhanced print options for printing records. The different 
combination of print options can be combined and saved as Print Templates. 
Print Templates make it easy to select print options that are set up for certain 
views or tasks. Once Print Templates have been appropriately defined to meet 
differing demands, the user can easily select them for printing records.
If you have the appropriate rights, you can extensively customize most tem-
plates. There are Print Templates for individual use and templates that are shared 
with other users. Shared templates are displayed in italics. 
A Print Template defines how records will be printed. Print Templates include 
definitions for the document layout (page size and orientation, as well as mar-
gins) and the layout of the records to be printed. To serve as print layout for the 
records, you can either use a Record View Set or define advanced print settings. 
The advanced print settings allow you to specify how the printed records will 
appear on the page. They include options for: 
• the grid to be used (e.g number of rows and columns)
• the thumbnail (e.g. alignment and resolution)
• the fields to be included in the print-out of each record (including font selec-

tion)
• the header and footer text (including font selection)
• PDF creation (PDF security settings and enabling Cumulus Web Client/Sites 

URL-link feature)
When defining advanced print settings for a Print Template, a Preview function 
enables you to check the result of your settings. You can see just what a page 
looks like before deciding to save the template.
Print Templates can be used when printing records (File > Print.)
Print Templates are created and edited in the Preference dialog window 
( Cumulus / Edit > Preferences  > Print Templates.)
PRECONDITIONS: To view and modify Print Templates, you must have the 
appropriate permissions (Server Permissions > Print Templates Permissions.) 

Creating and Editing a Print Template
A new Print Template is created by duplicating an existing one and adapting its 
settings:

1. Select Cumulus / Edit > Preferences. 

2. Click Print Templates.

3. Under Template, select the Print Template to be used as the basis for the 
new one.

4. Click the Duplicate button. The  Name and Settings dialog opens.

5. Enter a name for the new template and optionally –

• Activate the Allow Sharing option, if you want this template to be avail-
able to other users.

• Activate Copy display names only, if you also want to take over the lan-
guage-specific display names from the original (not recommended for 
new print templates).

• Activate Copy description only, if you also want to take over the descrip-
tions specified for other languages from the original (not recommended 
for new print templates).

6. Click OK.
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7. Define the new Print Template. (See “Print Templates,” p. 229, for an over-
view of the options available.) TIP: If you define advanced print settings, use 
the Preview function to check your settings before you save them.

8. Click Apply to save your changes.

TIP: Previewing a Print Template including Live Previews of Images
If you want to check the result of your settings with live previews of 
images, you should select these images before you open the prefer-
ence dialog. Select at least as many images as needed to fill the 
intended grid cells of one page.

To change an existing Print Template:

1. Select Cumulus / Edit > Preferences. 

2. Click Print Templates.

3. Under Template, select the template you want to edit.

4. Make the changes. (See “Print Templates,” p. 229, for an overview of the 
options available.) TIP: If you define advanced print settings, use the Preview 
function to check your settings before you save them. 

5. Click Apply to save your changes.

Setting A Default Print Template
You can define one Print Template to be the default template. This default is not 
required by any standard function of this version of Cumulus, but may be used 
by additional functions, such as those developed by third party partners. The 
default template is denoted by bold characters in the list for selecting a tem-
plate. 
To set the default template:

1. Select Cumulus / Edit > Preferences. 

2. Click Print Templates.

3. Under Template, select the template you want as default. This should be a 
shared template (denoted by italics).

4. Click the Set as Default button.

5. Click Apply to save your changes.
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erview: Print Templates
int Template stores a specific combination of print options. It can be used when printing records. Print Templa
reated and edited in the Preference dialog window ( Cumulus / Edit  > Preferences  > Print Template

isplays the selected Print Template.
isplays a list of available Print Templates for selection. 
hared Print Templates are displayed in italics.
pens the Properties dialog for the selected template – 
roviding two tabs. On the Description tab you may enter 
r modify language-specific display names and descrip-

ions. The Sharing tab allows you to define whether you 
ant to share the template with others. Additionally you 
ay restrict the usage to specific users or roles.
pens a dialog to create a new Print Template by copying 

he selected one.
pens a dialog to rename the selected Print Template.
OTE: When renaming shared templates, remember to 
pdate users’ permissions for the template.
eletes the selected Print Template.
ets the selected Print Template as default.

ument Settings
Document Settings tab defines the layout for the entire 
ment.
aper Setup settings define the paper size: either a stan-
ard size or a custom size for which the width, height and 
easurement unit can be defined.
OTE: The Units selected here refer to all measurements 
f the template.

9 Orientation defines the orientation for the output (portrait 
landscape).

10 Margins settings define the margins for the page layout.

ut
Layout tab defines the layout for the printed records. You 
either use a Record View Set for the layout, or define 
nced print settings.

f activated, a Record View Set is used for the layout.
f Record View Set Defines Layout is activated, you can 
hoose:
he current Record View is used for layout. 
 specific Record View from a a specific Record View Set is 
sed for layout. You can select the Record View Set and the 
iew to be used.
E: If a Record View Set defines the layout and if you have 
ated the print option Print Entire Assets as Thumb-

s in the Printing tab and set the thumbnail size to 1024 in 
isplay tab of your User Settings, the records’ thumbnails 
e printed in high-resolution, so the printouts can serve as 

act sheets. This may take a while as each of the thumb-
 has to be created.

f activated, you can define Advanced Print Settings for 
he layout.
f Advanced Print Settings Define Layout is activated, 
ou can:
elect the item you want to define for layout.

For an overview on the Advanced Print Settings, see “Overview
Print Templates – Advanced Print Settings,” p. 233.

For an overview on the margin settings, see “Overview: Print Te
plates – Margin Settings,” p. 232
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iew: Print Templates – Advanced Print Settings
e a Print Template, select Cumulus / Edit  > Preferences  > Print Templates.
ced Print Settings Define Layout is activated on the Layout tab, you can define various layout options. The o
ped by topic items and represented by icons. Select the corresponding icon to define your layout.

etermines how many records can be printed on one page. 
er of columns and rows defines the amount (and size) of 
 cell contains a record. The grid shrinks to fit into the space 
 defined margins and spacing. For an overview of the mar-
pacing, see “Overview: Print Templates – Margin Settings,” 

al Options are:
round Color: Determines the background color for the 

 pages except the areas around the image and for the field 
ation. (See also below.)

 Border around Each Cell: Activate this option to have a 
 drawn around each cell.

ge, regardless of size, is scaled in proportion to fit to one cell. 
ment: Determines the alignment point for the image with 
t to the cell.
round Color: see below
 Margin: see “Overview: Print Templates – Margin Set-

” p. 232.
ntire Assets at: Determines whether the entire asset should 
d for printing and the highest resolution an image should 

nted with. (The resolution for the printout cannot be higher 
hat of the original.) 
 the thumbnails is faster but using the entire assets lets you 
e the dpi and so you can decide on the quality. Using the 
 assets also lets you choose the JPEG quality.
humbnails: Determines whether the thumbnail should be 
or printing an image. 
 Assset Action: Activate this option to select an Asset 
 to be performed, e.g. to watermark printed thumbnail

 Border around each Image: Activate this option to have a 
 drawn around each image.

Fields
Under Fields Shown define the fields which values you wan
included in the printout. 
To add fields click the Add button. This opens a list of availab
To define the display properties of a field, select the field and
Properties button. 
Properties concerning the layout of all displayed fields are se
Additional Properties.
• Alignment: Determines the display position for record fi

ues – depending on Show Field Names activated or not
Field Names is activated, the alignment point is the endi
longest field name.

• Align to Image: Determines the display position with re
the image. 

• Margin to Image, Outer Margin and Line Spacing: see
view: Print Templates – Margin Settings,” p. 232.

• Background Color: see below
• Show Field Names: Activate this option to have the field

displayed along with the field value.

NOTE: Space for Displaying Field Information
Each image is scaled in proportion to fit to one cell. Only the s
in a cell is used to show field information. Take this into consi
when selecting the fields and defining their display propertie
image takes precedence over the field information. If an imag
cell, the record field information will not be shown.

Background Colors
Background colors are defined by settings on the Grid, Imag
Fields tab.

Grid Image 
Fields
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PDF Print Options
Cumulus requires no additional software to generate print output as PDF. The 
generated PDF documents can even include links to access the records via Inter-
net. If you have a Cumulus Web Client, Sites, Web Publisher Pro (WPP) or Internet 
Client Pro (ICP) installation, you can take advantage of the URL-link feature. 
To allow the creation of a PDF document, you must activate the Allow PDF Print-
ing option in a Print Template. This enables a user to choose the Print to PDF 
option when the template is selected for printing. If the user chooses Print to 
PDF and the Allow changes to PDF settings when printing option was set in 
template, the dialog PDF Print Settings opens where several PDF options can be 

and Footer
er and footer are printed at the top or bottom of each page 
ut the print output. Headers and footers can include individ-
nd automatic text – for example, page numbers, the date, 
g's name, or the user name. The text can be formatted.

s a dialog for defining the font attributes for the selected 

s bold formatting to the selected text.
s italic formatting attribute to the selected text.
s underline formatting to the selected text.

 a menu to select a placeholder for inserting automatic text 
all image at cursor position in the header or footer text. 
atic text is provided for common header or footer items, 

s running total page numbers (Page 1 of 10), time and date. 
an also include the name(s) of the catalog(s), the Login 
 of the user who uses the Print template or the name of the 
uter running your Cumulus Server.
: You can also define your own placeholders for headers and 
s. If you enter a word beginning with the % character (e.g. 
ect), Cumulus will open a dialog that asks you to fill this 
older when a print process is started that uses this tem-

6 Ruler that displays the tab stop positions and right docu
margin. The measurement unit for the ruler is the unit se
the Document Settings.
To insert a tab stop, click on the position where you wan
To move a tab stop, drag the tab marker to the right or le
horizontal ruler.

PDF Options 
For an overview on the various options, see “PDF Print Optio
p. 234.

Preview
Provides a preview reflecting the current status of the print te
Use this function to check your settings before you save them
clicking Apply or OK .) 
TIP: Resize the Preference window to see the preview sized to
needs. 

• Use Live Previews of Selected Records: Activate this op
see the defined template with live previews of images. Ho
depending on the images’ sizes and resolutions this may
consuming.

TIP: Previewing a Print Template including Live Previews of I
If you want to check the result of your settings with live prev
images, you should select these images before you open the
ence dialog. Select at least as many images as needed to fill 
intended grid cells of one page. 

iew: Print Templates – Advanced Print Settings
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determined. The further PDF Print Options set in the template serve as pre-set-
tings which can be changed in this dialog.

For PDF creation the following options can be pre-set in a Print Template:
• Allow Web Client/Sites URL-Link Feature

If the records derive from catalog(s) that are published on the Internet, you 
can use this option to include links to the records in the PDF. 
• In the field Web Client/Sites Base URL enter the path to your Cumulus 

Web Client, Sites, Web Publisher Pro (WPP) or Internet Client Pro (ICP) 
installation application:
http://[Web server address]/Sites for Sites
(e.g.: http://123.45.67.89:8080/Sites
or http://[Web server address]/Cumulus for WPP 
(e.g.: http://123.45.67.89:8080/Cumulus)
or http://[Web server address]/webclient for ICP or Web Client 
(e.g.: http://123.45.67.89:8080/webclient). 

• Activate Record URL for Display in Web Client / Sites, if you want the links 
lead to records which will be displayed in Sites or the Web Client (addition-
ally, you may activate Use guest Login to allow allow guest access without 
login name and password).
OR
Activate Asset URL for Download, if you want the links lead to assets 
which can be downloaded (provided that asset URLs have been config-
ured for the respective assets; for details see “Configuring Web URL,” 
p. 100).

• Enable PDF Security
When creating PDF files you can use password security to add restrictions 
that can prevent a file from being opened, printed or edited. Passwords can 
only be set when creating the PDF document. (For details, see “Record Print-
ing to PDF with Cumulus,” p. 236.) For details on the PDF security options that 

The Print Template determines whether a 
PDF can be created in general. And it can 
have PDF options set that serve as pre-set-
tings for the final PDF Print Settings.

Dialog for defining PDF Print Settings when 
creating a PDF (only available when in the 
Print Template used for printing the Allow 
changes to PDF settings when printing 
option is activated.)
The PDF options set in the Print template 
serve as pre-settings for this dialog.

enables

opens 
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can be pre-set with a Print Template, see table below.
PDF security options that can be pre-set in a Cumulus Print Template are:

Record Printing to PDF with Cumulus
For printing records Cumulus offers the possibility to print to PDF. To generate 
print output as PDF no additional software is required. The PDF documents can 
even include links to access the records via the Internet. If you have an installa-
tion with a Cumulus Internet Solution, you can take advantage of the URL-link 
feature.
To make use of the Cumulus PDF printing feature you have to use a Print Tem-
plate for printing that uses the advanced print settings which are set to allow 
printing to PDF. 
If you select a Print Template for printing records that allows PDF printing, you 
can choose to have the output saved as a PDF file. 
If the Print to PDF File and the Allow changes to PDF settings when printing 
options were set in template, clicking on the Print button opens the PDF Print 
Settings dialog. The various options are pre-set as defined in the current Print 
Template. Only the password options are not pre-set to prevent them to be set 
by mistake or/and nobody can remember the passwords.

F Security Option If the option is activated, users can 

llow Printing in High Resolution print the document in any resolution

llow Printing in Low Resolution print the document at resolution no higher than 150-dpi 

llow Document Changes change the document (including assembling and filling in forms as we
as adding digital signatures)

llow Document Assembly assemble the document (insert, rotate, or delete pages as well as create
bookmarks or thumbnail pages), even if Allow Document Changes is 
not set.

llow Content Copying or Extraction copy and extract document’s contents (text and graphics)

llow Content Copying or Extraction 
r Screen Readers

use screen reader devices for copying or extracting document’s con-
tents only. Visually impaired users are allowed to read the document 
with screen reader devices in any case. This option adds the permission
to copy and extract.

llow Modifying Annotations can add and edit comments as well as form fields and digital signature

llow Filling in Forms and Signing fill in forms and add digital signatures only. 
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Web Client/Sites URL-Link Feature
If the records derive from catalog(s) that are published on the Internet, you can 
use this option to include links to the records in the PDF. Activate the Allow Web 
Client/Sites URL-Link Feature option and 
• In the field Web Client/Sites Base URL enter the path to your Cumulus Web 

Client, Sites, WPP or ICP application:
http://[Web server address]/Sites for Sites 
(e.g.: http://localhost:8080/Sites) or 
http://[Web server address]/Cumulus for WPP 
(e.g.: http://localhost:8080/Cumulus) or 
http://[Web server address]/webclient for Web Client or ICP 
(e.g.: http://123.45.67.89:8080/webclient) 

• To allow logging in for the PDF users without login name and password, acti-
vate the Use Guest Login option.

PDF Security
PDF security can be compared with home security. Just as you lock your doors to 
prevent others from entering your house without permission, you may use the 
various security features to “lock” PDF documents. For example, you can add 
passwords to restrict users from opening a PDF document, or they can prevent 
users from printing or editing a document. 
A PDF file can have two kinds of password: a Document Open password and a 
Permissions password. If you are restricting printing and editing, you should add 
a Document Open password to enhance security. 
• Opening the document with the correct Permissions password allows full 

access to the document. This unlimited access includes the ability to change 
the document’s passwords and access permissions. 

• Opening the document with the correct Document Open password allows 
additional operations to be performed according to the set PDF security 
options.

With Enable PDF Security activated but Document Open and Permissions pass-
words not specified, the document will be encrypted, with user-level access, and 
a random Permissions password is generated; the user will not be prompted for 
a password, but nobody can have full access to the document.
With Enable PDF Security activated but only the Document Open password 
specified, a random Permissions password is generated, the document will be 
encrypted and the user will be prompted for a password. Again, nobody can 
have full access to the document. If both passwords are specified, the document 
will be encrypted and the user will be prompted for a password; depending on 
the password entered, the user can have full access, or only restricted access to 
the document. 
For details on the other options, see “PDF Security Option,” p. 236.
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Sub-Pane Filters
Sub-Pane Filters provide enhanced support for managing related assets. The panes 
of the split view display certain assets only. Assets that are related to the assets 
selected in the main pane. Which assets are displayed is determined by the option 
selected in the pane’s display drop-down list. This option defines how they are 
related. Sub-Pane Filters make it easy to set up such options. Each Sub-Pane Filter is 
a list option in the sub-panes’ display list. Cumulus provides various pre-configured 
Sub-Pane Filters that should suffice most needs but you can also create your own 
Sub-Pane Filters. 

Sub-Pane Filters are created and edited in the Preference dialog window 
( Cumulus / Edit > Preferences > Sub-Pane Filters.)
PRECONDITIONS: To view and modify Sub-Pane Filters, you must have the 
appropriate permissions (Server Permissions > Sub-Pane Filters Permissions.) 
Once you have set up the Sub-Pane Filters as needed, you assign them to users. 
So you can provide individual menus to your users. The availability of Sub-Pane 
Filters for users is defined with the User Manager in each user’s properties. (File 
> Administration > Server Console > User Manager > User/Role Properties > 
Sub-Pane Filters.)

Creating and Editing a Sub-Pane Filter
A new Sub-Pane Filter is created by duplicating an existing one and adapting its 
settings:

1. Select Cumulus / Edit > Preferences. 

2. Click Sub-Pane Filters.

3. Under Filter, select the Sub-Pane Filter to be used as a basis for the new one.

Example of a pre-configured Cumulus Sub-Pane Filter. With this filter employed a sub-
pane will show all contained assets of type Page/Slide only but from all levels.
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4. Click the Duplicate button. The  Name and Settings dialog opens.

5. Enter a name for the new filter and  optionally

• Activate the Allow Sharing option, if you want this filter to be available to 
other users.

• Activate Copy display names only, if you also want to take over the lan-
guage-specific display names from the original (not recommended for 
new sub-pane filters).

• Activate Copy description only, if you also want to take over the descrip-
tions specified for other languages from the original (not recommended 
for new sub-pane filters).

6. Click OK.

7. Define the new Sub-Pane Filter. The settings define what will be displayed in 
a sub-pane for related assets view.

Choose the relation between the selected record(s) and the records dis-
played in the sub-pane by selecting a relation type from the drop-down list. 
For details on relations types, see “Relationships,” p. 124.)

Then choose the level of relation.

• First Level only: Only directly related, contained or referenced assets are 
displayed. (Example use: to see the assets contained in a ZIP file only and 
not the assets that may be contained in these assets.) 

• Last Level only: (Example use: Remember, an image can be a variant of a 
source but it itself is also the source of another variant. But you don’t care 
whether the selected record in the main pane is a variant of another vari-
ant. You are only interested in the top level variant source (the origin) and 
that’s what you want to see in the sub-pane.)

• All Related Assets: The records of all related assets are displayed regardless 
of whether the relation is direct or indirect.
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If you want to have only Pages and Slides or Video shots displayed in the 
sub-pane, activate the Further ... option and select include only from the 
drop-down list. Then activate the asset type that you want to be displayed 
only.

If you don’t want to have Pages and Slides or Video shots displayed in the 
sub-pane, activate the Further ... option and select exclude from the drop-
down list. Then activate the asset type that you don’t want to be displayed.

If you want the displayed result to be based on selected records only, you 
can include a record query in the settings of the Sub-Pane Filter. To do so, 
activate the Use Additional Query option. The Use Query and Use File but-
tons are enabled. Click the Use Query or Use File button. A dialog for select-
ing the corresponding query will open. Select the query you want to apply 
as filter option and click OK/Select. The query is saved with the filter settings 
and the search conditions of the query are displayed. Note that the data of 
the query is saved with the Sub-Pane Filter and if you change the query later 
on, the Sub-Pane Filter will not be changed accordingly.

NOTE:  If you cannot open the default folder for storing queries, it may 
be due to its folder properties. If the folder properties are set to Hidden, 
this folder cannot be addressed by the Select dialog. Then you either have 
to change the folder properties or save the queries to another location 
that you can access. 

8. Click Apply to save your changes.

To change an existing Sub-Pane Filter:

1. Select Cumulus / Edit > Preferences. 

2. Click Sub-Pane Filters.

3. Under Filter, select the one you want to edit.

4. Make the changes. 

5. Click Apply to save your changes.

Setting A Default Sub-Pane Filter
You can define one Sub-Pane Filter to be the default. This default is not required 
by any standard function of this version of Cumulus, but may be used by addi-
tional functions, such as those developed by third party partners. The Sub-Pane 
Filter is denoted by bold characters in the list for selecting a filter. 
To set the default Sub-Pane Filter:

1. Select Cumulus / Edit > Preferences. 

2. Click Sub-Pane Filters.

3. Under Filter, select the one you want as default. This should be a shared one 
(denoted by italics).

4. Click the Set as Default button.

5. Click Apply to save your changes.
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Permissions Templates 
Permissions templates enable you to assign, remove or explicitly set individual 
asset or category permissions for users or entire groups at once. 

Optional feature!  May not be available with your Cumulus configuration.

A Permissions Template includes permissions for records and categories. 
Depending on the context in which a template is used, either the record or cat-
egory permissions will be used. With selected records, the defined record per-
missions will be used; with categories, the defined category permissions will be 
used.

IMPORTANT! Permissions Templates refer to individual record or category permis-
sions only. Remember that these are always added to the permissions a user has in 
general for all records and categories of the catalog. A user’s permissions cannot be 
reduced by individual record or category permissions. If a user is given an Application 
permission for the records or categories of a catalog, he/she will have this permission 
– no matter whether this permission is set to be removed in a Permissions Template 
used. Only an individual record or category permission can be removed by a Permis-
sions Template. 

Permissions Templates can be used in the Properties dialog window for records 
or categories. With records, they can also be used when cataloging assets or 
updating records. For cataloging, a Permissions Template is used when the cat-
aloging user has access to at least one Permissions Template. Users who have 
access to more than one Permissions Template are prompted to select one for 
the cataloging process. 
Permissions Templates can also be used for auto-cataloging. This requires that the 
catalog contains the Category field AutoSync Permissions Template.
Permissions Templates are created and edited in the Preference dialog window 
( Cumulus / Edit > Preferences  > Permissions Templates.)
PRECONDITIONS: To view and modify Permissions Templates, you must have 
the appropriate permissions (Server Permissions > Permissions Templates Per-
missions.) 

Creating and Editing Permissions Templates
A new Permissions Template is created by duplicating an existing one and 
adapting its settings:

1. Select Cumulus / Edit > Preferences. 

2. Click Permissions Templates.

3. Under Permissions Template, select the one you want to be the basis for 
the new one.

4. Click the Duplicate button. The  Name and Settings dialog opens.

5. Enter a name for the new template and and optionally
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• Activate the Allow Sharing option, if you want this view set to be available 
to other users.

• Activate Copy display names only, if you also want to take over the lan-
guage-specific display names from the original  (not recommended for 
new permissions templates).

• Activate Copy description only, if you also want to take over the descrip-
tions specified for other languages from the original (not recommended 
for new permissions templates).

6. Click OK.

7. Define the new Permissions Template.

• Add the user(s) and/or role(s) to which you want to assign the record/cat-
egory permissions by clicking the appropriate button (Add User or Add 
Role). (The Add User button is available only if you have the Browse for 
Users permission.)These buttons open a corresponding dialog.
To add users, you can search for available users. The possible search criteria 
depend on the authentication method (see above). Default search criteria 
is the login name. Enter the search value (a matching string) and click the 
Find button. The result of this search is listed below. Select the user(s) you 
want and click OK. The users are added.
When adding roles, Cumulus will list the available roles. Select the role(s) 
you want and click OK. The roles are added.

• Select the user/role you want to assign permissions to.
• Activate the permissions you want to be set with this template. Then 

define for each activated permission whether it should be added to or 
removed from the permissions already given. (See “Overview: Permissions 
Templates,” p. 243, for an overview of the options available. For more infor-
mation on the permissions available with Cumulus, see Administrator 
Guide.)

8. Click Apply to save your changes.

To change an existing Permissions Template:

1. Select Cumulus / Edit > Preferences. 

2. Click Permissions Templates.

3. Under Permissions Template, select the one you want to edit.

4. Make the changes. (See “Overview: Permissions Templates,” p. 243, for an 
overview of the options available. For more information on the permissions 
available with Cumulus, see Administrator Guide.)

5. Click Apply to save your changes.

TIP: 
If you have the appropriate permissions, you can easily access the 
preferences of Permissions Templates by selecting the Customize 
entry in the list for selecting Permissions Template. This entry opens 
the preferences for the current Permissions Template.
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Setting A Default Permissions Template
You can define one Permissions Template as the default template. This default is 
not used by any standard function of Cumulus, but it can and might be used by 
custom program functions, such as those added by third party partners.
The default set is denoted in the templates list by bold characters. To set the 
default set:

1. Select Cumulus / Edit > Preferences. 

2. Click Permissions Templates.

3. Under Permissions Template, select the one you want as default. This 
should be a shared one (denoted by italics).

4. Click the Default button.

5. Click Apply to save your changes.

view: Permissions Templates 
ions Templates are used to set record and category permissions for selected records or categories. They can be
roperties dialog window for records or categories. With records, they can also be used when cataloging asse
g records. 
p Permissions Templates, select Cumulus / Edit > Preferences and click Permissions Templates. 

lays the selected Permissions Template.
ns a list of available Permissions Templates. 
ed Permissions Templates are displayed in italics.

ns the Properties dialog for the selected template – 
iding two tabs.  On the Description tab you may 
r or modify language-specific display names and 
riptions. The Sharing tab allows you to define 
ther you want to share the template with others. 
itionally you may restrict the usage to specific users 
les.

ns a dialog used to create a new Permissions Tem-
 by copying the selected one.

ns a dialog used to rename the selected Permis-
s Template.
E: When renaming a shared templates, remember 
date user permissions for this template, as 
ed.
tes the selected Permissions Template.

 the selected Permissions Template as default.
ates type: User or Role

 the names of users or roles the template will affect.
ns a dialog used to select users. (Available only if 
have the Browse for Users permission.)
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15 If activated, the permission will be removed when the template is 
NOTE: The permission will be removed only if it was set as individu
record or category permission.

16 Use for advanced configurations only.
For more information on the permissions available with Cumulus
Administrator Guide.
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Menu Reference
This section serves as a road map to the entire Cumulus product from

the perspective of the user interface. Explanations are given for each

of the program’s menus and toolbars. 
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 The Cumulus Menu

About Cumulus
Displays a dialog that shows the version of Cumulus you’re using. It also provides 
a button that launches your default Web browser and initiates a connection to 
the Canto Website. This requires an Internet connection.

Preferences
Opens the Preferences window, from which you can set all preferences. (See 
“Customize Cumulus,” p. 181, for details.)

Quit Cumulus
Quits Cumulus.

The File Menu

Open Catalog
Works as a shortcut to the Catalogs tab of the Connect To dialog. The login of 
the current catalog is used for the connection to the Cumulus Server. 
When opening a catalog you either open it in a separate window or in the win-
dow of the current collection. Activate the desired option.

Open Recent Catalog
Opens a submenu that lists all catalogs opened recently. Selecting the entry for 
a catalog will open it. The submenu also includes an entry that allows you to clear 
the list of recently opened catalogs. 

Connect to Server 
This menu item opens a dialog in which you can connect to a catalog on a 
remote Cumulus Server and open the catalog.
When the Connect to Server dialog is opened:

1. Using the drop-down list in the Server field, select the Server you wish to 
connect to. All currently active Cumulus Servers in the network appear in 
this list. 
If your Cumulus Administrator specified a custom TCP/IP port number for 
the Client-Server connection, enter the IP address and – separated by a 
colon – the port number in the Server field (e.g. 123.123.123:1234).

2. Select either Guest or Registered User. If connecting as a registered user, 
type your user name and password. Your Cumulus Administrator can help 
you determine which way you should log on. 

To have Cumulus remember your password for future log-ons, select 
Remember Password.

NOTE: If this option is activated, any collection you save is password pro-
tected. 
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NOTE: Exported Collections
If this option is activated, any collection you export or mail contains your 
login information. Opening such an exported or emailed collection will 
connect to the Cumulus Server with your login and password. This means 
that the user who opens the collection works as you and has your permis-
sions. If this option is not activated, the Connect to Server dialog will 
appear when an exported or emailed collection is opened. 

3. Click OK. The server is contacted. Once the connection is made, the Catalog 
Access window appears. On its Catalog tab, this window lists all catalogs 
your Cumulus Administrator has made available to you. On its Collections 
tab, this windows lists all collections that are available to you.

4. Select a catalog or collection and – if you already have a catalog or collec-
tion open, select the desired option, whether you want to open the addi-
tional catalog or collection in a separate window or in the window of the 
current collection. 

5. Click OK. (If you are logged in as the Cumulus Administrator, the Catalog tab 
of the Catalog Access window offers more options. See below for further 
details.)

Catalog Access Window
The Catalog Access window provides two tabs:
• Catalog tab: lists all catalogs your Cumulus Administrator has made available 

to you. 
• Collections tab: lists all collections that are available to you – either your own 

collections or shared collections provided by other users.
Select the catalog or collection you want to work with and click Open.
On the Collections tab the Delete button allows you to delete collections – if you 
have the permissions to do so.

Catalog Access Window for Administrators
For the Cumulus Administrator, the Catalog Access window is the starting point 
for performing numerous administrative tasks. The Catalog tab of the Catalog 
Access window offers the following buttons and options to the Cumulus Admin-
istrator:
• New

Opens a dialog for creating a new catalog.
• Add to List

Opens a dialog for adding an existing catalog.
• Remove from List

Removes selected catalogs from the list Cumulus Clients see when logging 
onto the Cumulus Server. If a Client is still connected to such a catalog, the 
Disconnect Client dialog appears. 
The catalogs are not deleted, but they are no longer administered by the 
Cumulus Server and thus no longer available to Clients. 

• Rebuild
Opens a dialog in which you can repair (rebuild) the selected catalog. (See 
Administrator Guide for more information.)

• Migrate
Migrates selected catalogs to the current catalog format:

• Share Catalog
Enabling this option makes a catalog available to Cumulus Clients. 
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• Allow Web Access
Enabling this option makes selected catalog accessible by Cumulus web 
interfaces. 

• Done
Saves the changes and closes the window.

• Open
Opens the selected catalog files. Opening a catalog as the Cumulus Admin-
istrator is the first step to modifying catalog settings. 

NOTE: For the Cumulus Administrator only, the Catalog Access window dis-
plays catalogs that are damaged. They are displayed in red.

Close
Closes the active window, e.g. the Collection, Preview, Record or Category Infor-
mation window.

New Collection
Opens a submenu with two options for creating a new collection: 
• From Selection – The new collection will contain the currently selected 

records.
• Empty – The new collection will be empty.
For more information on collections see “Collections,” p. 20.

Open Collection
Works as a shortcut to the Collections tab of the Connect To dialog. The login of 
the current collection is used for the connection to the Cumulus Server. If no cat-
alog is opened by the Cumulus Client who selects the Open Collection menu 
item, the Connect To dialog is displayed.
For more information on collections see “Collections,” p. 20.

Save Collection
Saves the collection as it is shown.
For more information on collections see “Collections,” p. 20.

Save Collection As
Saves the collection as it is shown under a new name. A dialog is displayed for 
you to name the new collection. Enter a name for the collection and if you want 
the collection to be available for other users, activate the Share Collection 
option.
For more information on collections see “Collections,” p. 20.

Send Collection Link
Opens a submenu with two options for sending collection links via e-mail:
• Selected Records to send a link to a collection that contains the currently 

selected records
• All Records to send a link to the current collection 
Using this collection link, recipients, which don't need to be Cumulus users, may 
open the collection in any web browser. An additional link is offered allowing 
Cumulus users to open the collection with the Cumulus Client application. The 
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sender can specify which actions recipients may perform on the assets via Per-
missions checkboxes in the Send Collection Link dialog.
Preconditions for sending collection links: 
• your Cumulus installation includes Cumulus Sites.
• a Base Web URL was defined by your Cumulus Administrator in the Cumulus 

Server Settings (Server Console > Remote Admin).
• Cumulus is configured to work with a mail server (Server Console > Mail 

Manager). 
To send a collection link:

1. Open a saved collection, or create a new one. If desired, select the records 
you want to include in the collection to be sent.

2. Select File > Send Collection Link > Selected Records or
select File > Send Collection Link > All Records

The first part of the Send Collection Link dialog is displayed, allowing to 
specify settings for the collection to be sent. Most Fields already contain pro-
posals which you may adopt or simply overwrite.

3. Specify a name for the collection.

4. The embargo date is the current date by default. Optionally, change the 
embargo date. Recipients won’t be able to access the collection before this 
date.

5. The expiration date is two weeks ahead of the current date by default. 
Optionally, change the expiration date. Recipients won’t be able to access 
the collection after this date.

The expiration date is required. If you try to delete it, the value is automati-
cally reset to the default.

6. The Base URL for Web Access field displays the base URL specified by your 
Cumulus Administrator. (Only if your Cumulus installation includes more 
than one web server, you may select a different base URL from the drop-
down list.)
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7. Optionally, set a password. 

If you decide to require a password, you must not forget to communicate it 
to the recipients – otherwise the recipients won’t be able to view the collec-
tion.

8. Specify which actions the recipients will be allowed to perform on the assets 
by activating or deactivating the Permissions checkboxes.

9. Click Next. The second part of the Send Collection Link dialog is displayed, 
allowing to specify the recipient(s) and a message.

10. Fill in the necessary address information.

11. The From field is prefilled with the current users email address. You may 
overwrite this with a different address. 

NOTE: If your Cumulus administrator has defined a From address to be 
used with all sent mails, the content of the this field is ignored.

12. Specify a Subject and a message Text, if desired.

13. Click Send. The dialog is closed and the collection link is sent to the recipi-
ent(s) specified in the To field. 

TIP: Copy URL for Other Purposes
Instead of sending the collection link via Cumulus, you may as well 
copy it from the URL field and use it in a different way, e.g. sending it 
via your email application or via Twitter, or inserting it on a web page. 
In this case, quit the dialog with Cancel. 
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NOTE: Additonally,the sent email contains a second link that allows the col-
lection to be opened in the native Cumulus Client, if it is installed on the recip-
ients computer. 

Add Catalog to Collection
Opens a dialog to select another catalog to be opened within the current collec-
tion.
For more information on collections see “Collections,” p. 20.

Remove Catalog from Collection
Opens a dialog which lists the open catalogs and lets you choose the catalog to 
be removed from the current collection.
For more information on collections see “Collections,” p. 20.

Save
Saves any changes depending on the active window; e.g. the Record or Category 
Information window.

Add Assets to Catalog
Open a submenu with following menu options:

Browse for Assets 
Opens a dialog in which you can browse for assets you want to add to a catalog 
(in Cumulus-speak: you want to “catalog”.) Depending on your individual set-
tings several options for cataloging might be offered to you before the dialog for 
selecting the assets is opened.

A collection as seen by the recipient of a sent collection link. What a recipi-
ent can do with the files depends on the permissions granted by the sender. 
In this example, only one function (Download) has been permitted.
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BACKGROUND INFORMATION:  
“Cataloging assets” is Cumulus-speak for adding media files to your 
catalog. There are several ways to catalog assets: via menu item, con-
text menu and with drag and drop. As you catalog your assets, 
Cumulus creates special catalog entries called records that represent 
the assets to be managed. Each record contains vital searchable infor-
mation about the asset it represents. 
How Cumulus deals with your assets during the cataloging process 
depends on the Asset Handling Set used. Asset Handling Sets define 
many aspect of asset handling, including which Asset Stores and Fil-
ters should be used, where the assets should be stored when cata-
loged, and which metadata template (if any) should be automatically 
applied. 

TIP: Cataloging Asset via Drag & Drop
You also catalog assets by dragging them from an Explorer/Finder 
window into the Cumulus window.

Options While Cataloging
Several options for the cataloging process are possible – most of them depend 
on the selections made in your User Settings ( Cumulus / Edit > Prefer-
ences > User Settings > General or Asset Handling.) 

Showing Progress Dialog
If activated in the User Settings, a progress dialog is shown while Cumulus is cat-
aloging the assets. With Cumulus, you can have multiple cataloging processes 
running simultaneously and you can go on working with Cumulus while catalog-
ing. With a Cumulus Client under Mac OS X you see an icon for each of the pro-
cesses.

Selecting Asset Handling Set
If you have activated the option Show dialog when cataloging in the Asset Han-
dling section of your User Settings, you will be prompted to select an Asset Han-
dling Set for each cataloging process. 

Make sure the selected Asset Handling Set fits to the catalog you want to add the 
assets to. 
In the list of Asset Handling Sets, you can use the Customize option to access the 
preferences of the selected Asset Handling Set– if you have the appropriate per-
missions. (See “Overview: Asset Handling Sets,” p. 202 for details on how to set up 
Asset Handling Sets.)
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Selecting Catalog
If you have multiple catalogs open in one window, you are prompted to select 
the catalog to which you want to add the assets. 

If you have activated the option Show dialog while cataloging in your User Set-
tings and have multiple catalogs open in one window you are prompted to 
select the catalog to which you want to add the assets and select an Asset Han-
dling Set for this cataloging process. Make sure the selected catalog and the 
selected Asset Handling Set match.  

Employing the Metadata Editor 
If the Asset Handling Set you use, has the Show Metadata Editor for New Records 
activated, a dialog is displayed when cataloging assets. It allows you to add meta-
data information to the records of those assets you are just cataloging. (The fields 
displayed depend on the Record View Set that was selected for the Metadata 
Editor in the settings of the Asset Handling Set.) You can use a Metadata Tem-
plate and/or manually enter metadata information.
If you don’t want to add any of your own information to the current asset’s 
record, select the Skip button. 

Creating TAG Files 
If you catalog assets from a location where you are allowed to save files, Cumulus 
can create a TAG file for each cataloged asset. The file has the same name as the 
asset with the extension .tag added and is saved in the folder where the asset 
resides. TAG files are a standard exchange file format for metadata information 
on the asset. TAG files hold all of the information that can be viewed in the Asset 
Information – and more. For example, if a particular asset has been cataloged 
into different catalogs, this information is part of that asset’s TAG file.
If you want Cumulus to create these TAG files while cataloging, use an Asset Han-
dling Set that has an activated asset storage module Cumulus Metadata Sup-
port (properties set to Always).

New Empty Record
Creates an empty record. Opens a Dialog where you can specify the catalog to 
which the record is added, as well as the Asset Handling Set and the Permissions 
Template to be used with the new record. You can assign metadata and an asset 
to such a record later on. 
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TIP: 
To assign an asset to an empty record later on, use the Change Asset 
Reference function.

Assign Asset to Record
Only available if one – and only one – record is selected that has no asset 
assigned to.
Opens a dialog to select the asset to be assigned to the record. Subsequently, the 
asset is cataloged and assigned to the selected record. (If applicable, the asset is 
also copied or moved to a Central Asset Location.) Optionally – depending on 
what is specified for the current catalog in the User Settings – a dialog for select-
ing an Asset Handling Set is displayed first.

Recatalog Category Folder
Synchronizes the content of the selected folder category with the contents of 
the folder represented by this category. This option compares the contents of 
the folder and Cumulus: files that are new in the folder are automatically cata-
loged. (Available for folder categories only.) 

Setup Auto Cataloging
Opens a dialog to define auto cataloging for the selected category. (See “Cate-
gories and Auto-cataloging,” p. 34, for details.) (Available for folder categories 
only.)

TIP: More Autocataloging Features
Optional features provide additional auto-cataloging options; e.g. a 
Cumulus Scheduler Action that enables Cumulus to check a standard 
POP3 email account and retrieve and automatically catalog any emails 
it finds. For more information, see the Administrator Guide.

Import
Opens a submenu with several menu options. Each opens a dialog in which you 
can select an appropriate file type for import. The various file types are listed by 
the import type below:
• Assets – Lets you add assets to catalogs. After selecting an Asset Handling 

Set, a dialog opens to browse for the assets you want to add. For a description 
on how to go on see “Browse for Assets,” p. 251.

• Records – Lets you import records that were exported to XML files or to 
Cumulus Record Exchange Files. If you have multiple catalogs open in one 
window, you are prompted to select the catalog to which you want to import 
the records. The imported records are appended to the active collection. 

• Categories – Lets you import categories that were exported to XML files or 
Cumulus Category Exchange Files. If you have multiple catalogs open in one 
window, you are prompted to select the catalog to which you want to import 
the categories. The imported categories are appended to the active/selected 
catalog. If a category in the import file has the same name as an existing cat-
egory, the category is not imported. 

• Collection – Lets you import collections stored with previous Cumulus ver-
sions on the computer running the Client application and collections sent to 
you via email. If you have multiple catalogs open in one window, you are 
prompted to select the catalog which you want to import the collection to.
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• From Text/CSV File – Lets you import metadata from text files (separated by 
delimiters.) As a comma is a very common delimiter, such files are also called 
Comma Separated Value (CSV) files. This import option enables you to import 
metadata from other database systems into Cumulus catalogs. 

For detailed information on importing, see “Importing and Exporting,” p. 102.

Export
Opens a submenu with several export options. Each opens a dialog in which you 
can name an appropriate file type for export. All exported files can be used on 
any supported Cumulus platform. The options are explained below:
• Selected Records – Exports the currently selected records. (This menu item 

is disabled if no records are selected.)
• All Records – Exports all records of the active collection. If you want to export 

all records of the catalog(s) included in the collection, you have to perform 
Find > Find All Records first.

• Selected Categories – Exports the currently selected categories in the active 
collection. (This menu item is disabled if no categories are selected.)

• All Categories – Exports all categories of the Category pane. 
• Collections – To store collections in any location other than the Cumulus 

Server, 
• Mail Collection To – Sends a collection via email to another user. However, 

don’t forget: Since a collection is always connected to catalog(s), it is necessary 
for the recipient to have access to the catalog(s) ‘serving’ the collection. To make 
use of a collection you received via email you use the import function.

For detailed information on exporting, see “Importing and Exporting,” p. 102.

Page Setup
This menu item opens a standard page setup window from which you can con-
figure your printing options. The options available to you will depend on your 
system configuration. See your computer’s operating system manual for details.
Under Mac OS, the Preview button allows you to view the printed output before 
it gets sent to your printer. Under Windows, Cumulus provides a Print Preview 
menu item.

 Print Preview
This option allows you to view the print output before it gets sent to your printer. 
The output options are taken from the current print settings.

Print
Opens a submenu with the following menu options: 

• Selected – Prints selected items (records, categories or preview sections) – 
depending on the active window or pane. 

• All – Prints all items – depending on the active window or pane. 
The print function is context sensitive (meaning that what is printed depends on 
the position of the cursor). If the active window or pane is: 
• the category pane, the categories (all or selected) will be printed as they 

appear in the Category window. Make sure to expand the category list if you 
want to see all the subcategories in the print out. 
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• the record pane and thumbnail or details view is the current view mode, the 
records (selected or all of the active collection) are printed using Print Tem-
plates. (For more information on Print Templates, see “Print Templates,” 
p. 229.)

• the record pane and information view is the current view mode, the informa-
tion displayed will be printed.

• an information window, the information displayed in the window will be 
printed.

• a preview window, the preview will be printed – in case it is available as a 
pixel image (e.g. JPEG, TIF or GIF). The preview will be printed in the size of 
the paper selected under Page Setup. This may take a while! 
If your intention is to print the actual asset, instead of its record or preview, 
see “Print With,” p. 280, for details.

Administration
Opens a submenu with several administration options. Most of these options are 
only available if you are Cumulus Administrator or have the appropriate permis-
sions. Descriptions on how to use the administrative functions for catalogs can 
be found in the Administrator Guide. 

Server Console (only if installed on the machine)
Opens a dialog in which you can administrate the Cumulus Server if you have the 
permissions to do so. (For more information, see Administrator Guide.)

Connect to Server As
Opens a dialog to log in to the Cumulus Server and then act as a different user 
(“Run As”). – This function is useful for substitution purposes, e.g. for holiday 
replacement.  

The user who logs in must have the permission to act as the specified user. (For 
more information, see Administrator Guide.)

IMPORTANT! A user A running as user B literally becomes user B, i.e. gets all permis-
sions (and role assignments, if any) of user B. To become active again, user A must 
login anew.

Change Password
Opens a dialog to change your Cumulus user password. (Disabled if you don’t 
have the appropriate permissions.)
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Switch Application Language
Opens a dialog to select a different language for your Cumulus application’s user 
interface. Expand the list to see the languages Cumulus supports.

Languages marked in bold already provide a localized user interface. For all other 
languages, an English user interface is displayed, but specific writing capabilities 
for the selected language are supported. This applies to the category tree, input 
fields and Quicksearch function.
Select the desired language and click OK. You must quit the Cumulus application 
and start it again before the language switch takes effect. If the selected lan-
guage is not available on your computer, the Cumulus application language will 
default to English.

Prepare Catalog
Opens a submenu with options for preparing catalogs to manage different stan-
dard metadata formats. With Workgroup or Enterprise, these functions for pre-
paring catalogs are for the Cumulus Administrator only. You need the 
Administrator permission Modify Catalog Settings for the catalog to be pre-
pared, and the Server permissions Modify Asset Handling Sets and Manage 
User Asset Handling Set. 
• For IPTC

IPTC (International Press Telecommunication Council) is a standard for digital 
text applied to an image. Applications used for professional imaging support 
IPTC; e.g. the text information in Photoshop is a subset of the IPTC informa-
tion. 
Cumulus can read IPTC metadata information while cataloging. You can view 
and edit this metadata and Cumulus can write your changes back to the 
asset. Reading and writing back IPTC data is possible for assets of the follow-
ing formats: JPEG, TIFF, PSD, and EPS. (For more information on writing back 
metadata, see “Write back Metadata,” p. 275”.)
If you want to capture IPTC data from assets and to write back IPTC data to 
assets, the Asset Handling Set(s) and the catalog(s) managing these assets 
must be prepared for this feature. IPTC record fields have to be added to the 
catalog(s) and their properties have to be enabled for field linking. The Writ-
ing back Metadata option must be activated in the Asset Handling Sets used 
to handle the assets containing IPTC data. 
The function makes the process of preparation easy. Follow the on-screen 
instructions.
NOTE: To view the captured metadata, the corresponding record fields 
must be included in one of your Record View Sets. If none of your Record 
View Sets provide a view that includes the fields, you have to add these 
fields to one view of at least one Record View Set. For a description on how 
to add fields to a view, see “Adding a Field to a Record View,” p. 191. 

• For EXIF
EXIF (Exchangeable Image File Format) is a standard for storing interchange-
able information in image files, especially those using JPEG compression. 
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Most digital cameras now use the EXIF format. Cumulus can read EXIF meta-
data information while cataloging. You can view and edit this metadata.
If you want a catalog to store EXIF information on assets, you have to add the 
EXIF record fields to this catalog. This function does it for you. Follow the on-
screen instructions.
NOTE: To view the captured metadata, the corresponding record fields 
must be included in one of your Record View Sets. If none of your Record 
View Sets provide a view that includes the fields, you have to add these 
fields to one view of at least one Record View Set. For a description on how 
to add fields to a view, see “Adding a Field to a Record View,” p. 191. 

• For XMP
Adobe’s XMP (Extensible Metadata Platform) is a labeling technology that 
allows you to embed metadata into the asset itself. With an XMP-enabled 
application (e.g. all applications of Adobe Creative Suite), information about 
a project can be captured during the content creation process and embed-
ded within the file and into a content management system. 
Cumulus can read XMP metadata information while cataloging from assets 
of the following formats: PDF, JPEG, DNG, TIFF and Adobe Photoshop, Illustra-
tor and InDesign files. You can view and edit this metadata and Cumulus can 
write your changes back to the asset. Writing back XMP data is only possible 
for assets of the following formats: JPEG, DNG, TIFF, and PSD. (For more infor-
mation on writing back metadata, see “Write back Metadata,” p. 275”.)
If you want to capture XMP data from assets and to write back XMP data to 
assets, the Asset Handling Set(s) and the catalog(s) managing these assets 
must be prepared for this feature. XMP record fields have to be added to the 
catalog(s) and their properties have to be enabled for field linking. The Writ-
ing back Metadata option must be activated in the Asset Handling Sets used 
to handle the assets containing XMP data. 
The function makes the process of preparation easy. Follow the on-screen 
instructions.
NOTE: To view the captured metadata, the corresponding record fields 
must be included in one of your Record View Sets. If none of your Record 
View Sets provide a view that includes the fields, you have to add these 
fields to one view of at least one Record View Set. For a description on how 
to add fields to a view, see “Adding a Field to a Record View,” p. 191. 

Rebuild Catalog
Opens a dialog in which you can repair (rebuild) the active catalog. (See Admin-
istrator Guide for more information.)

Backup Catalog
Opens a dialog in which you can save a backup copy of the active catalog. (See 
Administrator Guide for more information.)

Compress Catalog
Opens a dialog in which you can compress the active catalog. (Disabled if the 
catalog is already compressed as much as possible.) (See Administrator Guide for 
more information.)

Merge Categories
Merges the records assigned to different folder categories. This function affects 
only those categories created automatically by Cumulus when cataloging. If 
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some of a catalog’s assets were cataloged from a Windows computer and others 
were cataloged from a Mac OS computer, then you may have category struc-
tures that are the same, though named differently because of the directory-nam-
ing convention differences between the two operating systems. This application 
merges the records assigned to those two category structures. It does not affect 
other categories.

Migrate Catalog 
Open a dialog to convert older Cumulus catalogs into a format compatible with 
the latest Cumulus version. (See Administrator Guide for more information.)

Convert WPP/ICP 3.0 Triggers
Converts the triggers from Web Publisher Pro or Internet Client Pro 3.0 that are 
assigned to the catalogs included in the current collection. The Web Publisher 
Pro or Internet Client Pro 3.0 Mail Notification feature has created triggers for all 
users who have activated the Watch Asset option. These triggers need to be 
converted before they can be used with a Cumulus 7 Server. 

IMPORTANT! Have this function run on every catalog that might have triggers 
assigned. 

Exit
Quits Cumulus.

The Edit Menu

Undo
Allows you to undo some of the errors you may have made while entering text 
into fields. It reverts to the former text entry. It works for string fields of the Infor-
mation window or view, for the Quicksearch entry field and when renaming cat-
egories. (Disabled if not available.)
Note that this function is limited to revert text entries, it will not reverse any func-
tions. 

Cut
Removes the current item or text selection and places it on the Clipboard so that 
it can be pasted elsewhere.

Copy
Copies the current item or text selection and places it on the Clipboard so that it 
can be pasted elsewhere.

Paste
Places the contents of the Clipboard into the current location or text insertion 
point.
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Delete
Deletes the selected records or categories from the catalog after confirmation of 
the action. (Disabled if no records or categories are selected.)
The confirmation dialog for deleting records offers two options: to delete the 
record only or to delete the record and its associated asset, too. This is not undo-
able. Make sure that you no longer need an asset or that you have a copy else-
where before deleting one. 

If you decided to have the asset deleted as well but the asset cannot be deleted 
(e.g. because it is read-only access), the record will not be deleted either. Note 
that records that represent assets stored on CDs will be deleted.

NOTE: Deleting Related Assets
If the record to be deleted represents a preferred alternate or a variant source 
you will get an informing message that also lets you cancel the process. 

Select All
Selects all objects or text. The type of selection depends on which window is 
active and whether you have clicked inside a text area.

Deselect All
Cancels any previous selection.

Preview Tools
Opens a submenu that lets you toggle between Hand tool and Select tool and 
that offers functions for the comment tool. For more information on these tools, 
see “Overview: Toolbars for Previews,” p. 69. (Disabled if no Preview window or 
view is activated.)

Preferences
Opens the Preferences window, from which you can set all preferences. (See 
“Customize Cumulus,” p. 181, for details.)

The View Menu

Palette Mode
Changes the view of the Cumulus application to palette mode and back. In Pal-
ette Mode, the thumbnails and the contents of record fields are displayed as 
defined in selected view set. 
In palette mode the Cumulus application will shrink to a palette that can conve-
niently be used with another application. That way you can easily drag and drop 
cataloged assets into other applications. All open collections will be changed to 
palette mode. They are displayed on top of each other. The Palette Mode win-
dow can be resized to fit your needs (and all display changes will be kept when 
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you reopen the palette mode). All Cumulus functions remain available; to display 
the menus select Menu. 

Toolbar
Offers a submenu to select the size of the toolbar and options to toggle the tool-
bar on and off. 

Statusbar
Toggles the statusbar on and off. 

Workspace
Opens a submenu with options that let you toggle panes of your workspace on 
and off:

Several menu options enable you to open (and close) additional panes in the 
current Collection window and to save this combination of panes as a work-
space. A workspace saves even more information. It includes:
• window size
• window location
• visible panes
• view sets selected for each pane.
Below these menu options you will find more options if any saved layouts are 
available for you.
The additional panes will be displayed at the bottom of the Category pane.

TIP: Resizing Panes
You can resize the panes by pressing the ALT / Option key and 
dragging the split bar. (Just clicking the split bar will resize the top-
most pane and the sub-pane of the dragged split bar only.) 
Collapsing: Pressing the ALT / Option key and double-clicking in 
a pane’s statusbar will collapse the pane so that the statusbar is dis-
played only and the pane above will fill the area. (Just double-clicking 
lets the pane above retain its size and the topmost pane will be 
enlarged.) A double-click on the statusbar of the topmost pane will 
collapse all panes below.
Expanding: Pressing the ALT / Option key and double-clicking in 
a collapsed pane’s statusbar will expand the pane again – using space 
from the above pane. (If you just click it – without the ALT / 

Option key – the pane will be expanded using space from the top-
most pane.) A double-click on the statusbar of the collapsed topmost 
pane will expand all panes below.
Minimizing: Double-clicking a pane’s split bar minimizes the pane or 
resizes it again.
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Calendar Pane
Toggles the Calendar pane on and off. 

Use the Calendar pane to search for records by date. Dates that correspond 
records are highlighted. If you move the cursor over a highlighted date, a tooltip 
shows the number of corresponding records in all catalogs open in the current 
collection. 
Clicking on the  icon opens a menu with the following options:
• Record View Set – to change the used Record View Set
• Calendar Mode – to toggle between Month mode and Year mode. In month 

mode, you can select a single day or multiple days of the month or an entire 
month for searching. In year mode, you can select a single month or multiple 
months of the year or an entire year for searching.

• Field – to select the record field to which the highlighted items in the Calen-
dar pane correspond, e.g. Asset Creation Date, Asset Modification Date, 
Record Creation Date, etc. You can select from all date fields and date-only 
fields that are indexed for searching in the currently open catalogs. 

If you move the cursor over the  icon, a tooltip shows the current settings.
Select a day/month by a single click on any highlighted item. With a  Ctrl-click 
/ Command-click, the selection is increased or reduced by single items. With 
Shift-click, the selection is increased or reduced by a range of items. 
Double-clicking any highlighted date or the month/year title starts a record 
search. Double-clicking a date inside a multiple date selection, finds all records 
belonging to any of the selected days/months. The search result will replace the 
current selection in the record main pane.
If you hold the Ctrl key while double-clicking a highlighted item in year view, it 
switches to the specified month displayed in month view.
The Calendar pane has its own toolbar.

Category Pane
Toggles the Category pane on and off. (Menu equivalent to the toolbar icon.)

Calendar pane in view by 
month mode

Calendar pane in view by year 
mode

Calendar Pane Toolbar Items

1 Switches to current month/year
2 Switches to the previous year
3 Switches to the previous month (disabled in year mode)
4 Switches to next month (disabled in year mode)
5 Switches to next year
6 Opens a menu with following options:

– Record View Set.
– Calendar Mode (month/year)
– Field 

7 Minimizes the pane.
8 Closes the pane.

7 81 2 4 653
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Category Information Pane
Toggles the Category Information pane on and off. The Category Information 
pane displays information about the selected category. Which fields are dis-
played in the Category Information pane depends on the settings in the current 
Category View Set.

Collection Basket Pane
Toggles the Collection Basket pane on and off. The Collection Basket that 
enables you to gather and sort records for one-click access and optional process-
ing.
The Collection Basket only slightly differs in function from regular collections. For 
this reason, most of the functions available while working with standard collec-
tions—changing view sets, saving and sharing contents, resorting, etc.—are also 
available from within the Collection Basket.
The Collection Basket pane appears on the right side of the main collection win-
dow and has its own toolbar.

Changing the Appearance and Size of the Collection Basket
The appearance of the Collection Basket can be changed using many of the 
same options you know from standard collections:
• Thumbnails and Details — Use the toolbar icons for changing the Collection 

Basket between thumbnail and detail views. (Make sure the Collection Basket 
is the active pane before making the change.)

• Record View Sets — Use the Record View Set menu found under the  icon 
located at the top of the Collection Basket pane to choose from the available 
record view sets. 

• Thumbnail Size — Use the standard thumbnail resizing icon located on the 
toolbar to adjust the size of Collection Basket thumbnails. You’ll also notice 
that when you reduce the width of the Basket using the vertical bar, the 
thumbnails scale down in size to remain visible.

In addition, you can resize the Collection Basket by dragging the bar that divides 
the main collection and Collection Basket panes. Double-clicking this bar mini-
mizes the pane or resizes it again.

Working with the Collection Basket’s Contents

Moving Asset Records Into the Basket
Add asset records to the Collection Basket from the main collection window 
using drag & drop. Select one or more records and drag them into the Basket. 
You can add as many records at a time as you need, and you can add additional 
records at any time thereafter.

Collection Basket Pane Toolbar Items

1 Lets you choose an action as output option (action) for Col-
lection Basket contents

2 Replaces the main collection window contents with the 
contents of the Collection Basket

3 Clears the Collection Basket
4 Lets you choose a record view set, sort field and sort order 

for the Collection Basket contents
5 Closes the Collection Basket

1 2 4 53
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Removing Asset Records from the Basket
Select one or more records inside the Collection Basket and press the DEL key on 
your keyboard to remove them from the Basket. The items are removed from the 
Basket, but not from the main collection or catalog.
Optionally, you can use the menu command Find > Remove Record from Col-
lection.

Rearranging the Order of Asset Records in the Basket
As you would in any other collection window, you can drag thumbnails around 
in the Collection Basket to rearrange them. You can also sort the contents of the 
Basket using the Sort By menu found under the  icon located at the top of the 
Collection Basket pane. (Use the Sort Direction menu to reverse the sort.)

Outputting the Collection Basket’s Contents
The  icon open a list from which you can select an output option for the con-
tents of the Collection Basket. It lists the asset actions available to you by permis-
sions, and also includes several standard Cumulus functions, such as emailing, 
creating Web albums and printing thumbnails.
Choose an asset action and then use the buttons provided to choose whether 
you intend to output the entire contents of the Collection Basket or just the 
selected items. 
Once you make your selection and click OK, the Collection Basket passes the list 
of assets to the selected action. Then the asset action is processing. At that point, 
you might see the user interface of the active module and can set parameters for 
the processing. (Or, if you’ve chosen an asset action that is configured for no user 
interaction, you will not see any further windows.)
• For information on asset actions, see “Using Asset Actions,” p. 66.
• For information on the Mail To function, see “Mailing Your Assets,” p. 67.
• For information on the Web Album function, see “WebAlbum,” p. 95.

Replacing the Main Collection with the Collection Basket Contents
If you ever want to replace the contents of the main collection pane with the 
contents of the Collection Basket, click the  icon. The main collection is 
updated. There is no “undo” for this operation, so make sure you intend to 
replace the main collection’s contents when you click this icon.

Clearing and Closing the Collection Basket
Clear the contents of the Collection Basket using the  icon at the top of the 
Collection Basket. There is no “undo” for this operation, so make sure you intend 
to clear the basket’s contents when you click this icon.
Click  to close the Collection Basket window. Closing the Collection Baskets 
does not clear it’s contents – when you reopen the Basket, the contents appear 
as you left them. (Note that the Server permission Manage User Collections is 
required for saving the contents.)

NOTE: If your User Settings have the Re-open Collections and Catalogs 
option activated, the contents of your Collection Basket will reappear the next 
time you open that same catalog (or set of catalogs), even when using the 
Web Clients. But if you open a different catalog in the interim, the contents of 
the Collection Basket are deleted. 

Information Pane
Toggles the Information pane on and off. The Information pane displays informa-
tion about the record(s) selected in the current collection. Which fields are dis-

tion Basket output options 
e asset actions and other 

res familiar to Cumulus 
.
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played in the Information pane depends on the settings for the Info View of the 
current Record View Set.

Preview Pane
Toggles the Preview pane on and off. The Preview pane displays the record 
selected in the active record pane in Preview View. This means that the display 
depends on the selected Record View Set. 

Sub-Pane for Relations
Opens a sub-pane below the active record or closes it. The sub-pane displays 
records or other information that are related to the selected record as defined in 
the active Sub-Pane Filter.

Thumbnail Pane
Toggles the Thumbnail pane on and off. The Thumbnail pane displays the record 
selected in the active record pane as thumbnail.

Save Current as Default Workspace
Saves the current layout as your default workspace for collection windows.

Use Default Workspace
Applies the saved default workspace as layout for the current collection window.

Save Current Workspace As
Opens a dialog that allows saving the current workspace under a selectable 
name. Enter a name for the workspace and – if you want this layout to be available 
to other users – activate the Share Workspace option. Note that shared layouts 
can be saved by the Cumulus Administrator only.
A saved layout includes:
• window size
• window location
• visible panes
• view sets selected for each pane.

Preview Pane Toolbar Items

1 Shows first page of preview (available with 
multi-page previews*)

2 Shows previous page of preview (available with 
multi-page previews*)

3 Shows next page of preview (available with 
multi-page previews*)

4 Shows last page of preview (available with 
multi-page previews*)

5 Opens a list for selecting a Record View Set.
6 Closes the pane.
* For more information on multi-page previews, see 
“Multi-page Previews,” p. 70
TIP: The preview images can be resized using the 
zoom slider in the main toolbar 

1 2 4 653
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Manage Workspace 
Opens a dialog displaying all available workspaces (in alphabetic order). You can 
select one and apply it to the current collection window by clicking Open.
You can also delete workspace layouts via this dialog. Select the entry and click 
Delete. Note that shared Workspaces can be deleted by the Cumulus Administra-
tor only.

Thumbnails
Activates Thumbnail View: Displays records as thumbnails and the contents of 
record fields as defined in the selected view set. (Menu equivalent to the toolbar 
icon.) Once this view mode is active, you can use the zoom slider to change the 
size of the thumbnails or use predefined sizes via menu (View > Thumbnail 
Sizes).

Details
Activates Details View: Displays records in a sorted text list as defined and the 
contents of record fields as defined in the selected view set. (Menu equivalent to 
the toolbar icon.)

Information
Activates Information View: Displays metadata information stored with the 
record. The displayed fields are defined by the selected view set. (Menu equiva-
lent to the toolbar icon.)

Preview
Activates Preview View: Displays records as previews. The records’ assets must be 
accessible to display the preview. Once this view mode is active, you can select 
different sizes for the previews. (Menu equivalent to the toolbar icon.)

TIP: 
The preview image can be resized using the zoom slider.

Report
Activates Report View: Displays thumbnail and metadata information in horizon-
tal order (a sort of hybrid between the Details and Info View modes.) It offers a 
convenient way to display the contents of text fields that contain lots of informa-
tion. Can display as many lines as needed for quick browsing. (Menu equivalent 
to the toolbar icon.)

TIP: 
The thumbnails can be resized using the zoom slider.

Record View Set
Opens a submenu with the available Record View Sets. For more information on 
Record View Sets, see “Record View Sets,” p. 188. (Disabled unless a record is 
selected.)
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TIP: 
If you have the appropriate permissions, you can easily access the 
preferences of Record View Sets by selecting the Customize entry in 
the list for selecting Record View Sets. This entry opens the prefer-
ences for the current Record View Set.

Category View Set
Opens a submenu with the available Category View Sets. For more information 
on Category View Sets, see “Category View Sets,” p. 195. (Disabled unless a cate-
gory is selected.)

TIP: 
If you have the appropriate permissions, you can easily access the 
preferences of Category View Sets by selecting the Customize entry in 
the list for selecting Category View Sets. This entry opens the prefer-
ences for the current Category View Set.

Preview/Thumbnail Sizes
Opens a submenu to select the size of thumbnails or previews.

Small 
Displays records as small thumbnails/previews (default 64 x 64 pixel). You can 
change the default size. (See “User Settings,” p. 183, for details.) 

Medium 
Displays records as medium thumbnails (default 128 x 128 pixel). You can 
change the default size. (See “User Settings,” p. 183, for details.) 

Large Thumbnail/Preview
Displays records as large thumbnails (default 256 x 256 pixel)/previews. You can 
change the default size. (See “User Settings,” p. 183, for details.) 

Sort By
Opens a list of the available fields of the current collection. Select the field you 
want to determine the sorting of. (Menu equivalent to the statusbar field.) 

NOTE: The selected field should be one with the most records containing 
information – otherwise you will be quite unhappy with the sorting. 

TIP: Unsorted
The option Unsorted will display the records in the order they were 
cataloged. You can sort by two fields. In Details view Cumulus lets you 
select a second field as sorting criteria. Click the column header for the 
field you want to use as first sorting criteria and then Shift-click the col-
umn header you want to use as second sorting criteria. If you switch 
to other views, the sorting will remain until you change the sorting. 
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Sort Direction
Opens a submenu that provides two options for the direction of the sort order:
• Sort Ascending – Sorts the records in an A to Z (0-9) direction.
• Sort Descending – Sorts the records in a Z to A (9-0) direction.
(Menu equivalent to the statusbar icon.)

Language for Field Values
Opens a submenu that provides the possibility to switch the language in which 
multilingual metadata fields are displayed.
The first entry in the menu is Application Language which is also the default. If 
Application Language is selected, multilingual fields are always displayed in the 
language of the application (see “Switch Application Language,” p. 257). 
If the language for field values is set to a language that is not defined for a mul-
tilingual field, this field displayed in its base language instead.
Changing the language for field values takes immediate effect.

Prerequisites and Additional Hints
The Language for Field Values function only works if the currently open catalog 
contains record fields and/or category fields that are enabled for multi language 
support.
Additionally, the following prerequisites must be met:
• To allow language switching for metadata fields, the Allow language switch 

for multilingual fields option must be activated in the preferences of the 
current View Set’s active view. If this option is not activated, multilingual fields 
are always displayed in the language of the field that was added to the view. 

• To allow language switching in the Category pane, the Preferred Language 
option must be activated and set to As defined in View menu in the Cate-
gory Pane preferences of the current Category View Set. If the Preferred Lan-
guage option is not activated, multilingual categories are always displayed in 
their base language.

There is one more issue with the category pane.
Instead of coupling the language of the Category pane to the selection made in 
the View menu. you may as well select a language to always be used with the 
category pane, independent of the language used for other metadata fields. 
Activate the Preferred Language option in the Category Pane preferences and 
select the desired language.

Category Pane and the Categories Field: Making the Language Consistent
If your Category pane is set to a language different from the language of other 
multilingual fields, you may nevertheless want to have the categories displayed 
always in the same language, both in the Category pane and in any specific View 
of your View Sets.
For example, you may have a German Category pane, whereas multilingual fields 
are set to be displayed in English. If category assignments of an asset are dis-
played in the Info View or the Asset Info Window, you would expect to see Ger-

Details view allows sorting by two fields: The first sorting criteria is 
indicated by a single arrow the second by a double arrow. 
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man category names here, as in the Category pane. However, according to the 
language settings for multilingual fields, they are displayed in English.
To solve this inconsistency and always have the same category language used 
both in the Category pane and in the Categories field displayed in a record view, 
open the Record View Set preferences, select the desired View Set and View and 
make sure that the Preferred Language settings in the Properties of the Cate-
gories field are identical to the Preferred Language settings of the Category 
pane.

NOTE: This has to be done individually for every View in every View Set where 
the Categories field is displayed.

Go To
Opens a submenu for navigation. The available options depend on the current 
focus.

Preview
Opens a submenu for preview display options. (Disabled if no Preview window 
or view is activated.)

Zoom In
Doubles the size of a preview image. Preview images can be increased to eight 
times or 800% of their original size. (Disabled if no Preview window is activated.)

Zoom Out
Halves the size of a preview image. Preview images can be reduced to one eighth 
or 12.5% of their original size. (Disabled if no Preview window is activated.)

Fit to Window
Resizes the Preview window to fit inside the main Cumulus window. Can be set 
as default, see “User Settings,” p. 183, for details. (Disabled if no Preview window 
is activated.)

Fit Width to Window
Resizes the Preview window to fit the width of the main Cumulus window. Can 
be set as default, see “User Settings,” p. 183, for details. (Disabled if no Preview 
window is activated.)

Fit Height to Window
Resizes the Preview window to fit the height of the main Cumulus window. Can 
be set as default, see “User Settings,” p. 183, for details. (Disabled if no Preview 
window is activated.)

Example of options available 
with the Go To submenu. 
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Full Screen
Displays a preview using the whole screen. (Disabled if no Preview window is 
activated.)
TIP: 
To view multiple assets at once, use Asset > Fullscreen Preview. 

Categories
Opens a submenu. 

Expand
Expands the selected categories to reveal subcategories. This works the same 
way as clicking on the arrow icon to the left of the parent category. (Disabled if 
no parent categories are selected.)
TIP: To expand all categories under a parent category, press the ALT / 

Option key when clicking on the category arrow icon.

Expand All
Expands all parent categories to reveal subcategories. (Disabled if all parent cat-
egories are already expanded.)

Collapse
Collapses the selected parent categories to hide subcategories. This works the 
same way as clicking on the arrow down icon to the left of the parent category. 
(Disabled if no expanded parent categories are selected.)
TIP: To collapse all categories under a parent category, press the ALT / 

Option key when clicking on the category arrow icon.

Collapse All
Collapses all parent categories to hide subcategories. (Disabled if all parent cate-
gories are already collapsed.)

The Find Menu

Find Records
Opens or activates the Record Find window. (See “Searching with the Find Win-
dow,” p. 45, for details.)

Find All Records
Resets the current selection of records to the entire contents of the catalog(s) 
opened in the collection. This is useful after a search operation has reduced the 
number of visible records.

Find Records by Query
Opens a list for selecting a record query that will be performed immediately. (Dis-
abled unless at least one record query is saved.)
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Find Records Assigned to Categories 
Finds all records that are associated with the selected categories. This is the 
menu equivalent to double-clicking on categories. (Disabled unless one or more 
categories are selected.) 

Find Duplicates
Searches the current collection for records with the same record name (the 
assets and asset names may be different). The search result will replace the cur-
rent collection. 

NOTE: This function may take a while. Hence, we suggest that you put up a 
collection that fits this search before starting this function. 

Find Records with Invalid Field Values
Checks all records of the current collection for any field value that is invalid 
according to the defined field validators. 
This function will find any record with invalid field values, even if the field in ques-
tion is not displayed in the current Record View Set.

NOTE: You may also check for invalid records on a regular base using the 
scheduler action Find Invalid Items.

Find Offline Assets
Searches the current collection for records with asset references that cannot be 
resolved. The search result will replace the current collection. 

NOTE: This function may take a while. Hence, we suggest that you put up a 
collection that fits this search before starting this function. 

Find Versionable Assets
Searches the current collection for records of assets under version control (e.g. 
Cumulus Vault.) The search result will replace the current collection. 

NOTE: This function may take a while. Hence, we suggest that you put up a 
collection that fits this search before starting this function. 

Invert Collection
Searches for all records (of the catalogs opened in the collection) that are not 
contained in the current collection and replaces the current collection with this 
search result. With one click you can obtain all records that are not currently 
shown.

Find Categories 
Opens or activates the Category Find window.

Find All Categories
Resets the current selection of categories to the entire contents of the catalog. 
This is useful after a search operation has reduced the number of visible catego-
ries.
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Find Categories by Query
Opens a list for selecting a category query that will be performed immediately. 
(Disabled unless at least one category query is saved.)

Show Original Category
Finds and highlights the original category of a selected related category. (See 
“Category Types,” p. 30.)

Show Related Categories
Finds and highlights the selected category’s related category or categories. (Dis-
abled unless a category is selected.) 

Show Categories Containing
Opens a dialog. In this dialog you can type a string of text that you would like to 
search for in all category names of the active catalog. Categories whose names 
contain the text string are highlighted. Related categories are included in the 
search.
For example: Typing “oa” would find categories called “Boats” and “Oasis.” 

Remove from Collection
Removes the record/category from the current collection but not from the catalog. 
(See “Delete,” p. 260, for deleting a record/category from a catalog.)

The Metadata Menu

Information
Depending on the active pane this menu item opens the Asset Information win-
dow or the Category Information window for the selected record/category.
Category Information window – For further information, see “Category Informa-
tion Window,” p. 33. 
Asset Information window (Menu equivalent to the toolbar icon.) – For further 
information, see “Asset Information,” p. 23, and “Editing Asset Information,” p. 25.)

Viewing and Editing Multiple Records 
If you have selected multiple records before opening the Asset Information win-
dow, you can change the field values for multiple records at once. But this is only 
possible, if in your User Settings for the Display of the Asset Information window 
the option Only One Window is activated and Display values identical for all 
selected records is checked. 
If the asset information of multiple records is shown in one window, only field 
contents which have the same values are displayed. So the Asset Reference and 
Thumbnail fields will always be empty. Check boxes (Boolean fields) with differ-
ent values appear gray. The field Categories only displays categories that the 
selected records have in common. All other field types are displayed with no 
value if there are different values for fields.
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Fields with different values do not show a value but can be edited – this also 
applies to gray (neutral) check boxes. If you add an additional category, this cat-
egory is added to the set of categories for each record.
If you add any text to a field that already contains values for one of the selected 
assets, you are asked whether you want the new text to replace the existing value 
or to be appended to the existing text.

IPTC Information
Opens the IPTC Information window that provides special access to the IPTC 
information on the asset(s) stored in the selected record(s). (Disabled when no 
record is selected.) See “Using the IPTC Information Window,” p. 153, for details. 
For a description on how to prepare a catalog for IPTC, see “For IPTC,” p. 257.

Bulk Edit
Opens a dialog to edit metadata of previously selected records. 

The Bulk Edit dialog shows the same fields as the Asset Information Window of 
the current Record View Set – but only if they are user editable.
For each field you can decide how its value is dealt with (default: Keep Current 
Value). Click the icon on the left to have the available options displayed and to 
choose from them. Note that these options vary slightly according to the type of 
field selected.
You can either choose an editing option and then enter the desired value, or you 
can start with entering a value (which automatically turns the editing options to 
Replace Current Value) and select the desired editing option later.
However, with the Categories field the first step is always to select the desired 
editing option and then to use drag & drop or the Add and Remove buttons to 
configure a set of categories to be assigned to or removed from the record.
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NOTE: Be carefully with the Replace Current Value and the Clear Current 
Value options! These options delete all existing category assignments and 
cannot be undone. 

Employing MetadataTemplates
You can use the metadata template icon in the lower left corner of the Bulk Edit 
dialog to prefill the fields with values from a selected metadata template. You 
may then edit theses values as necessary.

NOTE: Regardless of the actual content of the metadata template, only values 
for fields that are included in the Bulk Edit dialog are taken into account. 

Update Record
Opens a submenu with functions to refresh the selected records with the asset’s 
up-to-date information. This can be necessary if catalog settings have changed, 
but also if assets have been modified since they were cataloged. Records of 
unavailable assets cannot be updated. (The menu item is disabled if no records 
are selected.)

Update Updates the selected records according to the settings specified in the Prefer-
ences (User Settings > General > Application > When Updating). Depending 
on the settings specified for the current catalog (User Settings > Asset Handling), 
you may be prompted to select an Asset Handling Set.

Advanced Opens a dialog to specify settings for the current update process. The settings 
defined in this dialog will not affect the settings defined in the Preferences.

Define the settings according to your needs, then click OK to perform the 
update.

NOTE: If the Asset Handling Set used for the update does not provide the cor-
rect settings for creating records for pages/slides (e.g. because the required 
Asset Storage Module is not activated), the records representing the individual 
pages will be deleted. Because this might not be the intended result, Cumulus 
shows a list of the records that are to be deleted. Either confirm the deletion, or 
cancel the complete update process, or select single records on this list to con-
firm their deletion only. 
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Update Formula Fields
Updates all fields containing formulas in the selected records, no matter whether 
these fields are currently displayed or not. A dialog is displayed which lets you 
choose whether the Record Modification Date should be changed accordingly 
or not. (By default, the Record Modification Date is not changed.)

Write back Metadata 
Writes metadata from the selected records back to the related assets or metadata 
container, e.g. XMP files. Opens a dialog to specify an appropriate Asset Handling 
Set and optionally to select the metadata fields that should be written back. (Dis-
abled if no Asset Handling Set is available that has enabled the writing back 
metadata option.)  

When writing back metadata to assets, be aware of the following:
• Metadata can be written back to assets only

• if the assets are not write protected or stored on a write protected volume 
or media.

• if Cumulus has direct access to the assets (no Server/Client Asset Transfer).
• Some IPTC and XMP metadata fields overlap. All assets that have been edited 

with applications of the Adobe Creative Suite contain both IPTC and XMP 
metadata. When writing back metadata to such assets, make sure that both 
the Cumulus IPTC and the XMP filter are activated. If not, the IPTC and XMP 
data stored in the asset might differ.

NOTE: Captured IPTC and XMP metadata
As some image files contain IPTC as well XMP metadata in different blocks, and 
some metadata information is stored in both blocks, the metadata captured 
by different applications might differ. Some applications give priority to XMP 
(e.g. Adobe Creative Suite). With a standard installation, Cumulus captures 
IPTC metadata prior to XMP. If you want to alter the priority to XMP, you have 
to change the order of the formats for the Asset Handling Set employed for cat-
aloging. In the Asset Formats list of the Asset Handling Set, the entry for the 
Extensible Metadata Platform format supported by the XMP filter has to have 
a lower entry number than the first format supported by the IPTC filter. This is 
due to the fact that Cumulus starts searching for matching formats at the low-
est entry number. (See “Asset Format Support,” p. 217, for further details.) 
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NOTE: EXIF data size and JPEG assets
EXIF data in JPEG files is restricted to a size of 64 kB. However, EXIF data larger 
than 64 kB can be written back to the JPEG file and is saved in discrete seg-
ments of 64 kB each. Although this is conform to the specification, keep in 
mind that not every image editor / JPEG readers is able to read large EXIF 
metadata properly!

Assign Metadata From Template 
Open a dialog to select the metadata template to be used for filling. For further 
information, see “Using a Metadata Template,” p. 26. (Available only, if you are 
allowed to modify records.)

Find And Replace Metadata
Finds certain information stored on assets in selected records and replaces it with 
information entered by the user. (Available only if you are allowed to modify 
records.)

1. Select one or more records.

2. Select Metadata > Find And Replace Metadata. A dialog opens.

3. Select the field that stores the information you want replaced. Clicking the 
arrow button reveals a list of all editable String fields of all open catalogs.

4. Enter the text to be replaced in the Text to find field.

5. Enter the replacement text in the field Replace with.

NOTE: You may enter \n for a line break. 

FOR SPECIALISTS ONLY: If you activate the Use Regular Expression check-
box, you can enter regular expressions (Perl 5 like) in the Text to find and 
Replace with fields. For a description on using regular expressions, please 
refer to the special literature available in book stores and on the Web.

6. Click Start. Cumulus starts to search for the entered text in the selected field 
of the selected records. You will get a notice for each of the selected records 
whether the text was replaced or not. Replacements are not necessary if the 
text to be replaced wasn’t contained in the selected field or if a record is 
stored in a catalog that does not provide the selected field.

7. Click Close to finish.

Assign Label
Opens a submenu for selecting the labeling you want to assign to the select 
record(s). (Disabled if no Labeling field is included in the catalog or if the effects 
of assigning the label cannot be immediately seen by the user.) For more infor-
mation, see “Labeling,” p. 113. 

Assign Rating 
Opens a submenu for selecting the rating you want to assign to the select 
record(s). You can rate assets from 1 to 5. (Disabled, if no Rating field is included 
in the catalog.) For more information, see “Rating Assets,” p. 115. 
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Assign Categories
Assigns a selection of records to a selection of categories, or vice versa. (This is 
the opposite of “Detach Categories.’) (Available only, if you are allowed to modify 
records.) 

NOTE: If you have a large number of records (more than 500) you want to 
assign, it is better that you use this function rather than drag and drop. 

1. Select one or more records.

2. Select one or more categories to which you want to assign the selected 
records.

3. Select Metadata > Assign Categories. The records are assigned to each of 
the categories in the selection.

Detach Categories
Detaches a selection of records from a selection of categories, or vice versa. (This 
is the opposite of “Assign Categories’.) (Available only, if you are allowed to mod-
ify categories.)

1. Select one or more records.

2. Select one or more categories which you want to detach from the selected 
records.

3. Select Metadata > Detach Categories. The records are detached from each 
of the categories in the selection.

Optimize Thumbnail
Equalizes the appearance of the selected records’ thumbnails. This is useful for 
thumbnails that are too dark, too light, or lacking contrast. The action cannot be 
undone, but you can force-update the record to get back the original thumbnail. 
(Disabled if no records are selected.) (See “Update Record,” p. 274, for information 
on updating a record, including its thumbnail.)

Rotate Preview
Rotates the selected preview’s images in one of three ways:
• 90° clockwise
• 90° counter-clockwise
• 180° 
(Available only in Preview view or when the Preview window is open.)

Rotate Thumbnail
Rotates the selected records’ thumbnail images in one of three ways:
• 90° clockwise
• 90° counter-clockwise
• 180° 
(Disabled if no records are selected.)
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The record field Thumbnail Rotation saves the rotation value for a rotated 
thumbnail. The rotated thumbnail will be used for previewing, printing, export-
ing to HTML and creating slide shows.

NOTE: Catalogs Created with Versions Prior to Cumulus 5.5!
If the field Thumbnail Rotation (for storing the rotation value) should be 
available with catalogs that have been created with previous versions, this 
record field has to be added to the catalog. The field is then empty. There are 
two ways to fill it out:
– Either, open the Asset Information window and enter the according value 
(degree of rotation) manually.
– Or, select Metadata > Update Record. This will set the thumbnail back to 
the asset's orientation. Then rotate the thumbnail again. The value of the rota-
tion will then be stored in the Thumbnail Rotation field. 

Assign Variants
Assigns variants to an asset. The asset to which other assets are assigned is called 
the source of the variant. 

1. Select the records of the assets you want to assign as variants to a source 
asset

2. Select Metadata > Assign as Variants. Then a message prompts you to 
select the source. 

3. Select the record you want to be assigned as the source of the variants and 
click OK.

To have the variants of an asset displayed, open a subpane and select a corresponding 
Sub-Pane Filter. For more information on asset relations, see “Managing Related 
Assets,” p. 124.

Assign Alternates
Assigns alternates to assets and lets you define a preferred alternate. 

1. Select the records of the assets you want to become alternates.

2. Select Metadata > Assign Alternates. Then a message prompts you to 
select the preferred alternate.

3. From the selected records, select the one you want to be the preferred alter-
nate and click OK.

To have the alternates of an asset displayed, open a subpane and select a correspond-
ing Sub-Pane Filter. For more information on asset relations, see “Managing Related 
Assets,” p. 124.

Show Related
Opens a submenu displaying the available sub-pane filters. Once you have cho-
sen a filter, a sup-pane displays the records of related assets according to the 
selected sub-pane filter.
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New Category
Creates a category under the currently selected category, named “Category”. This 
name can be changed immediately to a more fitting one. (Disabled unless a sin-
gle category is selected.)

New Related Category
Makes a related category for each of the currently selected categories. (Disabled 
unless one or more categories are selected.) (See “Category Types,” p. 30.)

New Master Category (optional)
Opens a window to enter a name for the new master category that will be cre-
ated under the currently selected catalog category. A master category has its 
own tab. (Disabled unless a catalog category is selected. Available with Enter-
prise or a special option only.)

The Asset Menu

Preview
Opens a Preview window for each selected record. The records’ assets must be 
available to display the Preview window. (Menu equivalent to the toolbar icon.)
The contents of the window opened depends on the asset type and on the 
active Record View Set. (For a description on how to configure the view of the 
Preview window see “Record View Sets,” p. 188.)
Image previews can be zoomed in or out and displayed in different sizes and you 
can add user comments. For more information, see “Preview View and Window,” 
p. 68.

Fullscreen Preview
Shows assets as fullscreen previews. You can display up to six different assets at 
once. The records’ assets must be available to display. 
What is displayed depends on the asset type and on the active Record View Set. 
(For a description on how to configure the view of the Preview window see 
“Record View Sets,” p. 188.)
For more information, see “Fullscreen Preview,” p. 73.

Fullscreen Slide Show
Shows assets as fullscreen previews in a slide show. The records’ assets must be 
available to display. (Menu equivalent to the toolbar icon.)
What is displayed depends on the asset type and on the active Record View Set. 
(For a description on how to configure the view of the Preview window see 
“Record View Sets,” p. 188.)
For more information, see “Fullscreen Slide Show,” p. 76.

Image Editor
Opens the selected image asset in a special window that allows you to edit the 
image. The Image Editor offers image cropping as well as calibration tools that 
can enhance the color, sharpness and brightness of your images. For details see 
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“Editing Images,” p. 150. 

Compare Previews
Opens the selected two image assets along with a comparison image in 
fullscreen view. For details see “Comparing Previews,” p. 76. (Disabled if less or 
more than two records are selected.)

View With
Opens a submenu with options for choosing an application for viewing the 
selected asset. (Disabled if no records are selected.)

Creating Application
Opens the selected records’ assets with the application that created the assets (if it 
is known and available).

Other
Opens a dialog to choose an application with which to view the selected records’ 
assets. 

Customize
Lets you customize the options in the View With menu. You can add and delete 
applications. 

Edit With
Opens a submenu with options for choosing an application for opening and 
editing the selected asset. (Disabled if no records are selected.)

NOTE: If the asset is under control of a version control system (e.g. Cumulus 
Vault), it will be checked out.

Creating Application
Opens the selected records’ assets with the application that created the assets (if it 
is known and available) and lets you edit the asset.

Other
Opens a dialog to choose an application with which to open and edit the selected 
records’ assets. 

Customize
Lets you customize the options in the Edit With menu. You can add and delete 
applications. 

Print With
Opens submenu with options for choosing an application. (Disabled if no 
records are selected.)

Creating Application
Prints the selected records’ assets with the application that created the assets (if 
it’s known and available.)
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Other 
Opens a dialog to choose an application with which to print the selected records’ 
assets. 

Customize
Lets you customize the options in the Print With menu. You can add and delete 
applications. 

Perform Asset Action
Opens a submenu that lists Cumulus Assets Actions. Selecting an Action from 
that submenu will perform it. For further information, see “Using Asset Actions,” 
p. 66.

TIP: 
If you have the appropriate permissions, you can easily access the 
preferences of Asset Actions by selecting the Customize entry in the 
submenu for selecting an Action. This entry opens the preferences for 
the current Action.

Convert To
Opens a dialog for converting the asset associated with the selected record to 
another file format. The target formats depend on the availability of Cumulus 
Converter modules. Before you decide on the Converter module, you specify the 
location for the converted file.
The offered modules depend on the AssetProcessor modules activated for the 
Asset Handling Set selected for asset access in your user settings. Several Con-
verter modules are available with a Cumulus standard installation, e.g.:
• Pixel Image Converter (For more information, see “Converting Image Assets,” 

p. 79)
• Watermark AssetProcessor (For more information, see “Watermarking 

Assets,” p. 83)
• ZIP AssetProcessor (For more information, See “Creating ZIP Archives,” p. 93.)

NOTE: If you have selected multiple assets' records, the chosen settings will be 
applied to convert all selected assets. 

Mail To
Use this option to attach an asset to an outgoing e-mail message. Cumulus 

launches your e-mail application (in case you have more than one, offers you 
a menu to select) / launches your default e-mail application.

Copy To
Copies the selected records’ assets to the location specified in the dialog that 
appears. The original assets are left alone. (Disabled if no records are selected.)

Copy Assets Assigned to Category To 
Opens a dialog in which you can choose a destination. Cumulus then copies the 
assets of records that are associated with the selected categories to the location 
you selected. The assets are saved in folders named for the categories selected.
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This option is handy for collecting production files for output (assuming the files 
all have at least one common category, such as project name). (Disabled if no cat-
egory is selected.)

Duplicate Asset and Record
Duplicates the asset of the selected record and the record itself. A dialog appears 
in which you can choose a name and set several options for the new asset and 
record. 

Activate Copy Record Metadata to copy the metadata from the original to the 
duplicated record, except creation date and modification date.
Activate Update Record to update the metadata in the duplicated record from 
the duplicated asset.
Activate Assign as Variant to assign the duplicated asset as a variant to the orig-
inal asset.
Activate Assign as Alternate to assign the duplicated asset as an alternate to the 
original asset.

Create WebAlbum
Opens a dialog in which you can create a Web Album. For further information, 
see “WebAlbum,” p. 95.

Show Location
Locates the selected records’ assets and displays them in the Mac OS X Finder or 
Windows Explorer. (Disabled if no records are selected.)

TIP: Show Location of Folder Category
The context menu for categories offers a similar function for folder cat-
egories. The selected category’s folder is displayed, e.g., in the 
Mac OS X Finder or Windows Explorer. (Disabled if no folder category 
is selected.)

Configure Web URL
Opens a dialog to display the URL (Uniform Resource Locator) of the selected 
records, their assets, thumbnails or previews. You can copy these URLs and paste 
the links. The links will work if your Cumulus installation includes Cumulus Web 
Client or Sites. For details see “Configuring Web URL,” p. 100.
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Move To
Copies the selected records’ assets to the location specified in the dialog that 
appears and updates the records’ asset references to point to the new location. 
The original assets are deleted. (Disabled if no records are selected.)

Rename
Opens a submenu. The options are only available if you are allowed to modify 
records.

Single
Opens a dialog to rename the asset represented by the selected record. If asset 
name and record name are the same, the record name will be changed accord-
ing to the asset name.

Batch 
Opens a dialog to rename one or multiple assets represented by the selected 
records. If asset name and record name are the same, the record name will be 
changed according to the asset name.

The list on the left offers different name components for the new asset name(s). 
The list on the right displays the name components used for the renaming. 
Select the component you want to use in the left list and click the arrow button. 
The selected components are displayed in the right list. Each selected compo-
nent has to be defined before you can start the renaming. To define a compo-
nent, select it in the right list and click Properties. For each component, a 
different window is opened to define its properties. 
The result of your definitions is displayed under Preview. Once your definitions 
are as you like them, you have to decide what you want Cumulus to do if the 
name or one of the names created according to your definitions already exists in 
the folder where the asset to be renamed resides. Cumulus can either skip the 
renaming of this asset or add an auto number to the name of the renamed 
assets. 
If any assets can not be renamed (due to e.g. no writing rights or not writable 
storage media), a new category is created named Rename – Skipped Assets and 
inside a subcategory indicating date and time of the process to which the assets 
are assigned.
The definitions you made for renaming can be saved as a set. Using the icons, 
you can save the definitions as a set or open a saved set for renaming of the 
selected records. You can also open an existing set, modify it and then save it 
under a new name by using the Save As icon.
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Update Asset Reference(s)
Updates the path used to find the selected asset files, e.g when assets have been 
moved. Asset references can only be updated if the assets are available. (Disabled 
if no records are selected.)
Opens a dialog to specify how to proceed if asset references cannot be resolved:

• Assign record to special category – Records with unresolvable asset refer-
ences are assigned to a special category named Update reference -Skipped 
Assets and can be processed later. All other records are properly updated.

• Ask for asset location – The update process stops on every unresolvable 
asset reference and asks for the appropriate location

• Skip record – Records with unresolvable asset references are ignored. All 
other records are properly updated.

 Change Asset Reference
Opens a submenu. The options are only available if you are allowed to modify 
records.
This function allows you to update selected records to reflect a new location of 
their assets. This is useful if you have cataloged assets from a remote drive or vol-
ume that has since been renamed or have simply moved cataloged assets to a 
new location (and did not use Cumulus for moving them). Without this function, 
the records would still “point” to the old asset paths. This function does not over-
write, move or otherwise affect asset files at all. However, the function is available 
only if you are allowed to modify records.
You can either change the asset reference for a single asset by selecting an asset 
or you change the asset references for multiple assets through a batch process.

Select Single
Opens a dialog to browse for the asset that should be represented by the 
selected record.
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Batch 

1. Select the records that still point to the old location of the assets.

2. Select Asset > Change Asset Reference. 

3. Select Batch. 

A dialog appears asking you for the new location. The new location is 
defined in relation to the old location stored as asset reference.

• Server/Volume (under Windows only)
In case the assets now reside on another location in the Network, you have 
to activate the Network Option and then: 
a) if the assets now reside on another server (but a volume with the same 
name), activate the New Server option and enter the name of this new 
server into the field on the left.
b) if the assets now reside on another volume (but still on the same server), 
activate the New Volume option and enter the name of this new volume 
into the field on the left.
c) if the assets now reside on another server and another volume, activate 
both the New Server and the New Volume option and enter the names 
into the corresponding fields on the left.
In case the assets now reside on another local location, you have to acti-
vate the Local Option and then if the assets now reside on another drive, 
activate the New Drive option and select this new drive.

• Volume (under Mac OS X only)
In case the assets now reside on another volume, activate the New Volume 
option and select this new volume.

• Folder Settings
– Activate the Keep Existent option if the assets now reside in the same 
directory structure as they did before.
– Activate the None option if the assets now reside directly in the volume/
drive selected above (and not in any subdirectories).
– Activate the Add Parent option if the assets now reside in the same direc-
tory structure as they did before but this structure is now nested into 
another. The Add Parent option lets you enter the path of the directory 
that now nests the “old” directory structure.
– Activate the New option if the assets now reside in just one new directory 
(and not in any subdirectories). The New option lets you browse for the 
new directory by clicking the  button.
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4. After you select the options you want, click Start. 

The application searches for the assets represented by the selected records in the 
new location and updates the records to the new location. If an asset is not found 
in the new location, a new category is created named Change Reference – 
Skipped Assets and inside a subcategory indicating date and time of the process 
to which the asset is assigned.

Transform JPEG Original
Opens a submenu that allows you to rotate or flip the original asset if the asset is 
a JPEG file you have direct access to. The transformation will transverse the JPEG 
lossless. (Available only if you are allowed to modify records.)
The Advanced item opens a dialog to specify further settings.
Along with the transformation of the asset, its record will be updated as well. The 
thumbnail will be updated and resemble the transformed asset – regardless of 
whether the thumbnail was rotated before. The following record fields will be 
updated with the new values: Horizontal Pixel, Horizontal Resolution, Image 
Height, Image Width, Thumbnail Height, Thumbnail Rotation, Thumbnail Width, 
Vertical Pixel, and Vertical Resolution.

Check Out
Checks out the asset associated with the highlighted record to your workstation. 
Only available if asset versionig is enabled, e.g via File System Versioning or 
Cumulus Vault. (For more information on Cumulus Vault, see “Checking Assets 
Out,” p. 137.) 

Undo Check Out
Cancels a previous check-out. The asset is returned to the asset versioning sys-
tem but not as a new version. Only available if asset versionig is enabled, e.g via 
File System Versioning or Cumulus Vault. (For more information on Cumulus 
Vault, see “Undoing a Check Out,” p. 139.) 

Check In
Checks a previously checked-out asset back into the asset versioning system as 
a new version. Only available if asset versionig is enabled, e.g via File System Ver-
sioning or Cumulus Vault. (For more information on Cumulus Vault, see “Check-
ing Assets In,” p. 138.) 

Show History
Opens the Version History window, from which you can view version information 
on the asset associated with the selected record. Only available if asset versionig 
is enabled, e.g via File System Versioning or Cumulus Vault. (For more informa-
tion on Cumulus Vault, see “Viewing an Asset’s Version History,” p. 139.) 
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The Help Menu

Contents and Index
Opens the table of contents and searchable index window for Cumulus’ online 
help system. 

NOTE: The Cumulus help system is based on HTML pages that can be viewed 
with any standard Web browser. However, if you employ any pop up blockers, 
the display of the help system may not be possible. 

Source
Opens a submenu that offers the options for the source of the Cumulus help sys-
tem you use. Select the desired:

Online
Cumulus help comes from the Canto website, where the latest updates will 
always be available. (This requires an Internet connection.)

Local
Cumulus help comes from your hard drive – if you had it installed with your 
Cumulus Client application. 

About 
Displays a dialog that shows the version of Cumulus you’re using. You can get 
detailed version information by clicking the More button. It also provides a but-
ton that launches your default Web browser and initiates a connection to the 
Canto Web site. This requires an Internet connection. (See the Microsoft Win-
dows documentation for information on setting your default Web browser.)
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Keyboard Shortcuts
This appendix gives a list of keyboard shortcuts to common menu

commands and options. 
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Windows Mac OS X

Collection Window – Record Pane
Thumbnail View Ctrl+1 Cmd+1

Details View Ctrl+2 Cmd+2

Information View Ctrl+3 Cmd+3

Preview View Ctrl+4 Cmd+4

Open Information window Ctrl+I Cmd+I

Open IPTC Information window Ctrl+Shift+I Cmd+Shift+I

Open Preview window Ctrl+Y Cmd+Y

Open Fullscreen Preview window Ctrl+Shift+Y Cmd+Shift+Y

Open Record Find window Ctrl+F Cmd+F

Show location Ctrl+R Cmd+R

Open asset with creating application Ctrl+E Cmd+E

Connect to server Ctrl+Shift+O Shift+Cmd+O

Open catalog (when connected to a server) Ctrl+O Cmd+O

Catalog assets Ctrl+B Cmd+B

Print Ctrl+P Cmd+P

Display all records Ctrl+G Cmd+G

Select all Ctrl+A Cmd+A

Deselect all items Ctrl+Shift+A Shift+Cmd+A

Deselect one item Ctrl+spacebar     ---

Hide Cumulus     --- Cmd+H

Hide others     --- Alt+Cmd+H

New empty collection Ctrl+Shift+N Shift+Cmd+N

Close collection window Ctrl+F4 Cmd+W

Exit Cumulus Alt+F4 Cmd+Q

Undo Ctrl+Z Cmd+Z

Cut Ctrl+X Cmd+X

Copy Ctrl+C Cmd+C

Paste Ctrl+V Cmd+V

Edit Preferences Ctrl+, Cmd+,

Delete record from catalog Ctrl+Del Cmd+Del

Remove record from collection Del Del

Delete record from catalog without asking (same com-
mand as Cut)

Shift+Del Cmd+X

Assign rating: 1 star Ctrl+Alt+1 Alt+Cmd+1

Assign rating: 2 stars Ctrl+Alt+2 Alt+Cmd+2

Assign rating: 3 stars Ctrl+Alt+3 Alt+Cmd+3

Assign rating: 4 stars Ctrl+Alt+4 Alt+Cmd+4

Assign rating: 5 stars Ctrl+Alt+5 Alt+Cmd+5

Assign rating: no stars (no value) Ctrl+Alt+N Alt+Cmd+N

Start/quit Palette Mode Shift+Ctrl+P Shift+Cmd+P

For Thumbnail display

– use next larger size + +

– use next smaller size  - -

– rotate 90° clockwise Ctrl+Alt+R Alt+Cmd+R

– rotate 90° counterclockwise Ctrl+Shift+R Shift+Cmd+R

– rotate 180° Ctrl+Alt+Shift+R Shift+Alt+ Cmd+R

Change to next window Ctrl+Tab/Ctrl+F6  – – –

Thumbnail view 
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Go to previous record arrow left arrow left

Go to next record arrow right arrow right

Go to record above arrow up arrow up

Go to record below arrow down arrow down

Details view: 

Go to previous record arrow up arrow up

Go to next record arrow down arrow down

Go to first page (unmarked) Alt+Home Alt+Home

Go to previous page (unmarked) Alt+arrow left Alt+arrow left

Go to next page (unmarked) Alt+arrow right Alt+arrow right

Go to last page (unmarked) Alt+End Alt+End

Go to first page (marked) Home Home

Go to previous page (marked) PgUp PgUp

Go to next page (marked) PgDn PgDn

Go to last page (marked) End End

Assign categories Ctrl+Shift+5 Shift+Cmd+5

Detach categories Ctrl+Shift+6 Shift+Cmd+6

When dragging & dropping an OPI file into another applica-
tion:
– place high resolution file 
– place low resolution file

– – –
– – –

Alt+H
Alt+L

Toggle: category and record pane Tab Tab

Collection Window – Category Pane
Create new category Ctrl+J Cmd+J

Expand all categories Ctrl+Alt+X Alt+Cmd+X

Collapse all categories Ctrl+Alt+C Alt+Cmd+C

Category search for previous category Alt+arrow up Alt+arrow up

Category search for next category Alt+arrow down Alt+arrow down

Category search for selected category Enter Enter

Enterprise: Remove categories from collection 
Workgroup: Delete categories

Del Del

Delete categories Ctrl+Del Cmd+Del

With collapsed category: 
Go to category of next higher level 
With expanded category:
Collapse category

arrow left arrow left

With collapsed category: 
Expand category 
With expanded category:
Go to next subcategory

arrow right arrow right

Go to previous category arrow up arrow up

Go to next category arrow down arrow down

Go to first category (unmarked) Ctrl+Home Cmd+Home

Go to previous category page (unmarked) Ctrl+PgUp Cmd+PgUp

Go to next category page (unmarked) Ctrl+PgDn Cmd+PgDn

Go to last category (unmarked) Ctrl+End Cmd+End

Go to first category (marked) Home Home

Go to previous category page (marked) PgUp PgUp

Go to next category page (marked) PgDn PgDn

Go to last category (marked) End End

Collection Window
Show/hide Category pane Ctrl+F3 Cmd+F3

Show/hide Information pane Ctrl+F7 Cmd+F7

Windows Mac OS X
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Show/hide Category Information pane Ctrl+F8 Cmd+F8

Show/hide Thumbnail pane Ctrl+F9 Cmd+F9

Show/hide Preview pane Ctrl+F10 Cmd+F10

Show/hide Calendar pane Ctrl+F11 Cmd+F11

Show/hide Collection Basket pane Ctrl+F12 Cmd+F12

Use Default Workspace Ctrl+F1 Cmd+F1

Assign categories Ctrl+Shift+5 Cmd+Shift+5

Detach categories Ctrl+Shift+6 Cmd+Shift+5

Information Window / View/Pane
Save changes Ctrl+S Cmd+S

Print Information window Ctrl+P Cmd+P

Load information on

– first record in collection Alt+Home – – – 

– on next record in collection Alt+arrow right – – – 

– on previous record in collection Alt+arrow left – – – 

– on last record in collection Alt+End – – – 

Go to next field Tab Tab

Go to previous field Shift+Tab Shift+Tab

Preview Window and Preview Fullscreen
Load preview of

– first record in collection Home Home

– previous record in collection PgUp /
Alt+arrow left

PgUp /
Alt+arrow left

– next record in collection PgDn /
Alt+arrow right

PgDn /
Alt+arrow right

– last record in collection End End

100% display Alt+Ctrl+0 Alt+Cmd+0

Fit to main window Ctrl+0 Cmd+0

Zoom in Ctrl++ Cmd++

Zoom out Ctrl+- Cmd+-

Scroll in preview arrow keys arrow keys

Preview Window only
Print preview Ctrl+P Cmd+P

Edit with creating application Ctrl+E Cmd+E

Preview Fullscreen only
Start/stop loop spacebar spacebar

Close fullscreen mode Escape Escape

Multi-page Previews
Load first page of preview Alt+Shift+Home Alt+Shift+ Home

Load previous page of preview Alt+Shift+arrow left Alt+Shift+ arrow left

Load next page of preview Alt+Shift+arrow right Alt+Shift+ arrow right

Load last page of preview Alt+Shift+End Alt+Shift+End

Windows Mac OS X



Glossary
This Glossary offers an alphabetical listing of terms and phrases used

throughout this manual and Cumulus.
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Action 
Function or combination of certain functions. Cumulus provides different types 
of actions. See also Asset Action, Trigger Action.

Asset
A general term describing any type of digital media (including graphic, page lay-
out, presentation, sound, and video files) that has value to its owner. 

Asset Action
Combination of certain functions saved under a chosen name that is performed 
on assets in Cumulus. 

Asset Handling Module
When cataloging and accessing assets, Cumulus uses different modules: Asset 
Storage, Asset Processor, Metadata and Filter modules. 

Asset Handling Set
A setting that defines how assets are handled – during the cataloging process 
and when accessing assets.

Asset Information
The information about an asset as stored in the record associated with the asset.

Asset Information window
A special window that displays the information about a cataloged asset. This 
information is stored in the asset’s record. (See also Record.) Cumulus also pro-
vides an Information View and an Information Pane.

Asset Reference
The mechanism by which Cumulus tracks the actual location of an asset man-
aged in a Cumulus catalog.

AXR (Asset Cross References)
Automatic detection of usage and cross-references of assets within Cumulus. 
Cumulus is able to detect links and placed assets in compound documents such 
as QuarkXPress, EPS, Adobe InDesign, and Illustrator (version 8, 9) as well as 
Microsoft Word and PowerPoint documents. 

Boolean
A system of logic based on two possible values: true or false. Cumulus uses the 
Boolean operators "and" and "or" to combine search conditions.

Cache
A temporary storage area where frequently accessed data can be stored for rapid 
access.

Catalog
A special file (with the extension .ccf ) that Cumulus creates to manage cataloged 
assets. See also Asset and Cumulus Catalog File.

Catalog file name
Name of the special file for a catalog (  with the extension .ccf). The catalog 
name defaults to this file name (without the extension). The catalog name can 
be changed without changing the catalog file name. See also Cumulus Catalog 
File.
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Cataloging
The process by which a user adds one or more assets to a catalog. 

Category
Cumulus categories are used to organize records, much like folders are used to 
organize files in a traditional filing cabinet. But the asset can appear in any num-
ber of Cumulus categories at one time. They are similar in purpose to keywords 
used in other programs. See also Folder category and Related category.

Category Information window
A special window that displays the information about categories.

Category Exchange File
See Cumulus Category Exchange File. 

Category pane
Located on the left side of the Collection window. The Category pane displays 
category names in a hierarchical list. Multiple tabs are provided so that categories 
can be created and displayed in separate tabs.

Category View Set 
A setting that defines the display options for the Category Information window. 
For each tab different display options can be set.

Central asset location
A central asset location is a single storage location used to store certaindigital 
assets. Employing a central asset location ensures your assets remain accessible 
to all, and can more easily be accounted for.

Client
A computer user who accesses a server application (such as the Cumulus Server) 
across a network.

Client/server architecture
A software configuration in which users (also called clients) access a server appli-
cation across a network.

Collection
Any set of records from any one catalog, including their display properties. A col-
lection can be saved (see Cumulus Collection File) and opened again. A collec-
tion – whether saved or unsaved – is always connected to its catalog. In order to 
open a particular collection you must have access to its catalog.

Collection window
A window featuring two panes (Category pane and Record pane) that function 
as the central user interface. 

Compound search
A search query consisting of two or more search conditions.

Context menu
Also called shortcut menu. A menu that opens when clicking the right mouse 
button /  Control key + mouse button. The available options are related to the 
selected object.
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Cross Client
See Cumulus Cross Client.

Cumulus 
An indispensable digital asset management system for organizing and manag-
ing digital assets. See also Asset.

There are different editions of Cumulus designed to meet the needs of anyone 
who wants to keep track of their digital media: Cumulus Workgroup and 
Cumulus Enterprise. 

Cumulus Administrator 
A person who configures and manages Cumulus catalogs. The Administrator is 
responsible for keeping the catalogs running smoothly for Cumulus Client users, 
backing up catalogs, and other tasks. 

Cumulus application window
The main Cumulus window containing the menu bar, the toolbar, the statusbar, 
and – as “child” window(s) – the Collection window(s) with various panes.

Cumulus Action
See Asset Action.

Cumulus Catalog File
A special file(with the extension .ccf) that Cumulus creates to manage cataloged 
assets (digital media).

Cumulus Category Exchange File
A file (  with the extension .cce) that Cumulus creates when exporting category 
information.

Cumulus Collection File
A special file (  with the extension .cfe) that Cumulus creates to manage saved 
collections.

Cumulus Cross Client
Standalone version of the Cumulus Native Client. It enables users to create new 
catalogs on their local computers, open catalogs served by Cumulus Servers, and 
update metadata and assets between the two.

Cumulus Internet Client Pro
A Cumulus Option. A powerful Java based application designed to publish, dis-
tribute and market assets over the Internet. Users with a standard Web browser 
can comfortably search for cataloged assets, collect them into a collection basket 
and convert them as required. They can also catalog assets, assign them to cate-
gories and edit metadata. 

Cumulus Record Exchange File
A special file (  with the extension .cre) that Cumulus creates when exporting 
record information.

Cumulus Server
The computer where Cumulus Server software is installed and where Cumulus 
catalogs should reside.
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Cumulus Sites
A Cumulus Option. Starting with Cumulus 8.1, Cumulus Sites is the ideal tool to 
publish and market digital assets on dynamically generated Web pages to the 
Web. 

Cumulus Vault
A Cumulus Workgroup and Enterprise feature. A full-featured Version Control 
System that manages user access to asset files and provides up-to-the-minute 
information on each asset’s version history.

Cumulus Web Client
A Cumulus Option. Provides Cumulus catalogs online and offers read/write 
access for metadata edits as well as asset uploads and downloads to users with 
a standard Web browser. Starting with Cumulus 8.1, Cumulus Web Client is a 
standard feature on all Cumulus Workgroup, Enterprise and Complete systems. 
It is also available as an option for Cumulus Entry.

Cumulus Web Publisher Pro
A Cumulus Option. A powerful Java based application designed to publish, dis-
tribute and market assets over the Internet.

Details view
Each record appears in the Record pane as a text listing that includes fields you 
can define (e.g., record name, file format, resolution, etc.). See also Thumbnail 
view.

Drag and Drop
A way to move user-interface objects by dragging them with the mouse and 
dropping them into targets.

EJaP
Embedded Java PlugIn. Technology that provides unlimited possibilities to add 
new functionality or to integrate Cumulus into workflows. EJaPs are Java code 
that runs within the Cumulus application. 

EJSP
Embedded Server Plug-In. Technology that provides possibilities to add new 
functionality, or to integrate Cumulus into workflows. ESPs are similar to EJaPs 
(Embedded Java PlugIn). Whereas EJaPs are Java code that runs within the 
Cumulus application, ESPs are Java code that runs at the Cumulus Server. 

EXIF
Exchangeable Image File Format. Standard for storing interchangeable informa-
tion in image files, especially those using JPEG compression. Most digital cam-
eras now use the EXIF format. The format is part of the DCF standard created by 
JEIDA (Japan Electronics and Information Technology Industries Association) to 
encourage inter-operability between imaging devices. Cumulus can read EXIF 
metadata information while cataloging. You can view and edit this metadata. 
See also Metadata.

Filters
Software utilities that Cumulus uses to capture information about an asset dur-
ing the cataloging process. For more information on the availability of new file 
filters, please see the Canto Website (www.canto.com).
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Find window
Cumulus tool that enables users to search catalogs for records or categories that 
match search conditions.

Folder category
Folder categories are automatically created by Cumulus during the cataloging 
process. These automatically created categories resemble the folder or directory 
hierarchy in which the assets reside. They are identified by a smaller folder in their 
icons. They are created by default but this option can be disabled.

FTP
File Transfer Protocol. A standard Internet protocol, which is the simplest way to 
exchange files between computers on the Internet. 

HTTP
HyperText Transfer Protocol. A standard Internet protocol, which is the protocol 
most often used in the World Wide Web to transfer information between servers 
and browsers.

ICP
See Cumulus Internet Client Pro.

Information window
Special windows that display the information about records or catagories. See 
also Asset Information window,  and Category Information window.

IPTC 
International Press Telecommunication Council. Standard for digital text applied 
to an image. Applications used for professional imaging, support IPTC; e.g. the 
text information in Photoshop is a subset of the IPTC information. Cumulus can 
read IPTC metadata information while cataloging. You can view and edit this 
metadata and Cumulus can write your changes back to the asset. See also Meta-
data.

IPTC Information window
A special window that displays the IPTC information about a cataloged asset. This 
information is stored in the asset’s record. 

Java Server Page
Java Server Page (JSP) is a technology for controlling the content or appearance 
of Web pages through the use of servlets, small programs that are specified in 
the Web page and run on the Web server to modify the Web page before it is 
sent to the user who requested it. 

LDAP
Lightweight Directory Access Protocol. Directories containing information such 
as names, phone numbers, and addresses are often stored on a variety of incom-
patible systems. LDAP provides a simple protocol that allows you to access and 
search these disparate directories over the Internet.

Media file
Any electronic or digital media file (including graphic, page layout, presentation, 
sound and video files). See also Asset.
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Menubar
Appearing at the top of the Cumulus application window, the menubar houses 
menus that contain every program command.

Metadata
Metadata is any data that helps to describe the content or characteristics of an 
asset. It is the information stored with each asset—such as file name, location, 
etc. Different types of assets have different metadata fields: an image file, for 
example, would contain information on color and resolution, while an audio file 
would have a field for the playback duration.

Palette Mode
View mode that is specially designed for using Cumulus with another applica-
tion, e.g. a desktop publishing application. In palette mode the Cumulus applica-
tion shrinks to a palette that can conveniently be used with another application. 
That way you can easily drag and drop cataloged assets into other applications. 

Path/Pathname
A description of the location where a file is stored on a computer hard drive, 
server, or removable medium (such as CD-ROM, Syquest, Zip, Jaz, or MO car-
tridges).

Preview
A special program mode in which you can examine cataloged assets such as 
video clips, sound files, and image files.

Query
A combination of search conditions. Queries can be saved to disk and loaded 
into the Find window.

Quicklist
A list containing default field values to fill in fields. In Cumulus, available with the 
IPTC Information window.

Record
The actual catalog entry Cumulus creates when an asset is added to a catalog. 
Records store valuable information about an asset, such as the file name, file loca-
tion, file type, resolution, etc. 

Record Exchange File
See Cumulus Record Exchange file.

Record pane
Located on the right side of the Collection window, the Record pane displays 
records as thumbnails or plain text. See also Record, Thumbnail view and Details 
view.

Related category
An alias of an existing category that acts as a virtual cross reference to the original 
category. You can use related categories to place multiple instances of the same 
category under various parent categories, without having to copy the entire con-
tents of the category. By default, the names of related categories are displayed in 
italics with a “(related)” appendix. 
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Record View Set
A setting that defines how records are displayed in the different view modes 
Cumulus provides: Thumbnail View, Details View, Info View and Information win-
dow.

Resolution
The number of pixels per inch in any graphic file format. Higher-resolution files 
have a higher number of pixels per inch than lower-resolution files. Working with 
higher-resolution files usually requires more memory and hard disk space than 
working with lower-resolution files.

Script
A list of instructions executed by a computer. Scripts are used by Cumulus to per-
form complex tasks automatically.

Server/Client Asset Transfer
A Cumulus feature (especially useful in a cross platform environment) that allows 
users in a network to access assets for previewing, copying and transferring via 
their connection to the Cumulus Server. With this feature the user is not forced 
to have direct access to the computer where the asset is stored. Only the com-
puter running the Cumulus Server requires this access. 

Simple search
A search query consisting of one search condition.

Sites
See Cumulus Sites.

Skin
A term for the particular way in which information is arranged and displayed on 
a computer screen.

Statusbar
A bar providing descriptions on category/record status.

TAG file
The Cumulus Metadata Exchange file format, which Cumulus can create when 
cataloging assets from a location where you are allowed to save files. The file has 
the same name as the asset ( with the extension .tag). TAG files can hold all 
information that can be viewed in the Asset Information window – and more. For 
example, if a particular asset has been cataloged into different catalogs, this infor-
mation is part of that asset’s TAG file. 

Thumbnail
A miniature display of a cataloged asset.

Thumbnail view
The record appears with a miniature display of the cataloged asset in the Record 
pane.

Toolbar
A standard program tool that offers buttons as shortcuts to commonly used 
commands.
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Tooltip
A small floating descriptive window that appears above a toolbar button when 
the cursor is positioned over it.

Trigger
A stored procedure that is activated automatically when a specified event 
occurs. Cumulus Triggers can be used to perform many tasks, such as auditing 
catalogs, records and categories. Cumulus Triggers can be set for catalogs, 
records and categories. 

Trigger Action
The action performed when a Cumulus Trigger is activated. See also Action.

URL
Uniform Resource Locator. The address of a file (resource) accessible on the Inter-
net. 

XMP
Extensible Metadata Platform. Adobe’s XMP™ is a labeling technology that allows 
you to embed metadata into the asset itself. With an XMP-enabled application 
(e.g. all applications of Adobe Creative Suite), information about a project can be 
captured during the content creation process and embedded within the file and 
into a content management system. Cumulus can read XMP metadata informa-
tion while cataloging. You can view and edit this metadata and Cumulus can 
write your changes back to the asset. See also Metadata.

Web Client
See Cumulus Web Client.

WPP 
See Cumulus Web Publisher Pro.
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Index
A
About Cumulus (menu item) 246, 287

Access
locking for others by checking out 137
unlocking for others by checking in 138

Action (menu item) 281

Actions See Asset Actions

Activating
Asset Handling modules 206

Add Catalog to Collection (menu item) 251

Adding
assets to catalogs See Cataloging

Adobe InDesign See Indesign

Alternates 124
assign 129
preferred 125

Alternates tab 129

Apple iWork
Picture AssetStore 206
working with office documents 160

Apple Keynote Slides AssetStore 206

Application language, switch 257

Asset Actions
defining 222
editing definition 222
overview 223
setting as default 223
using 66

Asset Cross References 130
relation types 125

Asset Formats 217
creating 219
of Asset Handling Set 204

Asset Handling Modules 201
activating and deactivating 206
Apple iWork Picture AssetStore 206
Apple Keynote Slides AssetStore 206
Cumulus Metadata Support 215
Cumulus Vault 210
DCS File Support 211
Generic Asset Processor 212
HELIOS AssetProcessor 216
HELIOS XPV AssetStore 207
Mac OS File System AssetStore 207
MacBinary AssetStore 207

MS Power Point Picture AssetStore 208
MS PowerPoint Asset Processor 212
MS PowerPoint AssetStore 208
Office Open XML Pages and Slides AssetStore 208
Office Open XML Pictures and Media AssetStore 208
Office Open XML Presentation Processor 161, 212
Open Document AssetStore 208
OPI System Support 212
Outlook Message AssetStore 209
PDF AssetStore 209
PDF Image AssetStore 209
PDF Page Merge AssetProcessor 214
Pixel Image Converter 215
QXP AssetStore 209
QXP Server AssetProcessor 215
QXP Server AssetStorer 209
SCORM AssetStore 210
TAR AssetStore 210
Thumbnail Provider 212
UNIX File System 210
URL Support 210
Vault AssetStore 210
Video AssetSore 210
Watermark Asset Processor 215
Windows File System 211
XML Metadata Bridge 216
XML Metadata Prefiller 216
XMP Support 217
XUSR Metadata Bridge 217
Zip Asset Processor 215
ZIP AssetStore 211

Asset Handling Sets 199
Asset Access tab 203
Asset Formats tab 204
Cataloging tab 202
creating a new one 200
defining 200
editing definition 200
explained 39
overview 202
selected in User Settings 185
selecting 185
setting as default 201
Thumbnails tab 202

Asset Handling Sets, explained 12

Asset Information 23
editing 25
field types 24
window overview 36

Asset Processor Modules 211
creating presentations 86
offered when converting 185
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Asset References
changing 284

Asset Storage Modules 206

Assets 23
adding already cataloged to Vault 136
alternates 124

assign 129
cataloging 251

duplicate control during cataloging 202
from FTP or HTTP servers 145

checking in 138
checking out 137
configure web URLs 100
controlled by Vault 134
converting 281
copying 281

based on category 281
from Vault without check out 142
to an FTP location 148
while cataloging 203

creating own formats 219
defining version settings 141
deleting 260

from Vault 141
drag & drop 66

from Vault 143
editing version information 140
explained 10
file naming conventions 131
folder/directory naming conventions 132
formats supported 217
fullscreen previews 279
mailing 281

URL-cataloged 147
version 141

managing outside of Vault 142
menu options 279
moving

from Vault without check out 143
to an FTP location 148
to specified location 283

opening for viewing with specified application 280
opening Information window 24
opening URL-cataloged 147
opening with specified application 280
previewing latest or selected version 141
previews 266

zoom in 269
zoom out 269

printing
URL-cataloged 147
version 141
with specified application 280

rating 115
relation types 124
renaming 283
resampling 281
returning unchanged version 139
searching for assets under version control 271
Things You Can Do with 29

transfered by the Cumulus Server 300
variants 124

assign 130
versions 124

deleting all or selected 140
making previous version current 140
managing 139
rollback 140
viewing history of 139

Assign Categories (menu item) 277

Assigning
individual permissions for records/categories 175

Auto-cataloging 34

AXR 130
for Adobe InDesign documents 175
relation types 125

B
Backup (menu item) 258

Batch
changing asset references 285
renaming assets 283

Bulk Edit (menu item) 273

C
Calendar pane 262

Calendar Pane (menu item) 262

Canon Raw Metadata Support 159

Canon THM files 159

Catalog Assets (menu item) 251

Cataloging
adding assets via menu item 251
Asset Handling Set

selecting 185
assets from FTP or HTTP servers 145
automatic via folder category 34
copying assets to central location automatically 203
defining Asset Handling Set for 202
Embedded PDF Images 209
PDF files 209
Prefiller options 184
the slides of a PowerPoint presentation 165

Catalogs 17
assets

adding via menu option 251
select Asset Handling Set 251

backing up 258
closing 248
compressing 258
connecting to a remote server 246
explained 10
filtered views 17
naming

catalog names vs. catalog file names 132
legal cross-platform characters 132
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opening 246
opening recent 246
performance issues 17
preparing for EXIF 257
preparing for IPTC 257
preparing for XMP 258
rebuilding 258
removing from collections 251
scope of 17
showing all categories 271
showing all records 270
size, factors affecting 17
Things You Can Do with 18
thumbnail size options 202

Categories 29
assigning individual permissions to 175
assigning multiple 277
auto-cataloging 34
collapsing all 270
collapsing selected 270
copying associated assets 281
creating individual tabs 35
deleting from catalog 260
detaching multiple 277
dragging and dropping associated assets 66
editing a record’s category assignments 28
editing information 33
expanding all 270
expanding selected 270
explained 10
exporting 255
fields 33
find names containing 272
importing 254
information 272
Information pane 263
Live Filtering 31
merging 258
naming (length limit) 31
new 31
opening Information window 33
printing 255
related 30
removing records’ category assignments 28
renaming 31
searching for 54
searching with 271
show original for related 272
show related 272
showing all of a catalog 271
showing and hiding 262
synchronizing 254
Things You Can Do with 35
types 30
visible, number of 16

Category Child Permissions 176

Category Fields
adding to a view 196
defining display properties 197
field types 24

Category Information
window overview 36

Category Information Pane (menu item) 263

Category Properties
Permissions tab 178
Subcategories Permissions tab 179
Triggers tab 118

Category Tabs
creating individual 35
displaying selected 198

Category View Set (menu item) 267

Category View Sets 195
defining 195
editing definition 196

Central Asset Location
copying assets to during cataloging 203
on FTP server 149

Change Asset Reference (menu item) 284

Change Password (menu item) 256

Character Encoding
for Export 103
for ZIP files 94

Check In
assets 138
unchanged version 139

Check In (menu item) 286

Check Out
assets 137
cancelling 139
viewing availability for 144

Check Out (menu item) 286

Close (menu item) 248

Collapse (menu item) 270

Collapse All (menu item) 270

Collapsing
categories 270
panes 127, 261

Collection Basket Pane
show 263

Collection window
delete workspace 266
save default layout 265
save layout as 265
use default layout 265
use layout 266

Collection Window Layout See Workspace

Collections 17, 20
explained 10
inverting 271
new 248
opening 248
removing catalogs from 251



306  CUMULUS® –  CLIENT USER GUIDE
saving 248
saving as 248
sending links 248
showing all categories of entire catalog 271
showing all records of entire catalog 270
working with 21

Comments, entering on check in 138

Compare Previews (menu item) 280

Compress (menu item) 258

Compressing
assets into Zip archives 93
catalogs 258

Configure Web URL (menu item) 282

Connect to Server (menu item) 246

Contents and Index (menu item) 287

Convert To (menu item) 281

Converting
assets 281
pixel images 79
to PowerPoint presentation 86

Copy (menu item) 259

Copy Assets Assigned to Category To (menu item) 
281

Copy To (menu item) 281

Copying
assets 281
assets from Vault without check out 142
assets to an FTP location 148
records 28
to clipboard 259

Copying the record of a cataloged slide 166

Copyright 2
Create WebAlbum (menu item) 282

Creating
a new presentation from a cataloged slide 166
Asset Handling Set 200
categories 31
category tabs 35
Metadata Template 226
Permissions Template 241
Print Template 229
Record View Set 190
Sub-Pane Filter 238

Cropping 151

Cross-Platform Issues 9, 132

Cumulus Actions See Asset Actions

Cumulus Metadata Support 215

Cumulus Scheduler 123

Cumulus, detailed version information on 287

Customizing
Asset Handling Sets 199
Category View Sets 195

Record View Sets 188
User Settings 183

Cut (menu item) 259

D
DCS File Support 211

Deactivating
Asset Handling modules 206

Defining
Asset Actions 223
Asset Handling Sets 202
asset version settings 141
Category View Set 195
Metadata Templates 228
Permissions Templates 243
Print Templates 231
properties for Cumulus Metadata Support 215
properties for MediaDex Metadata Support 215
properties for the Digital Camera Raw Filter 158
properties of displayed category field 197
properties of displayed record field 193
Record View Set 188
Triggers 118

Delete (menu item) 260

Deleting
a cataloged slide 166
asset versions 141
catalogs from collection 251
categories from catalog 260
categories from collection 272
records from catalog 260
records’ category assignments 28
versions

all or selected 140
workspaces 266

Deselect All (menu item) 260

Detach Categories (menu item) 277

Details (menu item) 266

Digital Camera Raw Filter
defining properties 158
record fields for 158
sequence of formats for Asset Handling Set 158
supported formats 158

Drag and drop
assets into other applications 66
copying categories and associated assets 66
moving categories 31
of assets controlled by Vault 143

Duplicates
searching for 271
while cataloging 202

Duplicates (menu item) 271

Duplicates Control
while cataloging 202
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E
Editing

category names 31
information on assets 25
information on categories 33
IPTC data 154
metadata of multiple records at once 273
records’ category assignments 28
Vault version comments 140
Vault version information 140

Entering
comments on version 138
information on assets 25
information on categories 33
IPTC information on an asset 154

EXIF, preparing catalog for 257

Exit (menu item under Windows) 259

Expand (menu item) 270

Expand All (menu item) 270

Expanding
categories 270
panes 127, 261

Experience, required of the user 9
Export (menu item) 255

Exporting
categories 102
category assignments, maintaining 103
character encoding 103
menu options 255
process explained 103
quicklists 157
records 102
search queries 53

F
Field types 24

Audio 37

Fields
Category fields 33
for assets relations 125
mandatory 26, 156
Record fields 23
types 24
User Comment Thread 71

Files See Assets

Fill Metadata (menu item) 276

Filters
accessing 204
adding user live filter conditions 56
changing options 219
explained 205
file formats supported 217
generic 219

Managing User Live Filters 57
User Live Filter 56

Find All Categories (menu item) 271

Find All Records (menu item) 270

Find And Replace Metadata (menu item) 276

Find Categories (menu item) 271

Find Categories by Query (menu item) 272

Find Records (menu item) 270

Find Records Assigned to Categories (menu item) 
271

Find Records by Query (menu item) 270

Find window (advanced mode) 53

Find window simple mode) 45

Fit Heigt to Window (menu item) 269

Fit Width to Window (menu item) 269

Folder categories 31

Folder TAG files 216

Full Screen (menu item) 270

Fullscreen Preview (menu item) 279

Fullscreen preview window 73

Fullscreen Slide Show (menu item) 279

G
Generic Asset Processor 212

Go To (menu item) 269

H
HELIOS AssetProcessor 216

HELIOS XPV AssetStore 207

Help
accessing on website 287
Canto online resources 13
local source 287
online help contents and index 287
online help for users 13
online source 287
selecting source (online or local) 287

I
Image Editor 150

Image Editor (menu item) 279

Images
cropping 151
editing 150
rotating 152

Import (menu item) 254

Importing
assets into catalogs See Cataloging
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categories 102
category assignments, maintaining 103
from Text/CSV Files 106
graphic files into PowerPoint 168
menu options 254
process explained 103
quicklists 157
records 102
search queries 53
slides from Cumulus into PowerPoint 168
slides from MediaDex into PowerPoint 168

InDesign plug-in 170

InDesign support 170
AssetStore module 171
filter 172

Information (Category menu item) 272

Information (menu item) 266, 272

Information Pane (menu item) 264

Information view 266

Information window
opening with double-click on record 184
overview 36

Invert Collection (menu item) 271

IPTC
and XMP 275
preparing catalog for 257
writing IPTC data back to assets 257

IPTC data
viewing 154
writing back to assets 154

IPTC Information (menu item) 273

IPTC Information window 154
overview 155

J
JPEG

flipping 286
rotating 286

K
Keyboard shortcuts 289

L
Labeling 113

Labels
assign (menu item) 276
colors of 114
included in views 114

Language, switch application language 257

License
opening window 287

License (menu item) 287

Lighttable
previewing multiple images 73

Links
to collections 248

Live Filtering 17

Location
central for assets 203
show for selected record 282
show for seleted folder category 282

M
MacBinary AssetStore 207

Mail To (menu item) 281

Mailing
asset version 141
assets to 281
URL-cataloged assets 147

Managing related assets 124

Mandatory field 156

Master asset 129

Menus
Asset 279
File 246
Help 287
View 260

Merge Categories (menu item) 258

Metadata
and catalogs 17
and filters 205
and records 23
and TAG files 23
EXIF 257
Find and Replace 276
IPTC 257
IPTC and XMP 275
linking fields 205
modules for 205
XMP 258

Metadata Modules 215
Cumulus Metadata Support 215
XML Metadata Bridge 216
XML Metadata Prefiller 216
XMP Support 217
XUSR Metadata Bridge 217

Metadata Support 215

Metadata Templates 226
creating a new one 226
defining 227
editing definition 227
overview 228
setting as default 227
using 26

Metadata Templates, explained 12, 41
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Microsoft Office
working with office documents 160

Microsoft Office System
working with office documents 160

Migrate Cumulus 4 Catalog (menu item) 259

Missing Assets (menu item) 271

Move To (menu item) 283

Moving
already cataloged assets to Vault 136
assets 283
assets from Vault without check out 143
assets to an FTP location 148
records 28

MS Office documents
configurations for 163

MS PowerPoint
Add-In 166
Asset Processor 212

parameters 92
AssetStore 208
Picture AssetStore 208
support modules for Mac OS X 164
support modules for Windows 164

Multipage Preview 70

N
Naming

catalogs for cross plaform use 132
categories 31
file naming conventions 131

New (Collection menu item) 248

New Category (menu item) 279

New Master Category (menu item) 279

O
Office Open XML

Pages and Slides AssetStore 208
Pictures and Media AssetStore 208
Presentation Processor 161, 212

parameters 87, 92

Office PowerPoint 2007 presentations
creating 87

Open (Collection menu item) 248

Open Catalog (menu item) 246

Open Document AssetStore 208

Open Recent Catalog (menu item) 246

Open With (menu item) 280

Opening
Asset Information window 24
assets 280
catalogs 246
catalogs (Workgroup or Enterprise) 246

Category Find window 271
Category Information window 33
collections 248
Preview window 279
recent catalogs 246
Record Find window 270
URL-cataloged assets 147

OpenOffice
working with office documents 160

OPI System Support 212

Optimize Thumbnail(s) (menu item) 277

Outlook Message AssetStore 209

Overviews
Asset Actions 223
Asset Handling Sets 202
Metadata Templates 228
Permissions Templates 243
Print Templates 231
Print Templates - Advanced Print Settings 233
Print Templates - Margin Settings 232
Sample Search Options 47
The Find Window 46
Toolbars for previews 69
User Settings - Display Tab 186
User Settings 1 184

P
Page Setup (menu item) 255

Palette Mode (menu item) 260

Palette Mode, activate and deactivate 260

Panes
Asset Information 264
Calendar pane 262
Category Information pane 263
Category pane 16
Preview pane 265
Record pane 16
resizing 127, 261
sub-panes for related asset view 126
Thumbnail pane 265

Password
changing 256

Paste (menu item) 259

PDF
cataloging 209
cataloging embedded images 209
print options 234
printing to 236

PDF AssetStore 209

PDF Image AssetStore 209

PDF Page Merge AssetProcessor 214

Permissions Templates 241
creating a new one 241
editing definition 242
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explained 41
overview 243
setting as default 243

Permissions Templates, explained 12

Pixel Image Converter 215
parameters 79

Plug-in for Adobe InDesign 170

PowerPoint
support modules for Mac OS X 164
support modules for Windows 164

PowerPoint 97-2003 presentations
creating 91

PowerPoint Add-In 166
integrating with MS Office under Mac OS X 167
integrating with MS Office under Windows 167

PowerPoint Asset Processor 212
parameters 92

Preferences 182
Asset Actions (overview) 223
Asset Handling Sets 199
Asset Handling Sets (overview) 202
Category View Sets 195
Metadata Templates (overview) 228
Permissions Templates (overview) 243
Print Templates (overview) 231
Record View Sets 188
User Settings 183
User Settings - Display Tab 186
User Settings (overview 1) 184

Preferences (menu item under Mac OS) 246

Preferences (menu item under Windows) 260

Prefiller utility
options 184

Prepare Catalog (menu item) 257

Presentations
creating 86

Asset Processor modules 86
parameters 87, 92

creating Office PowerPoint 2007 format 87
creating PowerPoint 97-2003 format 91

Preview (menu item) 266, 269

Preview annotations 70

Preview pane
user comments 70

Preview Sizes (menu item) 267

Preview window
user comments 70

Previews
configure web URLs 100
full screen display 270
multipage 70
of assets from Vault 141

opening 279
printing 255
resizing 269
rotating 277
show pane 265
toolbars 69
zoom in 269
zoom out 269

Print (menu item) 255

Print Preview (menu item Windows) 255

Print Templates 229
creating a new one 229
editing definition 230
explained 41
overview 231
overview advanced print settings 233
overview margin settings 232
PDF print options 234
setting as default 230

Print Templates, explained 12

Print With (menu item) 280

Printing
asset version 141
contact sheets 185, 231
Page Setup 255
print previews (Windows) 255
Print Templates 229
printing assets with other applications 280
printing records, categories or previews 255
to PDF 236
URL-cataloged assets 147

Program performance concerns
catalog size 17
cataloging progress bar, disabling 184
deactivating unused formats 218

Properties
defining for

Cumulus Metadata Support 215
Digital Camera Raw Filter 158
filters 219
Mac OS File System 207
MediaDex Metadata Support 215
OPI System Support 213
TAR AssetStore 210
Windows File System 211
XML MetadaBridge 217
ZIP AssetStore 211

Q
Queries

exporting 53
importing 53
loading 52
saving 52

Quicklists
editing 156
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exporting 157
importing 157
using 154

Quicksearch 44
fields defined for search 185
search options 44

Quit (menu item under Mac OS) 246

QXP AssetStore 209

QXP Server AssetProcessor 215

QXP Server AssetStore 209

R
Rating 115

assign (menu item) 276

Rebuild (menu item) 258

Record Fields
adding to a view 191
defining display properties 193
Digital Camera Raw Filter 158
Related Master Assets 125
Related Sub Assets 125
types 24

Record Properties
Permissions tab 178
Triggers tab 118

Record View Set (menu item) 266

Record View Sets 188
creating a new one 190
editing definition 190
selecting 16
selecting in Information window 37
setting as default 191

Record/Category Permissions 175

Records 23
asset references, updating 29
assigning categories 277
assigning individual permissions to 175
cataloging duplicate control during 202
category assignments, editing 28
configure web URLs 100
copying between catalogs 28
deleting from catalog 260
detaching categories 277
duplicates while cataloging 202
editing metadata of multiple at once 273
editing multiple 37
explained 11
exporting 255
finding duplicates 271
importing 254
labeling 113
printing 255
relationship to assets 11, 23
removing category assignments 28
searchable information, minimum 23

searching for with inaccessiable asset references 271
showing all of a catalog 270
Size considerations 27
Things You Can Do with 28
thumbnail size 201
updating 166, 274
updating asset references 284
View Sets 188
visible, number of 16

Registration 287

Regular expression 276

Related categoy 30

Relation tabs 129

Relation types 124

Remove Catalog from Collection (menu item) 251

Remove Category from Collection (menu item) 272

Removing
catalogs from collection 251
categories from collection 272
format from Asset Handling Set 204
records’ category assignments 28

Rename (menu item) 283

Renaming
assets 283
shared Asset Actions 224
shared Asset Handling Sets 199
shared templates 228
shared view sets 190

Report (menu item) 266

Repurposing assets 77

Resizing
panes 127, 261

Retrieving assets from Vault 138, 142, 143

Returning assets to Vault 137, 139

Rollback for Versions (Vault) 140

Rotate Preview(s) (menu item) 277

Rotate Thumbnail(s) (menu item) 277

Rotating
images 152
JPEG original asset 286
previews 277
thumbnails 277

S
Save (Collection menu item) 248

Save As (Collection menu item) 248

Save Current as Default Workspace (menu item) 265

Save Current Workspace As (menu item) 265

Scheduler 123
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SCORM AssetStore 210

Searching 44
accessing the Category Find window 271
accessing the Record Find window 270
adding conditions 49
boolean operators 48, 49
broadening search results 51
by Calendar pane 262
by User Live Filter 56
Criteria 47
deleting conditions 49
examples

compound (more than one condition) 48
simple (only one condition) 47

fields selected for Quicksearch 185
Find window 46
Find window (advanced mode) 53
Find window (simple mode) 45
finding category names containing 272
for assets under version control 271
for categories 54
for duplicate records 271
for records using categories 44
for records with inaccessiable asset references 271
for records with Quicksearch 44
loading search queries 52
methods

broadening 51
narrowing 50

narrowing search results 50
Operator 47
options 185
performing a selected category query 272
performing a selected query 270
Preferences 44
Quicksearch 44
sample search options overview 47
saving search queries 52
Things You Can Do with Queries 53
using categories 271
Value 47

Select All (menu item) 260

Selecting
Asset Handling Sets in User Settings 185
Record View Sets in Information window 37

Send Collection Link (menu item) 248

Separator
adding to a view 192

Server Console (menu item) 256

Server/Client Asset Transfer 300

Show Categories Containing (menu item) 272

Show Category List (menu item) 262

Show Collection Basket Pane (menu item) 263

Show History (menu item) 286

Show Location (menu item) 282

Show Original Category (menu item) 272

Show Preview Pane (menu item) 265

Show Related Categories (menu item) 272

Showing Location
of a cataloged slide 165
of selected record 282

Size
of catalogs 17
of displayed thumbnails 186
of records 27
of thumbnails (stored with record) 202
of thumbnails, affect on record size 201

Slide shows
displaying fullscreen previews as 279

Slides
copying of cataloged 166
deleting of cataloged 166
showing location of cataloged 165

Sort By (menu item) 267

Sort Direction (menu item) 268

Sorting
by two fields 267
direction 268
selecting criteria 16, 267
User Settings options for 185

Source (menu item) 287

Split View 126

Status Bar
icons explained 16

Sticky notes 71

Storing already cataloged assets in Vault 136

String List fields 25

Sub-Pane Filters
creating a new one 238
editing definition 240
setting as default 240

Switch Application Language (menu item) 257

Synchronize Now (menu item) 254

T
TAG files 23, 215, 253

for folders 216
for InDesign documents 171
on FTP servers 145

TAR AssetStore 210

Templates
Permissions 241

Things You Can Do with
Assets 29
Catalogs 18
Categories 35
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Records 28
Searches/Queries 53

THM files 159

Thumbnail Pane (menu item) 265

Thumbnail Provider 212

Thumbnail Sizes (menu item) 267

Thumbnails
affect on record size 201
configure web URLs 100
optimizing 277
options for creation 202
rotating 277
show pane 265
size options for cataloging 202
size options for display 186

Thumbnails (menu item) 266

Toolbar (menu item) 261

Transform JPEG Original (menu item) 286

Trigger 117

Trigger Administrator (permission) 118

U
Undo (menu item) 259

Undo Check Out (menu item) 286

Undoing a check out 139

Update Asset Reference(s) (menu item) 284

Update Record (menu item) 274

Updating
asset references 284
records 166, 274

URL
get links for records, assets and previews 100

URL AssetStore 145

Use Default Workspace (menu item) 265

Use Workspace (menu item) 266

User Authentication
while cataloging from FTP or HTTP servers 145
while working with URL-cataloged assets 147

User comments 70
rectangle comment 71
sticky notes 71

User Guide
conventions used 9
user experience required to understand 9

User Interface
Information window 36
IPTC Information window 155
The Find Window 46
User Settings - Display (overview) 186
User Settings (overview 1) 184

User Live Filtering 56

User Settings 183
Asset Handling options 185
Asset Handling tab 185
Cataloging Prefiller options 184
Display tab 186

general options 186
transparency options 186

Printing tab 185
Search & Sort tab 185
Search options 185

Using Cumulus
user experience required to understand 9

V
Variants 124

assign 130

Variants tab 129

Vault
checking assets into 138
checking assets out of 137
copying assets controlled by 142
deleting assets controlled by 141
deleting assets from 140
deleting selected version or all 140
drag & drop of assets 143
editing version information 140
leaving version control 142
mailing assets controlled by 141
making previous version current 140
managing versions 139
moving assets from 143
previewing assets controlled by 141
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